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CHAPTER
ONE

INTRODUCTION

The OpenMOde"cq system described in this document has both short-term and long-term goals:

The short-term goal is to develop an efficient interactive computational environment for the Modelica lan-
guage, as well as a rather complete implementation of the language. It turns out that with support of
appropriate tools and libraries, Modelica is very well suited as a computational language for development
and execution of both low level and high level numerical algorithms, e.g. for control system design, solving
nonlinear equation systems, or to develop optimization algorithms that are applied to complex applications.

The long-term goal is to have a complete reference implementation of the Modelica language, including
simulation of equation based models and additional facilities in the programming environment, as well
as convenient facilities for research and experimentation in language design or other research activities.
However, our goal is not to reach the level of performance and quality provided by current commercial
Modelica environments that can handle large models requiring advanced analysis and optimization by the
Modelica compiler.

The long-term research related goals and issues of the OpenModelica open source implementation of a Modelica
environment include but are not limited to the following:

Development of a complete formal specification of Modelica, including both static and dynamic semantics.
Such a specification can be used to assist current and future Modelica implementers by providing a semantic
reference, as a kind of reference implementation.

Language design, e.g. to further extend the scope of the language, e.g. for use in diagnosis, structural
analysis, system identification, etc., as well as modeling problems that require extensions such as partial
differential equations, enlarged scope for discrete modeling and simulation, etc.

Language design to improve abstract properties such as expressiveness, orthogonality, declarativity, reuse,
configurability, architectural properties, etc.

Improved implementation techniques, e.g. to enhance the performance of compiled Modelica code by gen-
erating code for parallel hardware.

Improved debugging support for equation based languages such as Modelica, to make them even easier to
use.

Easy-to-use specialized high-level (graphical) user interfaces for certain application domains.
Visualization and animation techniques for interpretation and presentation of results.

Application usage and model library development by researchers in various application areas.

The OpenModelica environment provides a test bench for language design ideas that, if successful, can be submit-
ted to the Modelica Association for consideration regarding possible inclusion in the official Modelica standard.

The current version of the OpenModelica environment allows most of the expression, algorithm, and function
parts of Modelica to be executed interactively, as well as equation models and Modelica functions to be compiled
into efficient C code. The generated C code is combined with a library of utility functions, a run-time library, and
a numerical DAE solver.
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1.1 System Overview

The OpenModelica environment consists of several interconnected subsystems, as depicted in Figure 1.1.

MDT Eclipse Plugir GraphicalModel
Editor/Browser Editor/Browser
3
: Interactive t
OOtMthltm sessionhandler e Textual
ptimization ;
Subsystem / \ Model Editor
OMNotebook
DrModelica Execution Modelica
Model Editor Compiler
Modelica
Debugger

Figure 1.1: The architecture of the OpenModelica environment. Arrows denote data and control flow. The inter-
active session handler receives commands and shows results from evaluating commands and expressions that are
translated and executed. Several subsystems provide different forms of browsing and textual editing of Modelica
code. The debugger currently provides debugging of an extended algorithmic subset of Modelica.

The following subsystems are currently integrated in the OpenModelica environment:

* An interactive session handler, that parses and interprets commands and Modelica expressions for evalua-
tion, simulation, plotting, etc. The session handler also contains simple history facilities, and completion of
file names and certain identifiers in commands.

* A Modelica compiler subsystem, translating Modelica to C code, with a symbol table containing definitions
of classes, functions, and variables. Such definitions can be predefined, user-defined, or obtained from
libraries. The compiler also includes a Modelica interpreter for interactive usage and constant expression
evaluation. The subsystem also includes facilities for building simulation executables linked with selected
numerical ODE or DAE solvers.

* An execution and run-time module. This module currently executes compiled binary code from translated
expressions and functions, as well as simulation code from equation based models, linked with numerical
solvers. In the near future event handling facilities will be included for the discrete and hybrid parts of the
Modelica language.

* Eclipse plugin editor/browser. The Eclipse plugin called MDT (Modelica Development Tooling) provides
file and class hierarchy browsing and text editing capabilities, rather analogous to previously described
Emacs editor/browser. Some syntax highlighting facilities are also included. The Eclipse framework has
the advantage of making it easier to add future extensions such as refactoring and cross referencing support.

* OMNotebook DrModelica model editor. This subsystem provides a lightweight notebook editor, compared
to the more advanced Mathematica notebooks available in MathModelica. This basic functionality still
allows essentially the whole DrModelica tutorial to be handled. Hierarchical text documents with chapters
and sections can be represented and edited, including basic formatting. Cells can contain ordinary text
or Modelica models and expressions, which can be evaluated and simulated. However, no mathematical
typesetting facilities are yet available in the cells of this notebook editor.

* Graphical model editor/browser OMEdit. This is a graphical connection editor, for component based model
design by connecting instances of Modelica classes, and browsing Modelica model libraries for reading and
picking component models. The graphical model editor also includes a textual editor for editing model class
definitions, and a window for interactive Modelica command evaluation.

4 Chapter 1. Introduction
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* Optimization subsystem OMOptim. This is an optimization subsystem for OpenModelica, currently for
design optimization choosing an optimal set of design parameters for a model. The current version has a
graphical user interface, provides genetic optimization algorithms and Pareto front optimization, works in-
tegrated with the simulators and automatically accesses variables and design parameters from the Modelica
model.

* Dynamic Optimization subsystem. This is dynamic optimization using collocation methods, for Model-
ica models extended with optimization specifications with goal functions and additional constraints. This
subsystem is integrated with in the OpenModelica compiler.

* Modelica equation model debugger. The equation model debugger shows the location of an error in the
model equation source code. It keeps track of the symbolic transformations done by the compiler on the
way from equations to low-level generated C code, and also explains which transformations have been done.

* Modelica algorithmic code debugger. The algorithmic code Modelica debugger provides debugging for an
extended algorithmic subset of Modelica, excluding equation-based models and some other features, but in-
cluding some meta-programming and model transformation extensions to Modelica. This is a conventional
full-feature debugger, using Eclipse for displaying the source code during stepping, setting breakpoints, etc.
Various back-trace and inspection commands are available. The debugger also includes a data-view browser
for browsing hierarchical data such as tree- or list structures in extended Modelica.

1.2 Interactive Session with Examples

The following is an interactive session using the interactive session handler in the OpenModelica environment,
called OMShell — the OpenModelica Shell). Most of these examples are also available in the OMNotebook with
DrModelica and DrControl UsersGuideExamples.onb as well as the testmodels in:

>>> getInstallationDirectoryPath() + "/share/doc/omc/testmodels/"
"«OPENMODELICAHOME»/share/doc/omc/testmodels/"

The following commands were run using OpenModelica version:

>>> getVersion|()
"OMCompiler v1.13.0"

1.2.1 Starting the Interactive Session
The Windows version which at installation is made available in the start menu as OpenModelica->OpenModelica
Shell which responds with an interaction window:

We enter an assignment of a vector expression, created by the range construction expression 1:12, to be stored in
the variable x. The value of the expression is returned.

>>> x 1= 1:12
{1,2,3,4,5,6,7,8,9,10,11,12}

1.2.2 Using the Interactive Mode

When running OMC in interactive mode (for instance using OMShell) one can make load classes and execute
commands. Here we give a few example sessions.

Example Session 1

To get help on using OMShell and OpenModelica, type "help()" and press enter.

1.2. Interactive Session with Examples 5
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>>> model A Integer t = 1.5; end A; //The type is Integer but 1.5 is of Real Type
{A}

>>> instantiateModel (A7)

nmn

"[<interactive>:1:9-1:23:writable] Error: Type mismatch in binding t = 1.5
—expected subtype of Integer, got type Real.

Error: Error occurred while flattening model A

n

[

Example Session 2

To get help on using OMShell and OpenModelica, type "help()" and press enter.

model C
Integer a;
Real b;
equation
der (a) b;
der(b) = 12.0;
end C;

>>> instantiateModel (C)
nmnn

Error:

[<interactive>:5:3-5:13:writable] Error: Argument ’a’ to der has illegal type Integer, must be a subtype of
Real.

Error: Error occurred while flattening model C

1.2.3 Trying the Bubblesort Function

Load the function bubblesort, either by using the pull-down menu File->Load Model, or by explicitly giving the
command:

>>> loadFile (getInstallationDirectoryPath() + "/share/doc/omc/testmodels/
—bubblesort.mo")
true

The function bubblesort is called below to sort the vector x in descending order. The sorted result is returned to-
gether with its type. Note that the result vector is of type Real[:], instantiated as Real[12], since this is the declared
type of the function result. The input Integer vector was automatically converted to a Real vector according to
the Modelica type coercion rules. The function is automatically compiled when called if this has not been done
before.

>>> bubblesort (x)
{12.0,11.0,10.0,9.0,8.0,7.0,6.0,5.0,4.0,3.0,2.0,1.0}

Another call:

>>> bubblesort ({4,6,2,5,8})
{8.0,6.0,5.0,4.0,2.0}

6 Chapter 1. Introduction
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1.2.4 Trying the system and cd Commands

It is also possible to give operating system commands via the system utility function. A command is provided as
a string argument. The example below shows the system utility applied to the UNIX command cat, which here
outputs the contents of the file bubblesort.mo to the output stream when running omc from the command-line.

>>> sgystem("cat '"+getInstallationDirectoryPath()+"/share/doc/omc/testmodels/
—bubblesort.mo' > bubblesort.mo")
0

function bubblesort

input Real[:] x;

output Real[size(x,1)] vy;
protected

Real t;
algorithm

y 1= X

for i in 1l:size(x,1) loop

for j in 1l:size(x,1) loop
if y[i] > y[Jj] then

t o= ylil;
ylil = y[3];
yl[3l = t;
end if;
end for;
end for;

end bubblesort;

Note: The output emitted into stdout by system commands is put into log-files when running the CORBA-based
clients, not into the visible GUI windows. Thus the text emitted by the above cat command would not be returned,
which is why it is redirected to another file.

A better way to read the content of files would be the readFile command:

>>> readFile ("bubblesort.mo")
function bubblesort

input Real[:] x;

output Real[size(x,1)] vy;
protected

Real t;
algorithm

y = X

for i in l:size(x,1) loop

for j in 1l:size(x,1) loop
if y[i] > y[J] then

t = ylil;
y[il = y[31;
v[3l = t;
end if;
end for;
end for;

end bubblesort;

The system command only returns a success code (0 = success).

>>> system("dir")

0

>>> system("Non-existing command")
127

Another built-in command is cd, the change current directory command. The resulting current directory is returned
as a string.

1.2. Interactive Session with Examples 7
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>>> dir:=cd ()

"«DOCHOME»"

>>> cd("source")

"«DOCHOME»/source"

>>> cd(getInstallationDirectoryPath() + "/share/doc/omc/testmodels/")
"/var/lib/hudson/slave/workspace/OpenModelica_SPHINX/OpenModelica/build/share/doc/
—omc/testmodels"

>>> cd(dir)

"«DOCHOME» "

1.2.5 Modelica Library and DCMotor Model

We load a model, here the whole Modelica standard library, which also can be done through the File->Load
Modelica Library menu item:

>>> loadModel (Modelica)
true

We also load a file containing the decmotor model:

>>> loadFile (getInstallationDirectoryPath() + "/share/doc/omc/testmodels/dcmotor.mo
(_}")

true

It is simulated:

>>> simulate (dcmotor, startTime=0.0, stopTime=10.0)
record SimulationResult

resultFile = "«DOCHOME»/dcmotor_res.mat",

simulationOptions = "startTime = 0.0, stopTime = 10.0, numberOfIntervals = 500,
— tolerance = le-06, method = 'dassl', fileNamePrefix = 'dcmotor', options = '"', |,
—outputFormat = 'mat', variableFilter = '.x', cflags = '', simflags = ''",

messages = "LOG_SUCCESS | info | The initialization finished,
—successfully without homotopy method.
LOG_SUCCESS | info | The simulation finished successfully.

"
’

timeFrontend = 0.6101930330000001,
timeBackend 0.224586953,
timeSimCode 0.21120629,
timeTemplates = 0.096386233,
timeCompile = 0.748753252,
timeSimulation = 0.00964191,
timeTotal = 1.900915163

end SimulationResult;

‘We list the source code of the model:

>>> list (dcmotor)
model dcmotor
import Modelica.Electrical.Analog.Basic;
Basic.Resistor resistorl (R = 10);
Basic.Inductor inductorl(L = 0.2, i.fixed = true);
Basic.Ground groundl;
Modelica.Mechanics.Rotational.Components.Inertia load(J = 1, phi.fixed = true, w.
—~fixed = true);
Basic.EMF emfl(k = 1.0);
Modelica.Blocks.Sources.Step stepl;
Modelica.Electrical.Analog.Sources.SignalVoltage signalVoltagel;
equation
connect (stepl.y, signalVoltagel.v);

(continues on next page)
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(continued from previous page)

connect (signalVoltagel.p, resistorl.p);
connect (resistorl.n, inductorl.p);
connect (inductorl.n, emfl.p);
connect (emfl.flange, load.flange_a);
connect (signalVoltagel.n, groundl.p);
connect (groundl.p, emfl.n);
annotation (

uses (Modelica (version = "3.2.2")));

end dcmotor;

‘We test code instantiation of the model to flat code:

>>> instantiateModel (dcmotor)
class dcmotor

Real resistorl.v(quantity = "ElectricPotential", unit = "V") "Voltage drop,,
—between the two pins (= p.v — n.v)";

Real resistorl.i(quantity = "ElectricCurrent", unit = "A") "Current flowing from,
—pin p to pin n";

Real resistorl.p.v(quantity = "ElectricPotential", unit = "V") "Potential at the_
—pin";

Real resistorl.p.i(quantity = "ElectricCurrent", unit = "A") "Current flowing,
—into the pin";

Real resistorl.n.v(quantity = "ElectricPotential", unit = "V") "Potential at the_
—pin";

Real resistorl.n.i(quantity = "ElectricCurrent", unit = "A") "Current flowing_
—into the pin";

parameter Boolean resistorl.useHeatPort = false "=true, 1if heatPort is enabled";

parameter Real resistorl.T(quantity = "ThermodynamicTemperature", unit = "K",
—~displayUnit = "degC", min = 0.0, start = 288.15, nominal = 300.0) = resistorl.T_
—ref "Fixed device temperature if useHeatPort = false";

Real resistorl.LossPower (quantity = "Power", unit = "W") "Loss power leaving,
—component via heatPort";

Real resistorl.T_heatPort (quantity = "ThermodynamicTemperature", unit = "K", |
—displayUnit = "degC", min = 0.0, start = 288.15, nominal = 300.0) "Temperature
—~of heatPort";

parameter Real resistorl.R(quantity = "Resistance", unit = "Ohm", start = 1.0) =
—10.0 "Resistance at temperature T_ref";

parameter Real resistorl.T_ref (quantity = "ThermodynamicTemperature", unit = "K",
— displayUnit = "degC", min = 0.0, start = 288.15, nominal = 300.0) = 300.15
—"Reference temperature";

parameter Real resistorl.alpha(quantity = "LinearTemperatureCoefficient", unit =
—"1/K") = 0.0 "Temperature coefficient of resistance (R_actual = R* (1 + alpha=* (T_
—heatPort - T_ref))";

Real resistorl.R_actual (quantity = "Resistance", unit = "Ohm") "Actual_
—resistance = Rx (1l + alphax (T_heatPort - T_ref))";

Real inductorl.v(quantity = "ElectricPotential", unit = "V") "Voltage drop,,
—between the two pins (= p.v - n.v)";

Real inductorl.i(quantity = "ElectricCurrent", unit = "A", start = 0.0, fixed =_
—true) "Current flowing from pin p to pin n";

Real inductorl.p.v(quantity = "ElectricPotential", unit = "V") "Potential at the_
—pin";

Real inductorl.p.i(quantity = "ElectricCurrent", unit = "A") "Current flowing_
—into the pin";

Real inductorl.n.v(quantity = "ElectricPotential", unit = "V") "Potential at the_
—pin";

Real inductorl.n.i(quantity = "ElectricCurrent", unit = "A") "Current flowing,
—into the pin";

parameter Real inductorl.L(quantity = "Inductance", unit = "H", start = 1.0) = 0.
—2 "Inductance";

Real groundl.p.v(quantity = "ElectricPotential"”, unit = "V") "Potential at the
—pin";

(continues on next page)
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Real groundl.p.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into_
—the pin";

Real load.flange_a.phi (quantity = "Angle", unit = "rad", displayUnit = "deg")
—"Absolute rotation angle of flange";

Real load.flange_a.tau(quantity = "Torque", unit = "N.m") "Cut torque in the_
—~flange";

Real load.flange_b.phi (quantity = "Angle", unit = "rad", displayUnit = "deg")
—"Absolute rotation angle of flange";

Real load.flange_b.tau(quantity = "Torque", unit = "N.m") "Cut torque in the_
—flange";

parameter Real load.J(quantity = "MomentOfInertia", unit = "kg.m2", min = 0.0,
—start = 1.0) = 1.0 "Moment of inertia";

parameter enumeration (never, avoid, default, prefer, always) load.stateSelect =
—StateSelect.default "Priority to use phi and w as states";

[

Real load.phi(quantity = "Angle", unit = "rad", displayUnit = "deg", fixed =
—true, stateSelect = StateSelect.default) "Absolute rotation angle of component";

Real load.w(quantity = "AngularVelocity", unit = "rad/s", fixed = true,
—stateSelect = StateSelect.default) "Absolute angular velocity of component (=_
—der (phi))";

Real load.a(quantity = "AngularAcceleration", unit = "rad/s2") "Absolute angular,_
—acceleration of component (= der(w))";

parameter Boolean emfl.useSupport = false "= true, if support flange enabled,
—otherwise implicitly grounded";

parameter Real emfl.k(quantity = "ElectricalTorqueConstant", unit = "N.m/A",
—~start = 1.0) = 1.0 "Transformation coefficient";

Real emfl.v(quantity = "ElectricPotential", unit = "V") "Voltage drop between,
—the two pins";

Real emfl.i(quantity = "ElectricCurrent", unit = "A") "Current flowing from,
—positive to negative pin";

Real emfl.phi (quantity = "Angle", unit = "rad", displayUnit = "deg") "Angle of |
—shaft flange with respect to support (= flange.phi - support.phi)";

Real emfl.w(quantity = "AngularVelocity", unit = "rad/s") "Angular velocity of
—flange relative to support";

Real emfl.tau(quantity = "Torque", unit = "N.m") "Torque of flange";

Real emfl.tauElectrical (quantity = "Torque", unit = "N.m") "Electrical torque";

Real emfl.p.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin";

Real emfl.p.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into
—the pin";

Real emfl.n.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin";

Real emfl.n.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into
—the pin";

Real emfl.flange.phi(quantity = "Angle", unit = "rad", displayUnit = "deg")
—"Absolute rotation angle of flange";

Real emfl.flange.tau(quantity = "Torque", unit = "N.m") "Cut torque in the flange
=";

protected Real emfl.internalSupport.tau(quantity = "Torgque", unit = "N.m") = -
—emfl.tau "External support torque (must be computed via torque balance in model_,
—where InternalSupport is used; = flange.tau)";

protected Real emfl.internalSupport.phi (quantity = "Angle", unit = "rad",_
—displayUnit = "deg") "External support angle (= flange.phi)";

protected Real emfl.internalSupport.flange.phi(quantity = "Angle", unit = "rad",
—displayUnit = "deg") "Absolute rotation angle of flange";

protected Real emfl.internalSupport.flange.tau(quantity = "Torque", unit = "N.m
—") "Cut torque in the flange";

protected parameter Real emfl.fixed.phiO (quantity = "Angle", unit = "rad",_
—displayUnit = "deg") = 0.0 "Fixed offset angle of housing";

protected Real emfl.fixed.flange.phi (quantity = "Angle", unit = "rad",
—displayUnit = "deg") "Absolute rotation angle of flange";

protected Real emfl.fixed.flange.tau(quantity = "Torque", unit = "N.m") "Cut_

—torque in the flange";
Real stepl.y "Connector of Real output signal";

(continues on next page)
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parameter Real stepl.offset = 0.0 "Offset of output signal y";

parameter Real stepl.startTime (quantity = "Time", unit = "s") = 0.0 "Output vy =
—offset for time < startTime";

parameter Real stepl.height = 1.0 "Height of step";

Real signalVoltagel.p.v(quantity = "ElectricPotential", unit = "V") "Potential,
—at the pin";

Real signalVoltagel.p.i(quantity = "ElectricCurrent”, unit = "A") "Current
—flowing into the pin";

Real signalVoltagel.n.v(quantity = "ElectricPotential”, unit = "V") "Potential
—at the pin";

Real signalVoltagel.n.i(quantity = "ElectricCurrent"”, unit = "A") "Current
—flowing into the pin";

Real signalVoltagel.v(unit = "V") "Voltage between pin p and n (= p.v - n.v) as,
—input signal";

Real signalVoltagel.i(quantity = "ElectricCurrent", unit = "A") "Current flowing,,
—from pin p to pin n";
equation

assert (1.0 + resistorl.alpha * (resistorl.T_heatPort - resistorl.T_ref) >= le-15,
— "Temperature outside scope of model!");

resistorl.R_actual = resistorl.R % (1.0 + resistorl.alpha * (resistorl.T_
—heatPort - resistorl.T_ref));

resistorl.v = resistorl.R_actual *» resistorl.i;

resistorl.LossPower = resistorl.v * resistorl.i;

resistorl.v = resistorl.p.v - resistorl.n.v;

0.0 = resistorl.p.i + resistorl.n.i;

resistorl.i = resistorl.p.i;

resistorl.T_heatPort = resistorl.T;

inductorl.L * der (inductorl.i) = inductorl.v;

inductorl.v = inductorl.p.v - inductorl.n.v;

0.0 = inductorl.p.i + inductorl.n.i;

inductorl.i = inductorl.p.i;

groundl.p.v = 0.0;

load.phi = load.flange_a.phi;

load.phi = load.flange_b.phi;

load.w = der(load.phi);

load.a = der(load.w);

load.J * load.a = load.flange_a.tau + load.flange_b.tau;
emfl.internalSupport.flange.tau = emfl.internalSupport.tau;
emfl.internalSupport.flange.phi = emfl.internalSupport.phi;
emfl.fixed.flange.phi = emfl.fixed.phiO;

emfl.v = emfl.p.v - emfl.n.v;

0.0 = emfl.p.i + emfl.n.i;

emfl.i = emfl.p.1i;

emfl.phi = emfl.flange.phi - emfl.internalSupport.phi;
emfl.w = der(emfl.phi);

emfl.k » emfl.w = emfl.v;

emfl.tau = (-emfl.k) » emfl.i;

emfl.tauElectrical = —-emfl.tau;

emfl.tau = emfl.flange.tau;

stepl.y = stepl.offset + (if time < stepl.startTime then 0.0 else stepl.height);
signalVoltagel.v = signalVoltagel.p.v - signalVoltagel.n.v;
0.0 = signalVoltagel.p.i + signalVoltagel.n.i;
signalVoltagel.i = signalVoltagel.p.i;

resistorl.p.i + signalVoltagel.p.i = 0.0;

resistorl.n.i + inductorl.p.i = 0.0;

inductorl.n.i + emfl.p.i = 0.0;

groundl.p.i + emfl.n.i + signalVoltagel.n.i = 0.0;
load.flange_a.tau + emfl.flange.tau = 0.0;
load.flange_b.tau = 0.0;

emfl.fixed.flange.tau + emfl.internalSupport.flange.tau = 0.0;
emfl.fixed.flange.phi = emfl.internalSupport.flange.phi;

(continues on next page)
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signalVoltagel.v = stepl.y;
resistorl.p.v = signalVoltagel.p.v;
inductorl.p.v = resistorl.n.v;
emfl.p.v = inductorl.n.v;
emfl.flange.phi = load.flange_a.phi;
emfl.n.v = groundl.p.v;
emfl.n.v = signalVoltagel.n.v;

end dcmotor;

We plot part of the simulated result:

T
loadw —

35 | load.phi ——— /]

15 1

Figure 1.2: Rotation and rotational velocity of the DC motor

1.2.6 The val() function

The val(variableName,time) scription function can be used to retrieve the interpolated value of a simulation result
variable at a certain point in the simulation time, see usage in the BouncingBall simulation below.

1.2.7 BouncingBall and Switch Models

We load and simulate the BouncingBall example containing when-equations and if-expressions (the Modelica
keywords have been bold-faced by hand for better readability):

>>> loadFile (getInstallationDirectoryPath() + "/share/doc/omc/testmodels/
—BouncingBall.mo")
true

>>> list (BouncingBall)
model BouncingBall
parameter Real e = 0.7 "coefficient of restitution";
parameter Real g = 9.81 "gravity acceleration";
Real h(fixed = true, start = 1) "height of ball";
Real v (fixed = true) "velocity of ball";
Boolean flying(fixed = true, start = true) "true, if ball is flying";
Boolean impact;
Real v_new(fixed = true);

(continues on next page)
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Integer foo;
equation
impact = h <= 0.0;
foo = if impact then 1 else 2;
der (v) = if flying then -g else 0;
der (h) v;
when {h <= 0.0 and v <= 0.0, impact} then
v_new = if edge (impact) then -e » pre(v) else 0;
flying = v_new > 0;
reinit (v, v_new);
end when;
end BouncingBall;

Instead of just giving a simulate and plot command, we perform a runScript command on a .mos (Modelica script)
file sim_BouncingBall.mos that contains these commands:

>>> writeFile("sim_BouncingBall.mos", "

loadFile (getInstallationDirectoryPath() + \"/share/doc/omc/testmodels/
—BouncingBall.mo\");

simulate (BouncingBall, stopTime=3.0);

/+ plot ({h, flying}); =*/
")
true
>>> runScript ("sim_BouncingBall.mos")
"true
record SimulationResult

resultFile = \"«DOCHOME»/BouncingBall_res.mat\",

simulationOptions = \"startTime = 0.0, stopTime = 3.0, numberOfIntervals = 500,
— tolerance = le-06, method = 'dassl', fileNamePrefix = 'BouncingBall', options
—''", outputFormat = 'mat', variableFilter = '.%', cflags = '', simflags = ''\",

messages = \"LOG_SUCCESS | info | The initialization finished,
—successfully without homotopy method.
LOG_SUCCESS | info | The simulation finished successfully.
\",

timeFrontend = 0.004204951,

timeBackend = 0.003958843,

timeSimCode = 0.200533246,

timeTemplates = 0.115518449,
timeCompile = 0.6672871260000001,
timeSimulation = 0.011349154,
timeTotal = 1.002988758

end SimulationResult;
n

model Switch
Real v;
Real i;
Real il;
Real itot;
Boolean open;
equation
itot = 1 + 1i1;
if open then
v = 0;
else
i = 0;
end if;
1 - 11 = 0;
1 - v -1 = 0;
open = time >= 0.5;
end Switch;
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>>> gimulate (Switch, startTime=0, stopTime=1)
record SimulationResult

resultFile "«DOCHOME»/Switch_res.mat",

simulationOptions = "startTime = 0.0, stopTime = 1.0, numberOflIntervals = 500,
—tolerance = 1le-06, method = 'dassl', fileNamePrefix = 'Switch', options = '"', |
—outputFormat 'mat', variableFilter = '.x', cflags = '', simflags = ''",

messages = "LOG_SUCCESS | info | The initialization finished
—successfully without homotopy method.
LOG_SUCCESS | info | The simulation finished successfully.

n
’

timeFrontend = 0.005951028000000001,
timeBackend = 0.009170566,
timeSimCode = 0.215147463,
timeTemplates = 0.100785377,
timeCompile = 0.70580498,
timeSimulation = 0.008658168000000001,
timeTotal = 1.045642667

end SimulationResult;

Retrieve the value of itot at time=0 using the val(variableName, time) function:

>>> val (itot, 0)
1.0

Plot itot and open:

2 T T T T
itot
open
15 —
1
05 |
0 1 1 1 1
0 0.2 0.4 0.6 0.8 1

Figure 1.3: Plot when the switch opens

We note that the variable open switches from false (0) to true (1), causing itot to increase from 1.0 to 2.0.

1.2.8 Clear All Models

Now, first clear all loaded libraries and models:

>>> clear ()
true

List the loaded models — nothing left:
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>>> list ()

nn

1.2.9 VanDerPol Model and Parametric Plot

We load another model, the VanDerPol model (or via the menu File->Load Model):

>>> loadFile (getInstallationDirectoryPath() + "/share/doc/omc/testmodels/VanDerPol.
—mo™)
true

It is simulated:

>>> simulate (VanDerPol, stopTime=80)
record SimulationResult

resultFile = "«DOCHOME»/VanDerPol_res.mat",

simulationOptions = "startTime = 0.0, stopTime = 80.0, numberOfIntervals = 500,
— tolerance = 1le-06, method = 'dassl', fileNamePrefix = 'VanDerPol', options = '',
— outputFormat = 'mat', variableFilter = '.x', cflags = '', simflags = ''",

messages = "LOG_SUCCESS | info | The initialization finished
—successfully without homotopy method.
LOG_SUCCESS | info | The simulation finished successfully.

n
4

timeFrontend = 0.003788192,
timeBackend = 0.002349066,
timeSimCode 0.1947713219999999,
timeTemplates = 0.113817392,
timeCompile = 0.6635488540000001,
timeSimulation = 0.009246694,
timeTotal = 0.987650069

end SimulationResult;

It is plotted:

>>> plotParametric ("x","y")
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Figure 1.4: VanDerPol plotParametric(x,y)

Perform code instantiation to flat form of the VanDerPol model:
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>>> instantiateModel (VanDerPol)
class VanDerPol "Van der Pol oscillator model"
Real x(start = 1.0, fixed = true);
Real y(start = 1.0, fixed true);
parameter Real lambda = 0.3;
equation
der (x) = y;
der(y) = lambda » (1.0 — x ©~ 2.0) %= y — X%;
end VanDerPol;

1.2.10 Using Japanese or Chinese Characters

Japenese, Chinese, and other kinds of UniCode characters can be used within quoted (single quote) identifiers, see
for example the variable name to the right in the plot below:

File Edit Special

Plot by OpenModelica

027 }

0.0

0.0 0.3 1.0 1.5 2.0 2.2

1.2.11 Scripting with For-Loops, While-Loops, and If-Statements

A simple summing integer loop (using multi-line input without evaluation at each line into OMShell requires
copy-paste as one operation from another document):

>>> k := 0;

>>> for i in 1:1000 loop
k = k + 1i;

end for;

>>> k

500500

A nested loop summing reals and integers:

>>> g := 0.
>>> h := 5;
>>> for i in {23.0,77.12,88.23} loop
for j in 1:0.5: (i+1) loop
g =g+ 3J;
g :=g + h/ 2;

0;

(continues on next page)
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end for;
h :=h + g;
end for;

By putting two (or more) variables or assignment statements separated by semicolon(s), ending with a variable,
one can observe more than one variable value:

>>> h; g
1997.45
1479.09

A for-loop with vector traversal and concatenation of string elements:

>>> i:="";
>>> 1lst := {"Here ", "are ","some ","strings."};
>>> g = "";
>>> for i1 in 1lst loop
s := s + 1i;
end for;
>>> g

"Here are some strings."

Normal while-loop with concatenation of 10 "abc " strings:

>>> g:="";
>>> i:=1;
>>> while i<=10 loop
s:="abc "+s;
i:=1+1;
end while;
>>> g
"abc abc abc abc abc abc abc abc abc abc "

A simple if-statement. By putting the variable last, after the semicolon, its value is returned after evaluation:

>>> if 5>2 then a := 77; end if; a
77

An if-then-else statement with elseif:

>>> if false then

a := 5;
elseif a > 50 then
b:= "test"; a:= 100;
else
a:=34;
end if;

Take a look at the variables a and b:

>>> a;b
100
Htestﬂ

1.2.12 Variables, Functions, and Types of Variables

Assign a vector to a variable:

>>> a:=1:5
{112I3I4I5}
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Type in a function:

function mySqr
input Real x;
output Real y;

algorithm
YV iI=X*X;

end mySqr;

Call the function:

>>> b:i=mySqr (2)
4.0

Look at the value of variable a:

>>> a
{1,2,3,4,5}

Look at the type of a:

>>> typeOf (a)
"Integer[5]"

Retrieve the type of b:

>>> typeOf (b)
NReal"

What is the type of mySqr? Cannot currently be handled.

>>> typeOf (mySqr)

List the available variables:

>>> listVariables ()
{b,a,s,1lst,i,h,g,k,currentSimulationResult}

Clear again:

>>> clear ()
true

1.2.13 Getting Information about Error Cause

Call the function getErrorString() in order to get more information about the error cause after a simulation failure:

>>> getErrorString()

nn

1.2.14 Alternative Simulation Output Formats

There are several output format possibilities, with mat being the default. plt and mat are the only formats that
allow you to use the val() or plot() functions after a simulation. Compared to the speed of plt, mat is roughly 5
times for small files, and scales better for larger files due to being a binary format. The csv format is roughly twice
as fast as plt on data-heavy simulations. The plt format allocates all output data in RAM during simulation, which
means that simulations may fail due applications only being able to address 4GB of memory on 32-bit platforms.
Empty does no output at all and should be by far the fastest. The csv and plt formats are suitable when using an
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external scripts or tools like gnuplot to generate plots or process data. The mat format can be post-processed in
MATLAB or Octave.

>>> simulate (...

( outputFormat="mat")
>>> simulate (...

(

(

’

, outputFormat="csv")
>>> gsimulate (... ,
>>> simulate (... ,

outputFormat="plt")
outputFormat="empty")

It is also possible to specify which variables should be present in the result-file. This is done by using POSIX
Extended Regular Expressions. The given expression must match the full variable name (* and $ symbols are
automatically added to the given regular expression).

/I Default, match everything

’>>> simulate (... , variableFilter=".+")

/I match indices of variable myVar that only contain the numbers using combinations

/1 of the letters 1 through 3

’>>> simulate (... , variableFilter="myVar\\\[[1-31+«\\\1")

// match x or y or z

’>>> simulate (... , variableFilter="x|y|z")

1.2.15 Using External Functions

See Chapter Interoperability — C and Python for more information about calling functions in other programming
languages.

1.2.16 Using Parallel Simulation via OpenMP Multi-Core Support

Faster simulations on multi-core computers can be obtained by using a new OpenModelica feature that auto-
matically partitions the system of equations and schedules the parts for execution on different cores using shared-
memory OpenMP based execution. The speedup obtained is dependent on the model structure, whether the system
of equations can be partitioned well. This version in the current OpenModelica release is an experimental ver-
sion without load balancing. The following command, not yet available from the OpenModelica GUI, will run a
parallel simulation on a model:

>>> omc —d=openmp model.mo

1.2.17 Loading Specific Library Version

There exist many different versiosn of Modelica libraries which are not compatible. It is possible to keep mul-
tiple versions of the same library stored in the directory given by calling getModelicaPath(). By calling load-
Model(Modelica,{"3.2"}), OpenModelica will search for a directory called "Modelica 3.2" or a file called "Mod-
elica3.2.mo". Itis possible to give several library versions to search for, giving preference for a pre-release version
of a library if it is installed. If the searched version is "default", the priority is: no version name (Modelica), main
release version (Modelica 3.1), pre-release version (Modelica 3.1Beta 1) and unordered versions (Modelica Spe-
cial Release).

The loadModel command will also look at the uses annotation of the top-level class after it has been loaded. Given
the following package, Complex 1.0 and ModelicaServices 1.1 will also be loaded into the AST automatically.
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package Modelica
annotation (uses (Complex (version="1.0"),
ModelicaServices (version="1.1")));

end Modelica;

>>> clear ()
true

Packages will also be loaded if a model has a uses-annotation:

model M
annotation (uses (Modelica (version="3.2.1")));
end M;

>>> instantiateModel (M)
class M
end M;

Note:
Notification: Automatically loaded package Modelica 3.2.1 due to uses annotation.
Notification: Automatically loaded package Complex 3.2.1 due to uses annotation.

Notification: Automatically loaded package ModelicaServices 3.2.1 due to uses annotation.

Packages will also be loaded by looking at the first identifier in the path:

>>> instantiateModel (Modelica.Electrical.Analog.Basic.Ground)
class Modelica.Electrical.Analog.Basic.Ground "Ground node"

Real p.v(quantity = "ElectricPotential", unit = "V") "Potential at the pin";
Real p.i(quantity = "ElectricCurrent", unit = "A") "Current flowing into the pin
=";
equation
p.v = 0.0;
p.i = 0.0;

end Modelica.Electrical.Analog.Basic.Ground;

Note:
Notification: Automatically loaded package Complex 3.2.2 due to uses annotation.
Notification: Automatically loaded package ModelicaServices 3.2.2 due to uses annotation.

Notification: Automatically loaded package Modelica default due to uses annotation.

1.2.18 Calling the Model Query and Manipulation API

In the OpenModelica System Documentation, an external API (application programming interface) is described
which returns information about models and/or allows manipulation of models. Calls to these functions can be
done interactively as below, but more typically by program clients to the OpenModelica Compiler (OMC) server.
Current examples of such clients are the OpenModelica MDT Eclipse plugin, OMNotebook, the OMEdit graphic
model editor, etc. This API is untyped for performance reasons, i.e., no type checking and minimal error checking
is done on the calls. The results of a call is returned as a text string in Modelica syntax form, which the client has
to parse. An example parser in C++ is available in the OMNotebook source code, whereas another example parser
in Java is available in the MDT Eclipse plugin.
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Below we show a few calls on the previously simulated BouncingBall model. The full documentation on this API
is available in the system documentation. First we load and list the model again to show its structure:

>>> loadFile (getInstallationDirectoryPath() + "/share/doc/omc/testmodels/
—BouncingBall.mo");
>>> list (BouncingBall)
model BouncingBall
parameter Real e = 0.7 "coefficient of restitution";
parameter Real g = 9.81 "gravity acceleration";
Real h(fixed = true, start = 1) "height of ball";
Real v(fixed = true) "velocity of ball";
Boolean flying(fixed = true, start = true) "true, if ball is flying";
Boolean impact;
Real v_new(fixed = true);
Integer foo;
equation
impact = h <= 0.0;
foo = if impact then 1 else 2;
der(v) = if flying then -g else 0;
der (h) = v;
when {h <= 0.0 and v <= 0.0, impact} then
v_new = if edge (impact) then -e * pre(v) else 0;
flying = v_new > 0;
reinit (v, v_new);
end when;
end BouncingBall;

Different kinds of calls with returned results:

>>> getClassRestriction (BouncingBall)

"model"

>>> getClassInformation (BouncingBall)

("model","", false, false, false, "/var/lib/hudson/slave/workspace/OpenModelica_SPHINX/
—OpenModelica/build/share/doc/omc/testmodels/BouncingBall.mo", false, 1,1,23,17,{},
—~false, false,"","", false,"")

>>> isFunction (BouncingBall)

false

>>> existClass (BouncingBall)

true

>>> getComponents (BouncingBall)

{{Real,e,"coefficient of restitution", "public", false, false, false, false,
—"parameter", "none", "unspecified",{}},{Real,g,"gravity acceleration", "public",
—~false, false, false, false, "parameter", "none", "unspecified",{}}, {Real,h,
—"height of ball", "public", false, false, false, false, "unspecified", "none",
—"unspecified", {}}, {Real,v,"velocity of ball", "public", false, false, false,
—false, "unspecified", "none", "unspecified", {}},{Boolean,flying,"true, if ball
—is flying", "public", false, false, false, false, "unspecified", "none",
—~"unspecified", {}}, {Boolean, impact,"", "public", false, false, false, false,
—"unspecified", "none", "unspecified",{}},{Real,v_new,"", "public", false, false,
—~false, false, "unspecified", "none", "unspecified", {}}, {Integer,foo,"", "public",
— false, false, false, false, "unspecified", "none", "unspecified", {}}}

>>> getConnectionCount (BouncingBall)

0

>>> getInheritanceCount (BouncingBall)

0

>>> getComponentModifierValue (BouncingBall, e)

"o.7"

>>> getComponentModifierNames (BouncingBall, "e")

{}

>>> getClassRestriction (BouncingBall)

"model"

>>> getVersion() // Version of the currently running OMC

"OMCompiler v1.13.0"
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1.2.19 Quit OpenModelica

Leave and quit OpenModelica:

>>> quit ()

1.2.20 Dump XML Representation

The command dumpXMLDAE dumps an XML representation of a model, according to several optional parame-
ters.

dumpXMLDAE(modelname[ ,asInSimulationCode=<Boolean>] [.filePrefix=<String>] [,storeln-
Temp=<Boolean>] [,addMathMLCode =<Boolean>])

This command dumps the mathematical representation of a model using an XML representation, with optional
parameters. In particular, asInSimulationCode defines where to stop in the translation process (before dumping the
model), the other options are relative to the file storage: filePrefix for specifying a different name and storeInTemp
to use the temporary directory. The optional parameter addMathMLCode gives the possibility to don’t print the
MathML code within the xml file, to make it more readable. Usage is trivial, just: addMathMLCode=true/false
(default value is false).

1.2.21 Dump Matlab Representation

The command export dumps an XML representation of a model, according to several optional parameters.
exportDAEtoMatlab(modelname);

This command dumps the mathematical representation of a model using a Matlab representation. Example:

>>> loadFile (getInstallationDirectoryPath() + "/share/doc/omc/testmodels/
—BouncingBall.mo")

true

>>> exportDAEtoMatlab (BouncingBall)

"The equation system was dumped to Matlab file:BouncingBall_imatrix.m"

% Incidence Matrix

% number of rows: 6

IM={{3,6},{1,{"1if", "true','==" {3}, {},}}, {{"1E", "true','==" {4},{},}}, {5}, {2, {"if
—', 'edge(impact)' {3},{5},}},{4,2}};

VL = {'foo','v_new', "impact', 'flying','v','h'};

EgStr = {'impact = h <= 0.0;"',"'"foo = if impact then 1 else 2;','der(v) = if flying,
—then -g else 0.0;','der(h) = v;','when {h <= 0.0 and v <= 0.0, impact} then v_
—new = 1f edge (impact) then (-e) * pre(v) else 0.0; end when;', 'when {h <= 0.0,
—and v <= 0.0, impact} then flying = v_new > 0.0; end when;"'};

OldEgStr={'class BouncingBall',' parameter Real e = 0.7 "coefficient of

—restitution";',' parameter Real g = 9.81 "gravity acceleration";',' Real
—h(start = 1.0, fixed = true) "height of ball";',' Real v (fixed = true)
—"velocity of ball";',' Boolean flying(start = true, fixed = true) "true, if
—ball is flying";',' Boolean impact;',' Real v_new(fixed = true);',' Integer,
—~foo; ', '"equation', ' impact = h <= 0.0;"'," foo = if impact then 1 else 2;','
—der(v) = if flying then -g else 0.0;',"' der(h) = v;','" when {h <= 0.0 and v <=
—0.0, impact} then',' v_new = if edge (impact) then (-e) x pre(v) else 0.0;',"' _
— flying = v_new > 0.0;"'," reinit (v, v_new);"',' end when; ', 'end BouncingBall;

AL
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1.3 Summary of Commands for the Interactive Session Handler

The following is the complete list of commands currently available in the interactive session hander.

simulate(modelname) Translate a model named modelname and simulate it.

simulate(modelnamel startTime=<Real>][,stopTime=<Real>][ ,numberOflntervals
=<Integer>][,outputlnterval=<Real>][,method=<String>]
[,tolerance=<Real>][ fixedStepSize=<Real>]

[,outputFormat=<String>]) Translate and simulate a model, with optional start time, stop time, and optional
number of simulation intervals or steps for which the simulation results will be computed. More intervals will
give higher time resolution, but occupy more space and take longer to compute. The default number of intervals
is 500. It is possible to choose solving method, default is “dassl”, “euler” and “rungekutta” are also available.
Output format “mat” is default. “plt” and “mat” (MATLAB) are the only ones that work with the val() command,
“csv” (comma separated values) and “empty” (no output) are also available (see section Alternative Simulation
Output Formats).

plot(vars) Plot the variables given as a vector or a scalar, e.g. plot({x1,x2}) or plot(x1).

plotParametric(varl, var2) Plot var2 relative to varl from the most recently simulated model, e.g. plotParamet-
ric(X,y).

cd() Return the current directory.

cd(dir) Change directory to the directory given as string.
clear() Clear all loaded definitions.

clearVariables() Clear all defined variables.

dumpXMLDAE(modelname, ...) Dumps an XML representation of a model, according to several optional param-
eters.

exportDAEtoMatlab(name) Dumps a Matlab representation of a model.

instantiateModel(modelname)Performs code instantiation of a model/class and return a string containing the flat
class definition.

list() Return a string containing all loaded class definitions.
list(modelname) Return a string containing the class definition of the named class.
listVariables() Return a vector of the names of the currently defined variables.

loadModel(classname) Load model or package of name classname from the path indicated by the environment
variable OPENMODELICALIBRARY.

loadFile(str) Load Modelica file (.mo) with name given as string argument str.
readFile(str) Load file given as string str and return a string containing the file content.
runScript(str) Execute script file with file name given as string argument szr.

system(str) Execute str as a system(shell) command in the operating system; return integer success value. Output
into stdout from a shell command is put into the console window.

timing(expr) Evaluate expression expr and return the number of seconds (elapsed time) the evaluation took.
typeOf(variable) Return the type of the variable as a string.

saveModel(str,modelname) Save the model/class with name modelname in the file given by the string argument
Str.

val(variable,timePoint) Return the (interpolated) value of the variable at time timePoint.

help() Print this helptext (returned as a string).
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quit() Leave and quit the OpenModelica environment

1.4 Running the compiler from command line

The OpenModelica compiler can also be used from command line, in Windows cmd.exe.

Example Session 1 — obtaining information about command line parameters

C:\dev> C:\OpenModelical.9.2 \bin\omc -h

OpenModelica Compiler 1.9.2

Copyright © 2015 Open Source Modelica Consortium (OSMC)
Distributed under OMSC-PL and GPL, see https://www.openmodelica.org/
Usage: omc [Options] (Model.mo | Script.mos) [Libraries | .mo-files]

Example Session 2 - create an TestModel.mo file and run omc on it

C:\dev> echo model TestModel parameter Real x = 1; end TestModel; > TestModel.mo
C:\dev> C:\OpenModelical.9.2 \bin\omc TestModel.mo
class TestModel
parameter Real x = 1.0;
end TestModel;
C:\dev>

Example Session 3 - create an script.mos file and run omc on it

Create a file script.mos using your editor containing these commands:
/1 start script.mos
loadModel(Modelica); getErrorString();
simulate(Modelica.Mechanics.MultiBody.Examples.Elementary.Pendulum); getErrorString();
/ end script.mos
C:\dev> notepad script.mos
C:\dev> C:\OpenModelical.9.2 \bin\omc script.mos
true
record SimulationResult
resultFile = "C:/dev/Modelica.Mechanics.MultiBody.Examples.Elementary.Pendulum_res.mat",

simulationOptions = "startTime = 0.0, stopTime = 5.0, numberOfIntervals = 500, tolerance = 1e-006,
method = "dassl’, fileNamePrefix = "Modelica.Mechanics.MultiBody.Examples.Elementary. Pendulum’,

s

options =, outputFormat = *mat’, variableFilter = *.*’, cflags =, simflags =",
messages = "",

timeFrontend = 1.245787339209033,

timeBackend = 20.51007138993843,

timeSimCode = 0.1510248469321959,

timeTemplates = 0.5052317333954395,

timeCompile = 5.128213942691722,

timeSimulation = 0.4049189573103951,

timeTotal = 27.9458487395605
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end SimulationResult;

"nn

In order to obtain more information from the compiler one can use the command line options -
showErrorMessages -d=failtrace when running the compiler:

C:\dev> C:\OpenModelical.9.2 \bin\omc —showErrorMessages -d=failtrace script.mos
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CHAPTER
TWO

OMEDIT — OPENMODELICA CONNECTION EDITOR

OMEdit — OpenModelica Connection Editor is the new Graphical User Interface for graphical model editing in
OpenModelica. It is implemented in C++ using the Qt graphical user interface library and supports the Modelica
Standard Library that is included in the latest OpenModelica installation. This chapter gives a brief introduction
to OMEdit and also demonstrates how to create a DCMotor model using the editor.

OMEdit provides several user friendly features for creating, browsing, editing, and simulating models:
* Modeling — Easy model creation for Modelica models.
* Pre-defined models — Browsing the Modelica Standard library to access the provided models.
* User defined models — Users can create their own models for immediate usage and later reuse.

* Component interfaces — Smart connection editing for drawing and editing connections between model
interfaces.

* Simulation — Subsystem for running simulations and specifying simulation parameters start and stop
time, etc.

* Plotting — Interface to plot variables from simulated models.

2.1 Starting OMEdit

A splash screen similar to the one shown in Figure 2.1 will appear indicating that it is starting OMEdit. The
executable is found in different places depending on the platform (see below).

2.1.1 Microsoft Windows

OMEdit can be launched wusing the executable placed in OpenModelicalnstallationDirec-
tory/bin/OMEdit/OMEdit.exe. Alternately, choose OpenModelica > OpenModelica Connection Editor from the
start menu in Windows.

2.1.2 Linux

Start OMEdit by either selecting the corresponding menu application item or typing “OMEGit” at the shell or
command prompt.

2.1.3 Mac OS X

The default installation is /Application/MacPorts/OMEdit.app.
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OMEdit

—
. L L
{

Figure 2.1: OMEdit Splash Screen.

2.2 MainWindow & Browsers

The MainWindow contains several dockable browsers,
e Libraries Browser
¢ Documentation Browser
* Variables Browser
* Messages Browser
Figure 2.2 shows the MainWindow and browsers.

The default location of the browsers are shown in Figure 2.2. All browsers except for Message Browser can
be docked into left or right column. The Messages Browser can be docked into top or bottom areas. If you
want OMEdit to remember the new docked position of the browsers then you must enable Preserve User’s GUI
Customizations option, see section General.

2.2.1 Filter Classes

To filter a class click Edit > Filter Classes or press keyboard shortcut Ctrl+Shift+F. The loaded Modelica classes
can be filtered by typing any part of the class name.

2.2.2 Libraries Browser

To view the Libraries Browser click View > Windows > Libraries Browser. Shows the list of loaded Modelica
classes. Each item of the Libraries Browser has right click menu for easy manipulation and usage of the class. The
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Figure 2.2: OMEdit MainWindow and Browsers.

2.2. MainWindow & Browsers
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classes are shown in a tree structure with name and icon. The protected classes are not shown by default. If you
want to see the protected classes then you must enable the Show Protected Classes option, see section General.

o OMEdit - OpenModelica Connection Editor - ‘:'
File Edit View Simulation FMI Export Tools Help

FeBE Hoee \OHOTH -E-8-9- ¢

Libraries Browser

| chua

OMEdit - OpenModelica Connection Editor
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4 BB Analog Recent Files Latest News
“ E] Examples E:> Ci/Users/adeas31/Desktop/EigenTes E:> September 8, 2015 OpenModelica 1.9.3 released
o View Class 10, 2015: SIMS 2015 registration open
o View Documentation
18, 2015: New version scheme for nightly builds
Save Total
13, 2015: OpenMeodelica migrated from Subversion to
E Instantiate Model
o Check Model ch 17, 2015: OpenMedelica 1.9.2 released
@ Check All Models uary 02, 2013: OpenModelica 1.9.2 Betal released
=% Simulate Ctrl+B
3 Simulate with Transformational Debugger ram OpenModelica Annual Workshop 2015
@ Simulate with Algorithmic Debugger ram OpenModelica Annual Workshop 2016
S| Simulation Setup B
il Duplicate For more details visit our website www.openmodelica.org
& Export FMU
‘& Export XML Open Model/Library File(s)
B  Export Figaro

t Welcome gﬁ Modeling ﬂ Plotting

Figure 2.3: Libraries Browser.

2.2.3 Documentation Browser

Displays the HTML documentation of Modelica classes. It contains the navigation buttons for moving forward and
backward. It also contains a WYSIWYG editor which allows writing class documentation in HTML format. To see
documentation of any class, right click the Modelica class in Libraries Browser and choose View Documentation.

2.2.4 Variables Browser

The class variables are structured in the form of the tree and are displayed in the Variables Browser. Each variable
has a checkbox. Ticking the checkbox will plot the variable values. There is a find box on the top for filtering the
variable in the tree. The filtering can be done using Regular Expression, Wildcard and Fixed String. The complete
Variables Browser can be collapsed and expanded using the Collapse All and Expand All buttons.

The browser allows manipulation of changeable parameters for Re-simulating a Model. Tt also displays the unit
and description of the variable.

2.2.5 Messages Browser

Shows the list of errors. Following kinds of error can occur,

* Syntax
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that are based on standardized interface definitions. Some typical examples are shown in the next figure:
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Figure 2.4: Documentation Browser.
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Figure 2.5: Variables Browser.
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e Grammar
* Translation
¢ Symbolic
¢ Simulation
e Scripting

See section Messages for Messages Browser options.

2.3 Perspectives

The perspective tabs are loacted at the bottom right of the MainWindow:

* Welcome Perspective
* Modeling Perspective
* Plotting Perspective

* Debugging Perspective

2.3.1 Welcome Perspective

&t OMEdit - OpenMadelica Connection Editor

File Edit View Simulation FMI  Export Debug Git Tools Help

Libraries Browser 8 X

|Filter Classes | ¥ AT

Libraries

¥ @ OpenModelica

OMEdit - OpenModelica Connection Editor
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FeBA Heee \0 -EB- Q]3] fX )

> [] ModelicaServices

E» C:/Users/adeas3]/Desktop/PhotoVolt 0>
E» C:/Users/adeas3!/Desktop/OmecOmc 0>
B> C/Users/adeas31/Desktop/Folder/pa E»
< >
Clear Recent Files Reload

Recent Files Latest News
> . Complex
> @ Meodelica E:> C:/OpenModelica/OMCompiler/Exan ED’ February &, 2017: OpenMeodelica 1.11.0 released
’ 0 ModelicaReference E:> C:/Users/adeas31/Desktop/Connecto ED’ January 17, 2017: OpenModelica 1.11 Beta3 released

Decernber 20, 2016: OpenModelica 1.11 Beta2 released
Novemnber 22, 2016 OpenMoedelica 1.9.7 released
March 16, 2016: OpenModelica 1.9.6 released

March 9, 2016: OpenModelica 1.9.4 released

February 18, 2016: OpenModelica 1.9.4 betal released

Program OpenMeodelica Annual Workshop 2016

For more details visit our website www.openmodelica, or

t Welcome

Open Model/Library File(s)

oﬁ Modeling

ﬂ Plotting

ﬁ» Debugging

Figure 2.6: OMEdit Welcome Perspective.
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The Welcome Perspective shows the list of recent files and the list of latest news from https://www.openmodelica.
org/. See Figure 2.6. The orientation of recent files and latest news can be horizontal or vertical. User is allowed
to show/hide the latest news. See section General.

2.3.2 Modeling Perspective

The Modeling Perpective provides the interface where user can create and design their models. See Figure 2.7.

ot OMEdit - OpenMadelica Connection Editor - O >

File Edit View Simulation FM|  Export Debug Git Tools Help

reBR @006 \® -H Q9 [X- 1

Libraries Browser B X A4 DCMotor™ (]
|Filter Classes | & |||-| AE O ‘Wrimble |Model |Diagram View ‘DCMotor ‘DCMotor |Lir1e: 1, Cal: 0 ‘ |
Libraries

@ OpenModelica

l:J MedelicaServices
Complex

@ Modelica

o MedelicaReference

¥:-124.07  ¥:-32.34 t Welcome qli Modeling g Plotting - Debugging

Figure 2.7: OMEdit Modeling Perspective.

The Modeling Perspective interface can be viewed in two different modes, the tabbed view and subwindow view,
see section General.

2.3.3 Plotting Perspective

The Plotting Perspective shows the simulation results of the models. Plotting Perspective will automatically
become active when the simulation of the model is finished successfully. It will also become active when user
opens any of the OpenModelica’s supported result file. Similar to Modeling Perspective this perspective can also
be viewed in two different modes, the tabbed view and subwindow view, see section General.

2.3.4 Debugging Perspective

The application automatically switches to Debugging Perpective when user simulates the class with algorithmic
debugger. The prespective shows the list of stack frames, breakpoints and variables.
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Figure 2.8: OMEdit Plotting Perspective.
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Figure 2.9: OMEdit Debugging Perspective.
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2.4 Modeling a Model

2.4.1 Creating a New Modelica Class

Creating a new Modelica class in OMEdit is rather straightforward. Choose any of the following methods,
¢ Select File > New Modelica Class from the menu.
* Click on New Modelica Class toolbar button.
* Click on the Create New Modelica Class button available at the left bottom of Welcome Perspective.

¢ Press Ctrl+N.

2.4.2 Opening a Modelica File

Choose any of the following methods to open a Modelica file,
* Select File > Open Model/Library File(s) from the menu.
* Click on Open Model/Library File(s) toolbar button.
¢ Click on the Open Model/Library File(s) button available at the right bottom of Welcome Perspective.
* Press Ctrl+O.
(Note, for editing Modelica system files like MSL (not recommended), see Editing Modelica Standard Library)

2.4.3 Opening a Modelica File with Encoding

Select File > Open/Convert Modelica File(s) With Encoding from the menu. It is also possible to convert files to
UTF-8.

2.4.4 Model Widget

For each Modelica class one Model Widget is created. It has a statusbar and a view area. The statusbar contains
buttons for navigation between the views and labels for information. The view area is used to display the icon,
diagram and text layers of Modelica class. See Figure 2.10.

2.4.5 Adding Component Models

Drag the models from the Libraries Browser and drop them on either Diagram or Icon View of Model Widget.

2.4.6 Making Connections

In order to connect one component model to another the user first needs to enable the connect mode ('<:) from
the toolbar.

Move the mouse over the connector. The mouse cursor will change from arrow cursor to cross cursor. To start
the connection press left button and move while keeping the button pressed. Now release the left button. Move
towards the end connector and click when cursor changes to cross cursor.

2.4. Modeling a Model 37



OpenModelica User’s Guide, Release v1.13.0

A DCMator* (%]
I-l-IE € | writable | Model | Diagram View | C:/Users/adeas31/Desktop/DCmotor.mo Line: 1, Col: 0 | &
~
resistor 1 inductorl
sepl
4 oo
=
» )ﬁ
z
+ 5
[ | [
startTime=startTime
groundl
w
< >

Figure 2.10: Model Widget showing the Diagram View.
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2.5 Simulating a Model

The simulation options for each model are stored inside the OMEdit data structure. They have the following
sequence,

» Each model has its own simulation options.
* If the model is opened for the first time then the simulation options are set to default.

* experiment and _ OpenModelica_simulationFlags annotations are applied if the model con-
tains them.

 After that all the changes done via Simulation Setup window are preserved for the whole session. If you
want to use the same settings in the future sessions then you should store them inside experiment and
__OpenModelica_simulationFlags.

The OMEdit Simulation Setup can be launched by,
* Selecting Simulation > Simulation Setup from the menu. (requires a model to be active in ModelWidget)
* Clicking on the Simulation Setup toolbar button. (requires a model to be active in ModelWidget)

 Right clicking the model from the Libraries Browser and choosing Simulation Setup.

2.5.1 General Tab

 Simulation Interval

e Start Time — the simulation start time.

* Stop Time — the simulation stop time.

e Number of Intervals — the simulation number of intervals.
* Interval — the length of one interval (i.e., stepsize)

e [Interactive Simulation

» Simulate with steps (makes the interactive simulation synchronous; plots nicer curves at the expense of
performance)

 Simulation server port
* Integration
* Method — the simulation solver. See section Integration Methods for solver details.
* Tolerance — the simulation tolerance.
e Jacobian - the jacobain method to use.
* DASSL/IDA Options
* Root Finding - Activates the internal root finding procedure of dassl.
* Restart After Event - Activates the restart of dassl after an event is performed.
e Initial Step Size
* Maximum Step Size
o Maximum Integration Order
e C/C++ Compiler Flags (Optional) — the optional C/C++ compiler flags.
* Number of Processors — the number of processors used to build the simulation.
* Build Only — only builds the class.
* Launch Transformational Debugger — launches the transformational debugger.

* Launch Algorithmic Debugger — launches the algorithmic debugger.
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e Launch Animation — launches the 3d animation window.

2.5.2 Output Tab

Output Format — the simulation result file output format.

Single Precision - Output results in single precision (only for mat output format).
File Name Prefix (Optional) — the name is used as a prefix for the output files.
Result File (Optional) - the simulation result file name.

Variable Filter (Optional)

Protected Variables — adds the protected variables in result file.

Equidistant Time Grid — output the internal steps given by dassl instead of interpolating results into an
equidistant time grid as given by stepSize or numberOfIntervals

Store Variables at Events — adds the variables at time events.

Show Generated File — displays the generated files in a dialog box.

2.5.3 Simulation Flags Tab

Model Setup File (Optional) — specifies a new setup XML file to the generated simulation code.
Initialization Method (Optional) — specifies the initialization method.

Equation System Initialization File (Optional) — specifies an external file for the initialization of the model.
Equation System Initialization Time (Optional) — specifies a time for the initialization of the model.

Clock (Optional) — the type of clock to use.

Linear Solver (Optional) — specifies the linear solver method.

Non Linear Solver (Optional) — specifies the nonlinear solver.

Linearization Time (Optional) — specifies a time where the linearization of the model should be performed.

Output Variables (Optional) — outputs the variables a, b and c at the end of the simulation to the standard
output.

Profiling — creates a profiling HTML file.

CPU Time — dumps the cpu-time into the result file.

Enable All Warnings — outputs all warnings.

Logging (Optional)

stdout - standard output stream. This stream is always active, can be disabled with -lv=-stdout
assert - This stream is always active, can be disabled with -lv=-assert

LOG_DASSL - additional information about dassl solver.

LOG_DASSL_STATES - outputs the states at every dassl call.

LOG_DEBUG - additional debug information.

LOG_DSS - outputs information about dynamic state selection.

LOG_DSS_JAC - outputs jacobian of the dynamic state selection.

LOG_DT - additional information about dynamic tearing.

LOG_DT_CONS - additional information about dynamic tearing (local and global constraints).

LOG_EVENTS - additional information during event iteration.
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* LOG_EVENTS_V - verbose logging of event system.

e LOG_INIT - additional information during initialization.

* LOG_IPOPT - information from Ipopt.

e LOG_IPOPT_FULL - more information from Ipopt.

e LOG_IPOPT_JAC - check jacobian matrix with Ipopt.

e LOG_IPOPT_HESSE - check hessian matrix with Ipopt.

e LOG_IPOPT_ERROR - print max error in the optimization.

e LOG_JAC - outputs the jacobian matrix used by dassl.

e LOG_LS - logging for linear systems.

* LOG_LS_V - verbose logging of linear systems.

e LOG_NLS - logging for nonlinear systems.

e LOG_NLS_V - verbose logging of nonlinear systems.

* LOG_NLS_HOMOTOPY - logging of homotopy solver for nonlinear systems.
* LOG_NLS_JAC - outputs the jacobian of nonlinear systems.

* LOG_NLS_JAC_TEST - tests the analytical jacobian of nonlinear systems.

e LOG_NLS_RES - outputs every evaluation of the residual function.

* LOG_NLS_EXTRAPOLATE - outputs debug information about extrapolate process.
e LOG_RES_INIT - outputs residuals of the initialization.

* LOG_RT - additional information regarding real-time processes.

LOG_SIMULATION - additional information about simulation process.

* LOG_SOLVER - additional information about solver process.

LOG_SOLVER_V - verbose information about the integration process.
* LOG_SOLVER_CONTEXT - context information during the solver process.

e LOG_SOTI - final solution of the initialization.

LOG_STATS - additional statistics about timer/events/solver.

LOG_STATS_V - additional statistics for LOG_STATS.

e LOG_SUCCESS - This stream is always active, can be disabled with -lv=-LOG_SUCCESS.
 LOG_UTIL.

* LOG_ZEROCROSSINGS - additional information about the zerocrossings.

Additional Simulation Flags (Optional) — specify any other simulation flag.

2.5.4 Archived Simulations Tab

Shows the list of simulations already finished or running. Double clicking on any of them opens the simulation
output window.

2.6 Plotting the Simulation Results

Successful simulation of model produces the result file which contains the instance variables that are candidate for
plotting. Variables Browser will show the list of such instance variables. Each variable has a checkbox, checking
it will plot the variable. See Figure 2.8.
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2.6.1 Types of Plotting

The plotting type depends on the active Plot Window. By default the plotting type is Time Plot.

Time Plot

Plots the variable over the simulation time. You can have multiple Time Plot windows by clicking on New Plot

Window toolbar button (IZ).

Plot Parametric

Draws a two-dimensional parametric diagram, between variables x and y, with y as a function of x. You can have

multiple Plot Parametric windows by clicking on the New Plot Parametric toolbar button (I@).

Array Plot

Plots an array variable so that the array elements’ indexes are on the x-axis and corresponding elements’ values
are on the y-axis. The time is controlled by the slider above the variable tree. When an array is present in the
model, it has a principal array node in the variable tree. To plot this array as an Array Plot, match the principal
node. The principal node may be expanded into particular array elements. To plot a single element in the Time
Plot, match the element. A new Array Plot window is opened using the New Array Plot Window toolbar button

(IL").

Array Parametric Plot

Plots the first array elements’ values on the x-axis versus the second array elements’ values on the y-axis. The
time is controlled by the slider above the variable tree. To create a new Array Parametric Plot, press the New

Array Parametric Plot Window toolbar button ( {'7::}), then match the principle array node in the variable tree view
to be plotted on the x-axis and match the principle array node to be plotted on the y-axis.

2.7 Re-simulating a Model

The Variables Browser allows manipulation of changeable parameters for re-simulation. After changing the pa-

rameter values user can click on the re-simulate toolbar button (9), or right click the model in Variables Browser
and choose re-simulate from the menu.

2.8 3D Visualization

Since OpenModelica 1.11 , OMEdit has built-in 3D visualization, which replaces third-party libraries (such as
Modelica3D) for 3D visualization.

2.8.1 Running a Visualization

The 3d visualization is based on OpenSceneGraph. In order to run the visualization simply right click the class in
Libraries Browser an choose “Simulate with Animation” as shown in Figure 2.11.

One can also run the visualization via Simulation > Simulate with Animation from the menu.

When simulating a model in animation mode, the flag +d=visxml is set. Hence, the compiler will generate a
scene description file _visual.xml which stores all information on the multibody shapes. This scene description
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Figure 2.11: OMEdit Simulate with Animation.

references all variables which are needed for the animation of the multibody system. When simulating with
+d=visxml, the compiler will always generate results for these variables.

2.8.2 Viewing a Visualization

After the successful simulation of the model, the visualization window will show up automatically as shown in
Figure 2.12.

The animation starts with pushing the play button. The animation is played until stopTime or until the pause
button is pushed. By pushing the previous button, the animation jumps to the initial point of time. Points of time
can be selected by moving the time slider or by inserting a simulation time in the Time-box. The speed factor of
animation in relation to realtime can be set in the Speed-dialog. Other animations can be openend by using the
open file button and selecting a result file with a corresping scene description file.

The 3D camera view can be manipulated as follows:

Operation Key Mouse Action
Move Closer/Further none Wheel

Move Closer/Further Right Mouse Hold Up/Down
Move Up/Down/Left/Right | Middle Mouse Hold Move Mouse
Move Up/Down/Left/Right | Left and Right Mouse Hold | Move Mouse
Rotate Left Mouse Hold Move Mouse
Shape context menu Right Mouse + Shift

Predefined views (Isometric, Side, Front, Top) can be selected and the scene can be tilted by 90° either clock or
anticlockwise with the rotation buttons.
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Figure 2.12: OMEdit 3D Visualization.

2.8.3 Additional Visualization Features

The shapes that are displayed in the viewer can be selected with shift + right click. If a shape is selected, a context
menu pops up that offers additional visualization features

1 shape ' |€  Change Transparency
Reset Transparency and Texture [ Make Shape Invisible

&% Change Color

.. Apply Check Texture
&4 Apply Customn Texture

Remove Texure

The following features can be selected:

44 Chapter 2. OMEdit — OpenModelica Connection Editor



OpenModelica User’s Guide, Release v1.13.0

Menu Description

Change Transparency | The shape becomes either transparent or intransparent.

Make Shape Invisible | The shape becomes invisible.

Change Color A color dialog pops up and the color of the shape can be set.

Apply Check Texture A checked texture is applied to the shape.

Apply Custom Texture | A file selection dialog pops up and an image file can be selected as a texture.
Remove Texture Removes the current texture of the shape.

2.9 Interactive Simulation

Warning: Interactive simulation is an experimental feature.

Interactive simulation is enabled by selecting interactive simulation in the General tab of the simulation settings.

There are two main modes of execution: asynchronous and synchronous (simulate with steps). The difference is
that in synchronous (step mode), OMEdit sends a command to the simulation for each step that the simulation
should take. The asynchronous mode simply tells the simulation to run and samples variables values in real-time;
if the simulation runs very fast, fewer values will be sampled.

When running in asynchronous mode, it is possible to simulate the model in real-time (with a scaling factor just
like simulation flag -77, but with the ability to change the scaling factor during the interactive simulation). In the
synchronous mode, the speed of the simulation does not directly correspond to real-time.

2.10 How to Create User Defined Shapes — Icons

Users can create shapes of their own by using the shape creation tools available in OMEdit.

¢ Line Tool — Draws a line. A line is created with a minimum of two points. In order to create a line, the
user first selects the line tool from the toolbar and then click on the Icon/Diagram View; this will start
creating a line. If a user clicks again on the Icon/Diagram View a new line point is created. In order to
finish the line creation, user has to double click on the Icon/Diagram View.

¢ Polygon Tool — Draws a polygon. A polygon is created in a similar fashion as a line is created. The only
difference between a line and a polygon is that, if a polygon contains two points it will look like a line
and if a polygon contains more than two points it will become a closed polygon shape.
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* Rectangle Tool — Draws a rectangle. The rectangle only contains two points where first point indicates
the starting point and the second point indicates the ending the point. In order to create rectangle, the
user has to select the rectangle tool from the toolbar and then click on the Icon/Diagram View, this
click will become the first point of rectangle. In order to finish the rectangle creation, the user has to
click again on the Icon/Diagram View where he/she wants to finish the rectangle. The second click
will become the second point of rectangle.

Ellipse Tool — Draws an ellipse. The ellipse is created in a similar way as a rectangle is created.
* Text Tool — Draws a text label.
* Bitmap Tool — Draws a bitmap container.

The shape tools are located in the toolbar. See Figure 2.13.

( Rectangle Tool ) ( Text Tool >

\ /

{ ¢ Line Tool ) A—NWOHOEN —»( Bitmap Tool D

/N

( Polygon TooD (¢ Ellipse Tool )

Figure 2.13: User defined shapes.

The user can select any of the shape tools and start drawing on the Icon/Diagram View. The shapes created on the
Diagram View of Model Widget are part of the diagram and the shapes created on the Icon View will become the
icon representation of the model.

For example, if a user creates a model with name testModel and add a rectangle using the rectangle tool and a
polygon using the polygon tool, in the Icon View of the model. The model’s Modelica Text will appear as follows:

model testModel

annotation (Icon (graphics = {Rectangle(rotation = 0, lineColor = {0,0,255},
—~fillColor = {0,0,255}, pattern = LinePattern.Solid, fillPattern = FillPattern.
—None, lineThickness = 0.25, extent = {{ -64.5,88},{63, —-22.5}}),Polygon(points =
—{{ -47.5, -29.5},{52.5, -29.5},{4.5, -86},{ -47.5, -29.5}}, rotation = 0,
—lineColor = {0,0,255}, fillColor = {0,0,255}, pattern = LinePattern.Solid,
—~fillPattern = FillPattern.None, lineThickness = 0.25)1}));
end testModel;

In the above code snippet of testModel, the rectangle and a polygon are added to the icon annotation of the model.
Similarly, any user defined shape drawn on a Diagram View of the model will be added to the diagram annotation
of the model.

2.11 Global head section in documentation

If you want to use same styles or same JavaScript for the classes contained inside a package then you can de-
fine ___OpenModelica_infoHeader annotation inside the Documentation annotation of a package. For
example,
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package P
model M
annotation (Documentation (info="<html>
<a href=\"javascript:HelloWorld()\">Click here</a>
</html>"));
end M;
annotation (Documentation (___OpenModelica_infoHeader="
<script type=\"text/javascript\">
function HelloWorld() {
alert (\"Hello World!\");
t
</script>"));
end P;

In the above example model M does not need to define the javascript function HelloWorld. It is only defined
once at the package level using the _ OpenModelica_infoHeader and then all classes contained in the
package can use it.

In addition styles and JavaScript can be added from file locations using Modelica URIs. Example:

package P
model M
annotation (Documentation (info="<html>
<a href=\"javascript:HelloWorld()\">Click here</a>
</html>"));
end M;
annotation (Documentation (___OpenModelica_infoHeader="
<script type=\"text/javascript\">
src=\"modelica://P/Resources/hello.js\">
}
</script>"));
end P;

Where the file Resources/hello. js then contains:

function HelloWorld() {
alert ("Hello World!™);

2.12 Settings

OMEdit allows users to save several settings which will be remembered across different sessions of OMEdit. The
Options Dialog can be used for reading and writing the settings.

2.12.1 General

¢ General

» Language — Sets the application language.

» Working Directory — Sets the application working directory. All files are generated in this directory.
* Toolbar Icon Size — Sets the size for toolbar icons.

* Preserve User’s GUI Customizations — If true then OMEdit will remember its windows and toolbars posi-
tions and sizes.

» Terminal Command — Sets the terminal command. When user clicks on Tools > Open Terminal then this
command is executed.

» Terminal Command Arguments — Sets the terminal command arguments.
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Hide Variables Browser — Hides the variable browser when switching away from plotting perspective.

Activate Access Annotations — Activates the access annotations for the non-encrypted libraries. Access
annotations are always active for encrypted libraries.

Libraries Browser

Library Icon Size — Sets the size for library icons.

Show Protected Classes — If enabled then Libraries Browser will also list the protected classes.
Modeling View Mode

Tabbed View/SubWindow View — Sets the view mode for modeling.

Default View

Icon View/DiagramView/Modelica Text View/Documentation View — If no preferredView annotation is de-
fined then this setting is used to show the respective view when user double clicks on the class in the
Libraries Browser.

Enable Auto Save

Auto Save interval — Sets the auto save interval value. The minimum possible interval value is 60 seconds.
Enable Auto Save for single classes — Enables the auto save for one class saved in one file.

Enable Auto Save for one file packages — Enables the auto save for packages saved in one file.

Welcome Page

Horizontal View/Vertical View — Sets the view mode for welcome page.

Show Latest News — if true then displays the latest news.

2.12.2 Libraries

System Libraries — The list of system libraries that should be loaded every time OMEdit starts.

Force loading of Modelica Standard Library — If true then Modelica and ModelicaReference will always
load even if user has removed them from the list of system libraries.

Load OpenModelica library on startup — If true then OpenModelica package will be loaded when OMEdit
is started.

User Libraries — The list of user libraries/files that should be loaded every time OMEdit starts.

2.12.3 Text Editor

Format
Line Ending - Sets the file line ending.
Byte Order Mark (BOM) - Sets the file BOM.
Tabs and Indentation
Tab Policy — Sets the tab policy to either spaces or tabs only.
Tab Size — Sets the tab size.
Indent Size — Sets the indent size.
Syntax Highlight and Text Wrapping
» Enable Syntax Highlighting — Enable/Disable the syntax highlighting.
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* Enable Code Folding - Enable/Disable the code folding. When code folding is enabled multi-
line annotations are collapsed into a compact icon (a rectangle containing "...)"). A marker
containing a "+" sign becomes available at the left-side of the involved line, allowing the code
to be expanded/re-collapsed at will.

* Match Parentheses within Comments and Quotes — Enable/Disable the matching of parentheses
within comments and quotes.

» Enable Line Wrapping — Enable/Disable the line wrapping.
* Autocomplete
* Enable Autocomplete — Enable/Disable the autocomplete.
* Font
* Font Family — Shows the names list of available fonts. Sets the font for the editor.

e Font Size — Sets the font size for the editor.

2.12.4 Modelica Editor

e Preserve Text Indentation — If true then uses diffModelicaFileListings API call otherwise uses the OMC
pretty-printing.

* Colors
* Jtems — List of categories used of syntax highlighting the code.
e Jtem Color — Sets the color for the selected item.

* Preview — Shows the demo of the syntax highlighting.

2.12.5 MetaModelica Editor

* Colors
* Jtems — List of categories used of syntax highlighting the code.
* Item Color — Sets the color for the selected item.

* Preview — Shows the demo of the syntax highlighting.

2.12.6 CompositeModel Editor

* Colors
* Jtems — List of categories used of syntax highlighting the code.
e [tem Color — Sets the color for the selected item.

* Preview — Shows the demo of the syntax highlighting.

2.12.7 C/C++ Editor

* Colors
* Items — List of categories used of syntax highlighting the code.
e Item Color — Sets the color for the selected item.

* Preview — Shows the demo of the syntax highlighting.
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2.12.8 Graphical Views

* Extent

 Left — Defines the left extent point for the view.

* Bottom — Defines the bottom extent point for the view.

* Right — Defines the right extent point for the view.

» Top — Defines the top extent point for the view.

* Grid

* Horizontal — Defines the horizontal size of the view grid.

* Vertical — Defines the vertical size of the view grid.

* Component

* Scale factor — Defines the initial scale factor for the component dragged on the view.

* Preserve aspect ratio — If true then the component’s aspect ratio is preserved while scaling.

2.12.9 Simulation

¢ Simulation
* Matching Algorithm — sets the matching algorithm for simulation.
* Index Reduction Method — sets the index reduction method for simulation.
» Target Language — sets the target language in which the code is generated.
» Target Compiler — sets the target compiler for compiling the generated code.
* OMC Command Line Options — sets the OMC command line options for the simulation.

e Ignore __OpenModelica_commandLineOptions annotation — if true then ignores the __ Open-
Modelica_commandLineOptions annotation while running the simulation.

 Ignore __OpenModelica_simulationFlags annotation — if true then ignores the __OpenModel-
ica_simulationFlags annotation while running the simulation.

* Save class before simulation — if true then always saves the class before running the simulation.

» Switch to plotting perspective after simulation — if true then GUI always switches to plotting
perspective after the simulation.

* Close completed simulation output windows before simulation — if true then the completed sim-
ulation output windows are closed before starting a new simulation.

* Delete intermediate compilation files — if true then the files generated during the compilation
are deleted automatically.

e Delete entire simulation directory of the model when OMEdit is closed — if true then the entire
simulation directory is deleted on quit.

¢ QOutput
e Structured — Shows the simulation output in the form of tree structure.

o Formatted Text — Shows the simulation output in the form of formatted text.
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2.12.10 Messages

General

Output Size - Specifies the maximum number of rows the Messages Browser may have. If there are more
rows then the rows are removed from the beginning.

Reset messages number before simulation — Resets the messages counter before starting the simulation.
Font and Colors

Font Family — Sets the font for the messages.

Font Size — Sets the font size for the messages.

Notification Color — Sets the text color for notification messages.

Warning Color — Sets the text color for warning messages.

Error Color — Sets the text color for error messages.

2.12.11 Notifications

Notifications
Always quit without prompt — If true then OMEdit will quit without prompting the user.

Show item dropped on itself message — If true then a message will pop-up when a class is dragged and
dropped on itself.

Show model is defined as partial and component will be added as replaceable message — If true then a
message will pop-up when a partial class is added to another class.

Show component is declared as inner message — If true then a message will pop-up when an inner component
is added to another class.

Show save model for bitmap insertion message — If true then a message will pop-up when user tries to insert
a bitmap from a local directory to an unsaved class.

Always ask for the dragged component name — If true then a message will pop-up when user drag & drop
the component on the graphical view.

Always ask for what to do with the text editor error — If true then a message will always pop-up when there
is an error in the text editor.

2.12.12 Line Style

Line Style

Color — Sets the line color.

Pattern — Sets the line pattern.

Thickness — Sets the line thickness.

Start Arrow — Sets the line start arrow.

End Arrow — Sets the line end arrow.

Arrow Size — Sets the start and end arrow size.

Smooth — If true then the line is drawn as a Bezier curve.
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2.12.13 Fill Style

« Fill Style
e Color — Sets the fill color.

* Pattern — Sets the fill pattern.

2.12.14 Plotting

* General

» Auto Scale — sets whether to auto scale the plots or not.

* Plotting View Mode

 Tabbed View/SubWindow View — Sets the view mode for plotting.
* Curve Style

e Pattern — Sets the curve pattern.

e Thickness — Sets the curve thickness.

2.12.15 Figaro

* Figaro
e Figaro Library — the Figaro library file path.
* Tree generation options — the Figaro tree generation options file path.

* Figaro Processor — the Figaro processor location.

2.12.16 Debugger

¢ Algorithmic Debugger

* GDB Path — the gnu debugger path

* GDB Command Timeout — timeout for gdb commands.

* GDB Output Limit — limits the GDB output to N characters.
e Display C frames — if true then shows the C stack frames.

* Display unknown frames — if true then shows the unknown stack frames. Unknown stack frames means
frames whose file path is unknown.

* Clear old output on a new run — if true then clears the output window on new run.
* Clear old log on new run — if true then clears the log window on new run.
 Transformational Debugger

* Always show Transformational Debugger after compilation — if true then always open the Transformational
Debugger window after model compilation.

* Generate operations in the info xml — if true then adds the operations information in the info xml file.
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2.12.17 FMI

* Export
e Version
e 1.0 — Sets the FMI export version to 1.0
e 2.0 — Sets the FMI export version to 2.0
* Type
* Model Exchange — Sets the FMI export type to Model Exchange.
e Co-Simulation — Sets the FMI export type to Co-Simulation.

* Model Exchange and Co-Simulation — Sets the FMI export type to Model Exchange and Co-
Simulation.

e FMU Name — Sets a prefix for generated FMU file.
* Platforms - list of platforms to generate FMU binaries.
e Import

* Delete FMU directory and generated model when OMEdit is closed - If true then the temporary FMU
directory that is created for importing the FMU will be deleted.

2.12.18 OMTLMSimulator

* General
* Path - path to OMTLMSimulator bin directory.
* Manager Process - path to OMTLMSimulator managar process.

* Monitor Process - path to OMTLMSimulator monitor process.

2.12.19 OMSimulator

* General
* Working Directory - working directory for OMSimulator files.
* Logging Level - OMSimulator logging level.

2.13 __OpenModelica_commandLineOptions Annotation

OpenModelica specific annotation to define the command line options needed to simulate the model. For example
if you always want to simulate the model with a specific matching algorithm and index reduction method instead
of the default ones then you can write the following code,

model Test

annotation (___OpenModelica_commandLineOptions = "--matchingAlgorithm=BFSB —-
—indexReductionMethod=dynamicStateSelection");
end Test;

The annotation is a space separated list of options where each option is either just a command line flag or a flag
with a value.

In OMEdit right click inside the icon/diagram view of the model and choose Properties.
Then OMC Command Line Options and in the text field write -matchingAlgorithm=BFSB -
indexReductionMethod=dynamicStateSelection.
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It you want to ignore this annotation then use setCommandLineOptions("-
ignoreCommandLineOptionsAnnotation=true"). In OMEdit Tools > Options > Simulation check Ignore
__OpenModelica_commandLineOptions annotation.

2.14 _ OpenModelica_simulationFlags Annotation

OpenModelica specific annotation to define the simulation options needed to simulate the model. For example if
you always want to simulate the model with a specific solver instead of the default DASSL and would also like to
see the cpu time then you can write the following code,

model Test
annotation (___OpenModelica_simulationFlags (s = "heun", cpu = "()"));
end Test;

The annotation is a comma separated list of options where each option is a simulation flag with a value. For flags
that doesn’t have any value use () (See the above code example).

In OMEdit open the Simulation Setup and set the Simulation Flags then in the bottom check Save __OpenModel-
ica_simulationFlags annotation inside model and click on OK.

If you want to ignore this annotation then use setCommandLineOptions("-
ignoreSimulationFlagsAnnotation=true"). In OMEdit Tools > Options > Simulation check Ignore __OpenMod-
elica_simulationFlags annotation.

2.15 Debugger

For debugging capability, see Debugging.

2.16 Editing Modelica Standard Library

By default OMEdit loads the Modelica Standard Library (MSL) as a system library. System libraries are read-
only. If you want to edit MSL you need to load it as user library instead of system library. We don’t recommend
editing MSL but if you really need to and understand the consequences then follow these steps,

* Go to Tools > Options > Libraries.

* Remove Modelica & ModelicaReference from list of system libraries.

* Uncheck force loading of Modelica Standard Library.

Add SOPENMODELICAHOME/lib/omlibrary/Modelica X.X/package.mo under user libraries.

Restart OMEdit.

2.17 State Machines

2.17.1 Creating a New Modelica State Class

Follow the same steps as defined in Creating a New Modelica Class. Additionally make sure you check the State
checkbox.
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o't OMEdit - Create New Modelica Class 7 pd
Mame: Statel

Spedalization: Model i
Extends (optional): Browse...
Insert in class (optional): Browse...

[ ] Partial

[ ] Encapsulated
State

Ik Cancel

Figure 2.14: Creating a new Modelica state.
2.17.2 Making Transitions

3
In order to make a transition from one state to another the user first needs to enable the transition mode (—) from
the toolbar.

Move the mouse over the state. The mouse cursor will change from arrow cursor to cross cursor. To start the
transition press left button and move while keeping the button pressed. Now release the left button. Move towards
the end state and click when cursor changes to cross cursor.

A Create Transition dialog box will appear which allows you to set the transition attributes. Cancelling the dialog
will cancel the transition.

Double click the transition or right click and choose Edit Transition to modify the transition attributes.

2.17.3 State Machine Simulation

Support for Modelica state machines was added in the Modelica Language Specification v3.3. A subtle problem
can occur if Modelica v3.2 libraries are loaded, e.g., the Modelica Standard Library v3.2.2, because in this case
OMC automatically switches into Modelica v3.2 compatibility mode. Trying to simulate a state machine in
Modelica v3.2 compatibility mode results in an error. It is possible to use the OMC flag —std=latest in order to
ensure (at least) Modelica v3.3 support. In OMEdit this can be achieved by setting that flag in the Tools > Options
> Simulation dialog.
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OMEdit - Options

E General

% Libraries
Text Editor
Modelica Editor
MetaModelica Editor
CompositeModel Editor
C/C++ Editor
HTML Editor

d&. Graphical Views

-) Simulation
@ Messages
o Notifications

Simulation
Matching Algorithm: PFPlusExt i
Index Reduction Method: | dynamicStateSelection b
Target Language: C v
Target Compiler: gec ~
OMC Flags: —-std=latest | [
[ ] 1gnore __openModelica_commandLineQptions annotation
y |:| Ignore __OpenModelica_simulationFlags annotation "

* The changes will take effect after restart. OK Cancel

Figure 2.15: Ensure (at least) Modelica v3.3 support.
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CHAPTER
THREE

2D PLOTTING

This chapter covers the 2D plotting available in OpenModelica via OMNotebook, OMShell and command line
script. The plotting is based on OMPIlot application.

3.1 Example

class HelloWorld

Real x(start = 1, fixed = true);
parameter Real a = 1;

equation
der (x) = — a *» x;

end HelloWorld;

To create a simple time plot the above model HelloWorld is simulated. To reduce the amount of simulation data in
this example the number of intervals is limited with the argument numberOflIntervals=5. The simulation is started
with the command below.

>>> gsimulate (HelloWorld, outputFormat="csv", startTime=0, stopTime=4,
—numberOfIntervals=5)
record SimulationResult

resultFile = "«DOCHOME»/HelloWorld_res.csv",

simulationOptions = "startTime = 0.0, stopTime = 4.0, numberOflIntervals = 5, |
—tolerance = 1le-06, method = 'dassl', fileNamePrefix = 'HelloWorld', options = '',
— outputFormat = 'csv', variableFilter = '.x', cflags = '', simflags = ''",

messages = "LOG_SUCCESS | info | The initialization finished
—successfully without homotopy method.
LOG_SUCCESS | info | The simulation finished successfully.

n
4

timeFrontend = 0.008662360000000001,
timeBackend 0.003553526,
timeSimCode = 0.191354772,
timeTemplates = 0.102581629,
timeCompile = 0.6949837210000001,
timeSimulation = 0.00674046,
timeTotal = 1.008051774

end SimulationResult;

‘When the simulation is finished the file HelloWorld_res.csv contains the simulation data:

Listing 3.1: HelloWorld_res.csv

"time", "x", "der (x)"

0,1,-1
0.8,0.4493289092712475,-0.4493289092712475
.6,0.2018973974273906,-0.2018973974273906
.4,0.09071896372718975,-0.09071896372718975
.2,0.04076293845066793,-0.04076293845066793

w N =

(continues on next page)
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(continued from previous page)

4,0.01831609502171534,-0.01831609502171534
4,0.01831609502171534,-0.01831609502171534

Diagrams are now created with the new OMPlot program by using the following plot command:

09

0.8

0.6

04

0.2

0.1

0 1 1 1 1 1

0 0.5 1 1.5 2 2.5

Figure 3.1: Simple 2D plot of the HelloWorld example.

By re-simulating and saving results at many more points, for example using the default 500 intervals, a much
smoother plot can be obtained. Note that the default solver method dassl has more internal points than the output
points in the initial plot. The results are identical, except the detailed plot has a smoother curve.

>>> (O==system("./HelloWorld -override stepSize=0.008")
true

>>> res:=strtok (readFile ("HelloWorld res.csv"), "\n");
>>> res[end]
"4,0.01831609502171534,-0.01831609502171534"

0.9
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0.7
0.6
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T

0.3
0.2
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Figure 3.2: Simple 2D plot of the HelloWorld example with a larger number of output points.
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3.2 Plot Command Interface

Plot command have a number of optional arguments to further customize the the resulting diagram.

>>> list (OpenModelica.Scripting.plot,interfaceOnly=true)
"function plot
input VariableNames vars \"The variables you want to plot\";
input Boolean externalWindow = false \"Opens the plot in a new plot window\";
input String fileName = \"<default>\" \"The filename containing the variables.
—<default> will read the last simulation result\";
input String title = \"\" \"This text will be used as the diagram title.\";
input String grid = \"detailed\" \"Sets the grid for the plot i.e simple,
—detailed, none.\";

input Boolean logX = false \"Determines whether or not the horizontal axis is_
—logarithmically scaled.\";
input Boolean logY = false \"Determines whether or not the vertical axis is_

—logarithmically scaled.\";
input String xLabel = \"time\" \"This text will be used as the horizontal label_
—in the diagram.\";

input String yLabel = \"\" \"This text will be used as the vertical label in the_
—~diagram.\";

input Real xRange[2] = {0.0, 0.0} \"Determines the horizontal interval that is
—visible in the diagram. {0,0} will select a suitable range.\";
input Real yRange([2] = {0.0, 0.0} \"Determines the vertical interval that is_

—visible in the diagram. {0,0} will select a suitable range.\";

input Real curveWidth = 1.0 \"Sets the width of the curve.\";

input Integer curveStyle = 1 \"Sets the style of the curve. SolidLine=1,
—DashLine=2, DotLine=3, DashDotLine=4, DashDotDotLine=5, Sticks=6, Steps=7.\";

input String legendPosition = \"top\" \"Sets the POSITION of the legend i.e left,
— right, top, bottom, none.\";

input String footer = \"\" \"This text will be used as the diagram footer.\";

input Boolean autoScale = true \"Use auto scale while plotting.\";

input Boolean forceOMPlot = false \"if true launches OMPlot and doesn't call,,
—scallback function even if it is defined.\";

output Boolean success \"Returns true on success\";
end plot;"
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CHAPTER
FOUR

SOLVING MODELICA MODELS

4.1 Integration Methods

By default OpenModelica transforms a Modelica model into an ODE representation to perform a simulation by
using numerical integration methods. This section contains additional information about the different integration
methods in OpenModelica. They can be selected by the method parameter of the simulate command or the -s

simflag.
The different methods are also called solver and can be distinguished by their characteristic:
* explicit vs. implicit
* order
* step size control
e multi step

A good introduction on this topic may be found in [CK06] and a more mathematical approach can be found in
[HNorsettW93].

4.1.1 DASSL

DASSL is the default solver in OpenModelica, because of a severals reasons. It is an implicit, higher order,
multi-step solver with a step-size control and with these properties it is quite stable for a wide range of models.
Furthermore it has a mature source code, which was originally developed in the eighties an initial description may
be found in [Pet82].

This solver is based on backward differentiation formula (BDF), which is a family of implicit methods for numer-
ical integration. The used implementation is called DASPK?2.0 (see”) and it is translated automatically to C by f2c
(see?).

The following simulation flags can be used to adjust the behavior of the solver for specific simulation problems:
Jjacobian, noRootFinding, noRestart, initialStepSize, maxStepSize, maxIntegrationOrder, noEquidistantTimeGrid.

4.1.2 IDA

The IDA solver is part of a software family called sundials: SUite of Nonlinear and DIfferential/ALgebraic equa-
tion Solvers [HBG+05]. The implementation is based on DASPK with an extended linear solver interface, which
includes an interface to the high performance sparse linear solver KLU [DN10].

The simulation flags of DASSL are also valid for the IDA solver and furthermore it has the following IDA specific
flags: idaLS, idaMaxNonLinlters, idaMaxConvFails, idaNonLinConvCoef, idaMaxErrorTestFails.

2 DASPK Webpage
3 Cdaskr source
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4.1.3 Basic Explicit Solvers

The basic explicit solvers are performing with a fixed step-size and differ only in the integration order. The
step-size is based on the numberOflntervals, the startTime and stopTime parameters in the simulate command:
stopTime — startTime

stepSize ~
P numberOflntervals

e culer - order 1
¢ heun - order 2

* rungekutta - order 4

4.1.4 Basic Implicit Solvers

The basic implicit solvers are all based on the non-linear solver KINSOL from the SUNDIALS suite. The un-
derlining linear solver can be modified with the simflag -impRKLS. The step-size is determined as for the basic
explicit solvers.

* impeuler - order 1
e trapezoid - order 2

* imprungekutta - Based on Radau IIA and Lobatto IIIA defined by its Butcher tableau where the order can
be adjusted by -impRKorder.

4.1.5 Experimental Solvers

The following solvers are marked as experimental, mostly because they are till now not tested very well.
* rungekuttaSsc - Runge-Kutta based on Novikov (2016) - explicit, step-size control, order 4-5
¢ irksco - Own developed Runge-Kutta solver - implicit, step-size control, order 1-2
* symSolver - Symbolic inline solver (requires —symSolver) - fixed step-size, order 1

* symSolverSsc - Symbolic implicit inline Euler with step-size control (requires —symSolver) - step-size con-
trol, order 1-2

* gss - A QSS solver

4.2 DAE Mode Simulation

Beside the default ODE simulation, OpenModelica is able to simulate models in DAE mode. The DAE mode is
enabled by the flag —daeMode. In general the whole equation system of a model is passed to the DAE integrator,
including all algebraic loops. This reduces the amount of work that needs to be done in the post optimization
phase of the OpenModelica backend. Thus models with large algebraic loops might compile faster in DAE mode.

Once a model is compiled in DAE mode the simulation can be only performed with SUNDIALS/IDA integrator
and with enabled -daeMode simulation flag. Both are enabled automatically by default, when a simulation run is
started.

4.2.1 References
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CHAPTER
FIVE

DEBUGGING

There are two main ways to debug Modelica code, the transformations browser, which shows the transformations
OpenModelica performs on the equations. There is also a debugger for debugging of algorithm sections and
functions.

5.1 The Equation-based Debugger

This section gives a short description how to get started using the equation-based debugger in OMEdit.

5.1.1 Enable Tracing Symbolic Transformations

This enables tracing symbolic transformations of equations. It is optional but strongly recommended in order to
fully use the debugger. The compilation time overhead from having this tracing on is less than 1%, however, in
addition to that, some time is needed for the system to write the xml file containing the transformation tracing
information.

Enable -d=infoXmlOperations in Tools->Options->Simulation (see section Simulation) OR alternatively click on
the checkbox Generate operations in the info xml in Tools->Options->Debugger (see section Debugger) which
performs the same thing.

This adds all the transformations performed by OpenModelica on the equations and variables stored in the
model_info.xml file. This is necessary for the debugger to be able to show the whole path from the source
equation(s) to the position of the bug.

5.1.2 Load a Model to Debug

Load an interesting model. We will use the package Debugging.mo since it contains suitable, broken models to
demonstrate common errors.

5.1.3 Simulate and Start the Debugger

Select and simulate the model as usual. For example, if using the Debugging package, select the model Debug-
ging.Chattering.ChatteringEvents1. If there is an error, you will get a clickable link that starts the debugger. If the
user interface is unresponsive or the running simulation uses too much processing power, click cancel simulation
first.

5.1.4 Use the Transformation Debugger for Browsing

Use the transformation debugger. It opens on the equation where the error was found. You can browse through
the dependencies (variables that are defined by the equation, or the equation is dependent on), and similar for
variables. The equations and variables form a bipartite graph that you can walk.
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Running Simulation of Debugging.C hattering.C hatteringEvents1.
Please wait for a while.

IRNRNRNNNNNNNNRNRNEE

Cancel Simulation

™ OMEdit - Debugging.Chattering.ChatteringEvents1 Simulation Output - 0O &

Output Compilation ]

Jtop/OpenModel ica /OMEd] ¢ /Debugging . Chattering . ChatteringEventsl -

port=50212 -logFormat=xml -w -1wv=LOG_ STATS
stdout | info | Chattering detected arcund time

0.500000005..0.500000995001 (100 state events in a row with a total time
delta less than the step size 0.002). This can be a performance
bottleneck. Use -1v LOG EVENTS for more information. The zZero-crossing

was: 2 > 0.0 D;e%g more

Figure 5.1: Simulating the model.
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If the -d=infoXmlOperations was used or you clicked the “generate operations” button, the operations performed
on the equations and variables can be viewed. In the example package, there are not a lot of operations because
the models are small.

Try some larger models, e.g. in the MultiBody library or some other library, to see more operations with several
transformation steps between different versions of the relevant equation(s). If you do not trigger any errors in a
model, you can still open the debugger, using File->Open Transformations File (model_info.json).

OMEdit - Transformational Debugger

& | /tmp/OpenModelica_marsj/OMEdit/Debugging.Chattering.ChatteringEvents1_infoxml

Variables | [source Browser |
Variables Browser |[Defined In Equations | [used In Equations | fhome/marsj/trunk/testsuite/openmodelica,
Find variables |linc Type  Equation Inc* Type  Equation within ;
_] Case sensitive Regular Expression 2| |2 initial (assignmen...0 else 1.0 3 initial  (assignment)y=2.0*z package Debugging “Test
A A cases for debugging of
Expand All Collapse All 5 regular (assignmen...0else1.0 | 6 regular (assignment)y=2.0%z declarative models”
Variables ¥ Comment Line Location package Chattering “Models
X 7 /hom...q. with chattering behaviour®
v 8 /hom...g. model Che_)tteringEventsl
B "Exhibits chattering
z T after t = 0.5, with

[variable Operations | generated events”
Real x(start=1,
fixed=true);
Real y:
Real z;
equation
11 z = if x > @ then -1
else 1;
y = 2*%z;
der(x) =y;
v annotation
Equations. | (Documentation(info="<html>
<p=After t = 0.5, chattering
takes place, due to the
Inc * Type Equation Variable ¥ | Variable - discontinuity in the right
initial  (assignment) x = 1.0 z Lx hand side of the first
initial  (assignment....0 else 1.0 i:tg;;::e:iﬁ; can be
initial  (assignment)y=2.0%z detected because lots of
initial  (assignment) der(x) =y tightly spaced events are

regular (assignment....0 else 1.0 generated. The feedback to

Operations

Equations Browser |[Defines |[Depends |

. the user should allow to
regular (assignment) y=2.0*z identify the equation from
regular (assignment) der(x) =y = = which the zero crossing
[Equation Operat
EEn il e R function that generates the
Operations events originates.</p>

tsolved: z=if x> 0.0 then-1.0 else 1.0 </html="),

1
2
3
4
5
6
7

experiment(StopTime=1});
original: z = if x > 0 then -1 else 1; => flattened: z = if x > 0.0 then -1.0 else 1.0; end ChatteringEventsl;

model ChatteringEvents2
"Exhibits chattering
after t = 0.422, with

nenerated events” -

Figure 5.2: Transfomations Browser.

5.2 The Algorithmic Debugger

This section gives a short description how to get started using the algorithmic debugger in OMEdit. See section
Simulation for further details of debugger options/settings. The Algorithmic Debugger window can be launched
from Tools->Windows->Algorithmic Debugger.

5.2.1 Adding Breakpoints

There are two ways to add the breakpoints,

¢ Click directly on the line number in Text View, a red circle is created indicating a breakpoint as shown
in Figure 5.3.

* Open the Algorithmic Debugger window and add a breakpoint using the right click menu of Break-
points Browser window.
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Figure 5.3: Adding breakpoint in Text View.
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5.2.2 Start the Algorithmic Debugger

You should add breakpoints before starting the debugger because sometimes the simulation finishes quickly and
you won’t get any chance to add the breakpoints.

There are four ways to start the debugger,
¢ Open the Simulation Setup and click on Launch Algorithmic Debugger before pressing Simulate.
 Right click the model in Libraries Browser and select Simulate with Algorithmic Debugger.
* Open the Algorithmic Debugger window and from menu select Debug-> Debug Configurations.

* Open the Algorithmic Debugger window and from menu select Debug-> Attach to Running Process.

5.2.3 Debug Configurations
If you already have a simulation executable with debugging symbols outside of OMEdit then you can use the
Debug->Debug Configurations option to load it.

The debugger also supports MetaModelica data structures so one can debug omc executable. Select omc exe-
cutable as program and write the name of the mos script file in Arguments.

r" OMEdit - Debug Configurations L-A-J"
r R
& New_configurationl Name: |New_configuration |
Program: I || Browse. ..
Working Directory: | || Browse...
GDE Path: | €: joMDev ftools/mingw/bin/gdb.exe || Browse. ..
Arguments:
] (—
save | [save &Debua| | cancel |
L

Figure 5.4: Debug Configurations.
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5.2.4 Attach to Running Process

If you already have a running simulation executable with debugging symbols outside of OMEdit then you can
use the Debug->Attach to Running Process option to attach the debugger with it. Figure 5.5 shows the Attach
to Running Process dialog. The dialog shows the list of processes running on the machine. The user selects the
program that he/she wish to debug. OMEdit debugger attaches to the process.

| @& OMEdit - Attach to Running Process @1
Attach to Process ID: |
| Filter Processes |

Process ID MName : "‘
9760 AAM Updates Motifier.exe |—|
2164 AESTSA exe
2288 AppleMobileDeviceService.exe
38096 ETStackServerexe
1612 ETTray.exe
7606 BluetoothHeadsetProxy.exe
7972 CCC.exe
7580 C55.55erviceManager.exe
6628 CamRecorder.exe
4960 ComExec.exe
588 CmPRcService.exe
628 ConversicnService.exe
1244 eorceidor o
0K, Refresh ] [ Cancel

Figure 5.5: Attach to Running Process.

5.2.5 Using the Algorithmic Debugger Window

Figure 5.6 shows the Algorithmic Debugger window. The window contains the following browsers,

* Stack Frames Browser — shows the list of frames. It contains the program context buttons like resume,
interrupt, exit, step over, step in, step return. It also contains a threads drop down which allows
switching between different threads.

* BreakPoints Browser — shows the list of breakpoints. Allows adding/editing/removing breakpoints.

* Locals Browser — Shows the list of local variables with values. Select the variable and the value will be
shown in the bottom right window. This is just for convenience because some variables might have
long values.

* Debugger CLI — shows the commands sent to gdb and their responses. This is for advanced users who
want to have more control of the debugger. It allows sending commands to gdb.
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* Output Browser — shows the output of the debugged executable.

K B ™
@ OMEdit - Algorithmic Debugger [E=EE

Debug  View

Stack Frames Browser & ¥ BreakPoints Browser & X Locals Browser g x
o

N BIER=F= ‘Threads:‘stopp___eadl Line  File MNarme Type Value

Function Line | File «||® 5 C/Users..ByTwo.mo |:in\|'alue Real 1

=P getValueMultipliedByTwo 5 C/users/...dbytwo.mo outvalue Real 511434...23e-495

m

Simulation..Function.l 5 C:fusers/...nModel.mo
Simulation...[Equations 90 C:fusers/a...el_D6inz.c
symbolic_initialization

initialization

initializeModel

C:/Users/adeas31/Desktop/getvalusMultipliedByTwo.mo
1 function getValueMultipliedByTwo

2 input Real inValue;

3 output Eeal outValue;

4 algorithm

= cutValue := inValue * 2;

5 end getValueMultipliedByTIwo:

Debugger CLI & X Qutput Browser X |1
30-data-evaluate- -~ -~
expression (gdb)
"_outValue" l:l l:l
| Send

Figure 5.6: Algorithmic Debugger.
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CHAPTER
SIX

GENERATING GRAPH REPRESENTATIONS FOR MODELS

The system of equations after symbolic transformation is represented by a graph. OpenModelica can generate
graph representations which can be displayed in the graph tool yed (http://www.yworks.com/products/yed). The
graph generation is activated with the debug flag

+d=graphml

Two different graphml- files are generated in the working directory. TaskGraph_model.graphml, showing the
strongly-connected components of the model and BipartiteGraph_CompleteDAE_model.graphml showing all
variables and equations. When loading the graphs with yEd, all nodes are in one place. Please use the various
layout algorithms to get a better overview.

¥ TaskGraph_Modelica.Electrical.Spice3.Examples.Coupledinductors.graphml - yEd - m] X
File Edit View Layout Tools Grouping Windows Help -y
DOHS +BRE NN QA2 QAR HEeFE~ 83

¥ siartitctrap...tors.raphml = % | )} TaskGraph_Mod..tors.graphml *  x 4 E &
| %&j .. |

- zme
el

[m%]] Meighborhood | (51 Folder Contents | 85 Predecessors | 821 Successars

EE = General
Search Bescription} Number of Nodes 18
=[] Graph _ &r:er of Edges 14
- # Cli=(i2Zintenal) -R3. FOR CLi path
- # C2i=(d3.internal) - R5.i FOR C2.i

- # LLv =sineVoltage.v -RLvFORLLv
- # L2v =Clvinternal -R2.v FOR L2.v
- # L3.v = C2vinternal -R4.v FOR L3.v
- # RLv =RLR *Llintenal FORR1v
- # R2v =R2.R *L2intenal FORR2.v
i # R3.=Clvinternal /R3.R FORR3.
L # R4y =R4R *L3internal FOR R4V
# RS.=Clvinternal /R5.R FOR RS
L # Tom linear System

Figure 6.1: A task-graph representation of a model in yEd
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¥ BipartiteGraph_CompleteDAE_Medelica Electrical Spice3.Examples.Coupledinductors.graphmi - yEd - O x
[File | Edit  View Layout Tools Grouping Windows Help ] ‘
@ Overvien ] | Y viparttctrap..torsgraphml * x| 1re
I A
m Na'-j'bo’hood = D D O
E]N'hhhdlﬂ]FldChet‘sl‘lé]Pd I=E | — A a
eighborhoo oider Conten redecessors ucressars =
& F{ "Properties View RN
Structure View am - General ~
Search Description ~ Text 2
X 396.0
B} Graph ~ ¥ 556.0
© @ CLi=(L2internal) - R3.i Width 30.0
S ® CLIVARIABLE(nit = "A") "Current flowing from pin p to pin n” type: Rez et 0.0
- # Clvinternal:STATE(1)(unit = V" protected = true ) type: Real Eil iulur ..#mgﬁae
# CLi=(dL3.iinternal) - R5.i Fill Color 2 & #—
# C2Li:VARIABLE(unit = "A™) "Current flowing from pin p to pin n” type: Rez Line Color W #000000
# C2.vinternal:STATE(1)(unit = "V" protected = true ) type: Real i
# L1.ICP.di:VARTABLE(fow=false unit = "Afs") “di/dt" type: Real - hbel""e
# LLICP.v +kLinductiveCouplePin1.v +k2.inductiveCouplePinl.v = 0.0 Visible
< LLICP.v:VARTABLE(flow =true unit = V) type: Real |
# LLL*=L1ICP.di =L1lv +L1ICP.v :::jd(g:ound %::
# LLinternal:STATE(LL LICP. di)(unit = “A") type: Real " color Biooow v

Figure 6.2: A biparite graph representation of a model in yEd
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CHAPTER
SEVEN

FMI AND TLM-BASED SIMULATION AND CO-SIMULATION OF
EXTERNAL MODELS

7.1 Functional Mock-up Interface - FMI

The new standard for model exchange and co-simulation with Functional Mockup Interface (FMI) allows export of
pre-compiled models, i.e., C-code or binary code, from a tool for import in another tool, and vice versa. The FMI
standard is Modelica independent. Import and export works both between different Modelica tools, or between
certain non-Modelica tools. OpenModelica supports FMI 1.0 & 2.0,

* Model Exchange

* Co-Simulation (under development)

7.1.1 FMI Export

To export the FMU use the OpenModelica command translateModelFMU(ModelName) from command line in-
terface, OMShell, OMNotebook or MDT. The export FMU command is also integrated with OMEdit. Select FMI
> Export FMU the FMU package is generated in the current directory of omc. You can use the cd() command to
see the current location. You can set which version of FMI to export through OMEdit settings, see section FM]I.

To export the bouncing ball example to an FMU, use the following commands:

>>> loadFile (getInstallationDirectoryPath() + "/share/doc/omc/testmodels/
—BouncingBall.mo")

true

>>> translateModelFMU (BouncingBall)

"«DOCHOME» /BouncingBall. fmu"

>>> sgystem("unzip -1 BouncingBall.fmu | egrep -v 'sources|files' | tail -n+3 |
—grep —-o '[A-Za-z._0-9/1x$' > BB.log")

0

After the command execution is complete you will see that a file BouncingBall.fmu has been created. Its contents
varies depending on the current platform. On the machine generating this documentation, the contents in Listing
7.1 are generated (along with the C source code).

Listing 7.1: BouncingBall FMU contents

binaries/

binaries/linux64/
binaries/linux64/BouncingBall_FMU.libs
binaries/linux64/BouncingBall.so
modelDescription.xml

A log file for FMU creation is also generated named ModelName_FMU.log. If there are some errors while creating
FMU they will be shown in the command line window and logged in this log file as well.

By default an FMU that can be used for both Model Exchange and Co-Simulation is generated. We only support
FMI 2.0 for Co-Simulation FMUs.
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Currently the Co-Simulation FMU supports only the forward Euler solver with root finding which does an
Euler step of communicationStepSize in fmi2DoStep. Events are checked for before and after the call to
fmi2GetDerivatives.

7.1.2 FMI Import

To import the FMU package use the OpenModelica command importFMU,

>>> list (OpenModelica.Scripting.importFMU, interfaceOnly=true)
function importFMU

input String filename "the fmu file name";

input String workdir = "<default>" "The output directory for imported FMU files.
—<default> will put the files to current working directory.";

input Integer loglevel = 3 "loglevel _nothing=0;loglevel_fatal=1;loglevel_error=2;
—loglevel_warning=3;loglevel_info=4;loglevel_verbose=5; loglevel_debug=6";

input Boolean fullPath = false "When true the full output path is returned
—otherwise only the file name.";

input Boolean debuglLogging = false "When true the FMU's debug output is printed.
=";

input Boolean generateInputConnectors = true "When true creates the input,
—connector pins.";

input Boolean generateOutputConnectors = true "When true creates the output,
—connector pins.";

output String generatedFileName "Returns the full path of the generated file.";
end importFMU;

The command could be used from command line interface, OMShell, OMNotebook or MDT. The importFMU
command is also integrated with OMEdit. Select FMI > Import FMU the FMU package is extracted in the
directory specified by workdir, since the workdir parameter is optional so if its not specified then the current
directory of omc is used. You can use the cd() command to see the current location.

The implementation supports FMI for Model Exchange 1.0 & 2.0 and FMI for Co-Simulation 1.0 stand-alone.
The support for FMI Co-Simulation is still under development.

The FMI Import is currently a prototype. The prototype has been tested in OpenModelica with several examples.
It has also been tested with example FMUs from FMUSDK and Dymola. A more fullfleged version for FMI
Import will be released in the near future.

When importing the model into OMEdit, roughly the following commands will be executed:

>>> imported_fmu_mo_file:=importFMU ("BouncingBall.fmu")
"BouncingBall_me_FMU.mo"

>>> loadFile (imported_fmu_mo_file)

true

The imported FMU can then be simulated like any normal model:

>>> simulate (BouncingBall_me_FMU, stopTime=3.0)
record SimulationResult

resultFile = "«DOCHOME»/BouncingBall_me_FMU_res.mat",

simulationOptions = "startTime = 0.0, stopTime = 3.0, numberOflIntervals = 500,
—tolerance = 1le-06, method = 'dassl', fileNamePrefix = 'BouncingBall_me_FMU',
—options = '', outputFormat = 'mat', variableFilter = '.x', cflags = '', simflags,
= 1

messages = "LOG_SUCCESS | info | The initialization finished_
—successfully without homotopy method.
LOG_SUCCESS | info | The simulation finished successfully.

n
’

timeFrontend = 0.023884526,

timeBackend = 0.01235280499999991,
timeSimCode = 0.195888039,
timeTemplates = 0.138835103,

(continues on next page)
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(continued from previous page)

timeCompile = 0.736657603,
timeSimulation = 0.043978271,
timeTotal = 1.151718606

end SimulationResult;

Figure 7.1: Height of the bouncing ball, simulated through an FMU.

7.2 Transmission Line Modeling (TLM) Based Co-Simulation

This chapter gives a short description how to get started using the TLM-Based co-simulation accessible via
OMEdit.

The TLM Based co-simulation provides the following general functionalities:
* Import and add External non-Modelica models such as Matlab/SimuLink, Adams, and BEAST models

¢ Import and add External Modelica models e.g. from tools such as Dymola or Wolfram SystemModeler,
etc.

 Specify startup methods and interfaces of the external model
* Build the composite models by connecting the external models
* Set the co-simulation parameters in the composite model

* Simulate the composite models using TLM based co-simulation

7.3 Composite Model Editing of External Models

The graphical composite model editor is an extension and specialization of the OpenModelica connection editor
OMEdit. A composite model is composed of several external sub-models including the interconnections between
these sub-models. External models are models which need not be in Modelica, they can be FMUs, or models
accessed by proxies for co-simulation and connected by TLM-connections. The standard way to store a composite
model is in an XML format. The XML schema standard is accessible from timModelDescription.xsd. Currently
composite models can only be used for TLM based co-simulation of external models.
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7.3.1 Loading a Composite Model for Co-Simulation
To load the composite model, select File > Open Composite Model(s) from the menu and select composite-
model.xml.

OME(dit loads the composite model and show it in the Libraries Browser. Double-clicking the composite model
in the Libraries Browser will display the composite model as shown below in Figure 7.2.

ot OMEdit - OpenMadelica Cennection Editor - [doublePendulum)] - O >
a‘i File Edit View Simulation FM| Export Debug Git Tools Help - 8 X
= 'l ~ . K . -
TGI;H?H ﬁ o\e\e\ \Ono > »: e« »l: @ i pn >
Libraries Browser = |°ﬁ E |Wri13ble ‘Diagram View ‘C:fSICFfI'LMPIu...ePendqurn.m| ‘ 3D Viewer Browser g x
|Filter Claszes | \ 4

~

..........

Libraries

doublePendulum
L)

bl Fancul

£ >

t Welcome o!i Modeling g Plotting o Debugging

Figure 7.2: Composite Model with 3D View.

7.3.2 Co-Simulating the Composite Model
There are two ways to start co-simulation:

¢ Click TLM Co-Simulation setup button (@}) from the toolbar (requires a composite model to be active
in ModelWidget)

* Right click the composite model in the Libraries Browser and choose TLM Co-Simulation setup from
the popup menu (see Figure 7.3)

The TLM Co-Simulation setup appears as shown below in Figure 7.4.

Click Simulate from the Co-simulation setup to confirm the co-simulation. Figure 7.5 will appears in which you
will be able to see the progress information of the running co-simulation.

The editor also provides the means of reading the log files generated by the simulation manager and monitor.
When the simulation ends, click Open Manager Log File or Open Monitor Log File from the co-simulation
progress bar to check the log files.
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ot OMEdit - OpenModelica Cennection Editor - [deublePendulum)] — O *
gﬁ Eile Edit View Simulation FM|  Export Debug Git Tools Help - &8 X
[ L N 3 Bl

-+
Ea d=1- Heoe \OHO K- % 995
Libraries Browser = ||EE |‘.I'.|'riizble ‘Diagram View ‘C:!SIG:,IH_MPIU...EPendqum.m| h‘ 3D Viewer Browser g X
|Filter Classes | L4 s @Isnmetric - .?—'j\ fi'-::\
Libraries
</> doublePen
{4- Fetch Interface Data
< TLM Co-Simulation Setup
# Unload Del
|
Eukl e r
W
£ >
Opens the TLM co-simulation setup t Welcome uﬁ Modeling ﬂ Plotting ‘» Debugging

Figure 7.3: Co-simulating and Fetching Interface Data of a composite model from the Popup Menu .
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ot OMEdit - TLM Co-Simulation Setup - doublePendulum ? et

TLM Co-Simulation Setup - doublePendul

TLM Plugin Path: |C:/SKF/TLMPlugin,/bin Browse...
TLM Manager
Manager Process: |C:fSKF/TLMPlugin/binftmmanager. exe Browse...
Server Port: 11111
Monitor Port: 12111

[ ] Debug Mode

TLM Monitor

Monitor Process: | C:/SKF/TLMPlugin/bin/tmmonitor.exe Browse...

Mumber Of Steps: |

Time Step Size:

[ ] Debug Mode

Show TLM Co-Simulation Output Window

Simulate Cancel

Figure 7.4: TLM Co-simulation Setup.
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o't OMEdit - doublePendulum TLM Co-Simulation — O >

Running co-simulation using the doublePendulum composite model. Please wait for a while.

I TN

Manager Output Stop Manager | Open Manager Log File

tlm.config ~
timeEnd = 3

MaxTimeStep "<"= 0.0001000000

Writing caselIl doublePendulumZ and server name 130.Z3&.15%0.168:11111 to £file
tlm.config

Writing doublePendulumZ .mos

Writing doublePenduluml .mos

Starting COpenModelica

C: /OpenModelicabuild/ /bin/omc.exe doublePendulumZ  mos

Starting COpenModelica

C: /OpenModelicasbuild/  /bin/omc.exe doublePenduluml .mos

W

Monitor Output Stop Manitor | | Open Maonitor Log File

C:/8FF/TLMPlugin/bin/tlmmonitor.exe 130.236.15%0.168:12111 C:/5EKF/TILMPlugin/HMetaModels/
CmoCmeDoublePendul umy/doublePendulum. xml

Figure 7.5: TLM Co-Simulation Progress.
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7.3.3 Plotting the Simulation Results

When the co-simulation of the composite model is completed successful, simulation results are collected and
visualized in the OMEdit plotting perspective as shown in Figure 7.6 and Figure 7.7. The Variables Browser
display variables that can be plotted. Each variable has a checkbox, checking it will plot the variable.

ot OMEdit - OpenModelica Connection Editor - [Plat: 1] — O =
E File Edit View Simulation FM|  Export Debug Git Tools Help - 8 X
ETRLge csv &
JeBHB 95 Xeoea S ¥

Libraries Browser g X Auto Scale | FitinView  Sawve | Print | Grid | Detailed Grid = Mo Grid »| Variables Browser g x
|Filter Classes | & |Filter Variables
doublePendulum 1. tm.A(1, 1) [] doublePendulum1.tm. A(1,2) [

Libraries Simulation Time Unit | s -

doublePendulum 17 Variables Ve ™
] -

i = doublePendulum?

] = tlm

0.5 Maa

| M an.2) -1

| S|

1 Cdaei-]

1 Oaea -

0 Oaea -

1 HEERIR

Oaza -

OaEa -

[C1F_tie[...1) [M]

[C1F_tie[..2) [M]

[C1F_tie[...3) [M]

[CIM_tie... [Nm]

[CIM_tie... [Nm]
[IM_tie... [Nm]

L L L LA

0 0.5 1 1.5 2 2.5 3 [ 0meg...d/s]

time [s] n [M10mea..d/sl N W

|
-
_l

t Welcome di Modeling Plotting - Debugging

Figure 7.6: TLM Co-Simulation Results Plotting.

7.3.4 Preparing External Models

First step in co-simulation Modeling is to prepare the different external simulation models with TLM inter-
faces. Each external model belongs to a specific simulation tool, such as MATLAB/Simulink*, BEAST,
MSC/ADAMS, Dymola and Wolfram SystemModeler.

When the external models have all been prepared, the next step is to load external models in OMEdit by selecting
the File > Load External Model(s) from the menu.

OMEdit loads the external model and show it in the Libraries Browser as shown below in Figure 7.8.

7.3.5 Creating a New Composite Model

We will use the "Double pendulum" composite model which is a multibody system that consists of three sub-
models: Two OpenModelica Shaft sub-models (Shaftl and Shaft2) and one SKF/BEAST bearing sub-model
that together build a double pendulum. The SKF/BEAST bearing sub-model is a simplified model with only
three balls to speed up the simulation. Shaft1 is connected with a spherical joint to the world coordinate system.
The end of Shaftl is connected via a TLM interface to the outer ring of the BEAST bearing model. The inner ring
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ot OMEdit - OpenModelica Connection Editor - [deublePendulum.csv] — O *

Eile Edit  View Simulation FMI Export Debug Git Tools Help - &8 X
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CIF_tiel..2) [M]
CJF_tiel...2) [M]
I M_tie... [Mm]
I M _tie... [Nm]
I M _tie... [Nm]
[10Ormeg...d/s]
[10meq..dfs] ¥

£ >

t Welcome &i Modeling ﬂ Flotting ‘» Debugging

Figure 7.7: TLM Co-Simulation Visualization.
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-
gﬁ OMEdit - CpenModelica Connection Editor

File Edit View Simulation FMI Export Tools Help

lThHlﬂ 0‘\6‘\9\

Libraries Browser B X
Search Classes o
Libraries

k> OpenModelica

P
[» ﬂ ModelicaReference

[ ModelicaServices

k> i Complex

= A5 Modelica

chaftl
chaft?

TXT dgbb

Figure 7.8: External Models in OMEdit.
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of the bearing model is connected via another TLM interface to Shaft2. Together they build the double pendulum
with two shafts, one spherical OpenModelica joint, and one BEAST bearing.

To create a new composite model select File > New Composite Model from the menu.

Your new composite model will appear in the in the Libraries Browser once created. To facilitate the process of
textual composite modeling and to provide users with a starting point, the Text View (see Figure 7.9) includes the
composite model XML elements and the default simulation parameters.

ot OMEdit - OpenModelica Connection Editor - [CompositeModel1%] - O >
E File Edit View Simulation FM| Export Debug Tools Help - 8 X
reBB H0ee \0 -E @X1-
Libraries Browser = ‘gﬂ E ‘Wrimble |Text\ﬂew ‘ |Line: 1, Col: 0 ‘ |
|FilterCIasses | $ N -
1 <?xml version='l.0' encoding='UTF-8"'?>
Libraries <!=— The root node i= the composite-model -->
-y <Model Name="CompositeModell™:>
CompositeMadell <!-- List of connected sub-models -->
<SubModels/>
<!-— List of TLM connections -->
<Connections/>
<!-— Parameters for the simmlation -->
<SimulationParams StartTime="0" StopTime="1"/>
</Model>

¥:-101.11  ¥: 105.69 t Welcome o!i Modeling g Plotting o Debugging

Figure 7.9: New composite model text view.

7.3.6 Adding Submodels

It is possible to build the double pendulum by drag-and-drop of each simulation model component (sub-model)
from the Libraries Browser to the Diagram View. To place a component in the Diagram View of the double
pendulum model, drag each external sub-model of the double pendulum (i.e. Shaftl, Shaft2, and BEAST bearing
sub-model) from the Libraries Browser to the Diagram View.

7.3.7 Fetching Submodels Interface Data

To retrieve list of TLM interface data for sub-models, do any of the following methods:

¢ Click Fetch Interface Data button (<") from the toolbar (requires a composite model to be active in
ModelWidget)

 Right click the composite model in the Library Browser and choose Fetch Interface Data from the popup
menu (see Figure 7.3).

7.3. Composite Model Editing of External Models 83



OpenModelica User’s Guide, Release v1.13.0

.
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Figure 7.10: Adding sub-models to the double pendulum composite model.
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To retrieve list of TLM interface data for a specific sub-model,

¢ Right click the sub-model inside the composite model and choose Fetch Interface Data from the popup
menu.

Figure 7.11 will appear in which you will be able to see the progress information of fetching the interface data.

oA OMEdit - Fetch Interface Data - MetaModel1 P |t

Fetching interface data for MetaModell. ..

| - . Cancel Fetch Again

Output

C:%wTIMPluginiMetaModels\ test shaftll>goto DONE

C:WTIMPluginiMetaModels\ testshaftZl>goto DONE

C:3ZTIMPluginiyMetaModels\ testyshaftZl>»echo Done StartTLMOpenModelica
Done StartTLMOpenModelica

C:3WTIMPluginiMetaModels\ testhshaftll>echo Done StartTLMOpenModelica
Done StartTLMOpenModelica

1

Figure 7.11: Fetching Interface Data Progress.

Once the TLM interface data of the sub-models are retrieved, the interface points will appear in the diagram view
as shown below in Figure 7.12.

7.3.8 Connecting Submodels

When the sub-models and interface points have all been placed in the Diagram View, similar to Figure 7.12, the

next step is to connect the sub-models. Sub-models are connected using the Connection Line Button (<) from
the toolbar.

To connect two sub-models, select the Connection Line Button and place the mouse cursor over an interface and
click the left mouse button, then drag the cursor to the other sub-model interface, and click the left mouse button
again. A connection dialog box as shown below in Figure 7.13 will appear in which you will be able to specify
the connection attributes.

Continue to connect all sub-models until the composite model Diagram View looks like the one in Figure 7.14
below.

7.3.9 Changing Parameter Values of Submodels

To change a parameter value of a sub-model, do any of the following methods:
¢ Double-click on the sub-model you want to change its parameter
* Right click on the sub-model and choose Attributes from the popup menu

The parameter dialog of that sub-model appears as shown below in Figure 7.15 in which you will be able to specify
the sub-models attributes.
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Figure 7.12: Fetching Interface Data.
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Figure 7.13: Sub-models Connection Dialog.
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Figure 7.14: Connecting sub-models of the Double Pendulum Composite Model.
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Figure 7.15: Changing Parameter Values of Sub-models Dialog.

7.3.10 Changing Parameter Values of Connections

To change a parameter value of a connection, do any of the following methods:
* Double-click on the connection you want to change its parameter
 Right click on the connection and choose Attributes from the popup menu.

The parameter dialog of that connection appears (see Figure 7.13) in which you will be able to specify the con-
nections attributes.

7.3.11 Changing Co-Simulation Parameters
To change the co-simulation parameters, do any of the following methods:

b
e Click Simulation Parameters button (to t) from the toolbar (requires a composite model to be active in
ModelWidget)

* Right click an empty location in the Diagram View of the composite model and choose Simulation Param-
eters from the popup menu (see Figure 7.16)

The co-simulation parameter dialog of the composite model appears as shown below in Figure 7.17 in which you
will be able to specify the simulation parameters.
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b
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Figure 7.16: Changing Co-Simulation Parameters from the Popup Menu.

-
o't OMEdit - Simulation Parameters - pendulum u

Simulation Parameters - pendulum

Start Time: | 0.0 |

It StopTime: |1.0

I [ Save ] | Cancel

Figure 7.17: Changing Co-Simulation Parameters Dialog.
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CHAPTER
EIGHT

OMSIMULATOR

OMSimulator has its own documentation.
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CHAPTER
NINE

OPENMODELICA ENCRYPTION

The encryption module allows the library developers to encrypt their libraries for different platforms. Note that
you need a special version of OpenModelica with encryption support. Contact us if you want one.

9.1 Encrypting the Library

In order to encrypt the Modelica package call buildEncryptedPackage(TopLevelPackageName) from mos script or
from OMEJdit right click the package in Libraries Browser and select Export Encrypted Package or select Export
> Export Encrypted Package from the menu.

All the Modelica files are encrypted and the whole library is zipped into a single file i.e., PackageName.mol. Note
that you can only encrypt Modelica packages saved in a folder structure. The complete folder structure remains
as it is. No encryption is done on the resource files.

9.2 Loading an Encrypted Library

To load the encrypted package call loadEncryptedPackage(EncryptedPackage.mol) from the mos script or from
OMEdJdit File > Load Encrypted Package.

9.3 Notes

e There is no license management and obfuscation of the generated code and files. However just a basic
encryption and decryption is supported along with full support for protection access annotation as defined
in Modelica specification 18.9. This means that anyone who has an OpenModelica version with encryption
support can encrypt or decrypt files.

* OpenModelica encryption is based on SEMLA (Safe/Superiour/Super Encryption of Modelica Libraries
and Artifacts) module from Modelon AB.
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CHAPTER
TEN

OMNOTEBOOK WITH DRMODELICA AND DRCONTROL

This chapter covers the OpenModelica electronic notebook subsystem, called OMNotebook, together with the
DrModelica tutoring system for teaching Modelica, and DrControl for teaching control together with Modelica.
Both are using such notebooks.

10.1 Interactive Notebooks with Literate Programming

Interactive Electronic Notebooks are active documents that may contain technical computations and text, as well as
graphics. Hence, these documents are suitable to be used for teaching and experimentation, simulation scripting,
model documentation and storage, etc.

10.1.1 Mathematica Notebooks

Literate Programming [Knu84] is a form of programming where programs are integrated with documentation in
the same document. Mathematica notebooks [Wol96] is one of the first WYSIWYG (What-You-See-Is-What-
You-Get) systems that support Literate Programming. Such notebooks are used, e.g., in the MathModelica mod-
eling and simulation environment, see e.g. Figure 10.1 below and Chapter 19 in [Fri04].

10.1.2 OMNotebook

The OMNotebook software [Axe05][Fernstrom06] is a new open source free software that gives an interactive
WYSIWYG realization of Literate Programming, a form of programming where programs are integrated with
documentation in the same document.

The OMNotebook facility is actually an interactive WY SIW YG realization of Literate Programming, a form of
programming where programs are integrated with documentation in the same document. OMNotebook is a simple
open-source software tool for an electronic notebook supporting Modelica.

A more advanced electronic notebook tool, also supporting mathematical typesetting and many other facilities, is
provided by Mathematica notebooks in the MathModelica environment, see Figure 10.1.

Traditional documents, e.g. books and reports, essentially always have a hierarchical structure. They are divided
into sections, subsections, paragraphs, etc. Both the document itself and its sections usually have headings as
labels for easier navigation. This kind of structure is also reflected in electronic notebooks. Every notebook
corresponds to one document (one file) and contains a tree structure of cells. A cell can have different kinds of
contents, and can even contain other cells. The notebook hierarchy of cells thus reflects the hierarchy of sections
and subsections in a traditional document such as a book.

10.2 DrModelica Tutoring System — an Application of OMNotebook

Understanding programs is hard, especially code written by someone else. For educational purposes it is essential
to be able to show the source code and to give an explanation of it at the same time.
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Modeling|
Simulati
Process

Figure 10.1: Examples of Mathematica notebooks in the MathModelica modeling and simulation environment.

Moreover, it is important to show the result of the source code’s execution. In modeling and simulation it is
also important to have the source code, the documentation about the source code, the execution results of the
simulation model, and the documentation of the simulation results in the same document. The reason is that the
problem solving process in computational simulation is an iterative process that often requires a modification of
the original mathematical model and its software implementation after the interpretation and validation of the
computed results corresponding to an initial model.

Most of the environments associated with equation-based modeling languages focus more on providing efficient
numerical algorithms rather than giving attention to the aspects that should facilitate the learning and teaching of
the language. There is a need for an environment facilitating the learning and understanding of Modelica. These
are the reasons for developing the DrModelica teaching material for Modelica and for teaching modeling and
simulation.

An earlier version of DrModelica was developed using the MathModelica (now Wolfram SystemModeler) envi-
ronment. The rest of this chapter is concerned with the OMNotebook version of DrModelica and on the OMNote-
book tool itself.

DrModelica has a hierarchical structure represented as notebooks. The front-page notebook is similar to a table
of contents that holds all other notebooks together by providing links to them. This particular notebook is the first
page the user will see (Figure 10.2).

In each chapter of DrModelica the user is presented a short summary of the corresponding chapter of the Modelica
book [Fri04]. The summary introduces some keywords, being hyperlinks that will lead the user to other notebooks
describing the keywords in detail.

Now, let us consider that the link “HelloWorld” in DrModelica Section is clicked by the user. The new HelloWorld
notebook (see Figure 10.3), to which the user is being linked, is not only a textual description but also contains one
or more examples explaining the specific keyword. In this class, HelloWorld, a differential equation is specified.

No information in a notebook is fixed, which implies that the user can add, change, or remove anything in a
notebook. Alternatively, the user can create an entirely new notebook in order to write his/her own programs or
copy examples from other notebooks. This new notebook can be linked from existing notebooks.

When a class has been successfully evaluated the user can simulate and plot the result, as previously depicted in
Figure 10.3 for the simple HelloWorld example model.

After reading a chapter in DrModelica the user can immediately practice the newly acquired information by
doing the exercises that concern the specific chapter. Exercises have been written in order to elucidate language
constructs step by step based on the pedagogical assumption that a student learns better “using the strategy of
learning by doing”. The exercises consist of either theoretical questions or practical programming assignments.
All exercises provide answers in order to give the user immediate feedback.

Figure 10.4 shows part of Chapter 9 of the DrModelica teaching material. Here the user can read about language
constructs, like algorithm sections, when-statements, and reinit equations, and then practice these constructs by
solving the exercises corresponding to the recently studied section.

Exercise 1 from Chapter 9 is shown in Figure 10.5. In this exercise the user has the opportunity to practice different
language constructs and then compare the solution to the answer for the exercise. Notice that the answer is not
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E OMNotebook: DrModelica.onb™

File Edit Cel Format Insert  ‘Window  Help

Version 2006-04-11 |

DriModelic gmodetica Edition

Copyright: (o) Linképimng Universty, PELAR, 20032-2006, "Wiley-IEEE Press, Modelca &ssociation.
Contact: Openblodelica@ida lu.se; Opentdodelica Project web site:
www 1da i sefprojects/Opentdodelica

Book web page: www mathcore com/driodelica; Book author: Peter Fritzson(@ida . se

Dillodelica Authors: (2003 wersion) Susanna Monemat, Eva-Lena Lengouist Sandeling Peter Fritzzon, Peter Bunus
Dillodelica Authors: (2005 and later updates): Peter Fritzson

This DrMedelica notebook has been developed to facilitate learning the Maodelica language as well as
praviding an intraduction to abjeci-ariented madsling and sivudation. It iz based on and is
supplemantary material to the Modelica book: Feter Fritzeon: "Frinciples of Object-Orientad
Modeling and Simulation with Modelica® {2004), 940 pages, Wiley-IEEE Fress, ISEN 0-471-471631.
Al af the examples and exercises in DrModelica and the page refersnces are from that book. Most aof
the text in DrModelica is alsa based on that boalk.

Detailed Copiright and Acknowledgment Information
Getting Started Using OMNotebook
OpenModelica commands

Berkeley license OpenModelica

1 A Quick Tour of Modelica
1.1 Getting Started - First Basic Examples

There 15 a long tradiion that the first sample program m any computer language 15 a trivial program
printing the string "Hello World" (p. 19 in Peter Fritzson's boolt), Since Modelica 15 an equation based
language, printing a string does not make much sence. Instead, our Helle World Modelica program solves
a trovial diferential equation. The second example shows how you can write a model that sclves a

LDifferential Algebraic Equation System (p. 19). In the Van der Peol (p. 22) example declaration as well as

wutiahzation and prefix usage are shown i a shghtly more comphcated way.
1.2 Classes and Instances

In Modelica objects are created implicitly just by Declaring Tnstances of Classes (p. 26). Almost anything
mn Modelica 1z a class, but there are some keywords for specific use of the class concept, called i

Ready

Figure 10.2: The front-page notebook of the OMNotebook version of the DrModelica tutoring system.
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First Basic Class

1 HelloWorld

The program contains a declaration of a class called He11oWor1d with two fields and one equation. The first field
is the variable x which is initialized to a start value 2 at the time when the simulation starts. The second field is the
variable a, which is a constant that is initialized to 2 at the beginning of the simulation. Such a constant is prefixed by
the keyword parameter in order to indicate that it is constant during simulation but is a model parameter that can be
changed between simulations.

The Modelica program solves a trivial differential equation: ="' = — a * x=. The variable x is a state variable
that can change value over time. The x ' is the time derivative of x.

alasz=z HelloWorld
Eeal x(start = 1, fixed=true);
parameter Real a = 1;
equation
der(x) = - a * x;
end HelloWorld;

{Hellowaorld}

2 Simulation of HelloWorld

szimulate( HelloWorld, =startTime=0, stopTime=3 )

record SimulationResult
resultFile = "HelloWorld_res.mat”,
messages ="

end SimulationResult;

Plot the results.

plot({ x )
[done]

Pan  AutoScale  FitinView  Save  Print | Grid | Detailed Grid | Mo Grid [ JLog¥ []log¥ Setup

Plot by OpenModelica
1
0.8
0.6
0.4
0.2 \
] [
0 1 —_——_—_—-—_——————_
0 0.5 1 1.5 2 2.5 3 3.5 4
time
Ready

Figure 10.3: The HelloWorld class simulated and plotted using the OMNotebook version of DrModelica.
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U] oMMotebook: drmodelica.onb -0l x|
File Edit el Format  Insert  window  Help
Algorithms and Functions =
Algorithins
In Modelica, algorithmic statements can only occur within Algoritlun Sections (p. 285),
starting with the keyword algorithm. Smple Assicnment Statements (p. 287) is the
most common kind of statements in algorithm sections. There iz a gpecial form of
assignment statement that is only used when the right hand side contamns a call to a
Function with Multiple Results (p. 287).
The for-Statement (also called for-loop) i a convenient way of expressing iteration (p.
288). When uzing the for-loop for iteration we must be able to express the range of
values over which the iteration variable should iterate in a closed form as an iteration
expression. For cases where this iz not feasible there is alzo a While-loop iteration
construct in Modelica (p. 290). For conditional expressions the if-Statement (p. 292) i
used. When-Statements (p. 293) are used to express actions at event (nstanis and are
clozely related to when-equations. The Eemit (p. 296) statement can be uzed in
when-statements fo define new values for contimous-time state variabies of a model at
an event.
The Agzert (p. 298) statement provides a convenient means for epecifying checks on
model validity within a model.
The most common uzage of Ternunate (p. 298) is to give more appropriate stopping
criteria for terminating a simulation than a fixed point in time.
Exercises
Exercise 1
Exercise 2
Exercise 3
Exercise 4
Exercise S
Functions
The body of a Modelica function is a kind of algonithm section that containg procedural
algoritlunic code to be executed when the function iz Called (p. 300). Since a function is
a resfricted and enhanced kincd of clags. it iz nosgible to inherit an exigting fimction El
Ready 5

Figure 10.4: DrModelica Chapter on Algorithms and Functions in the main page of the OMNotebook version of
DrModelica.
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U] OMMotebook: Exercisel.nb =]

File Edit  Cell Format  Insert  Window  Help

Exercise 1

Using Algorithm Sections

Wiite a finction, Sum, which calculates the sum of munbers, i an array of arbitrary size.

Write a finction, Ave rage, which calculates the average of numbers, in an array of arbitrary size. Average
should use make a function call to Sum.

| ]

Write a class, LargestAverages, that has two arrays and calculates the average of each of them. Then it
cotnpares the averages and sets a vanable to true if the frst array 15 larger than the second and otherwise false.

| ]

Answer ]

Ready 7

Figure 10.5: Exercise 1 in Chapter 9 of DrModelica.
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visible until the Answer section is expanded. The answer is shown in Figure 10.6.

10.3 DrControl Tutorial for Teaching Control Theory

DrControl is an interactive OMNotebook document aimed at teaching control theory. It is included in the Open-
Modelica distribution and appears under the directory:

>>> getInstallationDirectoryPath() + "/share/omnotebook/drcontrol"
"«OPENMODELICAHOME»/share/omnotebook/drcontrol"

The front-page of DrControl resembles a linked table of content that can be used as a navigation center. The
content list contains topics like:

* Getting started

* The control problem in ordinary life
 Feedback loop

* Mathematical modeling

¢ Transfer function

* Stability

» Example of controlling a DC-motor
» Feedforward compensation

* State-space form

* State observation

* Closed loop control system.

* Reconstructed system

* Linear quadratic optimization

* Linearization

Each entry in this list leads to a new notebook page where either the theory is explained with Modelica examples
or an exercise with a solution is provided to illustrate the background theory. Below we show a few sections of
DrControl.

10.3.1 Feedback Loop

One of the basic concepts of control theory is using feedback loops either for neutralizing the disturbances from
the surroundings or a desire for a smoother output.

In Figure 10.7, control of a simple car model is illustrated where the car velocity on a road is controlled, first with
an open loop control, and then compared to a closed loop system with a feedback loop. The car has a mass m,
velocity y, and aerodynamic coefficient o. The 6 is the road slope, which in this case can be regarded as noise.

Lets look at the Modelica model for the open loop controlled car:

my =u— ay —mg * sin(0)

model noFeedback
import SI = Modelica.SIunits;

SI.Velocity vy; // output signal without noise,_,
—~theta = 0 —> v(t) =0
SI.Velocity yNoise; // output signal with noise, L

—theta <> 0 -> v(t) <> 0

(continues on next page)
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¢ OMNotebook: Exercisel.nb*® o ] 1

File Edit el Format Insert  ‘Window Help

| R

Answer

Sum

function Sum
input Real[:] =x=;
output Beal sum;
algorithm
for 1 in l:size(x,l]) loop
sum := sum + x[1];
end for;

end Sum;

Average

function Average

input Real[:] x;

output Beal average;
protected

Feal sum;

algorithm

average := Sumix) / size(x, 1);
end Average;

LargestAverage

class LargestAverage
parameter Integer[:] &1 = {1, 2, 3, 4, 53};
parameter Integer[:] AZ = {7, B, 9};
Real awverageil, averageli;
Boolean AlLargest({start = false);
algorithm
averageil := Average(il);

averagehs Average (AZ) ;

if awverageil > averagedZ then

AlLargest := true;
else

AlTargest := false;
end if;

end Largestiverage;

Simulation of LargestAverage

simulate( Largestaverage ); ]

When we lool at the values m the wanables we see that A2 has the largest average (8 ) and therefore the
vatiable &1L argest 15 false (= 0).

Ready

v L

Figure 10.6: The answer section to Exercise 1 in Chapter 9 of DrModelica.
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Feedback

One important method in designing control system is a feedback loop. It can be used to eliminate the
influence of noise or to decrease the output error.

Regulator

1 Example

Assume that we want to control the speed of a car on the road. The car has a mass m, velocity y, and
aerodynamic coefficient a. The 8 is the road slope, which in this case can be regarded as noise.

my =u— ay —mgsin(d)
It we want a reference speed of 20 m/s for a car with m=1500 kg, «=250 Ns/m, 6=0 rad, how high should

the amplification factor be in the regulator?
Try with u = 250*r.

\.'itJ=mgsini9}l=U

rit)=20m/s

1.1 Open Loop

loadModel (Modelica)
true

model noFeedback
import SI = Modelica.SIunits;

| ¥

SI.Velocity y; // output signal without
noise, theta = 8 -> v(t) = 8
ST Velnritu wNnice- LY nutnut eianal with nnica =]
v
Figure 10.7: Feedback loop.
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(continued from previous page)

parameter SI.Mass m = 1500;

parameter Real alpha = 200;

parameter SI.Angle theta = 5x3.141592/180;
parameter SI.Acceleration g = 9.82;
SI.Force u;

SI.Velocity r=20;

equation
m+der (y)=u-alphax*y; // signal without noise
m+der (yNoise)=u-alphaxryNoise-m+g*sin (theta); // with noise
u = 250xr;

end noFeedback;

By applying a road slope angle different from zero the car velocity is influenced which can be regarded as noise in
this model. The output signal in Figure 10.8 is stable but an overshoot can be observed compared to the reference
signal. Naturally the overshoot is not desired and the student will in the next exercise learn how to get rid of this
undesired behavior of the system.

>>> loadModel (Modelica)

true

>>> simulate (noFeedback, stopTime=100)
record SimulationResult

resultFile = "«DOCHOME»/noFeedback_res.mat",

simulationOptions = "startTime = 0.0, stopTime = 100.0, numberOfIntervals =_
—500, tolerance = 1le-06, method = 'dassl', fileNamePrefix = 'noFeedback', options,
—= "', outputFormat = 'mat', variableFilter = '.x', cflags = '', simflags = ''",

messages = "LOG_SUCCESS | info | The initialization finished
—successfully without homotopy method.
LOG_SUCCESS | info | The simulation finished successfully.

n
’

timeFrontend = 0.255163435,

timeBackend = 0.005532411,
timeSimCode = 0.202607949,
timeTemplates = 0.103647409,

timeCompile = 0.653817745,
timeSimulation = 0.008328008000000001,
timeTotal = 1.229267169

end SimulationResult;

Warning:

Warning: The initial conditions are not fully specified. For more information set -d=initialization.
In OMEdit Tools->Options->Simulation->OMCFlags, in OMNotebook call setCommandLineOptions("-
d=initialization").

The closed car model with a proportional regulator is shown below:

u=Kx(r—y)
model withFeedback
import SI = Modelica.SIunits;
SI.Velocity y; // output signal with feedback,
—1link and without noise, theta = 0 -> v(t) = 0
SI.Velocity yNoise; // output signal with feedback,
—~1link and noise, theta <> 0 -> v(t) <> 0

parameter SI.Mass m = 1500;

parameter Real alpha = 250;

parameter SI.Angle theta = 5%x3.141592/180;
parameter SI.Acceleration g = 9.82;

(continues on next page)
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Figure 10.8: Open loop control example.

(continued from previous page)

SI.Force u;
SI.Force uNoise;
SI.Velocity r=20;
equation
m+der (y)=u-alphax*y;
m+xder (yNoise)=uNoise—-alphaxyNoise-m*xg*sin (theta);
u = 5000*(r-y);
uNoise = 5000+ (r-yNoise);
end withFeedback;

By using the information about the current level of the output signal and re-tune the regulator the output quantity
can be controlled towards the reference signal smoothly and without an overshoot, as shown in Figure 10.9.

In the above simple example the flat modeling approach was adopted since it was the fastest one to quickly obtain
a working model. However, one could use the object oriented approach and encapsulate the car and regulator
models in separate classes with the Modelica connector mechanism in between.

>>> loadModel (Modelica)

true

>>> gimulate (withFeedback, stopTime=10)
record SimulationResult

resultFile = "«DOCHOME»/withFeedback_res.mat",

simulationOptions = "startTime = 0.0, stopTime = 10.0, numberOfIntervals = 500,
— tolerance = 1le-06, method = 'dassl', fileNamePrefix = 'withFeedback', options =
—'"'", outputFormat = 'mat', variableFilter = '.x', cflags = '', simflags = ''",

messages = "LOG_SUCCESS | info | The initialization finished_
—successfully without homotopy method.
LOG_SUCCESS | info | The simulation finished successfully.

n
4

timeFrontend = 0.455249417,

timeBackend = 0.004779561,
timeSimCode = 0.171295313,
timeTemplates = 0.095776416,

timeCompile = 0.6533165320000001,
timeSimulation = 0.008510417000000001,
timeTotal = 1.38906954

end SimulationResult;
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Warning:

Warning: The initial conditions are not fully specified. For more information set -d=initialization.
In OMEdit Tools->Options->Simulation->OMCFlags, in OMNotebook call setCommandLineOptions("-
d=initialization").

yNoisé -

Figure 10.9: Closed loop control example.

10.3.2 Mathematical Modeling with Characteristic Equations

In most systems the relation between the inputs and outputs can be described by a linear differential equation.
Tearing apart the solution of the differential equation into homogenous and particular parts is an important tech-
nique taught to the students in engineering courses, also illustrated in Figure 10.10.

any an—ly oM ou

Y b any =bo et A by o+ by,
R T B T TR

Now let us examine a second order system:

Jt+ay+ay=1

model NegRoots

Real y;

Real der_y;

parameter Real al 3;

parameter Real a2 = 2;
equation

der_y = der(y);

der (der_y) + alxder_y + a2xy = 1;
end NegRoots;

Choosing different values for a; and a, leads to different behavior as shown in Figure 10.11 and Figure 10.12.

In the first example the values of a; and a, are chosen in such way that the characteristic equation has negative
real roots and thereby a stable output response, see Figure 10.11.
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Mathematical Modeling

In most systems the relation between the inputs and outputs can be approximated by a linear differential
equation.

n n—1 d

d m d
Fe V(8 + a1 y(6) + et any(6) = bomu() + .+ bm_lgu(mbmu(t}

where the coefficients a; and b; are constants. The above differential equation has a homogeneous and a
particular solution:

Y=Vt

The homogeneous solution where u is set to zero has the form: }
Vi = Crelat + o+ O elnt

where }

AMta, At ta, A +a,=0

1 Example
Consider the following model. } 1
a2 at |
728 + a1 y(e) +ay(e) =1
Examine the behavior of the system for different values on a, and a, }

1.1 Characteristic Equation with Negative Real Roots, A=-1,-2

model negRoots

Real y;

Real der_y;

parameter Real al = 3;
parameter Real a2 = 2;

equation

der_y = der(y);

der(der_y) + al*der_y + a2*y = 1;
end negRoots;

{negRoots}
simulate(neaRoots.stopTime=101 1 =

Figure 10.10: Mathematical modeling with characteristic equation.
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>>> gsimulate (NegRoots, stopTime=10)
record SimulationResult

resultFile = "«DOCHOME»/NegRoots_res.mat",

simulationOptions = "startTime = 0.0, stopTime = 10.0, numberOfIntervals = 500,
— tolerance = 1le-06, method = 'dassl', fileNamePrefix = 'NegRoots', options = '', |,
—outputFormat = 'mat', variableFilter = '.x', cflags = '', simflags = ''",

messages = "LOG_SUCCESS | info | The initialization finished
—successfully without homotopy method.
LOG_SUCCESS | info | The simulation finished successfully.

n
’

timeFrontend = 0.5281604870000001,
timeBackend = 0.002912287,
timeSimCode = 0.18072962,
timeTemplates = 0.1198938859999999,
timeCompile = 0.658455482,
timeSimulation = 0.008676690000000001,
timeTotal = 1.49896261

end SimulationResult;

Warning:

Warning: The initial conditions are not fully specified. For more information set -d=initialization.
In OMEdit Tools->Options->Simulation->OMCFlags, in OMNotebook call setCommandLineOptions("-
d=initialization").
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Figure 10.11: Characteristic equation with real negative roots.

The importance of the sign of the roots in the characteristic equation is illustrated in Figure 10.11 and Figure
10.12, e.g., a stable system with negative real roots and an unstable system with positive imaginary roots resulting
in oscillations.

model ImgPosRoots
Real y;
Real der_y;
parameter Real al =
parameter Real a2 = 10;
equation
der_y = der(y);

|
|
N
~.

(continues on next page)
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(continued from previous page)

der (der_y) + alxder_y + a2xy = 1;
end ImgPosRoots;

>>> simulate (ImgPosRoots, stopTime=10)
record SimulationResult

resultFile = "«DOCHOME»/ImgPosRoots_res.mat",

simulationOptions = "startTime = 0.0, stopTime = 10.0, numberOfIntervals = 500,
— tolerance = 1le-06, method = 'dassl', fileNamePrefix = 'ImgPosRoots', options = '
—', outputFormat = 'mat', variableFilter = '.x', cflags = '', simflags = ''",

messages = "LOG_SUCCESS | info | The initialization finished,
—successfully without homotopy method.
LOG_SUCCESS | info | The simulation finished successfully.

n
’

timeFrontend = 0.2095216059999999,

timeBackend = 0.00250986,
timeSimCode = 0.198375817,
timeTemplates = 0.095336616,

timeCompile = 0.631844388,
timeSimulation = 0.012437883,
timeTotal = 1.150135243

end SimulationResult;

Warning:

Warning: The initial conditions are not fully specified. For more information set -d=initialization.
In OMEdit Tools->Options->Simulation->OMCFlags, in OMNotebook call setCommandLineOptions("-
d=initialization").
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Figure 10.12: Characteristic equation with imaginary roots with positive real part.

The theory and application of Kalman filters is also explained in the interactive course material.

In reality noise is present in almost every physical system under study and therefore the concept of noise is also
introduced in the course material, which is purely Modelica based.
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File Edit Cell Format Insert Window Help

W~ b | = k A ||« | @
1 Example J B
Consider a tank system with the following transfer function } ]
1 e
6(s) =—45
5+ T
‘What is the weight function? Can you plot the step response of the tank? }
1.1 Tank Transfer Function
loadModel (Modelica.Blocks) ]
model Tank |
Modelica.Blocks.Continuous.TransferFunction G(b={1/A},
a={1,1/T},y_start(fixed=true)=1/A);
Modelica.Blocks.Continuous.TransferFunction GStep(b={1/A}, a={1,1/T});
parameter Real T = 15;
parameter Real A = 5;
Real u = if (time > @ or time<@®) then @ else Modelica.Constants.inf;
Real uStep = if (time > @ or time<@) then 1 else 8;
equation
G.u = if time > © then 0 else 1e10;
GStep.u = uStep;
end Tank;
{Tank}
simulate(Tank, startTime=-1e-10, number0fIntervals=500, stopTime=10); ]
plot({G.y,GStep.y}) |
true
Plot by OpenModelica
1.4
1.2
1 @Gy
0.8
0.6
0.4 @ G5tep.y
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0 L/
0 2 6 8 10 Z
Ready Ln 8, Col1l
Figure 10.13: Step and pulse (weight function) response.
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File Edit Cell Format Inset Window Help
o «¥7 w = » & X : = | = ~ @
1 Kalman Filter

Often we don't have access to the internal states of a system and can only measure the outputs of the system and
have to reconstruct the state of the system based on these measurements. This is normally done with an observer.
The idea with an observer is that we feedback the difference of the measured output with the estimated output. If
the estiamtion is correct then the difference should be zero.

Another difficulty is that the measured quantities often contain disturbance, i.e. noise.

{f:Ai+Bu+e
J=Ct+v

Here are e denoting a disturbance in the input signal and v is a measurement error. The quality of the estimate can
be evalated by the difference

v K(y(t) — c2(t) — Du(t))

By using this quantity as feedback we obtain the observer

£ = AZ() + Bu(t) + K(3(t) — €2 () — Du(t))

Now form the error as

=i
I
=
|
L)

The differential error is

3
L

Ready Ready

Figure 10.14: Theory background about Kalman filter.
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model KalmanFeedback
parameter Real A[:,size(A, 1)] = {{0,1},{1,0}} ;
parameter Real B([size(a, 1),:] = {{0},{1}};
parameter Real C[:,size(a, 1)] = {{1,0}};
parameter Real([2,1] K = [2.4;3.4];
parameter Real[l,2] L = [2.4,3.4];
parameter Real([:,:] ABL = A-B%L;
parameter Real[:,:] BL = B*L;
[ parameter Real([:,:] 2 = zeros(size (ABL,2),size (ARC,1));
parameter Real[:,:] ARC = A-K*C;
parameter Real[:,:] Anew [0,1,0,0 ; -1.4, -3.4, 2.4,3.4; 0,0,-2.4,1;0,0,-2.4,0];
1
1

iy

parameter Real([:,:] Bnew [0;1;0;0];

parameter Real[:,:] Fnew = [1;0;0;0];

stateSpaceNoise Kalman (stateSpace.A=Anew,stateSpace.B=Bnew, stateSpace.C=[1,0,0,0],
stateSpace.F = Fnew);

stateﬁpacaﬂ'oise noKalman;
end KalmanFeedback;

simulate (KalmanFeedback, stopTime=3)
[ plot ({Kalman.stateSpace.y([1l],noKalman.stateSpace.y([1]})

il true
Plot by OpenModelica

15
@ Kalman, stateSpace. y[1]

@ nokalman.stateSpace.y[1]

w

Ready n12,Col39 |

Figure 10.15: Comparison of a noisy system with feedback link in DrControl.
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10.4 OpenModelica Notebook Commands

OMNotebook currently supports the commands and concepts that are described in this section.

10.4.1 Cells

Everything inside an OMNotebook document is made out of cells. A cell basically contains a chunk of data. That
data can be text, images, or other cells. OMNotebook has four types of cells: headercell, textcell, inputcell, and
groupcell. Cells are ordered in a tree structure, where one cell can be a parent to one or more additional cells. A
tree view is available close to the right border in the notebook window to display the relation between the cells.

¢ Textcell — This cell type is used to display ordinary text and images. Each textcell has a style that spec-
ifies how text is displayed. The cell’s style can be changed in the menu Format->Styles, example of
different styles are: Text, Title, and Subtitle. The Textcell type also has support for following links to
other notebook documents.

* Inputcell — This cell type has support for syntax highlighting and evaluation. It is intended to be used
for writing program code, e.g. Modelica code. Evaluation is done by pressing the key combina-
tion Shift+Return or Shift+Enter. All the text in the cell is sent to OMC (OpenModelica Com-
piler/interpreter), where the text is evaluated and the result is displayed below the inputcell. By
double-clicking on the cell marker in the tree view, the inputcell can be collapsed causing the result to
be hidden.

 Latexcell — This cell type has support for evaluation of latex scripts. Itis intended to be mainly used for
writing mathematical equations and formulas for advanced documentation in OMNotebook. Each La-
texcell supports a maximum of one page document output.To evaluate this cell, latex must be installed
in your system.The users can copy and paste the latex scripts and start the evaluation.Evaluation is
done by pressing the key combination Shift+Return or Shift+Enter or the green color eval button
present in the toolbar. The script in the cell is sent to latex compiler, where it is evaluated and the
output is displayed hiding the latex source. By double-clicking on the cell marker in the tree view,the
latex source is displayed for further modification.

e Groupcell — This cell type is used to group together other cell. A groupcell can be opened or closed.
When a groupcell is opened all the cells inside the groupcell are visible, but when the groupcell is
closed only the first cell inside the groupcell is visible. The state of the groupcell is changed by the
user double-clicking on the cell marker in the tree view. When the groupcell is closed the marker is
changed and the marker has an arrow at the bottom.

10.4.2 Cursors

An OMNotebook document contains cells which in turn contain text. Thus, two kinds of cursors are needed for
positioning, text cursor and cell cursor:

e Textcursor — A cursor between characters in a cell, appearing as a small vertical line. Position the cur-
sor by clicking on the text or using the arrow buttons.

¢ Cellcursor — This cursor shows which cell currently has the input focus. It consists of two parts. The
main cellcursor is basically just a thin black horizontal line below the cell with input focus. The
cellcursor is positioned by clicking on a cell, clicking between cells, or using the menu item Cell-
>Next Cell or Cell->Previous Cell. The cursor can also be moved with the key combination Ctrl+Up
or Ctrl+Down. The dynamic cellcursor is a short blinking horizontal line. To make this visible, you
must click once more on the main cellcursor (the long horizontal line). NOTE: In order to paste cells
at the cellcursor, the dynamic cellcursor must be made active by clicking on the main cellcursor (the
horizontal line).

10.4.3 Selection of Text or Cells

To perform operations on text or cells we often need to select a range of characters or cells.
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¢ Select characters — There are several ways of selecting characters, e.g.  double-clicking on a word,
clicking and dragging the mouse, or click followed by a shift-click at an adjacent positioin selects
the text between the previous click and the position of the most recent shift-click.

¢ Select cells — Cells can be selected by clicking on them. Holding down Ctrl and clicking on the cell
markers in the tree view allows several cells to be selected, one at a time. Several cells can be se-
lected at once in the tree view by holding down the Shift key. Holding down Shift selects all cells
between last selected cell and the cell clicked on. This only works if both cells belong to the same
groupcell.

10.4.4 File Menu

The following file related operations are available in the file menu:

* Create a new notebook — A new notebook can be created using the menu File->New or the key combi-
nation Ctrl+N. A new document window will then open, with a new document inside.

* Open a notebook — To open a notebook use File->Open in the menu or the key combination Ctrl+O.
Only files of the type .onb or .nb can be opened. If a file does not follow the OMNotebook format or the
FullForm Mathematica Notebook format, a message box is displayed telling the user what is wrong.
Mathematica Notebooks must be converted to fullform before they can be opened in OMNotebook.

* Save a notebook — To save a notebook use the menu item File->Save or File->Save As. If the notebook
has not been saved before the save as dialog is shown and a filename can be selected. OMNotebook
can only save in xml format and the saved file is not compatible with Mathematica. Key combination
for save is Ctrl+S and for save as Ctrl+Shift+S. The saved file by default obtains the file extension
.onb.

¢ Print — Printing a document to a printer is done by pressing the key combination Ctrl+P or using the
menu item File->Print. A normal print dialog is displayed where the usually properties can be changed.

e Import old document — Old documents, saved with the old version of OMNotebook where a different
file format was used, can be opened using the menu item File->Import->0Old OMNotebook file. Old
documents have the extension .xml.

* Export text — The text inside a document can be exported to a text document. The text is exported to
this document without almost any structure saved. The only structure that is saved is the cell structure.
Each paragraph in the text document will contain text from one cell. To use the export function, use
menu item File->Export->Pure Text.

¢ Close a notebook window — A notebook window can be closed using the menu item File->Close or the
key combination Ctrl+F4. Any unsaved changes in the document are lost when the notebook win-
dow is closed.

* Quitting OMNotebook — To quit OMNotebook, use menu item File->Quit or the key combination
Crtl+Q. This closes all notebook windows; users will have the option of closing OMC also. OMC
will not automatically shutdown because other programs may still use it. Evaluating the command
quit() has the same result as exiting OMNotebook.

10.4.5 Edit Menu

 Editing cell text — Cells have a set of of basic editing functions. The key combination for these are:
Undo (Ctrl+Z), Redo (Ctrl+Y), Cut (Ctrl+X), Copy (Ctrl+C) and Paste (Ctrl+V). These functions can
also be accessed from the edit menu; Undo (Edit->Undo), Redo (Edit->Redo), Cut (Edit->Cut), Copy
(Edit->Copy) and Paste (Edit->Paste). Selection of text is done in the usual way by double-clicking,
triple-clicking (select a paragraph), dragging the mouse, or using (Ctrl+A) to select all text within the
cell.

¢ Cut cell — Cells can be cut from a document with the menu item Edit->Cut or the key combination
Ctrl+X. The cut function will always cut cells if cells have been selected in the tree view, otherwise
the cut function cuts text.
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* Copy cell — Cells can be copied from a document with the menu item Edit->Copy or the key combina-
tion Ctrl+C. The copy function will always copy cells if cells have been selected in the tree view,
otherwise the copy function copy text.

¢ Paste cell — To paste copied or cut cells the cell cursor must be selected in the location where the cells
should be pasted. This is done by clicking on the cell cursor. Pasteing cells is done from the menu
Edit->Paste or the key combination Ctrl+V. If the cell cursor is selected the paste function will always
paste cells. OMNotebook share the same application-wide clipboard. Therefore cells that have been
copied from one document can be pasted into another document. Only pointers to the copied or cut
cells are added to the clipboard, thus the cell that should be pasted must still exist. Consequently a cell
can not be pasted from a document that has been closed.

 Find — Find text string in the current notebook, with the options match full word, match cell, search
within closed cells. Short command Ctrl+F.

* Replace — Find and replace text string in the current notebook, with the options match full word,
match cell, search+replace within closed cells. Short command Ctrl+H.

* View expression — Text in a cell is stored internally as a subset of HTML code and the menu item Edit-
>View Expression let the user switch between viewing the text or the internal HTML representation.
Changes made to the HTML code will affect how the text is displayed.

10.4.6 Cell Menu

* Add textcell — A new textcell is added with the menu item Cell->Add Cell (previous cell style) or the
key combination Alt+Enter. The new textcell gets the same style as the previous selected cell had.

* Add inputcell — A new inputcell is added with the menu item Cell->Add Inputcell or the key combina-
tion Ctrl+Shift+I.

* Add latexcell — A new latexcell is added with the menu item Cell->Add Latexcell or the key combina-
tion Ctrl+Shift+E.

e Add groupcell — A new groupcell is inserted with the menu item Cell->Groupcell or the key combina-
tion Ctrl+Shift+G. The selected cell will then become the first cell inside the groupcell.

e Ungroup groupcell — A groupcell can be ungrouped by selecting it in the tree view and using the menu
item Cell->Ungroup Groupcell or by using the key combination Ctrl+Shift+U. Only one groupcell at
a time can be ungrouped.

Split cell — Spliting a cell is done with the menu item Cell->Split cell or the key combination
Ctrl+Shift+P. The cell is splited at the position of the text cursor.

* Delete cell — The menu item Cell->Delete Cell will delete all cells that have been selected in the tree
view. If no cell is selected this action will delete the cell that have been selected by the cellcursor.
This action can also be called with the key combination Ctrl+Shift+D or the key Del (only works
when cells have been selected in the tree view).

* Cellcursor — This cell type is a special type that shows which cell that currently has the focus. The cell
is basically just a thin black line. The cellcursor is moved by clicking on a cell or using the menu
item Cell->Next Cell or Cell->Previous Cell. The cursor can also be moved with the key combination
Ctrl+Up or Ctrl+Down.

10.4.7 Format Menu

* Textcell — This cell type is used to display ordinary text and images. Each textcell has a style that spec-
ifies how text is displayed. The cells style can be changed in the menu Format->Styles, examples of
different styles are: Text, Title, and Subtitle. The Textcell type also have support for following links
to other notebook documents.

¢ Text manipulation — There are a number of different text manipulations that can be done to change the
appearance of the text. These manipulations include operations like: changing font, changing color
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and make text bold, but also operations like: changing the alignment of the text and the margin in-
side the cell. All text manipulations inside a cell can be done on single letters, words or the entire
text. Text settings are found in the Format menu. The following text manipulations are available in
OMNotebook:

> Font family

> Font face (Plain, Bold, Italic, Underline)
> Font size

> Font stretch

> Font color

> Text horizontal alignment

> Text vertical alignment

> Border thickness

> Margin (outside the border)

> Padding (inside the border)

10.4.8 Insert Menu

¢ Insert image — Images are added to a document with the menu item Insert->Image or the key combina-
tion Ctrl+Shift+M. After an image has been selected a dialog appears, where the size of the image can
be chosen. The images actual size is the default value of the image. OMNotebook stretches the image
accordantly to the selected size. All images are saved in the same file as the rest of the document.

e Insert link — A document can contain links to other OMNotebook file or Mathematica notebook and to
add a new link a piece of text must first be selected. The selected text make up the part of the link that
the user can click on. Inserting a link is done from the menu Insert->Link or with the key combination
Ctrl+Shift+L. A dialog window, much like the one used to open documents, allows the user to choose
the file that the link refers to. All links are saved in the document with a relative file path so documents
that belong together easily can be moved from one place to another without the links failing.

10.4.9 Window Menu

¢ Change window — Each opened document has its own document window. To switch between those use
the Window menu. The window menu lists all titles of the open documents, in the same order as they
were opened. To switch to another document, simple click on the title of that document.

10.4.10 Help Menu
e About OMNotebook — Accessing the about message box for OMNotebook is done from the menu Help-
>About OMNotebook.
e About Qt — To access the message box for Qt, use the menu Help->About Qt.

e Help Text — Opening the help text (document OMNotebookHelp.onb) for OMNotebook can be done in
the same way as any OMNotebook document is opened or with the menu Help->Help Text. The menu
item can also be triggered with the key F1.

10.4.11 Additional Features

¢ Links — By clicking on a link, OMNotebook will open the document that is referred to in the link.
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Update link — All links are stored with relative file path. Therefore OMNotebook has functions that au-
tomatically updating links if a document is resaved in another folder. Every time a document is saved,
OMNotebook checks if the document is saved in the same folder as last time. If the folder has changed,
the links are updated.

Evaluate whole Notebook — All the cells present in the Notebook can be evaluated in one step by press-
ing the red color evalall button in the toolbar. The cells are evaluated in the same order as they are in
the Notebook.However the latexcells cannot be evaluated by this feature.

Evaluate several cells — Several inputcells can be evaluated at the same time by selecting them in the
treeview and then pressing the key combination Shift+Enter or Shift+Return. The cells are evalu-
ated in the same order as they have been selected. If a groupcell is selected all inputcells in that
groupcell are evaluated, in the order they are located in the groupcell.

Moving and Reordering cells in a Notebook — 1t is possible to shift cells to a new position and change the
hierarchical order of the document.This can be done by clicking the cell and press the Up and Down
arrow button in the tool bar to move either Up or Down. The cells are moved one cell above or below.It
is also possible to move a cell directly to a new position with one single click by pressing the red color
bidirectional UpDown arrow button in the toolbar. To do this the user has to place the cell cursor to
a position where the selected cells must be moved. After selecting the cell cursor position, select the
cells you want to shift and press the bidirectional UpDown arrow button. The cells are shifted in the
same order as they are selected.This is especially very useful when shifting a group cell.

Command completion — Inputcells have command completion support, which checks if the user is typ-
ing a command (or any keyword defined in the file commands.xml) and finish the command. If the user
types the first two or three letters in a command, the command completion function fills in the rest. To
use command completion, press the key combination Ctrl+Space or Shift+Tab. The first command that
matches the letters written will then appear. Holding down Shift and pressing Tab (alternative holding
down Ctrl and pressing Space) again will display the second command that matches. Repeated request
to use command completion will loop through all commands that match the letters written. When a
command is displayed by the command completion functionality any field inside the command that
should be edited by the user is automatically selected. Some commands can have several of these fields
and by pressing the key combination Ctrl+Tab, the next field will be selected inside the command. >
Active Command completion: Ctrl+Space / Shift+Tab > Next command: Ctrl+Space / Shift+Tab >
Next field in command: Ctrl+Tab’

Generated plot — When plotting a simulation result, OMC uses the program Ptplot to create a plot.
From Ptplot OMNotebook gets an image of the plot and automatically adds that image to the out-
put part of an inputcell. Like all other images in a document, the plot is saved in the document file
when the document is saved.

Stylesheet -OMNotebook follows the style settings defined in stylesheet.xml and the correct style is ap-
plied to a cell when the cell is created.

Automatic Chapter Numbering — OMNotebook automatically numbers different chapter, subchapter,
section and other styles. The user can specify which styles should have chapter numbers and which
level the style should have. This is done in the stylesheet.xml file. Every style can have a <chapter-
Level> tag that specifies the chapter level. Level O or no tag at all, means that the style should not have
any chapter numbering.

Scrollarea — Scrolling through a document can be done by using the mouse wheel. A document can
also be scrolled by moving the cell cursor up or down.

Syntax highlighter — The syntax highlighter runs in a separated thread which speeds up the loading of
large document that contains many Modelica code cells. The syntax highlighter only highlights when
letters are added, not when they are removed. The color settings for the different types of keywords
are stored in the file modelicacolors.xml. Besides defining the text color and background color of
keywords, whether or not the keywords should be bold or/and italic can be defined.

Change indicator — A star (*) will appear behind the filename in the title of notebook window if the
document has been changed and needs saving. When the user closes a document that has some un-
saved change, OMNotebook asks the user if he/she wants to save the document before closing. If the
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document never has been saved before, the save-as dialog appears so that a filename can be choosen
for the new document.

e Update menus — All menus are constantly updated so that only menu items that are linked to actions
that can be performed on the currently selected cell is enabled. All other menu items will be dis-
abled. When a textcell is selected the Format menu is updated so that it indicates the text settings for
the text, in the current cursor position.
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CHAPTER
ELEVEN

OPTIMIZATION WITH OPENMODELICA

The following facilities for model-based optimization are provided with OpenModelica:

* Builtin Dynamic Optimization with OpenModelica and IpOpt using dynamic optimization is the recom-
mended way of performing dynamic optimization with OpenModelica.

¢ Dynamic Optimization with OpenModelica and CasADi. Use this if you want to employ the  CasADi
tool for dynamic optimization.

¢ Classical Parameter Sweep Optimization using OMOptim. Use this if you have a static optimization
problem.

11.1 Builtin Dynamic Optimization with OpenModelica and IpOpt

Note: this is a very short preliminary decription which soon will be considerably improved.

OpenModelica provides builtin dynamic optimization of models by using the powerful symbolic machinery of the
OpenModelica compiler for more efficient and automatic solution of dynamic optimization problems.

The builtin dynamic optimization allows users to define optimal control problems (OCP) using the Modelica
language for the model and the optimization language extension called Optimica (currently partially supported) for
the optimization part of the problem. This is used to solve the underlying dynamic optimization model formulation
using collocation methods, using a single execution instead of multiple simulations as in the parameter-sweep
optimization described in section Parameter Sweep Optimization using OMOptim.

For more detailed information regarding background and methods, see [BOR+12][RBB+14]

11.2 Compiling the Modelica code

Before starting the optimization the model should be symbolically instantiated by the compiler in order to get a
single flat system of equations. The model variables should also be scalarized. The compiler frontend performs
this, including syntax checking, semantics and type checking, simplification and constant evaluation etc. are
applied. Then the complete flattened model can be used for initialization, simulation and last but not least for
model-based dynamic optimization.

The OpenModelica command optimize(ModelName) from OMShell, OMNotebook or MDT runs immediately
the optimization. The generated result file can be read in and visualized with OMEdit or within OMNotebook.

11.3 An Example

In this section, a simple optimal control problem will be solved. When formulating the optimization problems,
models are expressed in the Modelica language and optimization specifications. The optimization language spec-
ification allows users to formulate dynamic optimization problems to be solved by a numerical algorithm. It
includes several constructs including a new specialized class optimization, a constraint section, startTime, final-
Time etc. See the optimal control problem for batch reactor model below.
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Create a new file named BarchReactor.mo and save it in you working directory. Notice that this model contains
both the dynamic system to be optimized and the optimization specification.

Once we have formulated the undelying optimal control problems, we can run the optimization by using OMShell,
OMNotebook, MDT, OMEdit using command line terminals similar to the options described below:

>>> setCommandLineOptions ("-g=Optimica");

Listing 11.1: BatchReactor.mo

model BatchReactor
Real x1(start =1, fixed=true, min=0, max=1);
Real x2 (start =0, fixed=true, min=0, max=1);
input Real u(min=0, max=5);

equation
der (x1) = —(u+tu”2/2)*x1;
der (x2) = u*x1;

end BatchReactor;

optimization nmpcBatchReactor (objective=-x2)
extends BatchReactor;
end nmpcBatchReactor;

>>> optimize (nmpcBatchReactor, numberOfIntervals=16, stopTime=1, tolerance=le-8)
record SimulationResult

resultFile = "«DOCHOME»/nmpcBatchReactor_res.mat",

simulationOptions = "startTime = 0.0, stopTime = 1.0, numberOfIntervals = 16,
—tolerance = 1e-08, method = 'optimization', fileNamePrefix = 'nmpcBatchReactor', |,
—options = '', outputFormat = 'mat', variableFilter = '.x', cflags = '', simflags,
—= ""I

messages = "LOG_SUCCESS | info | The initialization finished

—successfully without homotopy method.

Optimizer Variables

State[0] :x1 (start =

1, nominal = 1, min = 0, max 1, init 1)
State[l]:x2 (start = 0, nominal = 1, min = 0, max = 1, init = 0)
Input[2]:u(start = 0, nominal = 5, min = 0, max = 5)

R R b b b b b b b b b I b b b I I b b b I 2 b b b I b b b b b b b S I b b b I 2 b b b b b b b 2 b b b b I b b b I I b b b b I b b b b 2 b b i

This program contains Ipopt, a library for large-scale nonlinear optimization.

Ipopt is released as open source code under the Eclipse Public License (EPL).
For more information visit http://projects.coin-or.org/Ipopt

KA AR A AR A AR A AR A A A A AR A AR AR A A A A A A A A A A AR A AR A A A A AR A A A A A A A A FA A A A A A A AR A AR A AR A A AR AR A XKk

LOG_SUCCESS | info | The simulation finished successfully.

"
4

timeFrontend = 0.113387424,

timeBackend = 0.008936634000000001,
timeSimCode = 0.182218352,
timeTemplates = 0.123088243,

timeCompile = 0.7120957189999999,
timeSimulation = 0.02641724,
timeTotal = 1.166284296

end SimulationResult;

The control and state trajectories of the optimization results:
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1
Figure 11.1: Optimization results for Batch Reactor model — input variables.
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Figure 11.2: Optimization results for Batch Reactor model — state variables.
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11.4 Different Options for the Optimizer IPOPT

Table 11.1: New meanings of the usual simualtion options for Ipopt.

numberOfIntervals collocation intervals
startTime, stopTime time horizon
tolerance = le-8 e.g. le-8 solver tolerance
simflags all run/debug options

Table 11.2: New simulation options for Ipopt.

-lv LOG_IPOPT console output

-ipopt_hesse CONST,BFGS,NUM | hessian approximation
-ipopt_max_iter | number e.g. 10 maximal number of iteration for ipopt
externallnput.csv input guess

11.5 Dynamic Optimization with OpenModelica and CasADi

OpenModelica coupling with CasADi supports dynamic optimization of models by OpenModelica exporting
the optimization problem to CasADi which performs the optimization. In order to convey the dynamic system
model information between Modelica and CasADi, we use an XML-based model exchange format for differential-
algebraic equations (DAE). OpenModelica supports export of models written in Modelica and the Optimization
language extension using this XML format, while CasADi supports import of models represented in this format.
This allows users to define optimal control problems (OCP) using Modelica and Optimization language speci-
fications, and solve the underlying model formulation using a range of optimization methods, including direct
collocation and direct multiple shooting.

11.5.1 Compiling the Modelica code

Before exporting a model to XML, the model should be symbolically instantiated by the compiler in order to get
a single flat system of equations. The model variables should also be scalarized. The compiler frontend performs
this, including syntax checking, semantics and type checking, simplification and constant evaluation etc. are
applied. Then the complete flattened model is exported to XML code. The exported XML document can then be
imported to CasADi for model-based dynamic optimization.

The OpenModelica command translateModelXML(ModelName) from OMShell, OMNotebook or MDT exports
the XML. The export XML command is also integrated with OMEdit. Select XML > Export XML the XML
document is generated in the current directory of omc. You can use the cd() command to see the current location.
After the command execution is complete you will see that a file ModelName.xml has been exported.

Assuming that the model is defined in the modelName.mo, the model can also be exported to an XML code using
the following steps from the terminal window:

* Go to the path where your model file found

* Run command omc -g=Optimica —simCodeTarget=XML Model.mo
11.5.2 An example
In this section, a simple optimal control problem will be solved. When formulating the optimization problems,

models are expressed in the Modelica language and optimization specifications. The optimization language spec-
ification allows users to formulate dynamic optimization problems to be solved by a numerical algorithm. It
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includes several constructs including a new specialized class optimization, a constraint section, startTime, final-
Time etc. See the optimal control problem for batch reactor model below.

Create a new file named BarchReactor.mo and save it in you working directory. Notice that this model contains
both the dynamic system to be optimized and the optimization specification.

>>> list (BatchReactor)
model BatchReactor

Real x1(start = 1, fixed = true, min = 0, max = 1);
Real x2(start = 0, fixed = true, min = 0, max = 1);
input Real u(min = 0, max = 5);

equation
der(x1l) = —(u +u ~ 2 / 2) * x1;
der (x2) = u » x1;

end BatchReactor;

One we have formulated the undelying optimal control problems, we can export the XML by using OMShell,
OMNotebook, MDT, OMEdit or command line terminals which are described in Section XML Import to CasADi
via OpenModelica Python Script.

To export XML, we set the simulation target to XML:

>>> translateModelXML (BatchReactor)
"«DOCHOME»/BatchReactor.xml"

This will generate an XML file named BatchReactor.xml (Listing 11.2) that contains a symbolic representation of
the optimal control problem and can be inspected in a standard XML editor.

Listing 11.2: BatchReactor.xml

<?xml version="1.0" encoding="UTF-8"?>
<OpenModelicaModelDescription
xmlns:exp="https://svn.jmodelica.org/trunk/XML/daeExpressions.xsd"
xmlns:equ="https://svn.jmodelica.org/trunk/XML/daeEquations.xsd"
xmlns: fun="https://svn.jmodelica.org/trunk/XML/daeFunctions.xsd"
xmlns:opt="https://svn.jmodelica.org/trunk/XML/daeOptimization.xsd"
xmlns:xsi="http://www.w3.0rg/2001/XMLSchema-instance"
fmivVersion="1.0"
modelName="BatchReactor"
modelIdentifier="BatchReactor"
guid="{8c4e810f-3df3-4a00-8276-176fa3c9f9%9e0}"
generationDateAndTime="2018-12-20T23:41:18"
variableNamingConvention="structured"
numberOfContinuousStates="2"
numberOfEventIndicators="0"
>

<VendorAnnotations>
<Tool name="OpenModelica Compiler OMCompiler v1.13.0"> </Tool>
</VendorAnnotations>

<ModelVariables>
<ScalarVariable name="x1" valueReference="0" variability="continuous"_
—causality="internal" alias="noAlias">
<Real start="1.0" fixed="true" min="0.0" max="1.0" />
<QualifiedName>
<exp:QualifiedNamePart name="x1"/>
</QualifiedName>

<isLinearTimedVariables>
<TimePoint index="0" isLinear="true"/>
</isLinearTimedVariables>
<VariableCategory>state</VariableCategory>

(continues on next page)
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</ScalarVariable>

<ScalarVariable name="x2" valueReference="1" variability="continuous"_
—causality="internal" alias="noAlias">
<Real start="0.0" fixed="true" min="0.0" max="1.0" />
<QualifiedName>
<exp:QualifiedNamePart name="x2"/>
</QualifiedName>
<isLinearTimedVariables>
<TimePoint index="0" isLinear="true"/>
</isLinearTimedVariables>
<VariableCategory>state</VariableCategory>
</ScalarVariable>

<ScalarVariable name="der (x1)" valueReference="2" variability="continuous"_
—causality="internal" alias="noAlias">
<Real />
<QualifiedName>
<exp:QualifiedNamePart name="x1"/>
</QualifiedName>

<isLinearTimedVariables>
<TimePoint index="0" isLinear="true"/>
</isLinearTimedVariables>
<VariableCategory>derivative</VariableCategory>
</ScalarVariable>

<ScalarVariable name="der (x2)" valueReference="3" variability="continuous"_
—causality="internal" alias="noAlias">
<Real />
<QualifiedName>
<exp:QualifiedNamePart name="x2"/>
</QualifiedName>

<isLinearTimedVariables>
<TimePoint index="0" isLinear="true"/>
</isLinearTimedVariables>
<VariableCategory>derivative</VariableCategory>
</ScalarVariable>
<ScalarVariable name="u" valueReference="4" variability="continuous"
—causality="input" alias="noAlias">
<Real min="0.0" max="5.0" />
<QualifiedName>
<exp:QualifiedNamePart name="u"/>
</QualifiedName>
<isLinearTimedVariables>
<TimePoint index="0" isLinear="true"/>
</isLinearTimedVariables>
<VariableCategory>algebraic</VariableCategory>
</ScalarVariable>
</ModelVariables>

<equ:BindingEquations>
</equ:BindingEquations>

<equ:DynamicEquations>
<equ:Equation>
<exp:Sub>

<exp:Der>

<exp:Identifier>

<exp:QualifiedNamePart name="x2"/>

</exp:Identifier>
</exp:Der>
<exp:Mul>

(continues on next page)
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<exp:Identifier>
<exp:QualifiedNamePart name="u"/>
</exp:Identifier>
<exp:Identifier>
<exp:QualifiedNamePart name="x1"/>
</exp:Identifier>
</exp:Mul>
</exp:Sub>
</equ:Equation>
<equ:Equation>
<exp:Sub>
<exp:Der>
<exp:Identifier>
<exp:QualifiedNamePart name="x1"/>
</exp:Identifier>
</exp:Der>
<exp:Mul>
<exp:Sub>
<exp:Mul>
<exp:Realliteral>-0.5</exp:ReallLiteral>
<exp:Pow>
<exp:Identifier>
<exp:QualifiedNamePart name="u"/>
</exp:Identifier>
<exp:RealLiteral>2.0</exp:ReallLiteral>
</exp:Pow>
</exp:Mul>
<exp:Identifier>
<exp:QualifiedNamePart name="u"/>
</exp:Identifier>
</exp:Sub>
<exp:Identifier>
<exp:QualifiedNamePart name="x1"/>
</exp:Identifier>
</exp:Mul>
</exp:Sub>
</equ:Equation>
</equ:DynamicEquations>

<equ:InitialEquations>
<equ:Equation>
<exp:Sub>
<exp:Identifier>
<exp:QualifiedNamePart name="x1"/>
</exp:Identifier>
<exp:Realliteral>1.0</exp:RealLiteral>
</exp:Sub>
</equ:Equation>

<equ:Equation>
<exp:Sub>
<exp:Identifier>
<exp:QualifiedNamePart name="x2"/>
</exp:Identifier>
<exp:Realliteral>0.0</exp:RealLiteral>
</exp:Sub>
</equ:Equation>
<equ:Equation>
<exp:Sub>
<exp:Identifier>
<exp:QualifiedNamePart name="x1"/>

(continues on next page)
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</exp:Identifier>
<exp:Identifier>
<exp:QualifiedNamePart name="S$SSTART"/>
<exp:QualifiedNamePart name="x1"/>
</exp:Identifier>
</exp:Sub>
</equ:Equation>
<equ:Equation>
<exp:Sub>

</exp:Sub>
</equ:Equation>
<equ:Equation>

<exp:Sub>

</exp:Sub>
</equ:Equation>
<equ:Equation>
<exp:Sub>
<exp:Identifier>
<exp:QualifiedNamePart name="x2"/>
</exp:Identifier>
<exp:Identifier>
<exp:QualifiedNamePart name="SSTART"/>
<exp:QualifiedNamePart name="x2"/>
</exp:Identifier>
</exp:Sub>
</equ:Equation>
</equ:InitialEquations>

<fun:Algorithm>
</fun:Algorithm>

<fun:RecordsList>
</fun:RecordsList>

<fun:FunctionsList>
</fun:FunctionsList>

<opt:Optimization>
<opt :TimePoints>
<opt:TimePoint >
</opt : TimePoint>
</opt :TimePoints>
<opt:PathConstraints>
</opt :PathConstraints>
</opt:Optimization>

</OpenModelicaModelDescription>

11.5.3 XML Import to CasADi via OpenModelica Python Script

The symbolic optimal control problem representation (or just model description) contained in BatchReactor.xml
can be imported into CasADi in the form of the SymbolicOCP class via OpenModelica python script.

The SymbolicOCP class contains symbolic representation of the optimal control problem designed to be general
and allow manipulation. For a more detailed description of this class and its functionalities, we refer to the API
documentation of CasADi.

The following step compiles the model to an XML format, imports to CasADi and solves an optimization problem
in windows PowerShell:
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1. Create a new file named BatchReactor.mo and save it in you working directory.
E.g. C:\OpenModelical.9.2\share\casadi\testmodel
1. Perform compilation and generate the XML file
a. Go to your working directory
E.g. cd C:\OpenModelical.9.2\share\casadi\testmodel
a. Go to omc path from working directory and run the following command
E.g. .\.\..\bin\omc +s -g=Optimica —simCodeTarget=XML BatchReactor.mo
3. Run defaultStart.py python script from OpenModelica optimization directory
E.g. Python.exe ..\share\casadi\scripts defaultStart.py BatchReactor.xml

The control and state trajectories of the optimization results are shown below:

Input State

11.6 Parameter Sweep Optimization using OMOptim

OMOptim is a tool for parameter sweep design optimization of Modelica models. By optimization, one should
understand a procedure which minimizes/maximizes one or more objective functions by adjusting one or more
parameters. This is done by the optimization algorithm performing a parameter swep, i.e., systematically adjusting
values of selected parameters and running a number of simulations for different parameter combinations to find a
parameter setting that gives an optimal value of the goal function.

OMOptim 0.9 contains meta-heuristic optimization algorithms which allow optimizing all sorts of models with
following functionalities:

* One or several objectives optimized simultaneously
* One or several parameters (integer or real variables)

However, the user must be aware of the large number of simulations an optimization might require.

11.6.1 Preparing the Model

Before launching OMOptim, one must prepare the model in order to optimize it.

Parameters

An optimization parameter is picked up from all model variables. The choice of parameters can be done using the
OMOptim interface.

For all intended parameters, please note that:
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* The corresponding variable is constant during all simulations. The OMOptim optimization in version
0.9 only concerns static parameters’ optimization i.e. values found for these parameters will be con-
stant during all simulation time.

¢ The corresponding variable should play an input role in the model ie. its modification influences
model simulation results.

Constraints

If some constraints should be respected during optimization, they must be defined in the Modelica model itself.

For instance, if mechanical stress must be less than 5 N.m2, one should write in the model:

assert (mechanicalStress < 5, "Mechanical stress too high");

If during simulation, the variable mechanicalStress exceeds 5 N .m2, the simulation will stop and be considered
as a failure.

Objectives

As parameters, objectives are picked up from model variables. Objectives’ values are considered by the optimizer
at the final time.

11.6.2 Set problem in OMOptim
Launch OMOptim

OMOptim can be launched using the executable placed in OpenModelicalnstallationDirectory/bin/ OMOp-
tim/OMOptim.exe. Alternately, choose OpenModelica > OMOptim from the start menu.

Create a new project

To create a new project, click on menu File -> New project

Then set a name to the project and save it in a dedicated folder. The created file created has a .min extension. It
will contain information regarding model, problems, and results loaded.

Load models

First, you need to load the model(s) you want to optimize. To do so, click on Add .mo button on main window or
select menu Model -> Load Mo file. ..

When selecting a model, the file will be loaded in OpenModelica which runs in the background.

While OpenModelica is loading the model, you could have a frozen interface. This is due to multi-threading
limitation but the delay should be short (few seconds).

You can load as many models as you want.
If an error occurs (indicated in log window), this might be because:
* Dependencies have not been loaded before (e.g. modelica library)
* Model use syntax incompatible with OpenModelica.
Dependencies

OMOptim should detect dependencies and load corresponding files. However, it some errors occur, please load
by yourself dependencies. You can also load Modelica library using Model->Load Modelica library.

When the model correctly loaded, you should see a window similar to Figure 11.3.
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M_} |

Project | Optimization | OptCooling | Optimization result (3) | Optimizationresult | OptCoolingresult | OptCodir P
Project name :  testlinearactuator
Project file C !Docl.maris and Settings/Sayah/Mes documents/MinesModOptf TestLinearActuator ftestLinearfctuatonmin

and Settings/Sayah/Mes documents/Mines/ModOptfModelicaTotal
Loaded .mo files : CMNW&MWW&WMW@MNM

Log

Loading project (C:/Documents and Satthgs,fSa'yahMes documnents/MinesModOptf TestLinearActuator testLinearActuatormin) ..

Model loaded successfully™C:/Documents and Settings/SayvahfiMes dm:rﬂtsMﬂMdOptMndelcaTatd mo"
Loaiﬂq file : C:/Documents and Settings/SayahfMes documents/Mines/ModOptj TestLinearActuator Linearactuator mo
Model loaded successfully"C: /Documents and Settings/SayahfMes documents/Mines/ModOpt) TestLinearActuator fLinear actuator. mo
Loading mode file (C: fDocuments and SettingsfSayah/Mes MMMMMHMMWMMMMMW!WW)
Loading mode! file (C: fDocuments and SettingsfSayah/Mes
documents/Mines/ModOpt TestLinearActuatorModels/Modelica. Thermal. FluidHe atFlow. Examples, SimpleCooling/testLinearActuator.mmo) ..

Figure 11.3: OMOptim window after having loaded model.
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Create a new optimization problem

Problem->Add Problem->Optimization

A dialog should appear. Select the model you want to optimize. Only Model can be selected (no Package,
Component, Block.. .).

A new form will be displayed. This form has two tabs. One is called Variables, the other is called Optimization.

~ OMOptim Moes
Fle Models Problem Display Tools  About
Models | Problems | _ Optimization resuk | OpbCooling result | OptCooling resuk (2) | |
= [Modebca i A
# UsersGuide Fiker: | |
- Blocks . -
® Constants Name ¥ | vale | Description ||| Optimized varisbles @
[ Electrical
# Ions ol o Hame T value Description Datat]
#- Math LinearActustontorgue | o ingDanmper: :
@ Mochank Aange_butw D 40 ]
# Media Rlarga_bphi ° gOampertd 0 K o
B coaes . o <] 2]
# Thermal LinearActustortorgue 1 bearing phi o
ol £ Scanned varlables (%]
) ; spring LineardctustorstepLy 0 :an' Velue | Description | Dstatype  ScanMinimum | Scan M
s
- id n J—— o
+ inertial
- spri Lineardctustortep] offuet o )
® Inertia2 LinearActuatoratep L height o [<] >
# torquel
® stepl UnearAcustorspringDamper w_rel_stan. |0 Ontimizat ubned:iME]
ref
. LinearctustorspringD amper? w_rel 0
— o Mame Deescription Direction L . .
UineardctuatorspringDarmper?.
3 LinearActuator. sumDeviation - Minimize 0 SEIQCtEd ObJeCtlves
LinearActistorspringDarrper2.
phirel a0 <] =
| Add .mo Variables | Optimization
Log & x
Loading project (C:/Documents and Y doc ire:s Opt | TestLinearActuator ftestLinearActuatormin) ... .1
Lo-u:i’l'\q file : C:fDocumenits and SettingsSayahjMes doc ines{ModOptModel l.mo |
Model loaded successfuly™C: ,fDomnents and setmw‘sayd\rm doc [Mines ModOpt| mo”
Loading file : C:fDy < {ModOpt) TestLi n mo
Model loaded successfully™C: Documentt dac ines{ModOpt Testl ineards
Loading model file (C:, ,l'l)cu:mmhts and Setbn;ﬂ'sc!\-'d‘\llf'hs doc fMines ModOpt) TestL Mu,ﬁhﬂsﬂ.m&cmﬂ.m&t\mm}
Lom moded file {C:, ,ﬂ)«.\mntsmdsewsar&u'
Ot TestLi . Thermal. FhadHestFlow. Examples. SimpleCookng et Li
Problem “Optimization” added to project
Problem “OptCookng” addadbnpto]ed v
| Driack lasdin e sl Satbinac S aushiMas d i Mt Tack & et s . [l
MO | OMC Debug |

Figure 11.4: Forms for defining a new optimization problem.

List of Variables is Empty

If variables are not displayed, right click on model name in model hierarchy, and select Read variables.

Select Optimized Variables

To set optimization, we first have to define the variables the optimizer will consider as free i.e. those that it
should find best values of. To do this, select in the left list, the variables concerned. Then, add them to Optimized

variables by clicking on corresponding button (+).

For each variable, you must set minimum and maximum values it can take. This can be done in the Optimized
variables table.

Select objectives

Objectives correspond to the final values of chosen variables. To select these last, select in left list variables
concerned and click + button of Optimization objectives table.

For each objective, you must:

* Set minimum and maximum values it can take. If a configuration does not respect these values, this
configuration won’t be considered. You also can set minimum and maximum equals to “-* : it will
then
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Figure 11.5: Selecting read variables, set parameters, and selecting simulator.

* Define whether objective should be minimized or maximized.

This can be done in the Optimized variables table.

Select and configure algorithm

After having selected variables and objectives, you should now select and configure optimization algorithm. To
do this, click on Optimization tab.

Here, you can select optimization algorithm you want to use. In version 0.9, OMOptim offers three different
genetic algorithms. Let’s for example choose SPEA2Adapt which is an auto-adaptative genetic algorithm.

By clicking on parameters. .. button, a dialog is opened allowing defining parameters. These are:

* Population size: this is the number of configurations kept after a generation. If it is set to 50, your final
result can’t contain more than 50 different points.

* Off spring rate: this is the number of children per adult obtained after combination process. If it is set
to 3, each generation will contain 150 individual (considering population size is 50).

* Max generations: this number defines the number of generations after which optimization should stop.
In our case, each generation corresponds to 150 simulations. Note that you can still stop optimization
while it is running by clicking on sfop button (which will appear once optimization is launched).
Therefore, you can set a really high number and still stop optimization when you want without losing
results obtained until there.

¢ Save frequency: during optimization, best configurations can be regularly saved. It allows to analyze
evolution of best configurations but also to restart an optimization from previously obtained results. A
Save Frequency parameter set to 3 means that after three generations, a file is automatically created
containing best configurations. These files are named iteraionl.sav, iteration2.sav and are store in
Temp directory, and moved to SolvedProblems directory when optimization is finished.

* ReinitStdDev: this is a specific parameter of EAAdaptl. It defines whether standard deviation of vari-
ables should be reinitialized. It is used only if you start optimization from previously obtained con-
figurations (using Use start file option). Setting it to yes (1) will, in most of cases, lead to a spread
research of optimized configurations, forgetting parameters’ variations’ reduction obtained in previous
optimization.

Use start file

As indicated before, it is possible to pursue an optimization finished or stopped. To do this, you must enable Use
start file option and select file from which optimization should be started. This file is an iferation_.sav file created
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in previous optimization. It is stored in corresponding SolvedProblems folder (iterationl0.sav corresponds to the
tenth generation of previous optimization).

*Note that this functionality can only work with same variables and objectives*. However, minimum, maxi-
mum of variables and objectives can be changed before pursuing an optimization.

Launch

You can now launch Optimization by clicking Launch button.

Stopping Optimization

Optimization will be stopped when the generation counter will reach the generation number defined in parameters.
However, you can still stop the optimization while it is running without loosing obtained results. To do this, click
on Stop button. Note that this will not immediately stop optimization: it will first finish the current generation.

This stop function is especially useful when optimum points do not vary any more between generations. This
can be easily observed since at each generation, the optimum objectives values and corresponding parameters are
displayed in log window.

11.6.3 Results

The result tab appear when the optimization is finished. It consists of two parts: a table where variables are
displayed and a plot region.

Obtaining all Variable Values

During optimization, the values of optimized variables and objectives are memorized. The others are not. To get
these last, you must recomputed corresponding points. To achieve this, select one or several points in point’s list
region and click on recompute.

For each point, it will simulate model setting input parameters to point corresponding values. All values of this
point (including those which are not optimization parameters neither objectives).

11.6.4 Window Regions in OMOptim GUI
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Figure 11.6: Window regions in OMOptim GUI.
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CHAPTER
TWELVE

PARAMETER SENSITIVITIES WITH OPENMODELICA

This section describes the use of OpenModelica to compute parameter sensitivities using forward sensitivity anal-
ysis together with the Sundials/IDA solver.

Note: this is a very short preliminary description which soon will be considerably improved, since this a rather
new feature and will continuous improved.

Note: OpenModelica version 1.10 or newer is required.

12.1 Background

Parameter sensitivity analysis aims at analyzing the behavior of the corresponding model states w.r.t. model
parameters.

Formally, consider a Modelica model as a DAE system:

F(xvjayal% t) =0 I(to) = Io(p)
where z(t) € R" represent state variables, @(t) € R™ represent state derivatives, y(t) € R¥ represent algebraic
variables, p € R™ model parameters.

For parameter sensitivity analysis the derivatives

ox
dp
are required which quantify, according to their mathematical definition, the impact of parameters p on states x. In
the Sundials/IDA implementation the derivatives are used to evolve the solution over the time by:
) ox
S; =
Y Opi

12.2 An Example

This section demonstrates the usage of the sensitivities analysis in OpenModelica on an example. This module is
enabled by the following OpenModelica compiler flag:

’ >>> getCommandLineOptions ("--calculateSensitivities");

Listing 12.1: LotkaVolterra.mo

model LotkaVolterra
Real x(start=5, fixed=true),y(start=3, fixed=true);
parameter Real mul=5,mu2=2;
parameter Real lambdal=3, lambdaz2=1;

equation

(continues on next page)
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0 = x* (mul-lambdal*y) - der(x);
0 = —yx (mu2 -lambda2xx) - der(y);
end LotkaVolterra;

Also for the simulation it is needed to set IDA as solver integration method and add a further simulation flag
—-idaSensitivity to calculate the parameter sensitivities during the normal simulation.

>>> gsimulate (LotkaVolterra, method="ida", simflags="-idaSensitivity")
record SimulationResult

resultFile = "«DOCHOME»/LotkaVolterra_res.mat",

simulationOptions = "startTime = 0.0, stopTime = 1.0, numberOflIntervals = 500,
—tolerance = 1le-06, method = 'ida', fileNamePrefix = 'LotkaVolterra', options = '
', outputFormat = 'mat', variableFilter = '.x', cflags = '', simflags = '—
—idaSensitivity'",

messages = "LOG_SUCCESS | info | The initialization finished,
—successfully without homotopy method.
LOG_SUCCESS | info | The simulation finished successfully.

n
’

timeFrontend = 0.006327842,
timeBackend = 0.003129841,
timeSimCode 0.187213332,
timeTemplates = 0.115281675,
timeCompile = 0.64642477,
timeSimulation = 0.009731921000000001,
timeTotal = 0.968263446

end SimulationResult;

Now all calculated sensitivities are stored into the results mat file under the $Sensitivities block, where all currently
every top-level parameter of the Real type is used to calculate the sensitivities w.r.t. every state.

1.5 T T

T T
$Sensitivities.lambdal.x ——
1k $Sensitivities.lambdal.y ——

nsitivities.lambda2.x
$Sensitivities.lambda2.y
0.5 $Sensitivities.mul.x _
$Sensitivities.mully ——
0 $Sensitivities.mu2. X ———

$Sensitivities.mu2.y ——

Figure 12.1: Results of the sensitivities calculated by IDA solver.
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Figure 12.2: Results of the LotkaVolterra equations.
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PDEMODELICAT1

PDEModelical is nonstandardised experimental Modelica language extension for 1-dimensional partial differen-
tial extensions (PDE).

It is enabled using compiler flag ——grammar=PDEModelica. Compiler flags may be set e.g. in OMEdit
(Tools->Options->Simulation->OMC Flags) or in the OpenModelica script using command

>>> getCommandLineOptions ("-—grammar=PDEModelica™)
true

13.1 PDEModelical language elements

Let us introduce new PDEModelical language elements by an advection equation example model:

model Advection "advection equation"
parameter Real pi = Modelica.Constants.pi;

parameter DomainLineSegmentlD omega(L = 1, N = 100) "domain";
field Real u(domain = omega) "field";
initial equation
u = sin(2xpi*omega.x) "Ic";
equation
der (u) + pder (u,x) 0 indomain omega "PDE";
u=0 indomain omega.left "BC";
u = extrapolateField(u) indomain omega.right "extrapolation";

end Advection;

The domain omega represents the geometrical domain where the PDE holds. The domain is defined using the
built-in record DomainLineSegment 1D. This record contains among others L — the length of the domain, N —
the number of grid points, x — the coordinate variable and the regions left, right and interior, representing
the left and right boundaries and the interior of the domain.

The field variable u is defined using a new keyword field. The domain is a mandatory attribute to specify the
domain of the field.

The indomain operator specifies where the equation containing the field variable holds. It is utilised in the initial
conditions (IC) of the fields, in the PDE and in the boundary conditions (BC). The syntax is

anEquation indomain aDomain.aRegion;

If the region is omitted, interior is the default (e.g. the PDE in the example above).
The IC of the field variable u is written using an expression containing the coordinate variable omega . x.

The PDE contains a partial space derivative written using the pder operator. Also the second derivative is allowed
(not in this example), the syntax is e.g. pder (u, x, x) . It is not necessary to specify the domain of coordinate
in pder (to write e.g. pder (u, omega.x), even though x is a member of omega.
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13.2 Limitations

BCs may be written only in terms of variables that are spatially differentiated currently.

All fields that are spatially differentiated must have either BC or extrapolation at each boundary. This extrapolation
should be done automatically by the compiler, but this has not been implemented yet. The current workaround is
the usage of the extrapolateField () operator directly in the model.

If-equations are not spported yet, if-expressions must be used instead.

13.3 Viewing results

During translation field variables are replaced with arrays. These arrays may be plotted using Array Plot or even
better using Array Parametric Plot (to plot x-coordinate versus a field).
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MDT — THE OPENMODELICA DEVELOPMENT TOOLING ECLIPSE
PLUGIN

14.1 Introduction

The Modelica Development Tooling (MDT) Eclipse Plugin as part of OMDev — The OpenModelica Development
Environment integrates the OpenModelica compiler with Eclipse. MDT, together with the OpenModelica com-
piler, provides an environment for working with Modelica and MetaModelica development projects. This plugin
is primarily intended for tool developers rather than application Modelica modelers.

The following features are available:
* Browsing support for Modelica projects, packages, and classes
* Wizards for creating Modelica projects, packages, and classes
 Syntax color highlighting
* Syntax checking
* Browsing of the Modelica Standard Library or other libraries
¢ Code completion for class names and function argument lists
* Goto definition for classes, types, and functions

* Displaying type information when hovering the mouse over an identifier.

14.2 Installation

The installation of MDT is accomplished by following the below installation instructions. These instructions
assume that you have successfully downloaded and installed Eclipse (http://www.eclipse.org).

The latest installation instructions are available through the OpenModelica Trac.
1. Start Eclipse

Select Help->Software Updates->Find and Install... from the menu

Select ‘Search for new features to install’ and click ‘Next’

Select ‘New Remote Site...’

A

Enter ‘MDT’ as name and http://www.ida.liu.se/labs/pelab/modelica/OpenModelica/MDT as URL and click
‘OK?

Make sure ‘MDT"’ is selected and click ‘Finish’

In the updates dialog select the ‘MDT’ feature and click ‘Next’

Read through the license agreement, select ‘I accept...” and click ‘Next’

Click ‘Finish’ to install MDT

v »® =N
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14.3 Getting Started

14.3.1 Configuring the OpenModelica Compiler
MDT needs to be able to locate the binary of the compiler. It uses the environment variable OPENMODELICA -
HOME to do so.

If you have problems using MDT, make sure that OPENMODELICAHOME is pointing to the folder where the
OpenModelica Compiler is installed. In other words, OPENMODELICAHOME must point to the folder that
contains the Open Modelica Compiler (OMC) binary. On the Windows platform it’s called omc.exe and on Unix
platforms it’s called omc.

14.3.2 Using the Modelica Perspective

The most convenient way to work with Modelica projects is to use to the Modelica perspective. To switch to
the Modelica perspective, choose the Window menu item, pick Open Perspective followed by Other... Select the
Modelica option from the dialog presented and click OK..

14.3.3 Selecting a Workspace Folder

Eclipse stores your projects in a folder called a workspace. You need to choose a workspace folder for this session,
see Figure 14.1.

14.3.4 Creating one or more Modelica Projects

To start a new project, use the New Modelica Project Wizard. It is accessible through File->New-> Modelica
Project or by right-clicking in the Modelica Projects view and selecting New->Modelica Project.

You need to disable automatic build for the project(s) (Figure 14.3).

Repeat the procedure for all the projects you need, e.g. for the exercises described in the MetaModelica users
guide: 01_experiment, 02a_exp1, 02b_exp2, 03_assignment, 04a_assigntwotype, etc.

NOTE: Leave open only the projects you are working on! Close all the others!

14.3.5 Building and Running a Project

After having created a project, you eventually need to build the project (Figure 14.4).

The build options are the same as the make targets: you can build, build from scratch (clean), or run simulations
depending on how the project is setup. See Figure 14.5 for an example of how omc can be compiled (make omc
builds OMC).

14.3.6 Switching to Another Perspective

If you need, you can (temporarily) switch to another perspective, e.g. to the Java perspective for working with an
OpenModelica Java client as in Figure 14.7.

14.3.7 Creating a Package

To create a new package inside a Modelica project, select File->New->Modelica Package. Enter the desired name
of the package and a description of what it contains. Note: for the exercises we already have existing packages.
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& Modelica - Eclipse

File Edit Mavigate Search Project Run Window Help

New Shift+Alt+N  » |1 @& 4 ¥ !
Open File..

= | Refresh =5

Convert Line Delimiters To *

Switch Workspace r Other..
Restart

£ Import...
g Export...

Properties Alt+Enter

1 BouncingBall.mo [demo]
2 Absyn.mo [OpenModelica/OMCompiler/...]
2 MultiBall.mo [demo]

4 BouncingBall.mo [demo]

Exit

Figure 14.1: Eclipse Setup — Switching Workspace.
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Create a Modelica project

Create a Modelica project in the workspace.

Project name: | demo

(/?;' Cancel Finish

Figure 14.2: Eclipse Setup — creating a Modelica project in the workspace.
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¢ Modelica - Eclipse

File Edit Navigate Search Project Run Window Help

Close Project

B Build Al
Build Project
Build Working Set
Cle;

Build Automatically

» M BouncingBall.mo |
» M MultiBall.mo R pEl
¥ M VanDerPol.mo
(X| .project
b = Libraries
k Qg:v OpenModelica [OpenModelics

Figure 14.3: Eclipse Setup — disable automatic build for the projects.

¢ Modelica - Eclipse

File Edit MNavigate Search Project Run Window Help

Close Project

B euild Al
Build Project

Build Working Set

b & .externalToolBuilders

[ T, | NN EAEY

Figure 14.4: Eclipse MDT — Building a project.
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Please input a value

omc

Cancel OK

Figure 14.5: Eclipse — building a project.

& console 8 L = g

X % B H@® - =
<terminated= make [Program] /usr/binfmake
D (T i Sttty o O
Jsusr/bin/make -f Makefile --no-print-directory -C Jhome/marsj/0OpenModelicas0MCompiler/
make[5]: Nothing to be done for 'all'.
Jusr/bins/make -T Makefile --no-print-directory -C shome/marsj/OpenModelicas0OMCompiler/
make[5]: Nothing to be done for 'all'.
susr/bin/make - Makefile Makefile.sources
make[4]: 'Makefile.sources' 1is up to date.
Susr/bin/make -f Makefile interfaces INCLUDESOURCES=1
shomesmars]/0penModelicasbuild/binsomec +n=1 build/Absyn.stamp.mo.mos
Jusr/bins/make -T Makefile Makefile.depends INCLUDESOURCES=1
make[4]: 'Makefile.depends' 1is up to date.
susr/bins/make -T Makefile generate-files INCLUDESOURCES=1 INCLUDEDEPENDS=1
Jhomesmarsj /0OpenModelicasbuild/bin/omc +n=1 build/Absyn.stamp.mos
susr/bin/make - Makefile --no-print-directory install INCLUDESOURCES=1
clang -g -02 -fno-stack-protector -TPIC -I"/homesmars]j/0penModelicasbuild/includesomc/
clang -shared -Wl,-z,origin -W1, -rpath, ' $0RIGIN/. ./1ib/x86_64-linux-gnusomc' -W1, -rpat
test ! ".so0" = ".dylib" || install_name_tool -id @rpath/libOpenModelicaCompiler.dylib
clang build/_main.o -W1l,-z,origin -W1, -rpath, '$ORIGIN/../1ib/xB6_64-1linux-gnusomc' -Wl
cp -a build/OpenModelicaScriptingAPI.h /shomesmarsj/0penModelicasbuild/includesomcs/scri
cp -a buildfomc Shome/marsj/0penModelicas/builds/bins

Figure 14.6: Eclipse — building a project, resulting log.
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& Modelica - Eclipse

File Edit Navigate Project Run Window Help
NNy B~ EE New Window : ¥
Editor b
Hide Toolbar
GE Modelica Proj X = 0O Open Perspective 3 1+ Debug
0% v Show View v+ BB Modelica

. . [ ————
v (& demo Customize Perspective...

Save Perspective As..

® BouncingBall.mo

. BouncingBall Reset Perspective...

b [ MultiBallmo Close Perspective

» [ VanDerPol.mo Close All Perspectives
[X] project Mavigation b
> =k Libraries Preferences

b Qg = OpenModelica [OpenModelic

Figure 14.7: Eclipse — Switching to another perspective — e.g. the Java Perspective.

14.3.8 Creating a Class

To create a new Modelica class, select where in the hierarchy that you want to add your new class and select
File->New->Modelica Class. When creating a Modelica class you can add different restrictions on what the class
can contain. These can for example be model, connector, block, record, or function. When you have selected
your desired class type, you can select modifiers that add code blocks to the generated code. ‘Include initial code
block’ will for example add the line ‘initial equation’ to the class.

14.3.9 Syntax Checking

Whenever a build command is given to the MDT environment, modified and saved Modelica (.mo) files are
checked for syntactical errors. Any errors that are found are added to the Problems view and also marked in the
source code editor. Errors are marked in the editor as a red circle with a white cross, a squiggly red line under the
problematic construct, and as a red marker in the right-hand side of the editor. If you want to reach the problem,
you can either click the item in the Problems view or select the red box in the right-hand side of the editor.

14.3.10 Automatic Indentation Support

MDT currently has support for automatic indentation. When typing the Return (Enter) key, the next line is indented
correctly. You can also correct indentation of the current line or a range selection using CTRL+I or “Correct
Indentation” action on the toolbar or in the Edit menu.

14.3.11 Code Completion

MDT supports Code Completion in two variants. The first variant, code completion when typing a dot after a class
(package) name, shows alternatives in a menu. Besides the alternatives, Modelica documentation from comments
is shown if is available. This makes the selection easyer.

14.3. Getting Started 147



OpenModelica User’s Guide, Release v1.13.0

New Modelica Package

Modelica Package -

Create a new Modelica package.

Source folder: | PPCO970 | | Browse...
Name: Core

Description: | This package contains the core stuff

[ ] is encapsulated package

Finish || Cancel

Figure 14.8: Creating a new Modelica package.
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New Modelica Class

Modelica Class

Create a new Modelica class.

Source folder: | PPCO70/Core | | Browse...
Mame: ALU
Type: block hd |

Modifiers: include initial equation block
[ ] is partial class

[l

Finish || Cancel

Figure 14.9: Creating a new Modelica class.
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Madelica - ALU.mo - Eclipse SDK
File Edit Mavigate Search Project S5WT Hierarchy Run Window Help

I=AERENE X R JCSIR £ | % Modelica) >

|t &~

' = = = 4
% Modeli... 3 = ALU.mc =
- HPPCO7D block ALU E!

=
& Core equation

M ALU.mo .

M package.mo D inital equation
.project

end ALU; ;
[» =i System Library al |r]u
¥ —*l - =9 )
Console [£i Problems 2 = B
2 errors, 0 warnings, 0 infos
Description Resource |In Folder Location

(X unexpected token  ALU.mo PPCO970/Core  line 5
@ unexpected token  ALU.mo PPCO970/Core  line 5

L] NE3EN | 1+

Figure 14.10: Syntax checking.

= Modelica - DCEngine.mo - Eclipse SDK
File Edit Refactor Mavigate Search Run Projeck  Window Help

IB-Held | Q- |+ [eoe-a -

3 T
(v Modelica Projects 53 = 0| vl *oCEngine.ma &2
El{ﬁ EngineSimulation “model DCEngine
#- M| DCEngine.ma import Hudelica.l
o -projeck equation
i Blocks
[=1-m Standard Library gc ot
: ' onstants
ElEE Edelhcaks end DCEngine: 8 Electrical
-3 Bloc
#f3 Constants £ 1c0ns
i+ Electrical £ Math
- H Ieons B3 Mechanics
= H3 Math £ sIunits
Ce [ oacos B Thermal
- asin
- atan
#- - atan2
[~ baselcani

Figure 14.11: Code completion when typing a dot.
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The second variant is useful when typing a call to a function. It shows the function signature (formal param-
eter names and types) in a popup when typing the parenthesis after the function name, here the signature Real
sin(SI.Angle u) of the sin function:

= Modelica - DCEngine.mo - Eclipse SDK
File Edit Refactor Mawigate Search Run Project  ‘Window  Help

L={_|}'|_|3_|[; nt %" ‘C,:l;' ’E:Zl{::"

(M Madelica Projects 52 =0 *DCEngine. mo o
=122 EngineSimulation model DCEngine
+ DCEngine. mo import Modelica.Math.*;
=] .project output Real x;
—|--=, Standard Library equation
= Modelica Real sin{51Angle U} |
+--f3 Blacks % o= gimf
+- 3 Constants
+- 3 Electrical -
end DCEngine;
+-f4 Icons d

Figure 14.12: Code completion at a function call when typing left parenthesis.

14.3.12 Code Assistance on Identifiers when Hovering

When hovering with the mouse over an identifier a popup with information about the identifier is displayed. If the
text is too long, the user can press F2 to focus the popup dialog and scroll up and down to examine all the text. As
one can see the information in the popup dialog is syntax-highlighted.

B 8Java | [E Modelica

BouncingBall.mo £3 = 8

1- model MultiBall
2 BouncingBall balls[3];
3 en =l

model BouncingBall "A simple bouncing ball"
parameter Real e @.7 "coefficient of restitution";
parameter Real g 9.81 "gravity acceleration";
Real h{start = 1) "height of ball";
Real v "velocity of ball";
Boolean Tlying(start = true) "true, if ball is flying";
Boolean impact;
Real v_new;
Integer fToo;
equation
impact = h <= 0.0;

Press F2 to focus|

Figure 14.13: Displaying information for identifiers on hovering.

14.3.13 Go to Definition Support

Besides hovering information the user can press CTRL+click to go to the definition of the identifier. When
pressing CTRL the identifier will be presented as a link and when pressing mouse click the editor will go to the
definition of the identifier.
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14.3.14 Code Assistance on Writing Records

When writing records, the same functionality as for function calls is used. This is useful especially in MetaMod-
elica when writing cases in match constructs.

®  &'Java | @ Modelica|

*Absynmo = O

end FuncT; -
algorithm
outArgs := match outArgs

case FUNCTIONARGS()

algorithm
outArgs.args := list(inFunc{arg, inArg) for arg in outArgs.args);
then
outArgs;
FOR_ITER_FARG(Exp exp, ReductionlterType iterType, Forlterators iterators)
case FOR_ITER_FARG(
algorithm
outArgs.exp := inFunc(outArgs.exp, inArg);
outArgs.iterators := list(traverseExpShallowlterator({it, inArg, inFunc
for it in outArgs.iterators);
then
outArgs;

end match;
end traverseExpShallowFuncArgs;

Figure 14.14: Code assistance when writing cases with records in MetaModelica.

14.3.15 Using the MDT Console for Plotting
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¢ Modelica - Eclipse

File Edit MNavi

B  &'Java [ Modelical

[ Modelica Projects = g BouncingBall. mo = g

1= model BouncingBall

2 parameter Real e=0.7 "coefficient of restitution";
parameter Real g=9.81 "gravity acceleration";

Real h(start=1) "height of ball";

Real v "wvelocity of ball";

Boolean flying(start=true) "true, 1f ball is flying";
Boolean impact;

Real v_new;

Integer foo;

2% ¥
> (M demo

equation
impact = h <= 8.8;
foo = if impact then 1 else 2;
der(v) = if flying then -g else @;
der(h) = v;
when {h <= 0.6 and v <= ©.8, impact} then
v_new = if edge(impact) then -e*pre(v) else 0;
flying = v_new > 0;
reinit(v, v_new);
end when;
5= Outline 2 v = 0
mmed DrimedinaDal1 .

An outline is not available.

[*! Problems & conscle 2 [JlBookmarks sgP

I
No consoles to display at this time. 1 Java Stack Trace Console
m2 2 Maven Console
B3 cvs
4 New Console View

[
DT Console

Figure 14.15: Activate the MDT Console.
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[

File Edit Ns e & rch  Project Run  Window Help
= A DT & - ! Correct Indentation | Build project
o & dava | © Modelica |

[Ff Modelica Projects = [+l BouncingBall.mo &8 = B8

1= model BouncingBall

2 parameter Real e=0.7 "coefficient of restitution";
parameter Real g=9.81 "gravity acceleration";
Real h(start=1) "height of ball";

Real v "velocity of ball";

BES -
¥ (& demo
» [ BouncingBall.mo
» [ VanDerPol.mo

oo W

3] Boolean flying(start=true) "true, if ball is flying";
[¥] project 7 Boolean impact; ¢ OMPlot - OpenModelica
b = Libraries 8 Real v_new; File Opti
9 Integer foo; —IE LTS
10 Zoom | Pan || AutoScale | Fitin View »
equation
12 impact = h <= ©8.0; __
13 Too = 1T impact then 1 else 2;
der(v) = if flying then -g else 0; 1
5 der(h) = v; 08 35
0.6 5
17 when {h <= 0.0 and v <= 0.0,impact} then 0.4 4
18 v_new = if edge(impact) then -e*pre(v) else € p 3 \ /
flying = v_new > 0; V=
20 reinit{wv, v_new);
21 end when; 1] 0.5 1 15 2 25 3
5= Outline = g 22 time
292 and DAromednaDa17 .
PN U
v BouncingBall 2 Problems & console __|].|E‘.:--:-I<m-arl<3 Progress 5 ] e ]
°e OpenModelica Console
o flying omc> simulate(BouncingBall, stopTime=3.0) e
° foo record SimulationResult
° resultFile = "/tmp/BouncingBall_res.mat",
9 simulationOptions = "startTime = 0.8, stopTime = 3.8, numberOfIntervals = 500, toler
°h messages = "',
© impact t::LmeFronten-:I = 0.010819273,
timeBackend = 0.801918553,
o v timeSimCode = ©.811109793,
o v new timeTemplates = 0.Q007479943,
- timeCompile = 1.035183591,
timeSimulation = ©.813518222,
timeTotal = 1.080146115
end SimulationResult;
omc> plot(h) =

Figure 14.16: Simulation from MDT Console.

154 Chapter 14. MDT - The OpenModelica Development Tooling Eclipse Plugin



CHAPTER
FIFTEEN

MDT DEBUGGER FOR ALGORITHMIC MODELICA

The algorithmic code debugger, used for the algorithmic subset of the Modelica language as well as the Meta-
Modelica language is described in Section The Eclipse-based Debugger for Algorithmic Modelica. Using this
debugger replaces debugging of algorithmic code by primitive means such as print statements or asserts which
is complex, time-consuming and error- prone. The usual debugging functionality found in debuggers for proce-
dural or traditional object-oriented languages is supported, such as setting and removing breakpoints, stepping,
inspecting variables, etc. The debugger is integrated with Eclipse.

15.1 The Eclipse-based Debugger for Algorithmic Modelica

The debugging framework for the algorithmic subset of Modelica and MetaModelica is based on the Eclipse
environment and is implemented as a set of plugins which are available from Modelica Development Tooling
(MDT) environment. Some of the debugger functionality is presented below. In the right part a variable value is
explored. In the top-left part the stack trace is presented. In the middle-left part the execution point is presented.

The debugger provides the following general functionalities:
¢ Adding/Removing breakpoints.
 Step Over — moves to the next line, skipping the function calls.
* Step In — takes the user into the function call.

¢ Step Return — complete the execution of the function and takes the user back to the point from where
the function is called.

 Suspend — interrupts the running program.

15.1.1 Starting the Modelica Debugging Perspective

To be able to run in debug mode, one has to go through the following steps:
* create a mos file
* setting the debug configuration
* setting breakpoints
* running the debug configuration

All these steps are presented below using images.

Create mos file

In order to debug Modelica code we need to load the Modelica files into the OpenModelica Compiler. For this we
can write a small script file like this:
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& Debug - trunk/Compiler/FrontEnd /Inst.mo - Eclipse SDK - |E| 1[
File Edit Mavigate Search Project Run Window Help
J - (=] ‘ o1 J -0 -G - J [ I J - - L b J Correct Indentation Build project it ﬁDEhug >
%5 Debug 23 [ 7] | 2 TR | i = = O [t Variables 52 %o Ereakpomts} k5 | = =0
% moT coB [Modelica Developement Tooling (MOT) GDE] 2| _Name | Dedared Type | Value <
EJ@ MOT @ cache record<Env.Cache.CACHE>  record<Env.Cache.CACHE
o Main Thread (stepping) @ e record<5CodeRestriction.R... record=<5Code.Restriction.
= instClassdef2 at Inst.mo: 3434 ¥ pre record<Prefix.Prefic NOPRE> | record <Prefix.Prefix NOPR
= instClassdef at Inst.mo:3075 E @ eqgs list<record<5Code.Equatio... <2 items>
= instClassIn_ dispatch at Inst.mo:2140 B @ [1] record«<5Code.Equation.EQ...  record<5Code.Equation.E
= instClassIn at Inst.mo: 1813 = % eEquation record<5Code.EEquation.E... | record<5Code.EEquation.t
= instClass at Inst.mo: 1233 = & expleft record < Absyn Exp.CREF> record < Absyn.Bxp. CREF=
= instProgram at Inst.mo: 1055 1 E % compenentRe record<Absyn.Component...  record<Absyn.Componen
= instProgram at Inst.mo: 1085 # name String "
= instantiate at Inst.mo:227 @ subscripts list<Any> <0 item>
= instantizte at Main.mo:693 LI E % expRight record<Absyn.Exp.CALL> record = Absyn.Exp. CALL>
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Instmo &2 Interactive.mo W QuotedFunction.mo a4 = @ functionArgs record<Absyn.FunctionArg... record<Absyn.FunctionAr
normalAlgorithmlst = alg, ini:ialAlgnritnrrL;I A4 .comment Option<Any> NONEQ
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(cdefelts, extendsclasselts, extendselts, compelts) = splitE @ columnMNumt Integer 3
@ lineNumberEr Integer 12
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- E @ buildTimes  record<Absyn.TimeStamp.... record<Absyn. TimeStamp
4] | 3 ¥ lastBuildTi Real 0
~ @ lastEditTin Real 0
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B Console 5 \ﬁ,TasksW [2¢ Pmb‘qu G Execu‘table;] = ¥ els list<record<SCode.Element... <2 items>
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Figure 15.1: Debugging functionality.

function HelloWorld
input Real r;
output Real o;

algorithm
o 2 % r;

end HelloWorld;

>>> getCommandLineOptions ({"-d=rml, noevalfunc","-g=MetaModelica"})
{true, true}

>>> setCFlags (getCFlags ()
true

>>> HelloWorld(120.0)

+ " 7gn)

So lets say that we want to debug HelloWorld.mo. For that we must load it into the compiler using the script file.
Put all the Modelica files there in the script file to be loaded. We should also initiate the debugger by calling the
starting function, in the above code HelloWorld (120.0);

Setting the debug configuration

While the Modelica perspective is activated the user should click on the bug icon on the toolbar and select Debug
in order to access the dialog for building debug configurations.

To create the debug configuration, right click on the classification Modelica Development Tooling (MDT) GDB
and select New as in figure below. Then give a name to the configuration, select the debugging executable to
be executed and give it command line parameters. There are several tabs in which the user can select additional
debug configuration settings like the environment in which the executable should be run.

Note that we require Gnu Debugger (GDB) for debugging session. We must specify the GDB location, also we
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Figure 15.2: Accessing the debug configuration dialog.
must pass our script file as an argument to OMC.

Setting/Deleting Breakpoints

The Eclipse interface allows to add/remove breakpoints. At the moment only line number based breakpoints are
supported. Other alternative to set the breakpoints is; function breakpoints.

Starting the debugging session and enabling the debug perspective

15.1.2 The Debugging Perspective

The debug view primarily consists of two main views:
 Stack Frames View
* Variables View

The stack frame view, shown in the figure below, shows a list of frames that indicates how the flow had moved
from one function to another or from one file to another. This allows backtracing of the code. It is very much
possible to select the previous frame in the stack and inspect the values of the variables in that frame. However,
it is not possible to select any of the previous frame and start debugging from there. Each frame is shown as
<function_name at file_name:line_number>.

The Variables view shows the list of variables at a certain point in the program, containing four colums:
* Name — the variable name.
* Declared Type — the Modelica type of the variable.
* Value — the variable value.

e Actual Type — the mapped C type.
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Figure 15.3: Creating the Debug Configuration.
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Figure 15.6: Eclipse will ask if the user wants to switch to the debugging perspective.
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By preserving the stack frames and variables it is possible to keep track of the variables values. If the value of
any variable is changed while stepping then that variable will be highlighted yellow (the standard Eclipse way of
showing the change).
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Figure 15.7: The debugging perspective.
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CHAPTER
SIXTEEN

MODELICA PERFORMANCE ANALYZER

A common problem when simulating models in an equation-based language like Modelica is that the model may
contain non-linear equation systems. These are solved in each time-step by extrapolating an initial guess and
running a non-linear system solver. If the simulation takes too long to simulate, it is useful to run the performance
analysis tool. The tool has around 5~25% overhead, which is very low compared to instruction-level profilers
(30x-100x overhead). Due to being based on a single simulation run, the report may contain spikes in the charts.

When running a simulation for performance analysis, execution times of user-defined functions as well as linear,
non-linear and mixed equation systems are recorded.

To start a simulation in this mode, just use the measureTime flag of the simulate command.

>>> simulate (modelname, measureTime = true)

The generated report is in HTML format (with images in the SVG format), stored in a file modelname_prof.html,
but the XML database and measured times that generated the report and graphs are also available if you want to
customize the report for comparison with other tools.

Below we use the performance profiler on the simple model A:

model ProfilingTest
function £
input Real r;

output Real o = sin(r);

end £f;

String s = "abc";

Real x = f(x) "This is x";

Real y(start=1);

Real z1 = cos(z2);

Real z2 = sin(zl);
equation

der (y) = time;

end ProfilingTest;

We simulate as usual, but set measureTime=true to activate the profiling:

>>> getCommandLineOptions ("-—-profiling=blocks+html")
true

>>> simulate (ProfilingTest)

record SimulationResult

resultFile = "«DOCHOME»/ProfilingTest_res.mat",

simulationOptions = "startTime = 0.0, stopTime = 1.0, numberOfIntervals = 500,
—tolerance = 1le-06, method = 'dassl', fileNamePrefix = 'ProfilingTest', options =
—''", outputFormat = 'mat', variableFilter = '.x', cflags = '', simflags = ''",

messages = "LOG_SUCCESS | info | The initialization finished,
—successfully without homotopy method.
LOG_SUCCESS | info | The simulation finished successfully.

Warning: empty y range [1:1], adjusting to [0.99:1.01]
Warning: empty y range [1l:1], adjusting to [0.99:1.01]
Warning: empty y range [1:1], adjusting to [0.99:1.01]

(continues on next page)
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(continued from previous page)

Warning: empty y range [1:1], adjusting to [0.99:1.01]

Warning: empty y range [1:1], adjusting to [0.99:1.01]

Warning: empty y range [1:1], adjusting to [0.99:1.01]

stdout | info | Time measurements are stored in ProfilingTest_prof.
—html (human-readable) and ProfilingTest_prof.xml (for XSL transforms or more

—details)

n
’

timeFrontend = 0.013299116,

timeBackend = 0.019643247,

timeSimCode 0.191094251,

timeTemplates = 0.1090793839999999,

timeCompile = 0.7003446240000001,

timeSimulation = 0.077946421,

timeTotal = 1.111527691
end SimulationResult;
"Warning: The initial conditions are not fully specified. For more information set,
—-d=initialization. In OMEdit Tools->Options->Simulation->OMCFlags, in OMNotebook_,
—~call setCommandLineOptions ("-d=initialization").
Warning: There are iteration variables with default zero start attribute. For more_
—information set -d=initialization. In OMEdit Tools->Options->Simulation->
—OMCFlags, in OMNotebook call setCommandLineOptions ("-d=initialization").

n

16.1 Profiling information for ProfilingTest

16.1.1 Information

All times are measured using a real-time wall clock. This means context switching produces bad worst-case
execution times (max times) for blocks. If you want better results, use a CPU-time clock or run the command
using real-time priviliges (avoiding context switches).

Note that for blocks where the individual execution time is close to the accuracy of the real-time clock, the
maximum measured time may deviate a lot from the average.

For more details, see ProfilingTest_prof.xml.

16.1.2 Settings

Name Value

Integration method | dassl

Output format mat

Output name ProfilingTest_res.mat
Output size 24.0kB

Profiling data ProfilingTest_prof.data
Profiling size 0B
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16.1.3 Summary

Task Time Fraction
Pre-Initialization 0.000130 | 2.27%
Initialization 0.000161 | 2.81%
Event-handling 0.000030 | 0.52%
Creating output file 0.000461 | 8.04%
Linearization NaN%
Time steps 0.004065 | 70.87%
Overhead 0.000358 | 6.24%
Unknown NaN NaN%
Total simulation time | 0.005736 | 100.00%
16.1.4 Global Steps
Steps | Total Time | Fraction | Average Time Max Time Deviation
- 499 0.004065 70.87% 8.14629258517034e-06 | 0.000725457 | 88.05x
16.1.5 Measured Function Calls
Name Calls | Time Fraction | Max Time Deviation
kit ProfilingTest.f | 506 0.000009717 | 0.17% 0.000001083 | 55.40x
16.1.6 Measured Blocks
Name Calls | Time Fraction | Max Time Deviation
o ‘<#teq0>__ | 7 0.000089051 | 1.55% 0.000090797 | 6.14x
o ‘<tteql2>‘__ | 2 0.000002937 | 0.05% 0.000003228 | 1.20x
e ¢ <#eq20>‘__ | 504 0.001332029 | 23.22% | 0.000714986 | 269.53x
WWMWM ‘<#eq22>‘__ | 504 0.001041698 | 18.16% | 0.000026331 | 11.74x

16.1. Profiling information for ProfilingTest
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Equations
Name Variables
‘eq0 <>¢___
‘eql <>¢__ Y
‘eq2 <>¢__ 5
‘eq3 <>¢__
2
‘eqd <>°__ ¢
‘eqS <>¢__
‘eqb <> ¢ <fvarO0>°
‘eql <> ¢ <#varO0>‘__
¢ <#var(0>*
‘eq8 <>¢__ vart> —
¢ <#var()>*
‘eq9 <>¢__ vart> —
1
‘eql0 <>¢__ ¢
‘eqll <>¢__
‘eql2 <>¢__ o
d
‘eql3 <>¢__ er(y)
72
‘eqld <>¢__
‘eqlS <>¢__
¢ <#tvar0>*
‘eql6 <>¢__ var> —
¢ <#var0>*
‘eql7 <>¢__ vart> —
¢ <#var0>*
‘eql8 <>¢__ vart> —
¢ <#tvar0>*
‘eql9 <>¢__ vart> —
1
‘eq20 <>__ ¢
‘eq2l <>¢__
X
‘eq22 <>¢__
‘eq23 <>¢__
Variables
Name | Comment
Yy
der(y)
X This is x
z1
72
S

This report was generated by OpenModelica on 2018-12-20 23:41:23.
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16.2 Genenerated JSON for the Example

Listing 16.1: ProfilingTest_prof.json

{

"name":"ProfilingTest",

"prefix":"ProfilingTest",

"date":"2018-12-20 23:41:23",

"method":"dass1l",

"outputFormat":"mat",
"outputFilename":"ProfilingTest_res.mat",
"outputFilesize":24581,

"overheadTime":0.000357898,

"preinitTime":0.00013032,

"initTime":0.000160625,

"eventTime":2.973e-05,

"outputTime":0.000461499,

"jacobianTime":1.3889%e-05,

"totalTime":0.00573582,

"totalStepsTime":6.218e-06,
"totalTimeProfileBlocks":0.00246572,

"numStep":499,

"maxTime":0.000725457,

"functions": [

{"name":"ProfilingTest.f", "ncall":506,"time":0.000009717, "maxTime":0.000001083}
]I

"profileBlocks": [

{"id":0, "ncall":7, "time":0.000089051, "maxTime" :0.000090797},
{"id":12, "ncall":2, "time":0.000002937, "maxTime":0.000003228},
{"id":20, "ncall":504, "time":0.001332029, "maxTime":0.000714986},
{("id":22,"ncall":504, "time":0.001041698, "maxTime":0.000026331}
1

}

16.3 Using the Profiler from OMEdit

When running a simulation from OMEdit, it is possible to enable profiling information, which can be combined
with the transformations browser.

When profiling the DoublePendulum example from MSL, the following output in Figure 16.2 is a typical result.
This information clearly shows which system takes longest to simulate (a linear system, where most of the time
overhead probably comes from initializing LAPACK over and over).

16.2. Genenerated JSON for the Example 167



http://www.netlib.org/lapack/

OpenModelica User’s Guide, Release v1.13.0

General Output SimulationFlags|

Model Setup File (Optional): | | Browse...

Initialization Method (Optional): | =

Optimization Method (Optional): | =

Equation System Initialization File (Optional): | || Browse.. | |

Equation System Initialization Time (Optional): | |

Clock (Optional): | =

Linear Solver (Optional): | =

Non Linear Solver (Optional): | =
none

Linearization Time (Optional): blocks

Output Variables (Optional): blocks+html

Profiling (enable performance measurements) [l

[] CPU Time
& Enable all warnings

-

[] save simulation settings inside model Cancel

Figure 16.1: Setting up the profiler from OMEdit.

[Equations Browser | [Defines
Index Type  Equation Executions Maxtime Time Fraction + ||~ |Variable -
876 regular linear, size 2 4602 0.000199 0.0582 86.2% i damper.a_rel

836 regular (assignment) revolute2.R_rel.T[2,2] = cos(revolute2.phi) 1534 8.25e-05 0.000491 0.728% revolute2.frame_b.f2]
837 regular (assignment) revolute2.R_rel.T[2,1] = -sin(revolute2.phi) 1534 7.29e-05  0.000422 0.625%

841 regular (assignment) boxBody1.frame_...[2,1] =-sin(damper.phi_rel) 1534 7.1e-05 0.000395 0.585%

-840 regular (assignment) boxBody1.frame_...T[2,2] = cos{damper.phi_rel) 1534 7.08e-05  0.000361 0.535%

839 regular (assignment) revolute2.R_rel.T[1,1] = cos(revolute2.phi) 1534 7.33e-05  0.000303 0.449%

842 regular (assignment) boxBody1.frame_b.R.T[1,2] = sin(damper.phi_rel) 1534 7.45e-05  0.000303 0.449%

838 regular (assignment) revolute2.R_rel.T[1,2] = sin(revolute2.phi) 1534 7.11e-05  0.0003 0.444%

849 regular (assignment) boxBody1.frame_...T[1,1] = cos(damper.phi_rel) 1534 7.29e-05  0.000286 0.424%

827 regular (assignment) revolute1.tau = (-damper.d) * revolute1.w 1534 6.84e-05  0.000274 0.406%

Figure 16.2: Profiling results of the Modelica standard library DoublePendulum example, sorted by execution
time.
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CHAPTER
SEVENTEEN

SIMULATION IN WEB BROWSER

OpenModelica can simulate in a web browser on a client computer by model code being compiled to efficient
Javacript code.

For more information, see https://github.com/tshort/openmodelica-javascript

Below used on the MSL MultiBody RobotR3.fullRobot example model.
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CHAPTER
EIGHTEEN

INTEROPERABILITY — C AND PYTHON

Below is information and examples about the OpenModelica external C interfaces, as well as examples of Python
interoperability.

18.1 Calling External C functions

The following is a small example (ExternalLibraries.mo) to show the use of external C functions:

model Externallibraries

function ExternalFuncl
input Real x;
output Real y;
external y=ExternalFuncl_ext (x) annotation (Library="ExternalFuncl.o",
—LibraryDirectory="modelica://ExternallLibraries", Include="#include \
< "ExternalFuncl.h\"");
end ExternalFuncl;

function ExternalFunc2
input Real x;
output Real y;
external "C" annotation(Library="ExternalFunc2", LibraryDirectory="modelica://
—Externallibraries");
end ExternalFunc2;

Real x(start=1.0, fixed=true), y(start=2.0, fixed=true);
equation

der (x) =—ExternalFuncl (x);

der (y) =—-ExternalFunc2 (y) ;
end Externallibraries;

These C (.c) files and header files (.h) are needed (note that the headers are not needed since OpenModelica will
generate the correct definition if it is not present; using the headers it is possible to write C-code directly in the
Modelica source code or declare non-standard calling conventions):

Listing 18.1: ExternalFuncl.c

double ExternalFuncl_ext (double x)
{

double res;

res = x+2.0*x*x;

return res;
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Listing 18.2: ExternalFuncl.h

double ExternalFuncl_ext (double) ;

Listing 18.3: ExternalFunc2.c

double ExternalFunc?2 (double x)
{
double res;
res = (x-1.0)#*(x+2.0);
return res;

The following script file ExternalLibraries.mos will perform everything that is needed, provided you have gcc
installed in your path:

>>> system(getCompiler () + " —-c -o ExternalFuncl.o ExternalFuncl.c")
0

>>> system(getCompiler () + " -c -o ExternalFunc2.o ExternalFunc2.c")
0

>>> system("ar rcs libExternalFunc2.a ExternalFunc2.o")

0

>>> simulate (ExternallLibraries)
record SimulationResult

resultFile = "«DOCHOME»/ExternallLibraries_res.mat",

simulationOptions = "startTime = 0.0, stopTime = 1.0, numberOfIntervals = 500,
—tolerance = 1le-06, method = 'dassl', fileNamePrefix = 'Externallibraries',
—options = '', outputFormat = 'mat', variableFilter = '.x', cflags = '', simflags,

messages = "LOG_SUCCESS | info | The initialization finished,
—successfully without homotopy method.
LOG_SUCCESS | info | The simulation finished successfully.

n
’

timeFrontend = 0.007654909000000001,

timeBackend = 0.002636743,
timeSimCode = 0.174636418,
timeTemplates = 0.09049272200000001,

timeCompile = 0.660000159,
timeSimulation = 0.008497968,
timeTotal = 0.944024443

end SimulationResult;

And plot the results:

18.2 Calling external Python Code from a Modelica model

The following calls external Python code through a very simplistic external function (no data is retrieved from the
Python code). By making it a dynamically linked library, you might get the code to work without changing the
linker settings.

function pyRunString

input String s;
external "C" annotation(Include="
#include <Python.h>

void pyRunString(const char =str)

{
Py_SetProgramName (\"pyRunString\"); /% optional but recommended x/
Py_Initialize();

(continues on next page)
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Figure 18.1: Plot generated by OpenModelica+gnuplot
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PyRun_SimpleString(str);
Py_Finalize();

}

")

end pyRunString;

model CallExternalPython
algorithm
pyRunString ("
print 'Python says: simulation time',"+String(time)+"
")

end CallExternalPython;

>>> system("python-config --cflags > pycflags")

0

>>> system("python-config --ldflags > pyldflags")

0

>>> pycflags := stringReplace (readFile ("pycflags™),"\n","");
>>> pyldflags := stringReplace (readFile("pyldflags™),"\n","");
>>> setCFlags (getCFlags () tpycflags)

true

>>> getLinkerFlags (getLinkerFlags () +pyldflags)

true

>>> simulate (CallExternalPython, stopTime=2)
record SimulationResult

resultFile = "«DOCHOME»/CallExternalPython_res.mat",

simulationOptions = "startTime = 0.0, stopTime = 2.0, numberOflIntervals = 500,
—tolerance = 1le-06, method = 'dassl', fileNamePrefix = 'CallExternalPython',
—options = '', outputFormat = 'mat', variableFilter = '.x', cflags = '', simflags,
—= ""I

messages = "Python says: simulation time 0
Python says: simulation time 0
LOG_SUCCESS | info | The initialization finished successfully without,

—homotopy method.
Python says: simulation time 2
LOG_SUCCESS | info | The simulation finished successfully.

n
’

(continues on next page)
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timeFrontend = 0.003238336,
timeBackend = 0.014105545,
timeSimCode 0.18271234,
timeTemplates = 0.098706874,
timeCompile = 0.780786795,
timeSimulation = 0.036554899,
timeTotal = 1.116229537

end SimulationResult;

18.3 Calling OpenModelica from Python Code

This section describes a simple-minded approach to calling Python code from OpenModelica. For a description
of Python scripting with OpenModelica, see OMPython — OpenModelica Python Interface.

The interaction with Python can be perfomed in four different ways whereas one is illustrated below. Assume that
we have the following Modelica code:

Listing 18.4: CalledbyPython.mo

model CalledbyPython
Real x(start=1.0), y(start=2.0);
=2

parameter Real b .0;
equation
der (x) = -bxy;

der (y) = x;
end CalledbyPython;

In the following Python (.py) files the above Modelica model is simulated via the OpenModelica scripting inter-
face:

Listing 18.5: PythonCaller.py

#!/usr/bin/python

import sys,os

global newb = 0.5
execfile('CreateMosFile.py"')

os.popen (r"omc CalledbyPython.mos") .read()
execfile('RetrResult.py")

Listing 18.6: CreateMosFile.py

#!/usr/bin/python

mos_file = open('CalledbyPython.mos','w', 1)

mos_file.write('loadFile ("CalledbyPython.mo");\n")

mos_file.write ('setComponentModifierValue (CalledbyPython,b, $Code (="+str (newb)+"));
—\n")

mos_file.write('simulate (CalledbyPython, stopTime=10);\n")

mos_file.close()

Listing 18.7: RetrResult.py

#!/usr/bin/python

def zeros(n): #
vec = [0.0]
for i in range(int(n)-1): vec = vec + [0.0]

return vec
res_file = open("CalledbyPython_res.plt",'r',1)
line = res_file.readline ()

(continues on next page)
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size = int(res_file.readline() .split('=")[1])
time = zeros(size)
y = zeros(size)
while line != ['DataSet: time\\n']:
line = res_file.readline() .split (', ") [0:1]
for j in range (int (size)):
time[j]l=float (res\_file.readline () .split (', ") [0])
while line != ['DataSet: y\\n']:
line=res_file.readline () .split (', ") [0:1]
for j in range (int (size)):
y[jl=float (res\_file.readline () .split (', ") [1])
res_file.close()

A second option of simulating the above Modelica model is to use the command buildModel instead of the simulate
command and setting the parameter value in the initial parameter file, CalledbyPython_init.txt instead of using the
command setComponentModifierValue. Then the file CalledbyPython.exe is just executed.

The third option is to use the Corba interface for invoking the compiler and then just use the scripting interface to
send commands to the compiler via this interface.

The fourth variant is to use external function calls to directly communicate with the executing simulation process.
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CHAPTER
NINETEEN

OPENMODELICA PYTHON INTERFACE AND PYSIMULATOR

This chapter describes the OpenModelica Python integration facilities.

¢ OMPython — the OpenModelica Python scripting interface, see OMPython — OpenModelica Python Inter-
Jace.

* EnhancedOMPython - Enhanced OMPython scripting interface, see Enhanced OMPython Features.

» PySimulator — a Python package that provides simulation and post processing/analysis tools integrated with
OpenModelica, see PySimulator.

19.1 OMPython — OpenModelica Python Interface

OMPython — OpenModelica Python API is a free, open source, highly portable Python based interactive ses-
sion handler for Modelica scripting. It provides the modeler with components for creating a complete Modelica
modeling, compilation and simulation environment based on the latest OpenModelica library standard available.
OMPython is architectured to combine both the solving strategy and model building. So domain experts (people
writing the models) and computational engineers (people writing the solver code) can work on one unified tool
that is industrially viable for optimization of Modelica models, while offering a flexible platform for algorithm de-
velopment and research. OMPython is not a standalone package, it depends upon the OpenModelica installation.

OMPython is implemented in Python and depends either on the OmniORB and OmniORBpy - high performance
CORBA ORBs for Python or ZeroMQ - high performance asynchronous messaging library and it supports the
Modelica Standard Library version 3.2 that is included in starting with OpenModelica 1.9.2.

To install OMPython follow the instructions at https://github.com/OpenModelica/OMPython

19.1.1 Features of OMPython

OMPython provides user friendly features like:

* Interactive session handling, parsing, interpretation of commands and Modelica expressions for evaluation,
simulation, plotting, etc.

* Interface to the latest OpenModelica API calls.
* Optimized parser results that give control over every element of the output.
 Helper functions to allow manipulation on Nested dictionaries.

 Easy access to the library and testing of OpenModelica commands.

19.1.2 Test Commands

OMPython provides two classes for communicating with OpenModelica i.e., OMCSession and OMCSes-
sionZMQ. Both classes have the same interface, the only difference is that OMCSession uses omniORB and
OMCSessionZMQ uses ZeroMQ. All the examples listed down uses OMCSessionZMQ but if you want to test
OMCSession simply replace OMCSessionZMQ with OMCSession. We recommend to use OMCSessionZMQ.
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To test the command outputs, simply create an OMCSessionZMQ object by importing from the OMPython library
within Python interepreter. The module allows you to interactively send commands to the OMC server and display
their output.

To get started, create an OMCSessionZMQ object:

>>> from OMPython import OMCSessionZMQ
>>> omc = OMCSessionZMQ ()

>>> omc.sendExpression ("getVersion()")
OMCompiler v1.13.0
>>> omc.sendExpression("cd()")
«DOCHOME»
>>> omc.sendExpression ("loadModel (Modelica)")
True
>>> omc.sendExpression ("loadFile (getInstallationDirectoryPath() + \"/share/doc/omc/
—testmodels/BouncingBall.mo\")")
True
>>> omc.sendExpression("instantiateModel (BouncingBall)™)
class BouncingBall
parameter Real e 0.7 "coefficient of restitution";
parameter Real g 9.81 "gravity acceleration";
Real h(start = 1.0, fixed = true) "height of ball";
Real v(fixed = true) "velocity of ball";
Boolean flying(start = true, fixed = true) "true, if ball is flying";
Boolean impact;
Real v_new(fixed = true);
Integer foo;

equation
impact = h <= 0.0;
foo = if impact then 1 else 2;

der(v) = if flying then -g else 0.0;

der (h) = v;

when {h <= 0.0 and v <= 0.0, impact} then
v_new = if edge (impact) then (-e) *» pre(v) else 0.0;
flying = v_new > 0.0;
reinit (v, v_new);

end when;

end BouncingBall;

We get the name and other properties of a class:

>>> omc.sendExpression ("getClassNames () ")
('BouncingBall', 'ModelicaServices', 'Complex', 'Modelica')
>>> omc.sendExpression("isPartial (BouncingBall) ™)

False

>>> omc.sendExpression ("isPackage (BouncingBall)")
False

>>> omc.sendExpression ("isModel (BouncingBall)")
True

>>> omc.sendExpression ("checkModel (BouncingBall) ")

Check of BouncingBall completed successfully.

Class BouncingBall has 6 equation(s) and 6 variable(s).

1 of these are trivial equation(s).

>>> omc.sendExpression("getClassRestriction (BouncingBall)")

model
>>> omc.sendExpression ("getClassInformation (BouncingBall) ™)
('model', '', False, False, False, '/var/lib/hudson/slave/workspace/OpenModelica_

—»SPHINX/OpenModelica/build/share/doc/omc/testmodels/BouncingBall.mo', False, 1, 1,
- 23, 17, (), False, False, '', '', False, ''")

>>> omc.sendExpression ("getConnectionCount (BouncingBall)")

0

(continues on next page)
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>>> omc.sendExpression ("getInheritanceCount (BouncingBall) ")
0

>>> omc.sendExpression ("getComponentModifierValue (BouncingBall,e)")

0.7

>>> omc.sendExpression ("checkSettings()")

{"OMDEV_PATH': '', 'C_COMPILER_RESPONDING': True, 'CONFIGURE_CMDLINE': "Configured,,
—2018-12-20 23:35:22 using arguments: '—--disable-option-checking —--prefix=/var/
—lib/hudson/slave/workspace/OpenModelica_SPHINX/OpenModelica/build —-without-
—cppruntime —--with-omniORB --enable-modelica3d CC=clang CXX=clang++ OMPCC=gcc -
—fopenmp CFLAGS=-02 -march=native --without-omc --with-omlibrary=core —--with-
—ombuilddir=/var/lib/hudson/slave/workspace/OpenModelica_SPHINX/OpenModelica/
—build --cache-file=/dev/null --srcdir=.'", 'SYSTEM_PATH': '/opt/ghc/bin:/usr/
—local/bin:/usr/bin:/bin:/usr/local/games:/usr/games:/var/lib/hudson/.local/bin/:/
—var/lib/hudson/.cabal/bin/', 'C_COMPILER': 'clang', 'WORKING_DIRECTORY':

— '«DOCHOME» ', 'RTLIBS': ' -1OpenModelicaRuntimeC -llapack -1lblas —1lm —-lomcgc —
—lpthread -rdynamic', 'OPENMODELICALIBRARY': '«OPENMODELICAHOME»/lib/omlibrary',

— 'REMOVE_FILE_WORKS': True, 'SYSTEM_INFO': 'Linux asap 4.4.0-139-generic #165-
—Ubuntu SMP Wed Oct 24 10:58:50 UTC 2018 x86_64 x86_64 x86_64 GNU/Linux\n',

— "MODELICAUSERCFLAGS': '', 'OMC_FOUND': True, 'C_COMPILER_VERSION': 'clang,
—version 3.8.0-2ubuntu4 (tags/RELEASE_380/final)\nTarget: x86_64-pc—-linux-—
—gnu\nThread model: posix\nInstalledDir: /usr/bin\n', 'OS': 'linux', 'HAVE_CORBA

—': True, 'CREATE_FILE_WORKS': True, 'OPENMODELICAHOME': '«OPENMODELICAHOME»',
—'"OMC_PATH': '«OPENMODELICAHOME»/bin/omc'}

The common combination of a simulation followed by getting a value and doing a plot:

>>> omc.sendExpression("simulate (BouncingBall, stopTime=3.0)")

{'timeBackend': 0.231908302, 'timeSimCode': 0.211655199, 'timeFrontend': O.
—215155645, 'messages': 'LOG_SUCCESS | info | The initialization,
—finished successfully without homotopy method.\nLOG_SUCCESS | info I
—The simulation finished successfully.\n', 'resultFile': '«DOCHOME»/BouncingBall_
—res.mat', 'timeTemplates': 0.098097135, 'simulationOptions': "startTime = 0.0,
—stopTime = 3.0, numberOfIntervals = 500, tolerance = le-06, method = 'dassl',_
—fileNamePrefix = 'BouncingBall', options = '', outputFormat = 'mat',
—variableFilter = '.x', cflags = '', simflags = '"'", 'timeCompile': 0.724859802,
—'timeSimulation': 0.015029607, 'timeTotal': 1.496849416}

>>> omc.sendExpression("val(h , 2.0)")

0.04239430772884106

Import As Library

To use the module from within another python program, simply import OMCSessionZMQ from within the using
program.

For example:

# test.py
from OMPython import OMCSessionZMQ
omc = OMCSessionZMOQ ()
cmds = [
"loadModel (Modelica) ",
"model test end test;",
'loadFile (getInstallationDirectoryPath() + "/share/doc/omc/testmodels/
—BouncingBall.mo") ',
"getIconAnnotation (Modelica.Electrical.Analog.Basic.Resistor)",
"getElementsInfo (Modelica.Electrical.Analog.Basic.Resistor)",
"simulate (BouncingBall)",
"plot (h)"
]

for cmd in cmds:

(continues on next page)
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answer = omc.sendExpression (cmd)
print ("\n{}:\n{}".format (cmd, answer))

19.1.3 Implementation

Client Implementation

The OpenModelica Python API Interface — OMPython, attempts to mimic the OMShell’s style of operations.
OMPython is designed to,

¢ Initialize the CORBA/ZeroMQ communication.

* Send commands to the OMC server via the CORBA/ZeroMQ interface.

* Receive the string results.

* Use the Parser module to format the results.

* Return or display the results.

19.2 Enhanced OMPython Features

Some more improvements are added to OMPython functionality for querying more information about the models
and simulate them. A list of new user friendly API functionality allows user to extract information about models
using python objects. A list of API functionality is described below.

To get started, create a ModelicaSystem object:

>>> from OMPython import ModelicaSystem
>>> mod=ModelicaSystem("BouncingBall.mo", "BouncingBall")

The object constructor requires a minimum of 2 input arguments which are strings, and may need a third string
input argument.

* The first input argument must be a string with the file name of the Modelica code, with Modelica file
extension ".mo". If the Modelica file is not in the current directory of Python, then the file path must also
be included.

¢ The second input argument must be a string with the name of the Modelica model including the namespace
if the model is wrapped within a Modelica package.

 The third input argument is used to specify the list of dependent libraries e.g.,

>>> mod=ModelicaSystem("BouncingBall.mo", "BouncingBall", ["Modelica",
—"SystemDynamics"])

* By default ModelicaSystem uses OMCSessionZMQ but if you want to use OMCSession then pass the
argument useCorba=True to the constructor.

19.2.1 Standard get methods

* getQuantities()
 getContinuous()
* getlnputs()

e getOutputs()

 getParameters()
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* getSimulationOptions()

* getSolutions()
Two calling possibilities are accepted using getXXX() where "XXX" can be any of the above functions (eg:)
getParameters().

e getXXX() without input argument, returns a dictionary with names as keys and values as values.

o getXXX(S), where S is a sequence of strings of names, returns a tuple of values for the specified names.

19.2.2 Usage of getMethods

>>> mod.getQuantities ()

// method-1,
[{'aliasvariable':

list of all variables from xml file

None, 'Name': 'height', 'Variability': 'continuous', 'Value':
—'1.0"'", 'alias': 'noAlias', 'Changeable': 'true', 'Description': None}, {
—'aliasvariable': None, 'Name': 'c', 'Variability': 'parameter', 'vValue': '0.9',
—~'alias': 'noAlias', 'Changeable': 'true', 'Description': None}]

>>> mod.getQuantities ("height")
—quantity
[{'aliasvariable':
—'1.0'", 'alias':

// method-2, to query information about single_,
None, 'Name':

'height', 'Variability':
'noAlias',

'continuous', 'Value':
'Changeable':

'true', 'Description': None}]

>>> mod.getQuantities (["c","radius"]) // method-3, to query information about list,,
—of quantity

[{'aliasvariable': None, 'Name':

'c', 'Variability': 'parameter', 'Value': '0.9',
—'alias': 'noAlias', 'Changeable': 'true', 'Description': None}, {'aliasvariable
—': None, 'Name': 'radius', 'Variability': 'parameter',6 'Value': '0.1', 'alias':
—'noAlias', 'Changeable': 'true', 'Description': None}]

>>> mod.getContinuous () // method-1,
{'velocity':

-1.825929609047952,
—': =-1.825929609047952,

list of continuous variable

'der (velocity)': -9.8100000000000005, 'der (height)
'height': 0.65907039052943617}

>>> mod.getContinuous ("velocity", "height") // method-2,
—value information

get specific variable,
(-1.825929609047952,

0.65907039052943617)

>>> mod.getInputs ()
{}

>>>

{}

mod.getOutputs ()

>>> mod.getParameters ()

// method-1
{'c": 0.9, 'radius': 0.1}

>>> mod.getParameters ("c", "radius") // method-2
(0.9, 0.1)

>>> mod.getSimulationOptions ()
{'stepSize': 0.002,

—': 'dassl'}

// method-1
'stopTime': 1.0, 'tolerance': 1le-06,

'startTime': 0.0, 'solver

>>> mod.getSimulationOptions ("stepSize","tolerance") // method-2
(0.002, 1e-06)
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>>> mod.getSolutions () // method-1 returns list of simulation variables for which
—results are available
['"time', 'height', 'velocity', 'der (height)', 'der (velocity)', 'c', 'radius']

>>> mod.getSolutions ("time", "height") // method-2, return list of numpy arrays

19.2.3 Standard set methods

* setInputs()
¢ setParameters()
* setSimulationOptions()
Two calling possibilities are accepted using setXXXs(),where "XXX" can be any of above functions.
* setXXX(k) with K being a sequence of keyword assignments (e.g.) (name = value).

e setXXX(D) with D being a dictionary with quantity names as keywords and values.

19.2.4 Usage of setMethods

’>>> mod.setInputs (cAi=1,Ti=2)

’>>> mod.setParameters (radius=14,c¢=0.5) // method-1 setting parameter value

>>> mod.setParameters (x+{"radius":14,"c":0.5}) // method-2 setting parameter value
—using second option

’>>> mod.setSimulationOptions (stopTime=2.0,tolerance=1e-08)

19.2.5 Simulation

An example of how to get parameter names and change the value of parameters using set methods and finally
simulate the "BouncingBall.mo" model is given below.

>>> mod.getParameters ()
{'c': 0.9, 'radius': 0.1}

>>> mod.setParameters (radius=14,c=0.5) //setting parameter value using first
—option

To check whether new values are updated to model , we can again query the getParameters().

>>> mod.getParameters ()
{'c'": 0.5, 'radius': 14}

And then finally we can simulate the model using.

>>> mod.simulate ()

19.2.6 Linearization

The following methods are proposed for linearization.

¢ linearize()
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* getLinearizationOptions()
* setLinearizationOptions()
* getLinearInputs()

* getLinearOutputs()

* getLinearStates()

19.2.7 Usage of Linearization methods

>>> mod.getLinearizationOptions () // method-1

{'"simflags': ' ', 'stepSize': 0.002, 'stopTime': 1.0, 'startTime': 0.0,
— 'numberOfIntervals': 500.0, 'tolerance': 1le-08}

>>> mod.getLinearizationOptions ("startTime", "stopTime") // method-2
(0.0, 1.0)

>>> mod.setlLinearizationOptions (stopTime=2.0,tolerance=1e-06)

’>>> mod.linearize () //returns a tuple of 2D numpy arrays (matrices) A, B, C and D.

>>> mod.getLinearInputs () //returns a list of strings of names of inputs used
—when forming matrices.

>>> mod.getLinearOutputs () //returns a list of strings of names of outputs used
—when forming matrices

>>> mod.getLinearStates () // returns a list of strings of names of states used,,
—when forming matrices.

19.3 PySimulator

PySimulator provides a graphical user interface for performing analyses and simulating different model types
(currently Functional Mockup Units and Modelica Models are supported), plotting result variables and applying
simulation result analysis tools like Fast Fourier Transform.

Read more about the PySimulator at https://github.com/PySimulator/PySimulator.
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CHAPTER
TWENTY

OMMATLAB - OPENMODELICA MATLAB INTERFACE

OMMatlab — the OpenModelica Matlab API is a free, open source, highly portable Matlab-based interactive
session handler for Modelica scripting. It provides the modeler with components for creating a complete Modelica
modeling, compilation and simulation environment based on the latest OpenModelica library standard available.
OMMatlab is architectured to combine both the solving strategy and model building. So domain experts (people
writing the models) and computational engineers (people writing the solver code) can work on one unified tool
that is industrially viable for optimization of Modelica models, while offering a flexible platform for algorithm
development and research. OMMatlab is not a standalone package, it depends upon the OpenModelica installation.

OMMatlab is implemented in Matlab and depends on ZeroMQ - high performance asynchronous messaging li-
brary and it supports the Modelica Standard Library version 3.2 that is included in starting with OpenModelica
1.9.2.

The Development is in progress and will be soon available. At the moment a prototype of OMMatlab is completed
where the users will be able to import the OMMatlab package in Matlab and start to interact with omc through
API calls

20.1 Current Prototype

The current version of the OMMatlab pacakge contains the following features:
* Import the OMMatlab package in Matlab
¢ Connect with the OpenModelica compiler through zmq sockets

* Able to interact with the OpenModelica compiler through the available API

All the API calls are communicated with the help of the sendExpression method implemented in a Matlab
pacakge

* The results are returned as strings

20.2 Test Commands

To get started, create a OMMatlab session object:

>>> import OMMatlab.

>>> omc= OMMatlab ()

>>> omc.sendExpression ("getVersion()")
'vl.13.0-dev-531-gde26b558a (64-bit)"

>>> omc.sendExpression ("loadModel (Modelica)™)
'true'

>>> omc.sendExpression("model a Real s; equation s=sin(10xtime); end a;")
l{a}l

>>> omc.sendExpression("simulate(a)")

>>> omc.sendExpression("plot (s)")

'true'

185




OpenModelica User’s Guide, Release v1.13.0

0.5

-0.5 4

-1+ ; ; ; . ; ; ; . ; : ; , ; ; ; | . i :
] 0.2 0.4 0.5 (8= 1
time

Currently this is an incomplete Beta release. In the final release the OMMatlab interface is planned to implement
the more advanced API calls below where the users will have the ability to perform interactive simulation and
analysis similar to the enhanced OMPython features.

20.3 List of Planned API support

* getQuantities()

* getContinuous()

« getlnputs()

o getOutputs()
 getParameters()

* getSimulationOptions()
* getSolutions()

* setlnputs()

¢ setParameters()

* setSimulationOptions()

With the above list of API calls implemented, the users can have more control over the result types, returned using
Matlab data structures.
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CHAPTER
TWENTYONE

OMJULIA — OPENMODELICA JULIA INTERFACE

OMlJulia — the OpenModelica Julia API is a free, open source, highly portable Julia based interactive session han-
dler for Modelica scripting. It provides the modeler with components for creating a complete Modelica modeling,
compilation and simulation environment based on the latest OpenModelica library standard available. OMPython
is architectured to combine both the solving strategy and model building. So domain experts (people writing the
models) and computational engineers (people writing the solver code) can work on one unified tool that is indus-
trially viable for optimization of Modelica models, while offering a flexible platform for algorithm development
and research. OMJulia is not a standalone package, it depends upon the OpenModelica installation.

OMlulia is implemented in Julia and depends on ZeroMQ - high performance asynchronous messaging library
and it supports the Modelica Standard Library version 3.2 that is included in starting with OpenModelica 1.9.2.

To install OMJulia follow the instructions at https://github.com/OpenModelica/OMJulia.jl

21.1 Features of OMJulia

The OMIJulia package contains the following features:

¢ Interactive session handling, parsing, interpretation of commands and Modelica expressions for evaluation,
simulation, plotting, etc.

* Connect with the OpenModelica compiler through zmq sockets
» Able to interact with the OpenModelica compiler through the available API
 Easy access to the Modelica Standard library.

e All the API calls are communicated with the help of the sendExpression method implemented in a Julia
module

* The results are returned as strings

21.2 Test Commands

To get started, create an OMJulia session object:

>>> using OMJulia

>>> omc= OMJulia.OMCSession ()

>>> omc.sendExpression ("loadModel (Modelica) ")

"’I‘rue"

>>> omc.sendExpression("model a Real s; equation s=sin(l0xtime); end a;")
"{a}"

>>> omc.sendExpression("simulate(a)")

>>> omc.sendExpression ("plot (s)")

"true"
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21.2.1 Advanced OMJulia Features

OMJulia package has advanced functionality for querying more information about the models and simulate them.
A list of new user friendly API functionality allows user to extract information about models using julia objects.
A list of API functionality is described below.

To get started, create a ModelicaSystem object:

>>> using OMJulia
>>> mod = OMJulia.OMCSession ()
>>> mod.ModelicaSystem("BouncingBall.mo", "BouncingBall™)

The object constructor requires a minimum of 2 input arguments which are strings, and third input argument which
is optional .

* The first input argument must be a string with the file name of the Modelica code, with Modelica file
extension ".mo". If the Modelica file is not in the current directory, then the file path must also be included.

¢ The second input argument must be a string with the name of the Modelica model including the namespace
if the model is wrapped within a Modelica package.

e The third input argument (optional) is used to specify the list of dependent libraries The argument can be
passed as a string or array of strings e.g.,

>>> mod.ModelicaSystem("BouncingBall.mo", "BouncingBall", ["Modelica",
—"SystemDynamics"])

21.3 Standard get methods

 getQuantities()
¢ showQuantities()
* getContinuous()

* getlnputs()
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* getOutputs()
 getParameters()

* getSimulationOptions()
* getSolutions()

Three calling possibilities are accepted using getXXX() where "XXX" can be any of the above functions (eg:)
getParameters().

* getXXX() without input argument, returns a dictionary with names as keys and values as values.
o getXXX(S), where S is a string of names.
o getXXX(["S1","S2"]) where S1 and S1 are array of string elements

21.4 Usage of getMethods

>>> mod.getQuantities () // method-1, list of all variables from xml file
[{"aliasvariable": None, "Name": "height", "Variability": "continuous", "Value":
—"1.0", "alias": "noAlias", "Changeable": "true", "Description": None}, {
—"aliasvariable": None, "Name": "c", "Variability": "parameter", "Value": "0.9",
—~"alias": "noAlias", "Changeable": "true", "Description": None}]

>>> mod.getQuantities ("height") // method-2, to query information about single,,
—quantity

[{"aliasvariable": None, "Name": "height", "Variability": "continuous", "Value":
—"1.0", "alias": "noAlias", "Changeable": "true", "Description": None}]

>>> mod.getQuantities (["c","radius"]) // method-3, to query information about list,
—of quantity

[{"aliasvariable": None, "Name": "c", "Variability": "parameter", "Value": "0.9",
—"alias": "noAlias", "Changeable": "true", "Description": None}, {"aliasvariable
—": None, "Name": "radius", "Variability": "parameter", "Value": "0.1", "alias":
—"noAlias", "Changeable": "true", "Description": None}]

>>> mod.getContinuous () // method-1, list of continuous variable

{"velocity": "-1.825929609047952", "der (velocity)": "-9.8100000000000005",

—"der (height)": "-1.825929609047952", "height": "0.65907039052943617"}

>>> mod.getContinuous (["velocity", "height"]) // method-2, get specific variable

—value information
["-1.825929609047952", "0.65907039052943617"]

>>> mod.getInputs ()
{}

>>> mod.getOutputs ()
{}

>>> mod.getParameters () // method-1

{"c": "0‘9"’ "radiusﬂ: "O‘lll}

>>> mod.getParameters (["c", "radius"]) // method-2

[IIO-9", IIO-:L"J

>>> mod.getSimulationOptions () // method-1

{"stepSize": "0.002", "stopTime": "1.0", "tolerance": "le-06", "startTime": "0.0",
—"solver": "dassl"}
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>>> mod.getSimulationOptions (["stepSize","tolerance"]) // method-2
["0.002", "le-06"]

>>> mod.getSolutions () // method-1 returns list of simulation variables for which,
—results are available
["time", "height", ""velocity", "der (height)", "der (velocity)", "c", "radius"]

>>> mod.getSolutions (["time", "height"]) // method-2, return list of array

>>> mod.showQuantities () // same as getQuantities () but returns the results in the_,
—form table

21.5 Standard set methods

* setInputs()
* setParameters()
¢ setSimulationOptions()
Two setting possibilities are accepted using setXXXs(),where "XXX" can be any of above functions.
* setXXX(S) where S is a string of names
e setXXX([S1,S2]) where S1 and S1 are array of string elements

21.6 Usage of setMethods

’>>> mod.setInputs ("cAi=1") // method-1

’>>> mod.setInputs (["cAi=1","Ti=2"]) // method-2
’>>> mod.setParameters ("radius=14") // method-1
>>> mod.setParameters (["radius=14","c=0.5"]) // method-2 setting parameter value

—using array of string

’>>> mod.setSimulationOptions (["stopTime=2.0", "tolerance=1e-08"])

21.7 Advanced Simulation

An example of how to do advanced simulation to set parameter values using set methods and finally simulate the
"BouncingBall.mo" model is given below .

>>> mod.getParameters ()
{"CH: "O‘9"’ "radiusll: "O‘lll}

’>>> mod.setParameters (["radius=14","c=0.5"1)

To check whether new values are updated to model , we can again query the getParameters().

>>> mod.getParameters ()
{"cll: "O‘5"’ llradiusll: "14"}
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Similary we can also use setlnputs() to set a value for the inputs during various time interval can also be done

using the following.

’>>> mod.setInputs ("cAi=1")

And then finally we can simulate the model using.

’>>> mod.simulate ()

21.8 Linearization

The following methods are available for linearization of a modelica model
¢ linearize()
* getLinearizationOptions()
* setLinearizationOptions()
* getLinearInputs()
* getLinearOutputs()

* getLinearStates()

21.9 Usage of Linearization methods

>>> mod.getLinearizationOptions () // method-1

{"stepSize": "0.002", "stopTime": "1.0", "startTime": "0.0", "numberOfIntervals":
—"500.0", "tolerance": "le-08"}

>>> mod.getLinearizationOptions (["startTime", "stopTime"]) // method-2

["O'O"’ Ill.O"J

’>>> mod.setLinearizationOptions (["stopTime=2.0","tolerance=1e-06"])
>>> mod.linearize() //returns a tuple of 2D arrays (matrices) A, B, C and D.
>>> mod.getLinearInputs() //returns a list of strings of names of inputs used

—when forming matrices.

—when forming matrices.

>>> mod.getLinearOutputs () //returns a list of strings of names of outputs used

>>> mod.getLinearStates() // returns a list of strings of names of states used
—when forming matrices.

21.10 Sensitivity Analysis

A Method for computing numeric sensitivity of modelica model is available .
* (resl,res2) = sensitivity(argl,arg2,arg3)
The constructor requires a minimum of 3 input arguments .

e argl: Array of strings of Modelica Parameter names

21.8. Linearization
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* arg2: Array of strings of Modelica Variable names
 arg3: Array of float Excitations of parameters; defaults to scalar le-2
The results contains the following .

e resl: Vector of Sensitivity names.

* res2: Array of sensitivies: vector of elements per parameter, each element containing time series per vari-
able.

21.11 Usage

’ >>> (Sn, Sa) = mod.sensitivity (["UA","EdR"],["T","cA"],[le-2,1e-4])

With the above list of API calls implemented, the users can have more control over the result types, returned as
Julia data structures.
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CHAPTER
TWENTYTWO

SCRIPTING API

The following are short summaries of OpenModelica scripting commands. These commands are useful for loading
and saving classes, reading and storing data, plotting of results, and various other tasks.

The arguments passed to a scripting function should follow syntactic and typing rules for Modelica and for the
scripting function in question. In the following tables we briefly indicate the types or character of the formal

parameters to the functions by the following notation:

e String typed argument, e.g. "hello", "myfile.mo".

* TypeName — class, package or function name, e.g. MyClass, Modelica.Math.

e VariableName — variable name, e.g. v1, v2, varsl [2] .x, etc.
* Integer or Real typed argument, e.g. 35, 3.14, xintvariable.

* options — optional parameters with named formal parameter passing.

22.1 OpenModelica Scripting Commands

The following are brief descriptions of the scripting commands available in the OpenModelica environment. All

commands are shown in alphabetical order:

22.1.1 relocateFunctions

function relocateFunctions
input String fileName;
input String names[:, 2];
output Boolean success;
end relocateFunctions;

22.1.2 GC_expand_hp

function GC_expand hp
input Integer size;
output Boolean success;
end GC_expand_hp;

22.1.3 GC_gcollect_and_unmap

22.1.4 GC_get _prof_stats
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function GC_get_prof stats
output GC_PROFSTATS gcStats;
end GC_get_prof_ stats;

22.1.5 GC_set_max_heap_size

function GC_set_max heap_size
input Integer size;
output Boolean success;

end GC_set_max_heap_ size;

22.1.6 addClassAnnotation

function addClassAnnotation
input TypeName class_;
input ExpressionOrModification annotate;
output Boolean bool;

end addClassAnnotation;

22.1.7 addlnitialState

function addInitialState
input TypeName cl;
input String state;
input ExpressionOrModification annotate;
output Boolean bool;
end addInitialState;

22.1.8 addTransition

function addTransition
input TypeName cl;
input String from;
input String to;
input String condition;
input Boolean immediate = true;
input Boolean reset = true;
input Boolean synchronize = false;
input Integer priority = 1;
input ExpressionOrModification annotate;
output Boolean bool;
end addTransition;

22.1.9 alarm

impure function alarm

input Integer seconds;

output Integer previousSeconds;
end alarm;
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22.1.10 appendEnvironmentVar

Appends a variable to the environment variables list.

function appendEnvironmentVar

input String var;

input String value;

output String result "returns \"error\" if the variable could not be appended";
end appendEnvironmentVar;

22.1.11 basename

function basename
input String path;
output String basename;
end basename;

22.1.12 buildEncryptedPackage

function buildEncryptedPackage

input TypeName className "the class that should encrypted";

output Boolean success;

output String commandOutput "Output of the packagetool executable";
end buildEncryptedPackage;

22.1.13 buildLabel

builds Lable.

function buildLabel
input TypeName className "the class that should be built";

input Real startTime = 0.0 "the start time of the simulation. <default> = 0.0";

input Real stopTime = 1.0 "the stop time of the simulation. <default> = 1.0";

input Integer numberOfIntervals = 500 "number of intervals in the result file.
—<default> = 500";

input Real tolerance = le-6 "tolerance used by the integration method. <default>_
—= le-06";

input String method = "dassl" "integration method used for simulation. <default>
—= dassl";

input String fileNamePrefix = "" "fileNamePrefix. <default> = \"\"";

input String options = "" "options. <default> = \"\"";

input String outputFormat = "mat" "Format for the result file. <default> = \"mat\
="

input String variableFilter = ".x" "Filter for variables that should store in_
—result file. <default> = \".»\"";

input String cflags = "" "cflags. <default> = \"\"";

input String simflags = "" "simflags. <default> = \"\"";

output String[2] buildModelResults;
end buildLabel;

22.1.14 buildModel
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builds a modelica model by generating c¢ code and build it.

It does not run the code!

The only required argument is the className, while all others have some default
—values.

simulate (className, [startTime], [stopTime], [numberOfIntervals], [tolerance],
— [method], [fileNamePrefix], [options], [outputFormat], [variableFilter],
—[cflags], [simflags])

Example command:

simulate (A);

function buildModel
input TypeName className "the class that should be built";

input Real startTime = "<default>" "the start time of the simulation. <default>_
= 0.0",'

input Real stopTime = 1.0 "the stop time of the simulation. <default> = 1.0";

input Real numberOfIntervals = 500 "number of intervals in the result file.
—<default> = 500";

input Real tolerance = le-6 "tolerance used by the integration method. <default>_
= le-6";

input String method = "<default>" "integration method used for simulation.
—<default> = dassl";

input String fileNamePrefix = "<default>" "fileNamePrefix. <default> = \"\"";

input String options = "<default>" "options. <default> = \"\"";

input String outputFormat = "mat" "Format for the result file. <default> = \"mat\
<"

input String variableFilter = ".x" "Filter for variables that should store in_
—result file. <default> = \".»\"";

input String cflags = "<default>" "cflags. <default> = \"\"";

input String simflags = "<default>" "simflags. <default> = \"\"";

output String[2] buildModelResults;
end buildModel;

22.1.15 buildModelFMU

translates a modelica model into a Functional Mockup Unit.

The only required argument is the className, while all others have some default
—values.

Example command:

buildModelFMU (className, version="2.0");

function buildModelFMU
input TypeName className "the class that should translated";

input String version = "2.0" "FMU version, 1.0 or 2.0.";

input String fmuType = "me" "FMU type, me (model exchange), cs (co-simulation),
—me_cs (both model exchange and co-simulation)";

input String fileNamePrefix = "<default>" "fileNamePrefix. <default> = \
—"className\"";

input String platforms[:] = {"static"} "The list of platforms to generate code_

—for. \"dynamic\"=current platform, dynamically link the runtime. \"static\
—"=current platform, statically link everything. Else, use a host triple, e.g. \
—"x86_64-1inux—gnu\" or \"x86_64-w64-mingw32\"";

input Boolean includeResources = false "include Modelica based resources via,
—~loadResource or not";

output String generatedFileName "Returns the full path of the generated FMU.";
end buildModelFMU;
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22.1.16 buildOpenTURNSInterface

generates wrapper code for OpenTURNS

function buildOpenTURNSInterface
input TypeName className;
input String pythonTemplateFile;
input Boolean showFlatModelica = false;
output String outPythonScript;
end buildOpenTURNSInterface;

22.1.17 cd

change directory to the given path (which may be either relative or absolute)
returns the new working directory on success or a message on failure

if the given path is the empty string, the function simply returns the current
—working directory.

function cd

input String newWorkingDirectory = "";
output String workingDirectory;
end cd;

22.1.18 checkAllModelsRecursive

Checks all models recursively and returns number of variables and equations.

function checkAllModelsRecursive
input TypeName className;
input Boolean checkProtected = false "Checks also protected classes if true";
output String result;

end checkAllModelsRecursive;

22.1.19 checkCodeGraph

Checks if the given taskgraph has the same structure as the graph described in the
—codefile.

function checkCodeGraph
input String graphfile;
input String codefile;
output String[:] result;
end checkCodeGraph;

22.1.20 checkinterfaceOfPackages

function checkInterfaceOfPackages
input TypeName cl;
input String dependencyMatrix[:, :];
output Boolean success;

end checkInterfaceOfPackages;
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22.1.21 checkModel

Checks a model and returns number of variables and equations.

function checkModel
input TypeName className;
output String result;
end checkModel;

22.1.22 checkSettings

Display some diagnostics.

function checkSettings
output CheckSettingsResult result;
end checkSettings;

22.1.23 checkTaskGraph

Checks if the given taskgraph has the same structure as the reference taskgraph,_
—and if all attributes are set correctly.

function checkTaskGraph
input String filename;
input String reffilename;
output String[:] result;
end checkTaskGraph;

22.1.24 classAnnotationExists

Check if annotation exists

function classAnnotationExists
input TypeName className;
input TypeName annotationName;
output Boolean exists;

end classAnnotationExists;

22.1.25 clear

Clears everything: symboltable and variables.

function clear
output Boolean success;
end clear;

22.1.26 clearCommandLineOptions

Resets all command-line flags to their default values.
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function clearCommandLineOptions
output Boolean success;
end clearCommandLineOptions;

22.1.27 clearDebugFlags

Resets all debug flags to their default wvalues.

function clearDebugFlags
output Boolean success;
end clearDebugFlags;

22.1.28 clearMessages

Clears the error buffer.

function clearMessages
output Boolean success;
end clearMessages;

22.1.29 clearProgram

Clears loaded

function clearProgram
output Boolean success;
end clearProgram;

22.1.30 clearVariables

Clear all user defined variables.

function clearVariables
output Boolean success;
end clearVariables;

22.1.31 closeSimulationResultFile

Closes the current simulation result file.

Only needed by Windows. Windows cannot handle reading and writing to the same file
—from different processes.

To allow OMEdit to make successful simulation again on the same file we must close
—the file after reading the Simulation Result Variables.

Even OMEdit only use this API for Windows.

function closeSimulationResultFile
output Boolean success;
end closeSimulationResultFile;
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22.1.32 codeToString

function codeToString
input $Code className;
output String string;
end codeToString;

22.1.33 comparekFiles

impure function compareFiles
input String filel;
input String file2;
output Boolean isEqual;
end compareFiles;

22.1.34 compareFilesAndMove

impure function compareFilesAndMove
input String newFile;
input String oldFile;
output Boolean success;

end compareFilesAndMove;

22.1.35 compareSimulationResults

compares simulation results.

function compareSimulationResults
input String filename;
input String reffilename;
input String logfilename;
input Real relTol = 0.01;
input Real absTol = 0.0001;
input String[:] vars = £ill("", 0);
output String[:] result;
end compareSimulationResults;

22.1.36 convertUnits

function convertUnits
input String sl;
input String s2;
output Boolean unitsCompatible;
output Real scaleFactor;
output Real offset;
end convertUnits;

22.1.37 copy

copies the source file to the destined directory. Returns true if the file has_
—been copied.
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function copy
input String source;
input String destination;
output Boolean success;
end copy;

22.1.38 copyClass

Copies a class within the same level

function copyClass

input TypeName className "the class that should be copied";
input String newClassName "the name for new class";

input TypeName withIn = $Code (TopLevel)

output Boolean result;
end copyClass;

"the with in path for new

class";

22.1.39 countMessages

function countMessages
output Integer numMessages;
output Integer numErrors;
output Integer numWarnings;
end countMessages;

22.1.40 deleteFile

Deletes a file with the given name.

function deleteFile
input String fileName;
output Boolean success;
end deleteFile;

22.1.41 deletelnitialState

function deleteInitialState
input TypeName cl;
input String state;
output Boolean bool;

end deletelInitialState;

22.1.42 deleteTransition

function deleteTransition
input TypeName cl;
input String from;
input String to;
input String condition;
input Boolean immediate;
input Boolean reset;

(continues on next page)
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(continued from previous page)

input Boolean synchronize;
input Integer priority;
output Boolean bool;

end deleteTransition;

22.1.43 deltaSimulationResults

calculates the sum of absolute errors.

function deltaSimulationResults
input String filename;
input String reffilename;
input String method "method to compute then error. choose lnorm, 2norm, maxerr";
input String[:] vars = f£ill("", 0);
output Real result;
end deltaSimulationResults;

22.1.44 diffModelicaFileListings

Creates diffs of two strings corresponding to Modelica files

function diffModelicaFileListings
input String before, after;
input DiffFormat diffFormat = DiffFormat.color;
output String result;

end diffModelicaFilelistings;

22.1.45 diffSimulationResults

compares simulation results.

function diffSimulationResults
input String actualFile;
input String expectedFile;
input String diffPrefix;
input Real relTol = le-3 "y tolerance";
input Real relTolDiffMinMax = le—-4 "y tolerance based on the difference between_
—the maximum and minimum of the signal";
input Real rangeDelta = 0.002 "x tolerance";
input String[:] vars = £ill("", 0);
input Boolean keepEqualResults = false;
output Boolean success;
output String[:] failVars;
end diffSimulationResults;

22.1.46 diffSimulationResultsHtml

function diffSimulationResultsHtml
input String var;
input String actualFile;
input String expectedFile;
input Real relTol = le-3 "y tolerance";

(continues on next page)
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(continued from previous page)

input Real relTolDiffMinMax = le-4 "y tolerance based on the difference between_

—the maximum and minimum of the signal";
input Real rangeDelta = 0.002 "x tolerance";
output String html;

end diffSimulationResultsHtml;

22.1.47 directoryExists

function directoryExists
input String dirName;
output Boolean exists;
end directoryExists;

22.1.48 dirname

function dirname
input String path;
output String dirname;
end dirname;

22.1.49 dumpXMLDAE

Outputs the DAE system corresponding to a specific model.

function dumpXMLDAE
input TypeName className;

input String translationLevel = "flat" "flat, optimiser, backEnd, or stateSpace";
input Boolean addOriginalIncidenceMatrix = false;

input Boolean addSolvingInfo = false;

input Boolean addMathMLCode = false;

input Boolean dumpResiduals = false;

input String fileNamePrefix = "<default>" "this is the className in string form

—by default";

input String rewriteRulesFile = "" "the file from where the rewiteRules are read,

— default is empty which means no rewrite rules";

output Boolean success "if the function succeeded true/false";

output String xmlfileName "the Xml file";
end dumpXMLDAE;

22.1.50 echo

echo (false) disables Interactive output, echo(true) enables it again.

function echo
input Boolean setEcho;
output Boolean newEcho;
end echo;

22.1. OpenModelica Scripting Commands
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22.1.51 escapeXML

function escapeXML

input

String inStr;

output String outStr;
end escapeXML;

22.1.52 exit

function exit

input

Integer status;

end exit;

22.1.53 exportToFigaro

function exportToFigaro

input
input
input
input
input
input

TypeName path;

String directory = cd{();
String database;

String mode;

String options;

String processor;

output Boolean success;
end exportToFigaro;

22.1.54 extendsFrom

returns true if the given class extends from the given base class

function extendsFrom

input
input

TypeName className;
TypeName baseClassName;

output Boolean res;
end extendsFrom;

22.1.55 filterSimulationResults

function filterSimulationResults

input
input
input
input
input

String inFile;
String outFile;
String[:] vars;
Integer numberOfIntervals
Boolean removeDescription

output Boolean success;
end filterSimulationResults;

0 "0=Do not resample";

false;

22.1.56 generateCode

The input is a function name for which C-code is

SO

generated and compiled into a dll/
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function generateCode
input TypeName className;
output Boolean success;
end generateCode;

22.1.57 generateEntryPoint

function generateEntryPoint

input String fileName;

input TypeName entryPoint;

input String url = "https://trac.openmodelica.org/OpenModelica/newticket™";
end generateEntryPoint;

22.1.58 generateHeader

function generateHeader
input String fileName;
output Boolean success;
end generateHeader;

22.1.59 generateScriptingAPI

function generateScriptingAPI
input TypeName cl;
input String name;
output Boolean success;
output String moFile;
output String gtFile;
output String gtHeader;

end generateScriptingAPI;

22.1.60 generateSeparateCode

function generateSeparateCode

input TypeName className;

input Boolean cleanCache = false "If true, the cache is reset between each,
—generated package. This conserves memory at the cost of speed.";

output Boolean success;
end generateSeparateCode;

22.1.61 generateSeparateCodeDependencies

function generateSeparateCodeDependencies
input String stampSuffix = ".c" "Suffix to add to dependencies (often .c.stamp)";
output String[:] dependencies;

end generateSeparateCodeDependencies;

22.1.62 generateSeparateCodeDependenciesMakefile
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function generateSeparateCodeDependenciesMakefile
input String filename "The file to write the makefile to";
input String directory = "" "The relative path of the generated files";
input String suffix = ".c" "Often .stamp since we do not update all the files";
output Boolean success;
end generateSeparateCodeDependenciesMakefile;

22.1.63 generateVerificationScenarios

function generateVerificationScenarios
input TypeName path;
output Boolean success;

end generateVerificationScenarios;

22.1.64 getAlgorithmCount

Counts the number of Algorithm sections in a class.

function getAlgorithmCount
input TypeName class_;
output Integer count;
end getAlgorithmCount;

22.1.65 getAlgorithmltemsCount

Counts the number of Algorithm items in a class.

function getAlgorithmItemsCount
input TypeName class_;
output Integer count;

end getAlgorithmItemsCount;

22.1.66 getAnnotationCount

Counts the number of Annotation sections in a class.

function getAnnotationCount
input TypeName class_;
output Integer count;

end getAnnotationCount;

22.1.67 getAnnotationModifierValue

function getAnnotationModifierValue
input TypeName name;
input String vendorannotation;
input String modifiername;
output String modifiernamevalue;
end getAnnotationModifierValue;
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22.1.68 getAnnotationNamedModifiers

function getAnnotationNamedModifiers
input TypeName name;
input String vendorannotation;
output String[:] modifiernamelist;
end getAnnotationNamedModifiers;

22.1.69 getAnnotationVersion

Returns the current annotation version.

function getAnnotationVersion
output String annotationVersion;
end getAnnotationVersion;

22.1.70 getAstAsCorbaString

Print the whole AST on the CORBA format for records, e.g.
record Absyn.PROGRAM

classes = ...,
within_ = ...,
globalBuildTimes =

end Absyn.PROGRAM;

function getAstAsCorbaString

input String fileName = "<interactive>";

output String result "returns the string if fileName is interactive; else it
—returns ok or error depending on if writing the file succeeded";
end getAstAsCorbaString;

22.1.71 getAvailablelndexReductionMethods

function getAvailableIndexReductionMethods
output String[:] allChoices;
output String[:] allComments;

end getAvailableIndexReductionMethods;

22.1.72 getAvailableLibraries

function getAvailablelibraries
output String[:] libraries;
end getAvailablelibraries;

22.1.73 getAvailableMatchingAlgorithms

function getAvailableMatchingAlgorithms
output String[:] allChoices;
output String[:] allComments;

end getAvailableMatchingAlgorithms;
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22.1.74 getAvailableTearingMethods

function getAvailableTearingMethods
output String[:] allChoices;
output String[:] allComments;

end getAvailableTearingMethods;

22.1.75 getBooleanClassAnnotation

Check if annotation exists and returns its value

function getBooleanClassAnnotation
input TypeName className;
input TypeName annotationName;
output Boolean value;

end getBooleanClassAnnotation;

22.1.76 getBuiltinType

function getBuiltinType
input TypeName cl;
output String name;
end getBuiltinType;

22.1.77 getCFlags

CFLAGS

function getCFlags
output String outString;
end getCFlags;

22.1.78 getCXXCompiler

CXX

function getCXXCompiler
output String compiler;
end getCXXCompiler;

22.1.79 getClassComment

Returns the class comment.

function getClassComment
input TypeName cl;
output String comment;
end getClassComment;
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22.1.80 getClassinformation

function getClassInformation
input TypeName cl;
output String restriction,
output Boolean partialPrefix,
output String fileName;
output Boolean fileReadOnly;
output Integer lineNumberStart,

—columnNumberEnd;

comment;
finalPrefix,

output String dimensions|[:];

output Boolean isProtectedClass;
output Boolean isDocumentationClass;
output String version;

output String preferredView;

output Boolean state;

output String access;

end getClassInformation;

columnNumberStart,

encapsulatedPrefix;

lineNumberEnd,

22.1.81 getClassNames

Returns the list of class names defined

in the class.

function getClassNames
input TypeName class_ =
input Boolean recursive = false;
input Boolean qualified = false;
input Boolean sort = false;
input Boolean builtin = false
input Boolean showProtected =
input Boolean includeConstants =

false

"w.
1

output TypeName classNames|[:];
end getClassNames;

$SCode (AllLoadedClasses) ;

"List also builtin classes if true";
false "List also protected classes if true";
"List also constants in the class if

true

22.1.82 getClassRestriction

function getClassRestriction
input TypeName cl;
output String restriction;
end getClassRestriction;

22.1.83 getClassesinModelicaPath

MathCore-specific or not? Who knows!

function getClassesInModelicaPath
output String classesInModelicaPath;
end getClassesInModelicaPath;

22.1.84 getCommandLineOptions
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Returns all command line options who have non-default values as a list of
strings. The format of the strings is '—--flag=value —--flag2=value2'.

function getCommandLineOptions
output String[:] flags;
end getCommandLineOptions;

22.1.85 getCompileCommand

function getCompileCommand
output String compileCommand;
end getCompileCommand;

22.1.86 getCompiler

cC

function getCompiler
output String compiler;
end getCompiler;

22.1.87 getComponentModifierNames

function getComponentModifierNames
input TypeName class_;
input String componentName;
output String[:] modifiers;

end getComponentModifierNames;

22.1.88 getComponentModifierValue

function getComponentModifierValue
input TypeName class_;
input TypeName modifier;
output String value;

end getComponentModifierValue;

22.1.89 getComponentModifierValues

function getComponentModifierValues
input TypeName class_;
input TypeName modifier;
output String value;

end getComponentModifierValues;

22.1.90 getComponentsTest
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function getComponentsTest
input TypeName name;
output Component[:]
record Component

String className;

// when building record the constructor.
—components of basic types,

String name;

String comment;
isProtected;
isFinal;
isFlow;
isStream;
isReplaceable;

variability "'constant',
innerOuter

String inputOutput

String dimensions|[:];

end Component;
end getComponentsTest;

components;

arrays of basic types or other

Boolean
Boolean
Boolean
Boolean
Boolean
String

String

'parameter’',
rTrm,
4

'discrete',
"'inner',

"

'outer',

input', 'output',

vim,
’

Records are allowed to contain

only,,
records.

rim.,
’

22.1.91 getConfigFlagValidOptions

Returns the list of valid options for a string config flag,
—strings for these options if available

and the description_

function getConfigFlagValidOptions
input String flag;
output String validOptions|[:];
output String mainDescription;
output String descriptions[:];
end getConfigFlagValidOptions;

22.1.92 getConnectionCount

Counts the number of connect equation in a class.

function getConnectionCount
input TypeName className;
output Integer count;

end getConnectionCount;

22.1.93 getDefaultOpenCLDevice

Returns the id for the default OpenCL device to be used.

function getDefaultOpenCLDevice
output Integer defdevid;
end getDefaultOpenCLDevice;

22.1. OpenModelica Scripting Commands

211




OpenModelica User’s Guide, Release v1.13.0

22.1.94 getDerivedClassModifierNames

Returns the derived class modifier names.

Example command:

type Resistance = Real (final quantity="Resistance",final unit="Ohm");
getDerivedClassModifierNames (Resistance) => {"quantity","unit"}

function getDerivedClassModifierNames
input TypeName className;
output String[:] modifierNames;

end getDerivedClassModifierNames;

22.1.95 getDerivedClassModifierValue

Returns the derived class modifier value.

Example command:

type Resistance = Real (final quantity="Resistance",final unit="Ohn");
getDerivedClassModifierValue (Resistance, unit); => " = "Ohm""
getDerivedClassModifierValue (Resistance, quantity); => " = "Resistance""

function getDerivedClassModifierValue
input TypeName className;
input TypeName modifierName;
output String modifierValue;

end getDerivedClassModifierValue;

22.1.96 getDerivedUnits

function getDerivedUnits

input String baseUnit;

output String[:] derivedUnits;
end getDerivedUnits;

22.1.97 getDocumentationAnnotation

Returns the documentaiton annotation defined in the class.

function getDocumentationAnnotation

input TypeName cl;

output String out[3] "{info,revision, infoHeader} TODO: Should be changed to have_
—2 outputs instead of an array of 2 Strings...";
end getDocumentationAnnotation;

22.1.98 getEnvironmentVar

Returns the value of the environment variable.

function getEnvironmentVar

input String var;

output String value "returns empty string on failure";
end getEnvironmentVar;
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22.1.99 getEquationCount

Counts the number of Equation sections in a class.

function getEquationCount
input TypeName class_;
output Integer count;
end getEquationCount;

22.1.100 getEquationitemsCount

Counts the number of Equation items in a class.

function getEquationItemsCount
input TypeName class_;
output Integer count;

end getEquationItemsCount;

22.1.101 getErrorString

Returns the current error message. [file.mo:n:n-n:n:b] Error: message

impure function getErrorString
input Boolean warningsAsErrors = false;
output String errorString;

end getErrorString;

22.1.102 getimportCount

Counts the number of Import sections in a class.

function getImportCount
input TypeName class_;
output Integer count;
end getImportCount;

22.1.103 getindexReductionMethod

function getIndexReductionMethod
output String selected;
end getIndexReductionMethod;

22.1.104 getinheritedClasses

function getInheritedClasses

input TypeName name;

output TypeName inheritedClasses|[:];
end getInheritedClasses;
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22.1.105 getinitialAlgorithmCount

Counts the number of Initial Algorithm sections in a class.

function getInitialAlgorithmCount
input TypeName class_;
output Integer count;

end getInitialAlgorithmCount;

22.1.106 getinitialAlgorithmltemsCount

Counts the number of Initial Algorithm items in a class.

function getInitialAlgorithmItemsCount
input TypeName class_;
output Integer count;

end getInitialAlgorithmItemsCount;

22.1.107 getinitialEquationCount

Counts the number of Initial Equation sections in a class.

function getInitialEquationCount
input TypeName class_;
output Integer count;

end getInitialEquationCount;

22.1.108 getinitialEquationltemsCount

Counts the number of Initial Equation items in a class.

function getInitialEquationItemsCount
input TypeName class_;
output Integer count;

end getInitialEquationItemsCount;

22.1.109 getinitialStates

function getInitialStates

input TypeName cl;

output String[:, :] initialStates;
end getInitialStates;

22.1.110 getinstallationDirectoryPath

This returns OPENMODELICAHOME if it is set; on some platforms the default path is
—returned if it is not set.

function getInstallationDirectoryPath
output String installationDirectoryPath;
end getInstallationDirectoryPath;
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22.1.111 getinstantiatedParametersAndValues

function getInstantiatedParametersAndValues
input TypeName cls;
output String[:] values;

end getInstantiatedParametersAndValues;

22.1.112 getLanguageStandard

Returns the current Modelica Language Standard in use.

function getLanguageStandard
output String outVersion;
end getLanguageStandard;

22.1.113 getLinker

function getLinker
output String linker;
end getLinker;

22.1.114 getLinkerFlags

function getLinkerFlags
output String linkerFlags;
end getLinkerFlags;

22.1.115 getLoadedLibraries

function getLoadedLibraries
output String[:, 2] libraries;
end getLoadedLibraries;

22.1.116 getMatchingAlgorithm

function getMatchingAlgorithm
output String selected;
end getMatchingAlgorithm;

22.1.117 getMemorySize

function getMemorySize
output Real memory (unit = "MiB");
end getMemorySize;
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22.1.118 getMessagesString

see getErrorString ()

function getMessagesString
output String messagesString;
end getMessagesString;

22.1.119 getModelicaPath

Get the Modelica Library Path.

function getModelicaPath
output String modelicaPath;
end getModelicaPath;

22.1.120 getNoSimplify

Returns true if noSimplify flag is set.

function getNoSimplify
output Boolean noSimplify;
end getNoSimplify;

22.1.121 getNthAlgorithm

Returns the Nth Algorithm section.

function getNthAlgorithm
input TypeName class_;
input Integer index;
output String result;
end getNthAlgorithm;

22.1.122 getNthAlgorithmitem

Returns the Nth Algorithm Item.

function getNthAlgorithmItem
input TypeName class_;
input Integer index;
output String result;

end getNthAlgorithmItem;

22.1.123 getNthAnnotationString

Returns the Nth Annotation section as string.
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function getNthAnnotationString
input TypeName class_;
input Integer index;
output String result;

end getNthAnnotationString;

22.1.124 getNthConnection

Returns the Nth connection.
Example command:
getNthConnection (A) => {"from", "to",

"comment"}

function getNthConnection
input TypeName className;
input Integer index;
output String[:] result;
end getNthConnection;

22.1.125 getNthEquation

Returns the Nth Equation section.

function getNthEquation
input TypeName class_;
input Integer index;
output String result;
end getNthEquation;

22.1.126 getNthEquationltem

Returns the Nth Equation Item.

function getNthEquationItem
input TypeName class_;
input Integer index;
output String result;

end getNthEquationItem;

22.1.127 getNthimport

Returns the Nth Import as string.

function getNthImport
input TypeName class_;
input Integer index;

output String out[3] "{\"Path\",\"Id\",\"Kind\"}";

end getNthImport;
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22.1.128 getNthinitialAlgorithm

Returns the Nth Initial Algorithm section.

function getNthInitialAlgorithm
input TypeName class_;
input Integer index;
output String result;

end getNthInitialAlgorithm;

22.1.129 getNthinitialAlgorithmltem

Returns the Nth Initial Algorithm Item.

function getNthInitialAlgorithmItem
input TypeName class_;
input Integer index;
output String result;

end getNthInitialAlgorithmItem;

22.1.130 getNthlInitialEquation

Returns the Nth Initial Equation section.

function getNthInitialEquation
input TypeName class_;
input Integer index;
output String result;

end getNthInitialEquation;

22.1.131 getNthlinitialEquationltem

Returns the Nth Initial Equation Item.

function getNthInitialEquationItem
input TypeName class_;
input Integer index;
output String result;

end getNthInitialEquationItem;

22.1.132 getOrderConnections

Returns true if orderConnections flag is

function getOrderConnections
output Boolean orderConnections;
end getOrderConnections;
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22.1.133 getPackages

Returns the list of packages defined in the class.

function getPackages
input TypeName class_ = $Code(AllLoadedClasses);
output TypeName classNames|[:];

end getPackages;

22.1.134 getParameterNames

function getParameterNames
input TypeName class_;
output String[:] parameters;
end getParameterNames;

22.1.135 getParameterValue

function getParameterValue
input TypeName class_;
input String parameterName;
output String parameterValue;
end getParameterValue;

22.1.136 getSettings

function getSettings
output String settings;
end getSettings;

22.1.137 getShowAnnotations

function getShowAnnotations
output Boolean show;
end getShowAnnotations;

22.1.138 getSimulationOptions

function getSimulationOptions

input TypeName name;

input Real defaultStartTime = 0.0;

input Real defaultStopTime = 1.0;

input Real defaultTolerance = le-6;

input Integer defaultNumberOfIntervals = 500 "May be overridden by defining
—~defaultInterval instead";

input Real defaultInterval = 0.0 "If = 0.0, then numberOflIntervals is used to
—calculate the step size";

output Real startTime;

output Real stopTime;

output Real tolerance;

output Integer numberOfIntervals;

(continues on next page)
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(continued from previous page)

output Real interval;
end getSimulationOptions;

22.1.139 getSourceFile

Returns the filename of the class.

function getSourceFile

input TypeName class_;

output String filename "empty on failure";
end getSourceFile;

22.1.140 getTearingMethod

function getTearingMethod
output String selected;
end getTearingMethod;

22.1.141 getTempDirectoryPath

Returns the current user temporary directory location.

function getTempDirectoryPath
output String tempDirectoryPath;
end getTempDirectoryPath;

22.1.142 getTimeStamp

function getTimeStamp

input TypeName cl;

output Real timeStamp;

output String timeStampAsString;
end getTimeStamp;

22.1.143 getTransitions

function getTransitions

input TypeName cl;

output String[:, :] transitions;
end getTransitions;

22.1.144 getUsedClassNames

Returns the list of class names used in the total program defined by the class.

function getUsedClassNames
input TypeName className;
output TypeName classNames][:];
end getUsedClassNames;
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22.1.145 getUses

function getUses
input TypeName pack;
output String[:, :] uses;
end getUses;

22.1.146 getVectorizationLimit

function getVectorizationLimit
output Integer vectorizationLimit;
end getVectorizationLimit;

22.1.147 getVersion

Returns the version of the Modelica compiler.

function getVersion
input TypeName cl = $Code (OpenModelica);
output String version;

end getVersion;

22.1.148 help

display the OpenModelica help text.

function help

input String topic = "topics";
output String helpText;
end help;

22.1.149 iconv

The iconv () function converts one multibyte characters from one character
set to another.
See man (3) iconv for more information.

function iconv
input String string;
input String from;
input String to = "UTF-8";
output String result;
end iconv;

22.1.150 importFMU

Imports the Functional Mockup Unit
Example command:
importFMU ("A.fmu") ;
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function importFMU

input String filename "the fmu file name";

input String workdir = "<default>" "The output directory for imported FMU files.
—<default> will put the files to current working directory.";

input Integer loglevel = 3 "loglevel _nothing=0;loglevel_fatal=1;loglevel_error=2;
—loglevel_warning=3;loglevel_info=4;loglevel_verbose=5; loglevel_debug=6";

input Boolean fullPath = false "When true the full output path is returned,
—otherwise only the file name.";

input Boolean debuglogging = false "When true the FMU's debug output is printed.
=";

input Boolean generateInputConnectors = true "When true creates the input,
—connector pins.";

input Boolean generateOutputConnectors = true "When true creates the output
—connector pins.";

output String generatedFileName "Returns the full path of the generated file.";
end importFMU;

22.1.151 importFMUModelDescription

Imports modelDescription.xml
Example command:
importFMUModelDescription ("A.xml");

function importFMUModelDescription

input String filename "the fmu file name";

input String workdir = "<default>" "The output directory for imported FMU files.
—<default> will put the files to current working directory.";

input Integer loglevel = 3 "loglevel _nothing=0;loglevel_fatal=1;loglevel_error=2;
—loglevel_warning=3;loglevel_info=4;loglevel_verbose=5;loglevel_debug=6";

input Boolean fullPath = false "When true the full output path is returned
—otherwise only the file name.";

input Boolean debuglogging = false "When true the FMU's debug output is printed.
— 7

input Boolean generateInputConnectors = true "When true creates the input,
—connector pins.";

input Boolean generateOutputConnectors = true "When true creates the output,
—connector pins.";

output String generatedFileName "Returns the full path of the generated file.";
end importFMUModelDescription;

22.1.152 inferBindings

function inferBindings
input TypeName path;
output Boolean success;
end inferBindings;

22.1.153 instantiateModel

Instantiates the class and returns the flat Modelica code.

function instantiateModel
input TypeName className;
output String result;
end instantiateModel;
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22.1.154 isBlock

function isBlock
input TypeName cl;
output Boolean bj;
end isBlock;

22.1.155 isClass

function isClass
input TypeName cl;
output Boolean bj;
end isClass;

22.1.156 isConnector

function isConnector
input TypeName cl;
output Boolean b;
end isConnector;

22.1.157 isEnumeration

function isEnumeration
input TypeName cl;
output Boolean b;
end isEnumeration;

22.1.158 isExperiment

function isExperiment
input TypeName name;
output Boolean res;
end isExperiment;

22.1.159 isFunction

function isFunction
input TypeName cl;
output Boolean b;
end isFunction;

22.1.160 isModel

function isModel
input TypeName cl;
output Boolean b;
end isModel;
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22.1.161 isOperator

function isOperator
input TypeName cl;
output Boolean bj;
end isOperator;

22.1.162 isOperatorFunction

function isOperatorFunction
input TypeName cl;
output Boolean bj;

end isOperatorFunction;

22.1.163 isOperatorRecord

function isOperatorRecord
input TypeName cl;
output Boolean b;

end isOperatorRecord;

22.1.164 isOptimization

function isOptimization
input TypeName cl;
output Boolean b;

end isOptimization;

22.1.165 isPackage

function isPackage
input TypeName cl;
output Boolean b;
end isPackage;

22.1.166 isPartial

function isPartial
input TypeName cl;
output Boolean b;
end isPartial;

22.1.167 isProtectedClass

function isProtectedClass
input TypeName cl;
input String c2;
output Boolean b;

end isProtectedClass;
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22.1.168 isRecord

function isRecord
input TypeName cl;
output Boolean bj;
end isRecord;

22.1.169 isShortDefinition

returns true if the definition is a short class definition

function isShortDefinition
input TypeName class_;
output Boolean isShortCls;
end isShortDefinition;

22.1.170 isType

function isType
input TypeName cl;
output Boolean b;
end isType;

22.1.171 linearize

creates a model with symbolic linearization matrixes

function linearize
input TypeName className "the class that should simulated";

input Real startTime = "<default>" "the start time of the simulation. <default>
—= 0.0";

input Real stopTime = 1.0 "the stop time of the simulation. <default> = 1.0";

input Real numberOfIntervals = 500 "number of intervals in the result file.

—<default> = 500";
input Real stepSize = 0.002 "step size that is used for the result file.
—<default> = 0.002";

input Real tolerance = le-6 "tolerance used by the integration method. <default>
—= le-06";

input String method = "<default>" "integration method used for simulation.
—<default> = dassl";

input String fileNamePrefix = "<default>" "fileNamePrefix. <default> = \"\"";

input Boolean storeInTemp = false "storeInTemp. <default> = false";

input Boolean noClean = false "noClean. <default> = false";

input String options = "<default>" "options. <default> = \"\"";

input String outputFormat = "mat" "Format for the result file. <default> = \"mat\
="

input String variableFilter = ".x" "Filter for variables that should store in_
—result file. <default> = \".x\"";

input String cflags = "<default>" "cflags. <default> = \"\"";

input String simflags = "<default>" "simflags. <default> = \"\"";

output String linearizationResult;
end linearize;
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22.1.172 list

Lists the contents of the given class, or all loaded classes.

function list
input TypeName class_ = $Code(AllLoadedClasses);
input Boolean interfaceOnly = false;
input Boolean shortOnly = false "only short class definitions";
input ExportKind exportKind = ExportKind.Absyn;
output String contents;
end list;

22.1.173 listFile

Lists the contents of the file given by the class.

function listFile
input TypeName class_;
output String contents;
end listFile;

22.1.174 listVariables

Lists the names of the active variables in the scripting environment.

function listVariables
output TypeName variables([:];
end listVariables;

22.1.175 loadEncryptedPackage

function loadEncryptedPackage

input String fileName;

input String workdir = "<default>" "The output directory for imported encrypted
—files. <default> will put the files to current working directory.";

output Boolean success;
end loadEncryptedPackage;

22.1.176 loadFile

load file (*.mo) and merge it with the loaded AST.

function loadFile
input String fileName;
input String encoding = "UTE-8";
input Boolean uses = true;
output Boolean success;

end loadFile;
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22.1.177 loadFilelnteractive

function loadFileInteractive
input String filename;
input String encoding = "UTE-8";
output TypeName names|[:];

end loadFileInteractive;

22.1.178 loadFilelnteractiveQualified

function loadFilelInteractiveQualified
input String filename;
input String encoding = "UTF-8";
output TypeName names|[:];

end loadFileInteractiveQualified;

22.1.179 loadFiles

load files (*.mo) and merges them with the loaded AST.

function loadFiles
input String[:] fileNames;
input String encoding = "UTF-8";
input Integer numThreads = OpenModelica.Scripting.numProcessors();
output Boolean success;
end loadFiles;

22.1.180 loadModel

Loads the Modelica Standard Library.

function loadModel

input TypeName className;

input String[:] priorityVersion = {"default"};

input Boolean notify = false "Give a notification of the libraries and versions_
—that were loaded";

input String languageStandard = "" "Override the set language standard. Parse_
—with the given setting, but do not change it permanently.";

input Boolean requireExactVersion = false "If the version is required to be_
—exact, 1f there is a uses Modelica (version=\"3.2\"), Modelica 3.2.1 will not,
—match it.";

output Boolean success;
end loadModel;

22.1.181 loadModelica3D

function loadModelica3D
input String version = "3.2.1";
output Boolean status;

end loadModelica3D;
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22.1.182 loadString

Parses the data and merges the resulting AST with ithe

loaded AST.

If a filename is given, it 1is used to provide error-messages as if the string
was read in binary format from a file with the same name.

The file is converted to UTF-8 from the given character set.

When merge is true the classes cNew in the file will be merged with the already,,
—~loaded classes cOld in the following way:

1. get all the inner class definitions from cOld that were loaded from a different
—~file than itself

2. append all elements from step 1 to class cNew public list

NOTE: Encoding is deprecated as *ALL* strings are now UTF-8 encoded.

function loadString
input String data;

input String filename = "<interactive>";
input String encoding = "UTE-8";
input Boolean merge = false "if merge is true the parsed AST is merged with the_

—existing AST, default to false which means that is replaced, not merged";
output Boolean success;
end loadString;

22.1.183 mkdir

create directory of given path (which may be either relative or absolute)
returns true if directory was created or already exists.

function mkdir
input String newDirectory;
output Boolean success;
end mkdir;

22.1.184 moveClass

Moves a class up or down depending on the given offset, where a positive
offset moves the class down and a negative offset up. The offset is truncated
if the resulting index is outside the class list. It retains the visibility of
the class by adding public/protected sections when needed, and merges sections
of the same type if the class is moved from a section it was alone in. Returns
true if the move was successful, otherwise false.

function moveClass
input TypeName className "the class that should be moved";
input Integer offset "Offset in the class list.";
output Boolean result;

end moveClass;

22.1.185 moveClassToBottom

Moves a class to the bottom of its enclosing class. Returns true if the move
was successful, otherwise false.
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function moveClassToBottom
input TypeName className;
output Boolean result;
end moveClassToBottom;

22.1.186 moveClassToTop

Moves a class to the top of its enclosing class. Returns true if the move
was successful, otherwise false.

function moveClassToTop
input TypeName className;
output Boolean result;
end moveClassToTop;

22.1.187 ngspicetoModelica

Converts ngspice netlist to Modelica code. Modelica file is created in the same
—directory as netlist file.

function ngspicetoModelica
input String netlistfileName;
output Boolean success = false;
end ngspicetoModelica;

22.1.188 numProcessors

function numProcessors
output Integer result;
end numProcessors;

22.1.189 optimize

optimize a modelica/optimica model by generating c code, build it and run the_
—optimization executable.

The only required argument is the className, while all others have some default
—values.

simulate (className, [startTime], [stopTime], [numberOfIntervals], [stepSize],

— [tolerance], [fileNamePrefix], [options], [outputFormat], [variableFilter],
—[cflags], [simflags])

Example command:

simulate (A);

function optimize
input TypeName className "the class that should simulated";

input Real startTime = "<default>" "the start time of the simulation. <default>_
—= 0.0";

input Real stopTime = 1.0 "the stop time of the simulation. <default> = 1.0";

input Real numberOfIntervals = 500 "number of intervals in the result file.

—<default> = 500";
input Real stepSize = 0.002 "step size that is used for the result file.
—~<default> = 0.002";

(continues on next page)
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input Real tolerance = le—-6 "tolerance used by the integration method. <default>
—= le-06";

input String method = DAE.SCONST ("optimization") "optimize a modelica/optimica,,
—model.";

input String fileNamePrefix = "<default>" "fileNamePrefix. <default> = \"\"";

input Boolean storeInTemp = false "storeInTemp. <default> = false";

input Boolean noClean = false "noClean. <default> = false";

input String options = "<default>" "options. <default> = \"\"";

input String outputFormat = "mat" "Format for the result file. <default> = \"mat\
="

input String variableFilter = ".x" "Filter for variables that should store in_
—result file. <default> = \".»\"";

input String cflags = "<default>" "cflags. <default> = \"\"";

input String simflags = "<default>" "simflags. <default> = \"\"";

output String optimizationResults;
end optimize;

22.1.190 parseFile

function parseFile
input String filename;
input String encoding = "UTF-8";
output TypeName names|[:];

end parseFile;

22.1.191 parseString

function parseString
input String data;
input String filename = "<interactive>";
output TypeName names|[:];

end parseString;

22.1.192 plot

Launches a plot window using OMPlot.

function plot

input VariableNames vars "The variables you want to plot";

input Boolean externalWindow = false "Opens the plot in a new plot window";

input String fileName = "<default>" "The filename containing the variables.
—<default> will read the last simulation result";

input String title = "" "This text will be used as the diagram title.";

input String grid = "detailed" "Sets the grid for the plot i.e simple, detailed,
—none.";

input Boolean logX = false "Determines whether or not the horizontal axis is_
—~logarithmically scaled.";

input Boolean logY = false "Determines whether or not the vertical axis is_
—logarithmically scaled.";

input String xLabel = "time" "This text will be used as the horizontal label in_
—the diagram.";

input String yLabel = "" "This text will be used as the vertical label in the_
—diagram.";

input Real xRange[2] = {0.0, 0.0} "Determines the horizontal interval that is_

—visible in the diagram. {0,0} will select a suitable range.";

(continues on next page)
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input Real yRange[2] = {0.0, 0.0} "Determines the vertical interval that is_
—visible in the diagram. {0,0} will select a suitable range.";

input Real curveWidth = 1.0 "Sets the width of the curve.";

input Integer curveStyle = 1 "Sets the style of the curve. SolidLine=1, |
—DashLine=2, DotLine=3, DashDotLine=4, DashDotDotLine=5, Sticks=6, Steps=7.";

input String legendPosition = "top" "Sets the POSITION of the legend i.e left,
—right, top, bottom, none.";

input String footer = "" "This text will be used as the diagram footer.";

input Boolean autoScale = true "Use auto scale while plotting.";

input Boolean forceOMPlot = false "if true launches OMPlot and doesn't call,
—callback function even if it is defined.";

output Boolean success "Returns true on success";
end plot;

22.1.193 plotAll

Works in the same way as plot (), but does not accept any

variable names as input. Instead, all variables are part of the plot window.
Example command sequences:

simulate (A);plotAll();

simulate (A) ;plotAll (externalWindow=true) ;

simulate (A, fileNamePrefix="B");simulate (C);plotAll (x,fileName="B.mat");

function plotAll
input Boolean externalWindow = false "Opens the plot in a new plot window";

input String fileName = "<default>" "The filename containing the variables.
—<default> will read the last simulation result";

input String title = "" "This text will be used as the diagram title.";

input String grid = "detailed" "Sets the grid for the plot i.e simple, detailed,
—none.";

input Boolean logX = false "Determines whether or not the horizontal axis is_

—logarithmically scaled.";
input Boolean logY = false "Determines whether or not the vertical axis is,_
—logarithmically scaled.";

input String xLabel = "time" "This text will be used as the horizontal label in_
—the diagram.";

input String yLabel = "" "This text will be used as the vertical label in the_
—diagram.";

input Real xRange[2] = {0.0, 0.0} "Determines the horizontal interval that is_
—visible in the diagram. {0,0} will select a suitable range.";

input Real yRange[2] = {0.0, 0.0} "Determines the vertical interval that is_

—visible in the diagram. {0,0} will select a suitable range.";

input Real curveWidth = 1.0 "Sets the width of the curve.";

input Integer curveStyle = 1 "Sets the style of the curve. SolidLine=1,
—DashLine=2, DotLine=3, DashDotLine=4, DashDotDotLine=5, Sticks=6, Steps=7.";

input String legendPosition = "top" "Sets the POSITION of the legend i.e left,
—right, top, bottom, none.";
input String footer = "" "This text will be used as the diagram footer.";

input Boolean autoScale = true "Use auto scale while plotting.";

input Boolean forceOMPlot = false "if true launches OMPlot and doesn't call,
—callback function even if it is defined.";

output Boolean success "Returns true on success";
end plotAll;
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22.1.194 plotParametric

Launches a plotParametric window using OMPlot. Returns true on success.
Example command sequences:

simulate (A) ;plotParametric(x,v);

simulate (A) ;plotParametric(x,y, externalWindow=true);

function plotParametric
input VariableName xVariable;
input VariableName yVariable;
input Boolean externalWindow = false "Opens the plot in a new plot window";

input String fileName = "<default>" "The filename containing the variables.
—<default> will read the last simulation result";

input String title = "" "This text will be used as the diagram title.";

input String grid = "detailed" "Sets the grid for the plot i.e simple, detailed,
—none.";

input Boolean logX = false "Determines whether or not the horizontal axis is_,

—logarithmically scaled.";
input Boolean logY = false "Determines whether or not the vertical axis is,_
—logarithmically scaled.";

input String xLabel = "time" "This text will be used as the horizontal label in_
—the diagram.";

input String yLabel = "" "This text will be used as the vertical label in the_
—diagram.";

input Real xRange[2] = {0.0, 0.0} "Determines the horizontal interval that is_
—visible in the diagram. {0,0} will select a suitable range.";

input Real yRange[2] = {0.0, 0.0} "Determines the vertical interval that is_

—visible in the diagram. {0,0} will select a suitable range.";

input Real curveWidth = 1.0 "Sets the width of the curve.";

input Integer curveStyle = 1 "Sets the style of the curve. SolidLine=1,
—DashLine=2, DotLine=3, DashDotLine=4, DashDotDotLine=5, Sticks=6, Steps=7.";

input String legendPosition = "top" "Sets the POSITION of the legend i.e left,
—right, top, bottom, none.";

input String footer = "" "This text will be used as the diagram footer.";

input Boolean autoScale = true "Use auto scale while plotting.";

input Boolean forceOMPlot = false "if true launches OMPlot and doesn't call,
—callback function even if it is defined.";

output Boolean success "Returns true on success";
end plotParametric;

22.1.195 readFile

The contents of the given file are returned.
Note that if the function fails, the error message is returned as a string instead_
—of multiple output or similar.

impure function readFile
input String fileName;
output String contents;
end readFile;

22.1.196 readFileNoNumeric

Returns the contents of the file, with anything resembling a (real) number
—stripped out, and at the end adding:
Filter count from number domain: n.

(continues on next page)
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This should probably be changed to multiple outputs; the filtered string and an_
—integer.
Does anyone use this API call?

function readFileNoNumeric
input String fileName;
output String contents;
end readFileNoNumeric;

22.1.197 readSimulationResult

Reads a result file, returning a matrix corresponding to the variables and size_
—given.

function readSimulationResult

input String filename;

input VariableNames variables;

input Integer size = 0 "O=read any size... If the size is not the same as the_
—result-file, this function fails";

output Real result[:, :];
end readSimulationResult;

22.1.198 readSimulationResultSize

The number of intervals that are present in the output file.

function readSimulationResultSize
input String fileName;
output Integer sz;

end readSimulationResultSize;

22.1.199 readSimulationResultVars

Returns the variables in the simulation file; you can use val() and plot (),
—commands using these names.

function readSimulationResultVars
input String fileName;
input Boolean readParameters = true;
input Boolean openmodelicaStyle = false;
output String[:] vars;

end readSimulationResultVars;

22.1.200 realpath

Get full path name of file or directory name

function realpath
input String name "Absolute or relative file or directory name";
output String fullName "Full path of 'name'";

end realpath;
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22.1.201 reduceTerms

reduce terms.

function reduceTerms
input TypeName className "the class that should be built";

input Real startTime = 0.0 "the start time of the simulation. <default> = 0.0";

input Real stopTime = 1.0 "the stop time of the simulation. <default> = 1.0";

input Integer numberOfIntervals = 500 "number of intervals in the result file.
—<default> = 500";

input Real tolerance = le-6 "tolerance used by the integration method. <default>
—= le-6";

input String method = "dassl" "integration method used for simulation. <default>
—= dassl";

input String fileNamePrefix = "" "fileNamePrefix. <default> = \"\"";

input String options = "" "options. <default> = \"\"";

input String outputFormat = "mat" "Format for the result file. <default> = \"mat\
="

input String variableFilter = ".x" "Filter for variables that should store in_
—result file. <default> = \".x\"";

input String cflags = "" "cflags. <default> = \"\"";

input String simflags = "" "simflags. <default> = \"\"";

input String labelstoCancel = "";

output String[2] buildModelResults;
end reduceTerms;

22.1.202 regex

Sets the error buffer and returns -1 if the regex does not compile.
The returned result is the same as POSIX regex():

The first value is the complete matched string

The rest are the substrings that you wanted.

For example:

regex (lorem, " \ ([A-Za-z]x\) \([A-Za-z]*\) ",maxMatches=3)

=> {" ipsum dolor ","ipsum","dolor"}

This means if you have n groups, you want maxMatches=n+1l

function regex
input String str;
input String re;

input Integer maxMatches = 1 "The maximum number of matches that will be returned
=";

input Boolean extended = true "Use POSIX extended or regular syntax";

input Boolean caselnsensitive = false;

output Integer numMatches "-1 is an error, 0 means no match, else returns a_

—number 1..maxMatches";

output String matchedSubstrings[maxMatches] "unmatched strings are returned as,
—empty";
end regex;

22.1.203 regexBool

Returns true if the string matches the regular expression.

function regexBool
input String str;
input String re;

(continues on next page)
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input Boolean extended = true "Use POSIX extended or regular syntax";
input Boolean caselnsensitive = false;
output Boolean matches;

end regexBool;

22.1.204 regularFileExists

function regularFileExists
input String fileName;
output Boolean exists;
end regularFileExists;

22.1.205 reloadClass

reloads the file associated with the given (loaded class)

function reloadClass
input TypeName name;
input String encoding = "UTE-8";
output Boolean success;

end reloadClass;

22.1.206 remove

removes a file or directory of given path (which may be either relative or
—absolute) .

function remove

input String path;

output Boolean success "Returns true on success.";
end remove;

22.1.207 removeComponentModifiers

function removeComponentModifiers
input TypeName class_;
input String componentName;
input Boolean keepRedeclares = false;
output Boolean success;

end removeComponentModifiers;

22.1.208 removeExtendsModifiers

function removeExtendsModifiers
input TypeName className;
input TypeName baseClassName;
input Boolean keepRedeclares = false;
output Boolean success;
end removeExtendsModifiers;
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22.1.209 reopenStandardStream

function reopenStandardStream
input StandardStream _stream;
input String filename;
output Boolean success;

end reopenStandardStream;

22.1.210 rewriteBlockCall

Function for property modeling, transforms block calls into instantiations for a
—loaded model

function rewriteBlockCall
input TypeName className;
input TypeName inDefs;
output Boolean success;
end rewriteBlockCall;

22.1.211 runOpenTURNSPythonScript

runs OpenTURNS with the given python script returning the log file

function runOpenTURNSPythonScript
input String pythonScriptFile;
output String logOutputFile;
end runOpenTURNSPythonScript;

22.1.212 runScript

Runs the mos-script specified by the filename.

impure function runScript
input String fileName "*.mos";
output String result;

end runScript;

22.1.213 runScriptParallel

function runScriptParallel
input String scripts[:];

input Integer numThreads = numProcessors();
input Boolean useThreads = false;
output Boolean results[:];

end runScriptParallel;

22.1.214 save
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function save
input TypeName className;
output Boolean success;
end save;

22.1.215 saveAll

save the entire loaded AST to file.

function saveAll
input String fileName;
output Boolean success;
end saveAll;

22.1.216 saveModel

function saveModel
input String fileName;
input TypeName className;
output Boolean success;
end saveModel;

22.1.217 saveTotalModel

function saveTotalModel
input String fileName;
input TypeName className;
input Boolean stripAnnotations = false;
input Boolean stripComments = false;
output Boolean success;

end saveTotalModel;

22.1.218 saveTotalSCode

22.1.219 searchClassNames

Searches for the class name in the all the loaded classes.
Example command:

searchClassNames ("ground") ;

searchClassNames ("ground", true);

function searchClassNames
input String searchText;
input Boolean findInText = false;
output TypeName classNames[:];
end searchClassNames;

22.1.220 setAnnotationVersion

Sets the annotation version.
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function setAnnotationVersion
input String annotationVersion;
output Boolean success;

end setAnnotationVersion;

22.1.221 setCFlags

CEFLAGS

function setCFlags
input String inString;
output Boolean success;
end setCFlags;

22.1.222 setCXXCompiler

CXX

function setCXXCompiler
input String compiler;
output Boolean success;
end setCXXCompiler;

22.1.223 setCheapMatchingAlgorithm

example input: 3

function setCheapMatchingAlgorithm
input Integer matchingAlgorithm;
output Boolean success;

end setCheapMatchingAlgorithm;

22.1.224 setClassComment

Sets the class comment.

function setClassComment
input TypeName class_;
input String filename;
output Boolean success;
end setClassComment;

22.1.225 setCommandLineOptions

The input is a regular command-line flag given to OMC,

—g=MetaModelica

e.g. —-d=failtrace or -
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function setCommandLineOptions
input String option;
output Boolean success;

end setCommandLineOptions;

22.1.226 setCompileCommand

function setCompileCommand
input String compileCommand;
output Boolean success;

end setCompileCommand;

22.1.227 setCompiler

CcC

function setCompiler
input String compiler;
output Boolean success;
end setCompiler;

22.1.228 setCompilerFlags

function setCompilerFlags
input String compilerFlags;
output Boolean success;
end setCompilerFlags;

22.1.229 setCompilerPath

function setCompilerPath
input String compilerPath;
output Boolean success;
end setCompilerPath;

22.1.230 setDebugFlags

example input: failtrace, -noevalfunc

function setDebugFlags
input String debugFlags;
output Boolean success;
end setDebugFlags;

22.1.231 setDefaultOpenCLDevice

Sets the default OpenCL device to be used.
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function setDefaultOpenCLDevice
input Integer defdevid;
output Boolean success;

end setDefaultOpenCLDevice;

22.1.232 setDocumentationAnnotation

function setDocumentationAnnotation
input TypeName class_;
input String info = "";
input String revisions = "";
output Boolean bool;

end setDocumentationAnnotation;

22.1.233 setEnvironmentVar

function setEnvironmentVar
input String var;
input String value;
output Boolean success;
end setEnvironmentVar;

22.1.234 setindexReductionMethod

example input: dynamicStateSelection

function setIndexReductionMethod
input String method;
output Boolean success;

end setIndexReductionMethod;

22.1.235 setlnitXmlStartValue

function setInitXmlStartValue
input String fileName;
input String variableName;
input String startValue;
input String outputFile;
output Boolean success = false;
end setInitXmlStartValue;

22.1.236 setinstallationDirectoryPath

Sets the OPENMODELICAHOME environment variable. Use this method instead of
—setEnvironmentVar.

function setInstallationDirectoryPath
input String installationDirectoryPath;
output Boolean success;

end setInstallationDirectoryPath;
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22.1.237 setLanguageStandard

Sets the Modelica Language Standard.

function setLanguageStandard
input String inVersion;
output Boolean success;
end setLanguageStandard;

22.1.238 setLinker

function setLinker
input String linker;
output Boolean success;
end setLinker;

22.1.239 setLinkerFlags

function setLinkerFlags
input String linkerFlags;
output Boolean success;
end setLinkerFlags;

22.1.240 setMatchingAlgorithm

example input: omc

function setMatchingAlgorithm
input String matchingAlgorithm;
output Boolean success;

end setMatchingAlgorithm;

22.1.241 setModelicaPath

The Modelica Library Path - MODELICAPATH in the language specification;
—OPENMODELICALIBRARY in OpenModelica.

function setModelicaPath
input String modelicaPath;
output Boolean success;
end setModelicaPath;

22.1.242 setNoSimplify

Sets the noSimplify flag.

function setNoSimplify
input Boolean noSimplify;
output Boolean success;
end setNoSimplify;
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22.1.243 setOrderConnections

Sets the orderConnection flag.

function setOrderConnections
input Boolean orderConnections;
output Boolean success;

end setOrderConnections;

22.1.244 setPlotCommand

function setPlotCommand
input String plotCommand;
output Boolean success;
end setPlotCommand;

22.1.245 setPostOptModules

example input: lateInline,inlineArrayEqn,removeSimpleEquations.

function setPostOptModules
input String modules;
output Boolean success;
end setPostOptModules;

22.1.246 setPreOptModules

example input: removeFinalParameters, removeSimpleEquations, expandDerOperator

function setPreOptModules
input String modules;
output Boolean success;
end setPreOptModules;

22.1.247 setShowAnnotations

function setShowAnnotations
input Boolean show;
output Boolean success;
end setShowAnnotations;

22.1.248 setSourceFile

function setSourceFile
input TypeName class_;
input String filename;
output Boolean success;
end setSourceFile;
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22.1.249 setTearingMethod

example input: omcTearing

function setTearingMethod
input String tearingMethod;
output Boolean success;
end setTearingMethod;

22.1.250 setTempDirectoryPath

function setTempDirectoryPath
input String tempDirectoryPath;
output Boolean success;

end setTempDirectoryPath;

22.1.251 setVectorizationLimit

function setVectorizationLimit
input Integer vectorizationLimit;
output Boolean success;

end setVectorizationLimit;

22.1.252 simulate

simulates a modelica model by generating c code, build it and run the simulation_
—executable.

The only required argument is the className, while all others have some default
—values.

simulate (className, [startTime], [stopTime], [numberOfIntervals], [tolerance],

— [method], [fileNamePrefix], [options], [outputFormat], [variableFilter],
—[cflags], [simflags])

Example command:

simulate (A);

function simulate
input TypeName className "the class that should simulated";

input Real startTime = "<default>" "the start time of the simulation. <default>_
—= 0.0";

input Real stopTime = 1.0 "the stop time of the simulation. <default> = 1.0";

input Real numberOfIntervals = 500 "number of intervals in the result file.
—<default> = 500";

input Real tolerance = le-6 "tolerance used by the integration method. <default>
—= le-0";

input String method = "<default>" "integration method used for simulation.
—~<default> = dassl";

input String fileNamePrefix = "<default>" "fileNamePrefix. <default> = \"\"";

input String options = "<default>" "options. <default> = \"\"";

input String outputFormat = "mat" "Format for the result file. <default> = \"mat\
="

input String variableFilter = ".x" "Filter for variables that should store in_
—result file. <default> = \".x\"";

input String cflags = "<default>" "cflags. <default> = \"\"";

input String simflags = "<default>" "simflags. <default> = \"\"";

output SimulationResult simulationResults;

(continues on next page)
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record SimulationResult
String resultFile;
String simulationOptions;
String messages;
Real timeFrontend;
Real timeBackend;
Real timeSimCode;
Real timeTemplates;
Real timeCompile;
Real timeSimulation;
Real timeTotal;

end SimulationResult;

end simulate;

22.1.253 solveLinearSystem

Solve AxX = B,
Returns for solver dgesv:
For solver lp_solve: 2727

using dgesv or lp_
info>0:

solve (if any variable in X

Singular for element 1.

info<0:

is integer)
Bad input.

function solvelinearSystem
input Real[size(B, 1), size (B,
input Real[:] B;
input LinearSystemSolver solver
input Integer([:] isInt {-1}
output Real[size (B, 1)] X;
output Integer info;

end solvelinearSystem;

1 A;

LinearSystemSolver.dgesv;

"list of indices that are integers";

22.1.254 sortStrings

function sortStrings
input String arr[:];
output String sorted[:];
end sortStrings;

22.1.255 stat

impure function stat
input String fileName;
output Boolean success;
output Real fileSize;
output Real mtime;

end stat;

22.1.256 stringReplace

function stringReplace
input String str;
input String source;
input String target;
output String res;
end stringReplace;
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22.1.257 stringSplit

Splits the string at the places given by the character

function stringSplit
input String string;
input String token "single character only";
output String[:] strings;

end stringSplit;

22.1.258 stringTypeName

function stringTypeName
input String str;
output TypeName cl;
end stringTypeName;

22.1.259 stringVariableName

function stringVariableName
input String str;
output VariableName cl;
end stringVariableName;

22.1.260 strtok

Splits the strings at the places given by the token, for example:
StrtOk("abedef","b") :> {"a",llcll,"def"}
strtok ("abcbdef", "cd") => {"ab","ef"}

function strtok
input String string;
input String token;
output String[:] strings;
end strtok;

22.1.261 system

Similar to system(3). Executes the given command in the system shell.

impure function system

input String callStr "String to call: sh -c $callStr";

input String outputFile = "" "The output is redirected to this file (unless,
—already done by callStr)";

output Integer retval "Return value of the system call; usually 0 on success";
end system;

22.1.262 system_parallel

Similar to system(3). Executes the given commands in the system shell, in parallel
—if omc was compiled using OpenMP.
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impure function system parallel

input String callStr([:] "String to call: sh -c $callStr";
input Integer numThreads = numProcessors();
output Integer retval[:] "Return value of the system call; usually 0 on success";

end system_parallel;

22.1.263 testsuiteFriendlyName

function testsuiteFriendlyName
input String path;
output String fixed;

end testsuiteFriendlyName;

22.1.264 threadWorkFailed

22.1.265 translateGraphics

function translateGraphics
input TypeName className;
output String result;
end translateGraphics;

22.1.266 translateModelFMU

translates a modelica model into a Functional Mockup Unit.

The only required argument is the className, while all others have some default
—values.

Example command:

translateModelFMU (className, version="2.0");

function translateModelFMU
input TypeName className "the class that should translated";

input String version = "2.0" "FMU version, 1.0 or 2.0.";

input String fmuType = "me" "FMU type, me (model exchange), cs (co-simulation),
—me_cs (both model exchange and co-simulation)";

input String fileNamePrefix = "<default>" "fileNamePrefix. <default> = \

—"className\"";

input Boolean includeResources = false "include Modelica based resources via,
—~loadResource or not";

output String generatedFileName "Returns the full path of the generated FMU.";
end translateModelFMU;

22.1.267 typeNameString

function typeNameString
input TypeName cl;
output String out;
end typeNameString;
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22.1.268 typeNameStrings

function typeNameStrings
input TypeName cl;
output String out[:];
end typeNameStrings;

22.1.269 typeOf

function typeOf
input VariableName variableName;
output String result;

end typeOf;

22.1.270 updatelnitialState

function updateInitialState
input TypeName cl;
input String state;
input ExpressionOrModification annotate;
output Boolean bool;
end updatelInitialState;

22.1.271 updateTransition

function updateTransition
input TypeName cl;
input String from;
input String to;
input String oldCondition;
input Boolean oldImmediate;
input Boolean oldReset;
input Boolean oldSynchronize;
input Integer oldPriority;
input String newCondition;
input Boolean newImmediate;
input Boolean newReset;
input Boolean newSynchronize;
input Integer newPriority;
input ExpressionOrModification annotate;
output Boolean bool;

end updateTransition;

22.1.272 uriToFilename

function uriToFilename

input String uri;

output String filename = "";
end uriToFilename;

22.1. OpenModelica Scripting Commands

247




OpenModelica User’s Guide, Release v1.13.0

22.1.273 val

Return the value of a variable at a given time in the simulation results

function val
input VariableName var;
input Real timePoint = 0.0;

input String fileName = "<default>" "The contents of the currentSimulationResult_
—variable";

output Real valAtTime;
end val;

22.1.274 verifyCompiler

function verifyCompiler
output Boolean compilerWorks;
end verifyCompiler;

22.1.275 writeFile

Write the data to file. Returns true on success.

impure function writeFile
input String fileName;
input String data;
input Boolean append = false;
output Boolean success;

end writeFile;

22.2 Simulation Parameter Sweep

Following example shows how to update the parameters and re-run the simulation without compiling the model.

loadFile ("BouncingBall.mo");
getErrorString () ;
// build the model once
buildModel (BouncingBall) ;
getErrorString();
for i in 1:3 loop
// We update the parameter e start value from 0.7 to "0.7 + 1i".
value := 0.7 + 1i;
// call the generated simulation code to produce a result file BouncingBall$i$_
—res.mat
system("./BouncingBall -override=e="+String(value)+" -r=BouncingBall" + |
—String (i) + "_res.mat");
getErrorString();
end for;

We used the BouncingBall.mo in the example above. The above example produces three result files each contain-
ing different start value for e i.e., 1.7, 2.7, 3.7.
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22.3 Examples

The following is an interactive session with the OpenModelica environment including some of the abovemen-
tioned commands and examples. First we start the system, and use the command line interface from OMShell,

OMNotebook, or command window of some of the other tools.

We type in a very small model:

model Test "Testing OpenModelica Scripts"
Real x, vy;

equation
x = 5.0+time; y = 6.0;

end Test;

We give the command to flatten a model:

>>> instantiateModel (Test)
class Test "Testing OpenModelica Scripts"
Real x;
Real y;
equation
x = 5.0 + time;
y = 6.0;
end Test;

A range expression is typed in:

>>> a:=1:10
{1,2,3,4,5,6,7,8,9,10}

It is multiplied by 2:

>>> a*2
{2,4,6,8,10,12,14,16,18,20}

The variables are cleared:

>>> clearVariables ()
true

We print the loaded class test from its internal representation:

>>> list (Test)
model Test "Testing OpenModelica Scripts"
Real x, vy;

equation
x = 5.0 + time;
y = 6.0;

end Test;

We get the name and other properties of a class:

>>> getClassNames ()
{Test,ProfilingTest}

>>> getClassComment (Test)
"Testing OpenModelica Scripts"
>>> isPartial (Test)

false

>>> isPackage (Test)

false

>>> isModel (Test)

true

(continues on next page)
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(continued from previous page)

>>> checkModel (Test)

"Check of Test completed successfully.

Class Test has 2 equation(s) and 2 variable(s).
2 of these are trivial equation(s) ."

The common combination of a simulation followed by getting a value and doing a plot:

>>> simulate (Test, stopTime=3.0)
record SimulationResult

resultFile = "«DOCHOME»/Test_res.mat",
simulationOptions = "startTime = 0.0, stopTime = 3.0, numberOflIntervals = 500,
—tolerance = 1le-06, method = 'dassl', fileNamePrefix = 'Test', options = "',
—outputFormat = 'mat', variableFilter = '.x', cflags = '', simflags = ''",
messages = "LOG_SUCCESS | info | The initialization finished,
—successfully without homotopy method.
LOG_SUCCESS | info | The simulation finished successfully.
stdout | info | Time measurements are stored in Test_prof.html

— (human-readable) and Test_prof.xml (for XSL transforms or more details)

n
’

timeFrontend = 0.004345121,
timeBackend = 0.009830459000000001,
timeSimCode = 0.205508009,
timeTemplates = 0.119929737,
timeCompile = 0.613037639,
timeSimulation = 0.038297177,
timeTotal = 0.991070626

end SimulationResult;

>>> val(x , 2.0)

7.0

6.06 T T T T

6.04 | T

6.02 - _

5.98 - _

5.96 N

5.94 | T

592 1 1 1 1 1

Figure 22.1: Plot generated by OpenModelica+gnuplot

>>> plotall ()

22.3.1 Interactive Function Calls, Reading, and Writing

We enter an assignment of a vector expression, created by the range construction expression 1:12, to be stored in
the variable x. The type and the value of the expression is returned.
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Figure 22.2: Plot generated by OpenModelica+gnuplot

>>> x = 1:12
{1,2,3,4,5,6,7,8,9,10,11,12}

The function bubblesort is called to sort this vector in descending order. The sorted result is returned together with
its type. Note that the result vector is of type Real[:], instantiated as Real[12], since this is the declared type of the
function result. The input Integer vector was automatically converted to a Real vector according to the Modelica
type coercion rules.

>>> loadFile (getInstallationDirectoryPath() + "/share/doc/omc/testmodels/
—bubblesort.mo")

true

>>> bubblesort (x)

{12.0,11.0,10.0,9.0,8.0,7.0,6.0,5.0,4.0,3.0,2.0,1.0}

Now we want to try another small application, a simplex algorithm for optimization. First read in a small matrix
containing coefficients that define a simplex problem to be solved:

>>> a = {
{-1,-1,-1, 0, 0O, O, 0, O, 0O},
{-1, 1, 0, 1, o0, 0, 0, O, 5},
{1, 4, 0, 0, 1, 0, 0, O, 45},
{2, 1, 0, 0, 0O, 1, 0, 0, 27},
{ 3,-4, o0, 0, 0, O, 1, 0, 243,
{0 0, 1, 0, 0, 0, 0, 1, 4}

}
{{71171171101010101010}1{711110111010101015}1{114101011101010145}1{2111010101110101
—27},{3,-4,0,0,0,0,1,0,24},{0,0,1,0,0,0,0,1,4}}

function pivotl

input Real bl[:,:];

input Integer p;

input Integer g;

output Real a[size(b,1l),size(b,2)];
protected

Integer M;

Integer N;
algorithm

(continues on next page)
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(continued from previous page)

a := Db;
N := size(a,1)-1;
M := size(a,2)-1;

for j in 1:N loop
for k in 1:M loop
if j<>p and k<>g then
alj, k] := alj,k]1-0.3x3;
end if;
end for;
end for;
alp,q] := 0.05;
end pivotl;

function misc_simplexl
input Real matr[:,:];
output Real x[size (matr,2)-1]1;
output Real z;
output Integer qg;
output Integer p;
protected
Real a[size(matr,1l),size(matr,2)];
Integer M;
Integer N;
algorithm
N := size(a,1)-1;
:= size(a,2)-1
:= matr;
:=0;9:=0;
= pivotl(a,pt+l,g+l);
while not (g==(M) or p==(N)) loop
q := 0;
while not (g == (M) or a[0+1l,g+1l]>1) loop
q:=q+l;
end while;
p = 0;
while not (p == (N) or a[p+l,g+1]>0.1) loop
p:=p+l;
end while;
if (g < M) and (p < N) and(p>0) and (g>0) then
a := pivotl(a,p,q);
end if;
if (p<=0) and (g<=0) then
a := pivotl(a,p+l,g+l);
end if;
if (p<=0) and (g>0) then
a := pivotl(a,p+l,q);
end if;
if(p>0) and (g<=0) then
a := pivotl(a,p,qt+l);
end if;
end while;
z = al[l,M];
x = {a[l,i] for i in l:size(x,1)};
for i in 1:10 loop
for j in 1:M loop
x[J] := x[3]1+x[3]1+0.01;
end for;
end for;
end misc_simplexl;

’

(VRN eI UICS
|

Then call the simplex algorithm implemented as the Modelica function simplex1. This function returns four
results, which are represented as a tuple of four return values:

252 Chapter 22. Scripting API




OpenModelica User’s Guide, Release v1.13.0

>>> misc_simplexl (a)
({0.05523110627056022,-1.104622125411205,-1.104622125411205,0.0,0.0,0.0,0.0,0.0},0.
—0,8,1)
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CHAPTER
TWENTYTHREE

OPENMODELICA COMPILER FLAGS

Usage: omc [Options] (Model.mo | Script.mos) [Libraries | .mo-files]

e Libraries: Fully qualified names of libraries to load before processing Model or Script. The libraries should
be separated by spaces: Libl Lib2 ... LibN.

23.1 Options

-d, —debug
Sets debug flags. Use —help=debug to see available flags.
String list (default empty).
-h, —help
Displays the help text. Use —help=topics for more information.
String (default empty).
—V, —version
Print the version and exit.
Boolean (default false).
—target
Sets the target compiler to use.
String (default gcc). Valid options:
e gcc
* msvc
* msvcl0
e msvcl2
* msvcl3
* msvcl5
* vxworks69
* debugrt
-8, —grammar
Sets the grammar and semantics to accept.
String (default Modelica). Valid options:
* Modelica
* MetaModelica
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» ParModelica
e Optimica
* PDEModelica
—annotationVersion
Sets the annotation version that should be used.
String (default 3.x). Valid options:
e 1x
* 2.X
* 3Xx
—std
Sets the language standard that should be used.
String (default latest). Valid options:
e 1x
e 2X
* 3.1
32
« 33
* latest
—showErrorMessages
Show error messages immediately when they happen.
Boolean (default false).
—showAnnotations
Show annotations in the flattened code.
Boolean (default false).
—noSimplify
Do not simplify expressions if set.
Boolean (default false).
—preOptModules
Sets the pre optimization modules to use in the back end. See —help=optmodules for more info.

String list (default normallnlineFunction,evaluateParameters,simplifyIfEquations,expandDerOperator,removeEqualFunctionCalls,cl
Valid options:

¢ clockPartitioning (Does the clock partitioning.)

¢ collapseArrayExpressions (Simplifies {x[1],x[2],x[3]} — x for arrays of whole variable references (simpli-
fies code generation).)

* comSubExp (Introduces alias assignments for variables which are assigned to simple terms i.e. a =b/c; d =
b/c; —> a=d)

¢ dumpDAE (dumps the DAE representation of the current transformation state)
e dumpDAEXML (dumps the DAE as xml representation of the current transformation state)
* encapsulateWhenConditions (This module replaces each when condition with a boolean variable.)

* evalFunc (evaluates functions partially)
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* evaluateParameters  (Evaluates  parameters  with  annotation(Evaluate=true). Use -
evaluateFinalParameters=true’ or ’—evaluateProtectedParameters=true’ to specify additional parameters to
be evaluated. Use '—replaceEvaluatedParameters=true’ if the evaluated parameters should be replaced in
the DAE. To evaluate all parameters in the Frontend use -d=evaluate AllParameters.)

* expandDerOperator (Expands der(expr) using Derive.differentiteExpTime.)

« findStateOrder (Sets derivative information to states.)

* inlineArrayEqn (This module expands all array equations to scalar equations.)

» normallnlineFunction (Perform function inlining for function with annotation Inline=true.)
* inputDerivativesForDynOpt (Allowed derivatives of inputs in dyn. optimization.)

¢ introduceDerAlias (Adds for every der-call an alias equation e.g. dx = der(x).)

» removeEqualFunctionCalls (Detects equal function calls of the form a=f(b) and c=f(b) and substitutes them
to get speed up.)

» removeProtectedParameters (Replace all parameters with protected=true in the system.)

» removeSimpleEquations (Performs alias elimination and removes constant variables from the DAE, replac-
ing all occurrences of the old variable reference with the new value (constants) or variable reference (alias
elimination).)

» removeUnusedParameter (Strips all parameter not present in the equations from the system.)
» removeUnusedVariables (Strips all variables not present in the equations from the system.)

» remove VerySimpleEquations ([Experimental] Like removeSimpleEquations, but less thorough. Note that
this always uses the experimental new alias elimination, —removeSimpleEquations=new, which makes it
unstable. In particular, MultiBody systems fail to translate correctly. It can be used for simple (but large)
systems of equations.)

* replaceEdgeChange (Replace edge(b) = b and not pre(b) and change(b) = v <> pre(v).)

* residualForm (Transforms simple equations x=y to zero-sum equations 0=y-x.)

* resolveLoops (resolves linear equations in loops)

« simplify AllExpressions (Does simplifications on all expressions.)

 simplifyIfEquations (Tries to simplify if equations by use of information from evaluated parameters.)
* sortEqnsVars (Heuristic sorting for equations and variables.)

* unitChecking (Does advanced unit checking which consists of two parts: 1. calculation of unspecified unit
information for variables; 2. consistency check for all equations based on unit information. Please note:
This module is still experimental.)

» wrapFunctionCalls (This module introduces variables for each function call and substitutes all these calls
with the newly introduced variables.)

—cheapmatchingAlgorithm
Sets the cheap matching algorithm to use. A cheap matching algorithm gives a jump start matching by heuristics.
Integer (default 3). Valid options:

* 0 (No cheap matching.)

* 1 (Cheap matching, traverses all equations and match the first free variable.)

* 3 (Random Karp-Sipser: R. M. Karp and M. Sipser. Maximum matching in sparse random graphs.)
—matchingAlgorithm
Sets the matching algorithm to use. See —help=optmodules for more info.
String (default PFPlusExt). Valid options:

* BFSB (Breadth First Search based algorithm.)
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* DFSB (Depth First Search based algorithm.)

* MC21A (Depth First Search based algorithm with look ahead feature.)

* PF (Depth First Search based algorithm with look ahead feature.)

* PFPlus (Depth First Search based algorithm with look ahead feature and fair row traversal.)

e HK (Combined BFS and DFS algorithm.)

* HKDW (Combined BFS and DFS algorithm.)

¢ ABMP (Combined BFS and DFS algorithm.)

* PR (Matching algorithm using push relabel mechanism.)

* DFSBEXxt (Depth First Search based Algorithm external ¢ implementation.)

* BFSBEXt (Breadth First Search based Algorithm external ¢ implementation.)

e MC21AExt (Depth First Search based Algorithm with look ahead feature external ¢ implementation.)
* PFExt (Depth First Search based Algorithm with look ahead feature external ¢ implementation.)

» PFPlusExt (Depth First Search based Algorithm with look ahead feature and fair row traversal external c
implementation.)

* HKExt (Combined BFS and DFS algorithm external ¢ implementation.)
» HKDWExt (Combined BFS and DFS algorithm external ¢ implementation.)
* ABMPExt (Combined BFS and DFS algorithm external ¢ implementation.)
¢ PRExt (Matching algorithm using push relabel mechanism external ¢ implementation.)
* BB (BBs try.)
—indexReductionMethod
Sets the index reduction method to use. See —help=optmodules for more info.
String (default dynamicStateSelection). Valid options:
* none (Skip index reduction)
* uode (Use the underlying ODE without the constraints.)

* dynamicStateSelection (Simple index reduction method, select (dynamic) dummy states based on analysis
of the system.)

e dummyDerivatives (Simple index reduction method, select (static) dummy states based on heuristic.)
—postOptModules
Sets the post optimization modules to use in the back end. See —help=optmodules for more info.

String list (default lateInlineFunction,wrapFunctionCalls,inlineArrayEqn,constantLinearSystem,simplifysemiLinear,removeSimplel
Valid options:

¢ addScaledVars_states (added var_norm = var/nominal, where var is state)
¢ addScaledVars_inputs (added var_norm = var/nominal, where var is input)

» addTimeAsState (Experimental feature: this replaces each occurrence of variable time with a new intro-
duced state $time with equation der($time) = 1.0)

* calculateStateSetsJacobians (Generates analytical jacobian for dynamic state selection sets.)

¢ calculateStrongComponentJacobians (Generates analytical jacobian for torn linear and non-linear strong
components. By default non-linear components with user-defined function calls are skipped. See also
debug flags: NLSanalyticJacobian and forceNLSanalyticJacobian)

* collapseArrayExpressions (Simplifies {x[1],x[2],x[3]} — x for arrays of whole variable references (simpli-
fies code generation).)
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* constantLinearSystem (Evaluates constant linear systems (a*x+b*y=c; d*x+e*y=f; a,b,c,d,e.f are constants)
at compile-time.)

» countOperations (Count the mathematical operations of the system.)
* createAliasVarsForOutputStates (Module creates alias variables for output states.)
¢ cseBinary (Common Sub-expression Elimination)

¢ dumpComponentsGraphStr (Dumps the assignment graph used to determine strong components to format
suitable for Mathematica)

¢ dumpDAE (dumps the DAE representation of the current transformation state)
¢ dumpDAEXML (dumps the DAE as xml representation of the current transformation state)

bl

e evaluateParameters  (Evaluates  parameters with  annotation(Evaluate=true). Use -
evaluateFinalParameters=true’ or ’—evaluateProtectedParameters=true’ to specify additional parameters to
be evaluated. Use '—replaceEvaluatedParameters=true’ if the evaluated parameters should be replaced in
the DAE. To evaluate all parameters in the Frontend use -d=evaluate AllParameters.)

¢ extendDynamicOptimization (Move loops to constraints.)

» generateSymbolicLinearization (Generates symbolic linearization matrices A,B,C,D for linear model:z =
Az + Bu)

 generateSymbolicSensitivities (Generates symbolic Sensivities matrix, where der(x) is differentiated w.r.t.
param.)

* inlineArrayEqn (This module expands all array equations to scalar equations.)

« inputDerivativesUsed (Checks if derivatives of inputs are need to calculate the model.)

¢ lateInlineFunction (Perform function inlining for function with annotation Latelnline=true.)
* partlintornsystem (partitions linear torn systems.)

* recursiveTearing (inline and repeat tearing)

¢ reduceDynamicOptimization (Removes equations which are not needed for the calculations of cost and
constraints. This module requires -d=reduceDynOpt.)

* relaxSystem (relaxation from gausian elemination)
* removeConstants (Remove all constants in the system.)

* removeEqualFunctionCalls (Detects equal function calls of the form a=f(b) and c=f(b) and substitutes them
to get speed up.)

» removeSimpleEquations (Performs alias elimination and removes constant variables from the DAE, replac-
ing all occurrences of the old variable reference with the new value (constants) or variable reference (alias
elimination).)

» removeUnusedParameter (Strips all parameter not present in the equations from the system to get speed up
for compilation of target code.)

» removeUnusedVariables (Strips all variables not present in the equations from the system to get speed up
for compilation of target code.)

* reshufflePost (Reshuffles algebraic loops.)
« simplify AllExpressions (Does simplifications on all expressions.)

* simplifyComplexFunction (Some simplifications on complex functions (complex refers to the internal data
structure))

* simplifyConstraints (Rewrites nonlinear constraints into box constraints if possible. This module requires
+gDynOpt.)

* simplifyLoops (Simplifies algebraic loops. This modules requires +simplifyLoops.)
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der(param) -> 0.0, change(param) -> false, edge(param) -> false.)
simplifysemiLinear (Simplifies calls to semiLinear.)
solveLinearSystem (solve linear system with newton step)
solveSimpleEquations (Solves simple equations)

symSolver (Rewrites the ode system for implicit Euler method. This

if flag *—generateSymbolicJacobian’ is enabled.)

tearingSystem (For method selection use flag tearingMethod.)

with the newly introduced variables.)
—simCodeTarget
Sets the target language for the code generation.
String (default C). Valid options:

None
L]

Adevs
C

Cpp

CSharp
ExperimentalEmbeddedC
Java

JavaScript

sfmi

XML

MidC

—orderConnections

Orders connect equations alphabetically if set.
Boolean (default t rue).

-t, —typeinfo

Prints out extra type information if set.
Boolean (default false).

-a, —keepArrays

Sets whether to split arrays or not.

Boolean (default false).

-m, —modelicaOutput

Enables valid modelica output for flat modelica.
Boolean (default false).

-q, —silent

Turns on silent mode.

Boolean (default false).

simplifyTimeIndepFuncCalls (Simplifies time independent built in function calls like pre(param) -> param,

module requires +symSolver.)

symbolicJacobian (Detects the sparse pattern of the ODE system and calculates also the symbolic Jacobian

wrapFunctionCalls (This module introduces variables for each function call and substitutes all these calls
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-c, —corbaSessionName
Sets the name of the corba session if -d=interactiveCorba or —interactive=corba is used.
String (default empty).
-n, —-numProcs
Sets the number of processors to use (O=default=auto).
Integer (default 0).
-1, —latency
Sets the latency for parallel execution.
Integer (default 0).
-b, —bandwidth
Sets the bandwidth for parallel execution.
Integer (default 0).
-1, —instClass
Instantiate the class given by the fully qualified path.
String (default empty).
-V, —vectorizationLimit
Sets the vectorization limit, arrays and matrices larger than this will not be vectorized.
Integer (default 0).
-s, —simulationCg
Turns on simulation code generation.
Boolean (default false).
—evalAnnotationParams
Sets whether to evaluate parameters in annotations or not.
Boolean (default false).
—generateLabeledSimCode
Turns on labeled SimCode generation for reduction algorithms.
Boolean (default false).
—reduceTerms
Turns on reducing terms for reduction algorithms.
Boolean (default false).
—reductionMethod
Sets the reduction method to be used.
String (default deletion). Valid options:
* deletion
* substitution
¢ linearization
—demoMode
Disable Warning/Error Massages.

Boolean (default false).
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—locale

Override the locale from the environment.

String (default empty).
-0, —defaultOCLDevice

Sets the default OpenCL device to be used for parallel execution.

Integer (default 0).

—maxTraversals

Maximal traversals to find simple equations in the acausal system.

Integer (default 2).

—dumpTarget

Redirect the dump to file. If the file ends with .html HTML code is generated.

String (default empty).

—delayBreakLoop

Enables (very) experimental code to break algebraic loops using the delay() operator. Probably messes with
initialization.

Boolean (default t rue).

—tearingMethod

Sets the tearing method to use. Select no tearing or choose tearing method.

String (default cellier). Valid options:

noTearing (Skip tearing.)
omcTearing (Tearing method developed by TU Dresden: Frenkel, Schubert.)
cellier (Tearing based on Celliers method, revised by FH Bielefeld: Tduber, Patrick)

—tearingHeuristic

Sets the tearing heuristic to use for Cellier-tearing.

String (default MC3). Valid options:

MCI (Original cellier with consideration of impossible assignments and discrete Vars.)
MC?2 (Modified cellier, drop first step.)

MCI11 (Modified MC1, new last step ’count impossible assignments’.)

MC21 (Modified MC2, new last step ’count impossible assignments’.)

MCI12 (Modified MC1, step "count impossible assignments’ before last step.)

MC22 (Modified MC2, step ’count impossible assignments’ before last step.)

MCI13 (Modified MC1, build sum of impossible assignment and causalizable equations, choose var with
biggest sum.)

MC23 (Modified MC2, build sum of impossible assignment and causalizable equations, choose var with
biggest sum.)

MC231 (Modified MC23, Two rounds, choose better potentials-set.)

MC3 (Modified cellier, build sum of impossible assignment and causalizable equations for all vars, choose
var with biggest sum.)

MC4 (Modified cellier, use all heuristics, choose var that occurs most in potential sets)
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—disableLinearTearing

Disables the tearing of linear systems. That might improve the performance of large linear systems(N>1000) in
combination with a sparse solver (e.g. umfpack) at runtime (usage with: -Is umfpack). Deprecated flag: Use
—maxSizeLinearTearing=0 instead.

Boolean (default false).

—scalarizeMinMax

Scalarizes the builtin min/max reduction operators if true.
Boolean (default false).

—scalarizeBindings

Always scalarizes bindings if set.

Boolean (default false).
—corbaObjectReferenceFilePath

Sets the path for corba object reference file if -d=interactiveCorba is used.
String (default empty).

—hpcomScheduler

Sets the scheduler for task graph scheduling (list | listr | level | levelfix | ext | metis | mcp | taskdep | tds | bls | rand |
none). Default: level.

String (default level).

—hpcomCode

Sets the code-type produced by hpcom (openmp | pthreads | pthreads_spin | tbb | mpi). Default: openmp.
String (default openmp).

—rewriteRulesFile

Activates user given rewrite rules for Absyn expressions. The rules are read from the given file and are of the form
rewrite(fromExp, toExp);

String (default empty).
—replaceHomotopy

Replaces homotopy(actual, simplified) with the actual expression or the simplified expression. Good for debug-
ging models which use homotopy. The default is to not replace homotopy.

String (default none). Valid options:

 none (Default, do not replace homotopy.)

* actual (Replace homotopy(actual, simplified) with actual.)

* simplified (Replace homotopy(actual, simplified) with simplified.)
—generateSymbolicJacobian

Generates symbolic Jacobian matrix, where der(x) is differentiated w.r.t. x. This matrix can be used by dassl or
ida solver with simulation flag ’-jacobian’.

Boolean (default false).

—generateSymbolicLinearization

Generates symbolic linearization matrices A,B,C,D for linear model: & = Ax + Buy = Cx + Du
Boolean (default false).

—intEnumConversion

Allow Integer to enumeration conversion.
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Boolean (default false).

—profiling

Sets the profiling level to use. Profiled equations and functions record execution time and count for each time step
taken by the integrator.

String (default none). Valid options:
* none (Generate code without profiling)
* blocks (Generate code for profiling function calls as well as linear and non-linear systems of equations)
* blocks+html (Like blocks, but also run xsltproc and gnuplot to generate an html report)
* all (Generate code for profiling of all functions and equations)

* all_perf (Generate code for profiling of all functions and equations with additional performance data using
the papi-interface (cpp-runtime))

* all_stat (Generate code for profiling of all functions and equations with additional statistics (cpp-runtime))
—reshuffle
sets tolerance of reshuffling algorithm: 1: conservative, 2: more tolerant, 3 resolve all
Integer (default 1).
—gDynOpt
Generate dynamic optimization problem based on annotation approach.
Boolean (default false).
—maxSizeSolveLinearSystem
Max size for solveLinearSystem.
Integer (default 0).
—cppFlags
Sets extra flags for compilation with the C++ compiler (e.g. +cppFlags=-03,-Wall)
String list (default ).
—removeSimpleEquations
Specifies method that removes simple equations.
String (default default). Valid options:
¢ none (Disables module)

¢ default (Performs alias elimination and removes constant variables. Default case uses in preOpt phase the
fastAcausal and in postOpt phase the causal implementation.)

* causal (Performs alias elimination and removes constant variables. Causal implementation.)
* fastAcausal (Performs alias elimination and removes constant variables. fastimplementation fastAcausal.)
¢ allAcausal (Performs alias elimination and removes constant variables. Implementation allAcausal.)
* new (New implementation (experimental))
—dynamicTearing
Activates dynamic tearing (TearingSet can be changed automatically during runtime, strict set vs. casual set.)
String (default false). Valid options:
* false (No dynamic tearing.)
* true (Dynamic tearing for linear and nonlinear systems.)

¢ linear (Dynamic tearing only for linear systems.)
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* nonlinear (Dynamic tearing only for nonlinear systems.)
—symSolver
Activates symbolic implicit solver (original system is not changed).
String (default none). Valid options:
* none
» impEuler
» expEuler
—loop2con
Specifies method that transform loops in constraints. hint: using initial guess from file!
String (default none). Valid options:
¢ none (Disables module)
¢ lin (linear loops —> constraints)
* noLin (no linear loops —> constraints)
* all (loops —> constraints)
—forceTearing
Use tearing set even if it is not smaller than the original component.
Boolean (default false).
—simplifyLoops
Simplify algebraic loops.
Integer (default 0). Valid options:
* 0 (do nothing)
* 1 (special modification of residual expressions)
* 2 (special modification of residual expressions with helper variables)
—recursivelearing
Inline and repeat tearing.
Integer (default 0). Valid options:
* 0 (do nothing)
* 1 (linear tearing set of size 1)
* 2 (linear tearing)
—flowThreshold
Sets the minium threshold for stream flow rates
Real (default 1e-07).
—matrixFormat
Sets the matrix format type in cpp runtime which should be used (dense | sparse ). Default: dense.
String (default dense).
—partlintorn
Sets the limit for partitionin of linear torn systems.
Integer (default 0).
—initOptModules
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Sets the initialization optimization modules to use in the back end. See —help=optmodules for more info.

String list (default simplifyComplexFunction,tearingSystem,solveSimpleEquations,calculateStrongComponentJacobians,simplify Al
Valid options:

¢ calculateStrongComponentJacobians (Generates analytical jacobian for torn linear and non-linear strong
components. By default non-linear components with user-defined function calls are skipped. See also
debug flags: NLSanalyticJacobian and forceNLSanalyticJacobian)

* collapseArrayExpressions (Simplifies {x[1],x[2],x[3]} — x for arrays of whole variable references (simpli-
fies code generation).)

* constantLinearSystem (Evaluates constant linear systems (a*x+b*y=c; d*x+e*y=f; a,b,c,d,e,f are constants)
at compile-time.)

* extendDynamicOptimization (Move loops to constraints.)

 generatetHomotopyComponents (Finds the parts of the DAE that have to be handled by the homotopy solver
and creates a strong component out of it.)

* inlineHomotopy (Experimental: Inlines the homotopy expression to allow symbolic simplifications.)
* inputDerivativesUsed (Checks if derivatives of inputs are need to calculate the model.)
* recursiveTearing (inline and repeat tearing)

¢ reduceDynamicOptimization (Removes equations which are not needed for the calculations of cost and
constraints. This module requires -d=reduceDynOpt.)

* replaceHomotopyWithSimplified (Replaces the homotopy expression homotopy(actual, simplified) with the
simplified part.)

« simplify AllExpressions (Does simplifications on all expressions.)

* simplifyComplexFunction (Some simplifications on complex functions (complex refers to the internal data
structure))

 simplifyConstraints (Rewrites nonlinear constraints into box constraints if possible. This module requires
+gDynOpt.)

* simplifyLoops (Simplifies algebraic loops. This modules requires +simplifyLoops.)
* solveSimpleEquations (Solves simple equations)
* tearingSystem (For method selection use flag tearingMethod.)

» wrapFunctionCalls (This module introduces variables for each function call and substitutes all these calls
with the newly introduced variables.)

—maxMixedDeterminedIndex

Sets the maximum mixed-determined index that is handled by the initialization.
Integer (default 3).

—useLocalDirection

Keeps the input/output prefix for all variables in the flat model, not only top-level ones.
Boolean (default false).

—defaultOptModulesOrdering

If this is activated, then the specified pre-/post-/init-optimization modules will be rearranged to the recommended
ordering.

Boolean (default t rue).
—preOptModules+

Enables additional pre-optimization modules, e.g. —preOptModules+=modulel,module2 would additionally en-
able modulel and module2. See —/elp=optmodules for more info.

266 Chapter 23. OpenModelica Compiler Flags



OpenModelica User’s Guide, Release v1.13.0

String list (default empty).
—preOptModules-

Disables a list of pre-optimization modules, e.g. —preOptModules-=module1,module2 would disable modulel and
module2. See —help=optmodules for more info.

String list (default empty).
—postOptModules+

Enables additional post-optimization modules, e.g. —postOptModules+=modulel,module2 would additionally
enable modulel and module2. See —help=optmodules for more info.

String list (default empty).
—postOptModules-

Disables a list of post-optimization modules, e.g. —postOptModules-=modulel,module2 would disable modulel
and module2. See —help=optmodules for more info.

String list (default empty).
—initOptModules+

Enables additional init-optimization modules, e.g. —initOptModules+=modulel,module2 would additionally en-
able modulel and module2. See —/elp=optmodules for more info.

String list (default empty).
—initOptModules-

Disables a list of init-optimization modules, e.g. —initOptModules-=modulel,module2 would disable modulel
and module2. See —help=optmodules for more info.

String list (default empty).

—instCacheSize

Sets the size of the internal hash table used for instantiation caching.

Integer (default 25343).

—maxSizeLinearTearing

Sets the maximum system size for tearing of linear systems (default 200).
Integer (default 200).

—maxSizeNonlinearTearing

Sets the maximum system size for tearing of nonlinear systems (default 10000).
Integer (default 10000).

—noTearingForComponent

Deactivates tearing for the specified components. Use ’-d=tearingdump’ to find out the relevant indexes.
Unknown default valueFlags.FlagData.INT_LIST_FLAG(data = {NIL})
—daeMode

Generates code to simulate models in DAE mode. The whole system is passed directly to the DAE solver SUN-
DIALS/IDA and no algebraic solver is involved in the simulation process.

Boolean (default false).
—inlineMethod

Sets the inline method to use. replace : This method inlines by replacing in place all expressions. Might lead to
very long expression. append : This method inlines by adding additional variables to the whole system. Might
lead to much bigger system.

String (default replace). Valid options:
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* replace
* append
—setTearingVars

Sets the tearing variables by its strong component indexes. Use *-d=tearingdump’ to find out the relevant indexes.
Use following format: ’—setTearingVars=(sci,n,tl,...,tn)*’, with sci = strong component index, n = number of
tearing variables, tl,...tn = tearing variables. E.g.: ’—setTearingVars=4,2,3,5’ would select variables 3 and 5 in
strong component 4.

Unknown default valueFlags.FlagData.INT_LIST_FLAG(data = {NIL})
—setResidual Eqns

Sets the residual equations by its strong component indexes. Use ’-d=tearingdump’ to find out the relevant indexes
for the collective equations. Use following format: ’—setResidualEqns=(sci,n,r1,...,rn)*’, with sci = strong com-
ponent index, n = number of residual equations, rl,...rn = residual equations. E.g.: ’—setResidualEqns=4,2,3,5’
would select equations 3 and 5 in strong component 4. Only works in combination with ’setTearingVars’.

Unknown default valueFlags.FlagData INT_LIST_FLAG(data = {NIL})
—ignoreCommandLineOptionsAnnotation

Ignores the command line options specified as annotation in the class.
Boolean (default false).

—calculateSensitivities

Generates sensitivities variables and matrixes.

Boolean (default false).

-1, —alarm

Sets the number seconds until omc timeouts and exits. Used by the testing framework to terminate infinite running
processes.

Integer (default 0).
—totalTearing

Activates total tearing (determination of all possible tearing sets) for the specified components. Use ’-
d=tearingdump’ to find out the relevant indexes.

Unknown default valueFlags.FlagData.INT_LIST_FLAG(data = {NIL})
—ignoreSimulationFlagsAnnotation

Ignores the simulation flags specified as annotation in the class.

Boolean (default false).

—dynamicTearingForlnitialization

Enable Dynamic Tearing also for the initialization system.

Boolean (default false).

—preferTVarsWithStartValue

Prefer tearing variables with start value for initialization.

Boolean (default false).

—equationsPerFile

Generate code for at most this many equations per C-file (partially implemented in the compiler).
Integer (default 2000).

—evaluateFinalParameters

Evaluates all the final parameters in addition to parameters with annotation(Evaluate=true).
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Boolean (default false).

—evaluateProtectedParameters

Evaluates all the protected parameters in addition to parameters with annotation(Evaluate=true).
Boolean (default false).

—replaceEvaluatedParameters

Replaces all the evaluated parameters in the DAE.

Boolean (default t rue).

—condenseArrays

Sets whether array expressions containing function calls are condensed or not.

Boolean (default t rue).

—wfcAdvanced

wrapFunctionCalls ignores more then default cases, e.g. exp, sin, cos, log, (experimental flag)
Boolean (default false).

—tearingStrictness

Sets the strictness of the tearing method regarding the solvability restrictions.

String (default strict). Valid options:

* casual (Loose tearing rules using ExpressionSolve to determine the solvability instead of considering the
partial derivative. Allows to solve for everything that is analytically possible. This could lead to singularities
during simulation.)

* strict (Robust tearing rules by consideration of the partial derivative. Allows to divide by parameters that
are not equal to or close to zero.)

* veryStrict (Very strict tearing rules that do not allow to divide by any parameter. Use this if you aim at
overriding parameters after compilation with values equal to or close to zero.)

—interactive
Sets the interactive mode for omc.
String (default none). Valid options:
* none (do nothing)
* corba (Starts omc as a server listening on the socket interface.)
* tcp (Starts omc as a server listening on the Corba interface.)
» zmq (Starts omc as a ZeroMQ server listening on the socket interface.)
-z, —zeroM QFileSuffix
Sets the file suffix for zeroMQ port file if —interactive=zmgq is used.
String (default empty).
—homotopyApproach
Sets the homotopy approach.
String (default equidistantGlobal). Valid options:

¢ equidistantLocal (Local homotopy approach with equidistant lambda steps. The homotopy parameter only
effects the local strongly connected component.)

* adaptiveLocal (Local homotopy approach with adaptive lambda steps. The homotopy parameter only effects
the local strongly connected component.)
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* equidistantGlobal (Default, global homotopy approach with equidistant lambda steps. The homotopy pa-
rameter effects the entire initialization system.)

* adaptiveGlobal (Global homotopy approach with adaptive lambda steps. The homotopy parameter effects
the entire initialization system.)

—ignoreReplaceable

Sets whether to ignore replaceability or not when redeclaring.

Boolean (default false).

—postOptModulesDAE

Sets the optimization modules for the DAEmode in the back end. See —help=optmodules for more info.
String list (default lateInlineFunction,wrapFunctionCalls,simplifysemiLinear,simplifyComplexFunction,removeConstants,simplify’]
—evalLoopLimit

The loop iteration limit used when evaluating constant function calls.

Integer (default 100000).

—evalRecursionLimit

The recursion limit used when evaluating constant function calls.

Integer (default 256).

—singlelnstanceAglSolver

Sets to instantiate only one algebraic loop solver all algebraic loops

Boolean (default false).

23.2 Debug flags

The debug flag takes a comma-separated list of flags which are used by the compiler for debugging or experimental
purposes. Flags prefixed with "-" or "no" will be disabled. The available flags are (+ are enabled by default, - are
disabled):

Cache (default: on) Turns off the instantiation cache.

NLSanalyticJacobian (default: on) Enables analytical jacobian for non-linear strong components without user-
defined function calls, for that see forceNLSanalyticJacobian

acceptTooManyFields (default: off) Accepts passing records with more fields than expected to a function. This
is not allowed, but is used in Fluid.Dissipation. See https://trac.modelica.org/Modelica/ticket/1245 for de-
tails.

addDerAliases (default: off) Adds for every der-call an alias equation e.g. dx = der(x). It’s
a work-a-round flag, which helps in some cases to simulate the models e.g. Mod-
elica.Fluid. Examples.HeatExchanger.HeatExchangerSimulation. Deprecated  flag: Use -
preOptModules+=introduceDerAlias instead.

addScaledVars (default: off) Adds an alias equation var_nrom = var/nominal where var is state Deprecated flag:
Use —postOptModules+=addScaled Vars_states instead.

addScaledVarsInput (default: off) Adds an alias equation var_nrom = var/nominal where var is input Deprecated
flag: Use —postOptModules+=addScaledVars_inputs instead.

aliasConflicts (default: off) Dumps alias sets with different start or nominal values.

backendKeepEny (default: on) When enabled, the environment is kept when entering the backend, which en-
ables CevalFunction (function interpretation) to work. This module not essential for the backend to function
in most cases, but can improve simulation performance by evaluating functions. The drawback to keeping
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the environment graph in memory is that it is huge (~80% of the total memory in use when returning the
frontend DAE).

backendReduceDAE (default: off) Prints all Reduce DAE debug information.

backenddaeinfo (default: off) Enables dumping of back-end information about system (Number of equations
before back-end,...).

bltdump (default: off) Dumps information from index reduction.

bltmatrixdump (default: off) Dumps the blt matrix in html file. IE seems to be very good in displaying large
matrices.

buildExternalLibs (default: on) Use the autotools project in the Resources folder of the library to build missing
external libraries.

ceval (default: off) Prints extra information from Ceval.

cgraph (default: off) Prints out connection graph information.

cgraphGraphVizFile (default: off) Generates a graphviz file of the connection graph.
cgraphGraphVizShow (default: off) Displays the connection graph with the GraphViz lefty tool.
checkASUB (default: off) Prints out a warning if an ASUB is created from a CREF expression.

checkBackendDae (default: off) Do some simple analyses on the datastructure from the frontend to check if it
is consistent.

checkDAECrefType (default: off) Enables extra type checking for cref expressions.

checkSimplify (default: off) Enables checks for expression simplification and prints a notification whenever an
undesirable transformation has been performed.

constjac (default: off) solves linear systems with constant Jacobian and variable b-Vector symbolically
countOperations (default: off) Count operations.
daedumpgraphy (default: off) Dumps the DAE in graphviz format.

debugAlgebraicLoopsJacobian (default: off) Dumps debug output while creating symbolic jacobians for non-
linear systems.

debugAlias (default: off) Dumps some information about the process of removeSimpleEquations.
debugDAEmode (default: off) Dump debug output for the DAEmode.

debugDifferentiation (default: off) Dumps debug output for the differentiation process.
debugDifferentiationVerbose (default: off) Dumps verbose debug output for the differentiation process.
disableColoring (default: off) Disables coloring algorithm while spasity detection.

disableComSubExp (default: off) Deactivates module ’comSubExp’ Deprecated flag: Use —preOptModules-
=comSubExp instead.

disableDirectionalDerivatives (default: on) For FMI 2.0 only dependecy analysis will be perform.
disableFMIDependency (default: off) Disables the dependency analysis and generation for FMI 2.0.

disable JacsforSCC (default: off) Disables calculation of jacobians to detect if a SCC is linear or non-linear. By
disabling all SCC will handled like non-linear.

disablePartitioning (default: off) Deactivates partitioning of entire equation system. Deprecated flag: Use —
preOptModules-=clockPartitioning instead.

disableRecordConstructorOutput (default: off) Disables output of record constructors in the flat code.

disableSimplifyComplexFunction (default: off) disable simplifyComplexFunction Deprecated flag: Use —
postOptModules-=simplifyComplexFunction/—initOptModules-=simplifyComplexFunction instead.

disableSingleFlowEq (default: off) Disables the generation of single flow equations.

disableStartCalc (default: off) Deactivates the pre-calculation of start values during compile-time.
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disableWindowsPathCheckWarning (default: off) Disables warnings on Windows if OPENMODELICA-
HOME/MinGW is missing.

discreteinfo (default: off) Enables dumping of discrete variables. Extends -d=backenddaeinfo.

dummyselect (default: off) Dumps information from dummy state selection heuristic.

dump (default: off) Dumps the absyn representation of a program.

dumpBackendInline (default: off) Dumps debug output while inline function.

dumpBackendlInlineVerbose (default: off) Dumps debug output while inline function.

dumpCSE (default: off) Additional output for CSE module.

dumpCSE _verbose (default: off) Additional output for CSE module.

dumpConstrepl (default: off) Dump the found replacements for constants.

dumpEArepl (default: off) Dump the found replacements for evaluate annotations (evaluate=true) parameters.

dumpEncapsulateConditions (default: off) Dumps the results of the preOptModule encapsulateWhenCondi-
tions.

dumpEqInUC (default: off) Dumps all equations handled by the unit checker.
dumpEqUCStruct (default: off) Dumps all the equations handled by the unit checker as tree-structure.

dumpExcludedSym JacExps (default: off) This flags dumps all expression that are excluded from differentiation
of a symbolic Jacobian.

dumpF Prepl (default: off) Dump the found replacements for final parameters.

dumpFunctions (default: off) Add functions to backend dumps.

dumpHomotopy (default: off) Dumps the results of the postOptModule optimizeHomotopyCalls.
dumplnlineSolver (default: off) Dumps the inline solver equation system.

dumpLoops (default: off) Dumps loop equation.

dumpPPrepl (default: off) Dump the found replacements for protected parameters.
dumpParamrepl (default: off) Dump the found replacements for remove parameters.
dumpRecursiveTearing (default: off) Dump between steps of recursiveTearing
dumpSCCGraphML (default: off) Dumps graphml files with the strongly connected components.
dumpSimCode (default: off) Dumps the simCode model used for code generation.
dumpSimplifyLoops (default: off) Dump between steps of simplifyLoops
dumpSortEqnsAndVars (default: off) Dumps debug output for the modules sortEqnsVars.
dumpSparsePattern (default: off) Dumps sparse pattern with coloring used for simulation.

dumpSparsePatternVerbose (default: off) Dumps in verbose mode sparse pattern with coloring used for simula-
tion.

dumpSynchronous (default: off) Dumps information of the clock partitioning.

dumpTransformedModelica (default: off) Dumps the back-end DAE to a Modelica-like model after all symbolic
transformations are applied.

dumpUnits (default: off) Dumps all the calculated units.

dumpdaelow (default: off) Dumps the equation system at the beginning of the back end.

dumpdgesv (default: off) Enables dumping of the information whether DGESV is used to solve linear systems.
dumpegninorder (default: off) Enables dumping of the equations in the order they are calculated.
dumpindxdae (default: off) Dumps the equation system after index reduction and optimization.

dumpinitialsystem (default: off) Dumps the initial equation system.
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dumprepl (default: off) Dump the found replacements for simple equation removal.
dynload (default: off) Display debug information about dynamic loading of compiled functions.

evalConstFuncs (default: on) Evaluates functions complete and partially and checks for constant output. Dep-
recated flag: Use —preOptModules+=evalFunc instead.

evalFuncDump (default: off) dumps debug information about the function evaluation

evalOutputOnly (default: off) Generates equations to calculate outputs only.

evalParameterDump (default: off) Dumps information for evaluating parameters.

evalfunc (default: on) Turns on/off symbolic function evaluation.

evaluateAllParameters (default: off) Evaluates all parameters if set.

events (default: on) Turns on/off events handling.

execHash (default: off) Measures the time it takes to hash all simcode variables before code generation.
execstat (default: off) Prints out execution statistics for the compiler.

execstatGCcollect (default: off) When running execstat, also perform an extra full garbage collection.
experimentalReductions (default: off) Turns on custom reduction functions (OpenModelica extension).
failtrace (default: off) Sets whether to print a failtrace or not.

JfmuExperimental (default: off) Include an extra function in the FMU fmi2GetSpecificDerivatives.

JforceNLSanalyticJacobian (default: off) Forces calculation analytical jacobian also for non-linear strong com-
ponents with user-defined functions.

JfrontEndUnitCheck (default: off) Checks the consistency of units in equation.
gcProfiling (default: off) Prints garbage collection stats to standard output.

gen (default: off) Turns on/off dynamic loading of functions that are compiled during translation. Only enable
this if external functions are needed to calculate structural parameters or constants.

gendebugsymbols (default: off) Generate code with debugging symbols.

generateCodeCheat (default: off) Used to generate code for the bootstrapped compiler.

graphlnst (default: off) Do graph based instantiation.

graphlnstGenGraph (default: off) Dumps a graph of the program. Use with -d=graphInst
graphlnstRunDep (default: off) Run scode dependency analysis. Use with -d=graphlInst
graphlnstShowGraph (default: off) Display a graph of the program interactively. Use with -d=graphInst

graphml (default: off) Dumps .graphml files for the bipartite graph after Index Reduction and a task graph for
the SCCs. Can be displayed with yEd.

graphviz (default: off) Dumps the absyn representation of a program in graphviz format.

graphvizDump (default: off) Activates additional graphviz dumps (as .dot files). It can be used in addition to
one of the following flags: {dumpdaelowldumpinitialsystemsldumpindxdae}.

hardcodedStartValues (default: off) Embed the start values of variables and parameters into the c++ code and
do not read it from xml file.

hpcom (default: off) Enables parallel calculation based on task-graphs.

hpcomDump (default: off) Dumps additional information on the parallel execution with hpcom.
hpcomMemoryOpt (default: off) Optimize the memory structure regarding the selected scheduler
ignoreCycles (default: off) Ignores cycles between constant/parameter components.

implOde (default: off) activates implicit codegen

infoXmlOperations (default: off) Enables output of the operations in the _info.xml file when translating models.
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initialization (default: off) Shows additional information from the initialization process.
inlineFunctions (default: on) Controls if function inlining should be performed.
inlineSolver (default: off) Generates code for inline solver.

instance (default: off) Prints extra failtrace from InstanceHierarchy.

interactive (default: off) Starts omc as a server listening on the socket interface.
interactiveCorba (default: off) Starts omc as a server listening on the Corba interface.
interactivedump (default: off) Prints out debug information for the interactive server.
iterationVars (default: off) Shows a list of all iteration variables.
listAppendWrongOrder (default: on) Print notifications about bad usage of listAppend.
lookup (default: off) Print extra failtrace from lookup.

mergeAlgSections (default: off) Disables coloring algorithm while sparsity detection.

metaModelicaRecordAlloc Words (default: off) Instrument the source code to record memory allocations (re-
quires run-time and generated files compiled with -DOMC_RECORD_ALLOC_WORDS).

multirate (default: off) The solver can switch partitions in the system.

newlnst (default: off) Enables experimental new instantiation phase.

nfAPI (default: off) Enables experimental new instantiation use in the OMC API.

nfEvalConstArgFuncs (default: on) Evaluate all functions with constant arguments in the new frontend.
nfExpandFuncArgs (default: off) Expand all function arguments in the new frontend.

nfExpandOperations (default: on) Expand all unary/binary operations to scalar expressions in the new frontend.
nfScalarize (default: on) Run scalarization in NF, default true.

oldFrontEndUnitCheck (default: off) Checks the consistency of units in equation (for the old front-end).

onRelaxation (default: off) Perform O(n) relaxation. Deprecated flag: Use —postOptModules+=relaxSystem in-
stead.

optdaedump (default: off) Dumps information from the optimization modules.

parallelCodegen (default: on) Enables code generation in parallel (disable this if compiling a model causes you
to run out of RAM).

paramdlowdump (default: off) Enables dumping of the parameters in the order they are calculated.

parmodauto (default: off) Experimental: Enable parallelization of independent systems of equations in the trans-
lated model.

partitionInitialization (default: on) This flag controls if partitioning is applied to the initialization system.
patternmAlllnfo (default: off) Adds notifications of all pattern-matching optimizations that are performed.
patternmDeadCodeElimination (default: on) Performs dead code elimination in match-expressions.

patternmMoveLastExp (default: on) Optimization that moves the last assignment(s) into the result of a match-
expression. For example: equation ¢ = fn(b); then c; => then fn(b);

patternmSkipFilterUnusedBindings (default: off)

pedantic (default: off) Switch into pedantic debug-mode, to get much more feedback.
printStructuralParameters (default: off) Prints the structural parameters identified by the front-end
pthreads (default: off) Experimental: Unused parallelization.

reduceDynOpt (default: off) remove eqs which not need for the calculations of cost and constraints Deprecated
flag: Use —postOptModules+=reduceDynamicOptimization instead.

relidx (default: off) Prints out debug information about relations, that are used as zero crossings.
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relocatableFunctions (default: off) Generates relocatable code: all functions become function pointers and can
be replaced at run-time.

reportSerializedSize (default: off) Reports serialized sizes of various data structures used in the compiler.
reshufflePost (default: off) Reshuffles the systems of equations.

resolveLoopsDump (default: off) Debug Output for ResolveLoops Module.

rml (default: off) Converts Modelica-style arrays to lists.

runtimeStaticLinking (default: off) Use the static simulation runtime libraries (C++ simulation runtime).
scodeDep (default: on) Does scode dependency analysis prior to instantiation. Defaults to true.

semiLinear (default: off) Enables dumping of the optimization information when optimizing calls to semiLinear.
shortOutput (default: off) Enables short output of the simulate() command. Useful for tools like OMNotebook.
showDaeGeneration (default: off) Show the dae variable declarations as they happen.

showEquationSource (default: off) Display the element source information in the dumped DAE for easier de-
bugging.
showExpandablelnfo (default: off) Show information about expandable connector handling.

showlInstCachelnfo (default: off) Prints information about instantiation cache hits and additions. Defaults to
false.

showStartOrigin (default: off) Enables dumping of the DAE startOrigin attribute of the variables.
showStatement (default: off) Shows the statement that is currently being evaluated when evaluating a script.

skipInputOutputSyntacticSugar (default: off) Used when bootstrapping to preserve the input output parsing of
the code output by the list command.

stateselection (default: off) Enables dumping of selected states. Extends -d=backenddaeinfo.
static (default: off) Enables extra debug output from the static elaboration.
stripPrefix (default: on) Strips the environment prefix from path/crefs. Defaults to true.

susanDebug (default: off) Makes Susan generate code using try/else to better debug which function broke the
expected match semantics.

symjacdump (default: off) Dumps information about symbolic Jacobians. Can be used only with postOptMod-
ules: generateSymbolicJacobian, generateSymbolicLinearization.

symjacdumpeqn (default: off) Dump for debug purpose of symbolic Jacobians. (deactivated now).

symjacdumpverbose (default: off) Dumps information in verbose mode about symbolic Jacobians. Can be used
only with postOptModules: generateSymbolicJacobian, generateSymbolicLinearization.

symjacwarnings (default: off) Prints warnings regarding symoblic jacbians.

tail (default: off) Prints out a notification if tail recursion optimization has been applied.
tearingdump (default: off) Dumps tearing information.

tearingdumpV (default: off) Dumps verbose tearing information.

totaltearingdump (default: off) Dumps total tearing information.

totaltearingdumpV (default: off) Dumps verbose total tearing information.

tplPerfTimes (default: off) Enables output of template performance data for rendering text to file.

transformsbeforedump (default: off) Applies transformations required for code generation before dumping flat
code.

types (default: off) Prints extra failtrace from Types.
uncertainties (default: off) Enables dumping of status when calling modelEquationsUC.

updmod (default: off) Prints information about modification updates.
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useMPI (default: off) Add MPI init and finalize to main method (CPPruntime).

vectorize (default: off) Activates vectorization in the backend.

visxml (default: off) Outputs a xml-file that contains information for visualization.

warnMinMax (default: on) Makes a warning assert from min/max variable attributes instead of error.

warnNoNominal (default: off) Prints the iteration variables in the initialization and simulation DAE, which do
not have a nominal value.

writeToBuffer (default: off) Enables writing simulation results to buffer.

23.3 Flags for Optimization Modules

Flags that determine which symbolic methods are used to produce the causalized equation system.

The —preOptModules flag sets the optimization modules which are used before the matching and index reduction
in the back end. These modules are specified as a comma-separated list.

The —matchingAlgorithm sets the method that is used for the matching algorithm, after the pre optimization mod-
ules.

The —indexReductionMethod sets the method that is used for the index reduction, after the pre optimization mod-
ules.

The —initOptModules then sets the optimization modules which are used after the index reduction to optimize the
system for initialization, specified as a comma-separated list.

The —postOptModules then sets the optimization modules which are used after the index reduction to optimize the
system for simulation, specified as a comma-separated list.

276 Chapter 23. OpenModelica Compiler Flags



CHAPTER
TWENTYFOUR

SMALL OVERVIEW OF SIMULATION FLAGS

This chapter contains a short overview of simulation flags as well as additional details of the numerical integration
methods.

24.1 OpenModelica (C-runtime) Simulation Flags

The simulation executable takes the following flags:
-abortSlowSimulation Aborts if the simulation chatters.
-alarm=value or -alarm value Aborts after the given number of seconds (default=0 disables the alarm).
-clock=value or -clock value Selects the type of clock to use. Valid options include:
¢ RT (monotonic real-time clock)
* CYC (cpu cycles measured with RDTSC)
* CPU (process-based CPU-time)
-cpu Dumps the cpu-time into the result file using the variable named $cpuTime.
-csvOstep=value or -csvOstep value Value specifies csv-files for debug values for optimizer step.

-daeMode Enables daecMode simulation if the model was compiled with the omc flag —daeMode and ida method
is used.

-deltaXLinearize=value or -deltaXLinearize value Value specifies the delta x value for numerical differentiation
used by linearization. The default value is sqrt(DBL_EPSILON*2el).

-deltaXSolver=value or -deltaXSolver value Value specifies the delta x value for numerical differentiation used
by integration method. The default values is sqrt(DBL_EPSILON).

-embeddedServer=value or -embeddedServer value Enables an embedded server. Valid values:
¢ none - default, run without embedded server

* opc-da - [broken] run with embedded OPC DA server (WIN32 only, uses proprietary OPC SC inter-
face)

* opc-ua - [experimental] run with embedded OPC UA server (TCP port 4841 for now; will have its own
configuration option later)

* filename - path to a shared object implementing the embedded server interface (requires access to
internal OMC data-structures if you want to read or write data)

-embeddedServerPort=value or -embeddedServerPort value Value specifies the port number used by the em-
bedded server. The default value is 4841.

-mat_sync=value or -mat_sync value Syncs the mat file header after emitting every N time-points.
-emit_protected Emits protected variables to the result-file.

-f=value or -f value Value specifies a new setup XML file to the generated simulation code.
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-help=value or -help value Get detailed information that specifies the command-line flag
For example, -help=f prints detailed information for command-line flag f.

-homAdaptBend=value or -homAdaptBend value Maximum trajectory bending to accept the homotopy step.
Default: 0.5, which means the corrector vector has to be smaller than half of the predictor vector.

-homBacktraceStrategy=value or -homBacktraceStrategy value Value specifies the backtrace strategy in the
homotopy corrector step. Valid values:

* fix - default, go back to the path by fixing one coordinate
* orthogonal - go back to the path in an orthogonal direction to the tangent vector

-homHEps=value or -homHEps value Tolerance respecting residuals for the homotopy H-function (default: le-
35).

In the last step (lambda=1) newtonFTol is used as tolerance.

-homMaxLambdaSteps=value or -homMaxLambdaSteps value Maximum lambda steps allowed to run the ho-
motopy path (default: system size * 100).

-homMaxNewtonSteps=value or -homMaxNewtonSteps value Maximum newton steps in the homotopy cor-
rector step (default: 20).

-homMaxTries=value or -homMaxTries value Maximum number of tries for one homotopy lambda step (de-
fault: 10).

-homNegStartDir Start to run along the homotopy path in the negative direction.
If one direction fails, the other direction is always used as fallback option.

-homotopyOnFirstTry If the model contains the homotopy operator, directly use the homotopy method to solve
the initialization problem. Without this flag, the solver first tries to solve the initialization problem without
homotopy and only uses homotopy as fallback option.

-homTauDecFac=value or -homTauDecFac value Decrease homotopy step size tau by this factor if tau is too
big in the homotopy corrector step (default: 10.0).

-homTauDecFacPredictor=value or -homTauDecFacPredictor value Decrease homotopy step size tau by this
factor if tau is too big in the homotopy predictor step (default: 2.0).

-homTaulncFac=value or -homTaulncFac value Increase homotopy step size tau by this factor if tau can be
increased after the homotopy corrector step (default: 2.0).

-homTaulncThreshold=value or -homTaulncThreshold value Increase the homotopy step size tau if
homAdaptBend/bend > homTaulncThreshold (default: 10).

-homTauMax=value or -homTauMax value Maximum homotopy step size tau for the homotopy process (de-
fault: 10).

-homTauMin=value or -homTauMin value Minimum homotopy step size tau for the homotopy process (default:
le-4).

-homTauStart=value or -homTauStart value Homotopy step size tau at the beginning of the homotopy process
(default: 0.2).

-idaMaxErrorTestFails=value or -idaMaxErrorTestFails value Value specifies the maximum number of error
test failures in attempting one step. The default value is 7.

-idaMaxNonLinlters=value or -idaMaxNonLinIters value Value specifies the maximum number of nonlinear
solver iterations at one step. The default value is 3.

-idaMaxConvFails=value or -idaMaxConvFails value Value specifies the maximum number of nonlinear solver
convergence failures at one step. The default value is 10.

-idaNonLinConvCoef=value or -idaNonLinConvCoef value Value specifies the safety factor in the nonlinear
convergence test. The default value is 0.33.

-idaLS=value or -idaLS value Value specifies the linear solver of the ida integration method. Valid values:
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¢ dense (ida internal dense method.)
* klu (ida use sparse direct solver KLU. (default))
* spgmr (ida generalized minimal residual method. Iterative method)
* spbcg (ida Bi-CGStab. Iterative method)
e sptfgmr (ida TFQMR. Iterative method)
-idaScaling Enable scaling of the IDA solver.

-idaSensitivity Enables sensitivity analysis with respect to parameters if the model is compiled with omc flag
—calculateSensitivities.

-ignoreHideResult Emits also variables with HideResult=true annotation.
-iif=value or -iif value Value specifies an external file for the initialization of the model.

-iim=value or -iim value Value specifies the initialization method. Following options are available: ’symbolic’
(default) and ’none’.

* none (sets all variables to their start values and skips the initialization process)
» symbolic (solves the initialization problem symbolically - default)
-iit=value or -iit value Value [Real] specifies a time for the initialization of the model.

-ils=value or -ils value Value specifies the number of steps for homotopy method (required: -iim=symbolic). The
value is an Integer with default value 4.

-impRKOrder=value or -impRKOrder value Value specifies the integration order of the implicit Runge-Kutta
method. Valid values: 1 to 6. Default order is 5.

-impRKLS=value or -impRKLS value Selects the linear solver of the integration methods impeuler, trapezoid
and imprungekuta:

* iterativ - default, sparse iterativ linear solver with fallback case to dense solver
¢ dense - dense linear solver, SUNDIALS default method

-initialStepSize=value or -initialStepSize value Value specifies an initial step size, used by the methods: dassl,
ida

-csvInput=value or -csvinput value Value specifies an csv-file with inputs for the simulation/optimization of the
model

-exInputFile=value or -exInputFile value Value specifies an external file with inputs for the simula-
tion/optimization of the model.

-stateFile=value or -stateFile value Value specifies an file with states start values for the optimization of the
model.

-inputPath=value or -inputPath value Value specifies a path for reading the input files i.e., model_init.xml and
model_info.json

-ipopt_hesse=value or -ipopt_hesse value Value specifies the hessematrix for Ipopt(OMC, BFGS, const).
-ipopt_init=value or -ipopt_init value Value specifies the initial guess for optimization (sim, const).
-ipopt_jac=value or -ipopt_jac value Value specifies the Jacobian for Ipopt(SYM, NUM, NUMDENSE).
-ipopt_max_iter=value or -ipopt_max_iter value Value specifies the max number of iteration for ipopt.
-ipopt_warm_start=value or -ipopt_warm_start value Value specifies 1vl for a warm start in ipopt: 1,2,3,...
-jacobian=value or -jacobian value Select the calculation method for Jacobian used by the integration method:

* coloredNumerical (Colored numerical Jacobian, which is default for dassl and ida. With option -
idaLL.S=klu a sparse matrix is used.)

¢ internalNumerical (Dense solver internal numerical Jacobian.)
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* coloredSymbolical (Colored symbolical Jacobian. Needs omc compiler flag -
generateSymbolicJacobian. With option -idaLS=klu a sparse matrix is used.)

¢ numerical (Dense numerical Jacobian.)

» symbolical (Dense symbolical Jacobian. Needs omc compiler flag —generateSymbolicJacobian.)
-I=value or -1 value Value specifies a time where the linearization of the model should be performed.
-l_datarec Emit data recovery matrices with model linearization.
-logFormat=value or -logFormat value Value specifies the log format of the executable:

e text (default)

e xml

* xmltcp (required -port flag)
-Is=value or -lIs value Value specifies the linear solver method

¢ lapack (method using LAPACK LU factorization)

¢ lis (method using iterative solver Lis)

klu (method using KLU sparse linear solver)

» umfpack (method using UMFPACK sparse linear solver)

* totalpivot (method using a total pivoting LU factorization for underdetermination systems)
e default (default method - LAPACK with total pivoting as fallback)

-Is_ipopt=value or -1s_ipopt value Value specifies the linear solver method for Ipopt, default mumps. Note: Use
if you build ipopt with other linear solver like ma27

-Iss=value or -Iss value Value specifies the linear sparse solver method
¢ default (the default sparse linear solver (or a dense solver if there is none available) )
¢ lis (method using iterative solver Lis)
¢ klu (method using klu sparse linear solver)
* umfpack (method using umfpack sparse linear solver)

-IssMaxDensity=value or -IssMaxDensity value Value specifies the maximum density for using a linear sparse
solver. The value is a Double with default value 0.2.

-IssMinSize=value or -1ssMinSize value Value specifies the minimum system size for using a linear sparse
solver. The value is an Integer with default value 4001.

-lv=value or -lv value Value (a comma-separated String list) specifies which logging levels to enable. Multiple
options can be enabled at the same time.

* stdout (this stream is always active, can be disabled with -lv=-stdout)
e assert (this stream is always active, can be disabled with -lv=-assert)
* LOG_DASSL (additional information about dassl solver)

* LOG_DASSL_STATES (outputs the states at every dassl call)

* LOG_DEBUG (additional debug information)

* LOG_DSS (outputs information about dynamic state selection)

* LOG_DSS_JAC (outputs jacobian of the dynamic state selection)

* LOG_DT (additional information about dynamic tearing)

e LOG_DT_CONS (additional information about dynamic tearing (local and global constraints))
* LOG_EVENTS (additional information during event iteration)

* LOG_EVENTS_V (verbose logging of event system)
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e LOG_INIT (additional information during initialization)

e LOG_IPOPT (information from Ipopt)

* LOG_IPOPT_FULL (more information from Ipopt)

* LOG_IPOPT_JAC (check jacobian matrix with Ipopt)

¢ LOG_IPOPT_HESSE (check hessian matrix with Ipopt)

* LOG_IPOPT_ERROR (print max error in the optimization)

* LOG_JAC (outputs the jacobian matrix used by dassl)

* LOG_LS (logging for linear systems)

* LOG_LS_V (verbose logging of linear systems)

* LOG_NLS (logging for nonlinear systems)

* LOG_NLS_V (verbose logging of nonlinear systems)

* LOG_NLS_HOMOTOPY (logging of homotopy solver for nonlinear systems)
* LOG_NLS_JAC (outputs the jacobian of nonlinear systems)

* LOG_NLS_JAC_TEST (tests the analytical jacobian of nonlinear systems)

* LOG_NLS_RES (outputs every evaluation of the residual function)

* LOG_NLS_EXTRAPOLATE (outputs debug information about extrapolate process)
* LOG_RES_INIT (outputs residuals of the initialization)

* LOG_RT (additional information regarding real-time processes)

* LOG_SIMULATION (additional information about simulation process)

* LOG_SOLVER (additional information about solver process)

* LOG_SOLVER_V (verbose information about the integration process)

* LOG_SOLVER_CONTEXT (context information during the solver process)

¢ LOG_SOTI (final solution of the initialization)

* LOG_STATS (additional statistics about timer/events/solver)

e LOG_STATS_V (additional statistics for LOG_STATS)

* LOG_SUCCESS (this stream is always active, unless deactivated with -lv=-LOG_SUCCESS)
* LOG_UTIL (??7)

* LOG_ZEROCROSSINGS (additional information about the zerocrossings)

-mbi=value or -mbi value Value specifies the maximum number of bisection iterations for state event detection
or zero for default behavior

-mei=value or -mei value Value specifies the maximum number of event iterations. The value is an Integer with
default value 20.

-maxIntegrationOrder=value or -maxIntegrationOrder value Value specifies maximum integration order, used
by the methods: dassl, ida.

-maxStepSize=value or -maxStepSize value Value specifies maximum absolute step size, used by the methods:
dassl, ida.

-measureTimePlotFormat=value or -measureTimePlotFormat value Value specifies the output format of the
measure time functionality:

* svg
* jpg
L] ps
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o gif

-newtonF Tol=value or -newtonFTol value Tolerance respecting residuals for updating solution vector in Newton
solver. Solution is accepted if the (scaled) 2-norm of the residuals is smaller than the tolerance newtonFTol
and the (scaled) newton correction (delta_x) is smaller than the tolerance newtonXTol. The value is a Double
with default value le-12.

-newtonMaxStepFactor=value or -newtonMaxStepFactor value Maximum newton step factor mxnewtstep =
maxStepFactor * norm2(xScaling). Used currently only by KINSOL.

-newtonXTol=value or -newtonXTol value Tolerance respecting newton correction (delta_x) for updating solu-
tion vector in Newton solver. Solution is accepted if the (scaled) 2-norm of the residuals is smaller than the
tolerance newtonFTol and the (scaled) newton correction (delta_x) is smaller than the tolerance newtonX-
Tol. The value is a Double with default value le-12.

-newton=value or -newton value Value specifies the damping strategy for the newton solver.
* damped (Newton with a damping strategy)
e damped2 (Newton with a damping strategy 2)
* damped_Is (Newton with a damping line search)
* damped_bt (Newton with a damping backtracking and a minimum search via golden ratio method)
e pure (Newton without damping strategy)
-nls=value or -nls value Value specifies the nonlinear solver:

* hybrid (Modification of the Powell hybrid method from minpack - former default solver)

kinsol (SUNDIALS/KINSOL includes an interface to the sparse direct solver, KLU. See simulation
option -nlsLS for more information.)

* newton (Newton Raphson - prototype implementation)

* mixed (Mixed strategy. First the homotopy solver is tried and then as fallback the hybrid solver.)

* homotopy (Damped Newton solver if failing case fixed-point and Newton homotopies are tried.)
-nlsInfo Outputs detailed information about solving process of non-linear systems into csv files.
-nlsLS=value or -nlsLS value Value specifies the linear solver used by the non-linear solver:

¢ default (chooses the nls linear solver based on which nls is being used.)

* totalpivot (internal total pivot implementation. Solve in some case even under-determined systems.)

e lapack (use external LAPACK implementation.)

¢ klu (use KLU direct sparse solver. Only with KINSOL available.)

-nlssMaxDensity=value or -nlssMaxDensity value Value specifies the maximum density for using a non-linear
sparse solver. The value is a Double with default value 0.2.

-nlssMinSize=value or -nlssMinSize value Value specifies the minimum system size for using a non-linear
sparse solver. The value is an Integer with default value 10001.

-noemit Do not emit any results to the result file.

-noEquidistantTimeGrid Output the internal steps given by dassl/ida instead of interpolating results into an
equidistant time grid as given by stepSize or numberOfIntervals.

-noEquidistantOutputFrequency=value or -noEquidistantOutputFrequency value Integer value n controls
the output frequency in noEquidistantTimeGrid mode and outputs every n-th time step

-noEquidistantOutputTime=value or -noEquidistantOutputTime value Real value timeValue controls the out-
put time point in noEquidistantOutputTime mode and outputs every time>=k*timeValue, where k is an
integer

-noEventEmit Do not emit event points to the result file.
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-noRestart Disables the restart of the integration method after an event is performed, used by the methods: dassl,
ida

-noRootFinding Disables the internal root finding procedure of methods: dassl and ida.
-noScaling Disables scaling for the variables and the residuals in the algebraic nonlinear solver KINSOL.

-noSuppressAlg Flag to not suppress algebraic variables in the local error test of the ida solver in daeMode. In
general, the use of this option is discouraged when solving DAE systems of index 1, whereas it is generally
encouraged for systems of index 2 or more.

-optDebug Jac=value or -optDebugJac value Value specifies the number of iterations from the dynamic opti-
mization, which will be debugged, creating .csv and .py files.

-optimizerNP=value or -optimizerNP value Value specifies the number of points in a subinterval. Currently
supports numbers 1 and 3.

-optimizer TimeGrid=value or -optimizerTimeGrid value Value specifies external file with time points.

-output=value or -output value Output the variables a, b and c at the end of the simulation to the standard output:
time = value, a = value, b = value, ¢ = value

-outputPath=value or -outputPath value Value specifies a path for writing the output files i.e., model_res.mat,
model_prof.intdata, model_prof.realdata etc.

-override=value or -override value Override the variables or the simulation settings in the XML setup file For
example: varl=startl,var2=start2,par3=start3,startTime=vall,stopTime=val2

-overrideFile=value or -overrideFile value Will override the variables or the simulation settings in the XML
setup file with the values from the file. Note that: -overrideFile CANNOT be used with -override. Use when
variables for -override are too many. overrideFileName contains lines of the form: varl=startl

-port=value or -port value Value specifies the port for simulation status (default disabled).

-r=value or -r value Value specifies the name of the output result file. The default file-name is based on the model
name and output format. For example: Model_res.mat.

-rt=value or -rt value Value specifies the scaling factor for real-time synchronization (0 disables). A value > 1
means the simulation takes a longer time to simulate.

-s=value or -s value Value specifies the integration method. For additional information see the User’s Guide
* euler - Euler - explicit, fixed step size, order 1
* heun - Heun’s method - explicit, fixed step, order 2
* rungekutta - classical Runge-Kutta - explicit, fixed step, order 4
* impeuler - Euler - implicit, fixed step size, order 1
e trapezoid - trapezoidal rule - implicit, fixed step size, order 2

* imprungekutta - Runge-Kutta methods based on Radau and Lobatto ITA - implicit, fixed step size,
order 1-6(selected manually by flag -impRKOrder)

¢ irksco - own developed Runge-Kutta solver - implicit, step size control, order 1-2
¢ dassl - default solver - BDF method - implicit, step size control, order 1-5

* ida - SUNDIALS IDA solver - BDF method with sparse linear solver - implicit, step size control, order
1-5

* rungekuttaSsc - Runge-Kutta based on Novikov (2016) - explicit, step size control, order 4-5 [experi-
mental]

* symSolver - symbolic inline Solver [compiler flag +symSolver needed] - fixed step size, order 1

* symSolverSsc - symbolic implicit Euler with step size control [compiler flag +symSolver needed] -
step size control, order 1

* gss - A QSS solver [experimental]
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* optimization - Special solver for dynamic optimization
-single Output results in single precision (mat-format only).
-steps Dumps the number of integration steps into the result file.
-steadyState Aborts the simulation if steady state is reached.

-steadyStateTol=value or -steadyStateTol value This relative tolerance is used to detect steady state:
max(ld(x_i)/dtl/nominal(x_i)) < steadyStateTol

-keepHessian=value or -keepHessian value Value specifies the number of steps, which keep Hessian matrix con-
stant.

-w Shows all warnings even if a related log-stream is inactive.
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CHAPTER
TWENTYFIVE

TECHNICAL DETAILS

This chapter gives an overview of some implementation details that might be interesting when building tools
around OpenModelica.

25.1 The MATv4 Result File Format

The default result-file format of OpenModelica is based on MATLAB level 4 MAT-files as described in the MAT-
LAB documentation. This format can be read by tools such as MATLAB, Octave, Scilab, and SciPy. Open-
Modelica will write the result-files in a particular way that can be read by tools such as DyMat and Dymola
(OpenModelica can also read files generated by Dymola since the used format is the same).

The variables stored in the MAT-file are (in the order required by OpenModelica):
Aclass

* Aclass (1, :) isalways Atrajectory

* Aclass (2, :) is 1.1 in OpenModelica

e Aclass (3, :) isempty

e Aclass (4, :) iseitherbinTrans or binNormal

The most important part of the variable is Aclass (4, :) since there are two main ways the result-file is
stored: transposed or not. For efficiency, the result-file is written time-step by time-step during simulation.
But the best way to read the data for a single variable is if the variables are stored variable by variable.
If Aclass (4, :) is binTrans, all matrices need to be transposed since the file was not transposed for
efficient reading of the file. Note that this affects all matrices, even matrices that do not change during
simulation (such as name and description).

name Is an n x m character (int8) matrix, where n is the number of variables stored in the result-file (including
time). m is the length of the longest variable. OpenModelica stores the trailing part of the name as NIL
bytes (0) whereas other tools use spaces for the trailing part.

description Is an n x m character (int8) matrix containing the comment-string corresponding to the variable in
the name matrix.

datalnfo Is an n x 4 integer matrix containing information for each variable (in the same order as the name and
description matrices).

e dataInfo (i, 1) is 1 or 2, saying if variable i is stored in the data_1 or data_2 matrix. If it is 0, it
is the abscissa (time variable).

e dataInfo (i, 2) contains the index in the data_1 or data_2 matrix. The index is 1-based and may
contain several variables pointing to the same row (alias variables). A negative value means that the
variable is a negated alias variable.

e dataInfo (i, 3) is 0 to signify linear interpolation. In other tools the value is the number of times
differentiable this variable is, which may improve plotting.
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e dataInfo (i, 4) is —1 in OpenModelica to signify that the value is not defined outside the time
range. 0 keeps the first/last value when going outside the time range and 1 performs linear interpola-
tion on the first/last two points.

data_1 If it is an n x 1 matrix it contains the values of parameters. If it is an n x 2 matrix, the first and second
column signify start and stop-values.

data_2 Each row contains the values of a variable at the sampled times. The corresponding time stamps are stored
indata_2 (1, :).data_2 (2, 1) isthe value of some variable at time data_2 (1,1).
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CHAPTER
TWENTYSIX

FREQUENTLY ASKED QUESTIONS (FAQ)

Below are some frequently asked questions in three areas, with associated answers.

26.1 OpenModelica General

* Q: OpenModelica does not read the MODELICAPATH environment variable, even though this is
part of the Modelica Language Specification.

* A: Use the OPENMODELICALIBRARY environment variable instead. We have temporarily
switched to this variable, in order not to interfere with other Modelica tools which might be
installed on the same system. In the future, we might switch to a solution with a settings file, that also
allows the user to turn on the MODELICAPATH functionality if desired.

* Q: How do I enter multi-line models into OMShell since it evaluates when typing the Enter/Return
key?

* A: There are basically three methods: 1) load the model from a file using the pull-down menu or the
loadModel command. 2) Enter the model/function as one (possibly long) line. 3) Type in the model
in another editor, where using multiple lines is no problem, and copy/paste the model into OMShell as
one operation, then push Enter. Another option is to use OMNotebook instead to enter and evaluate
models.

26.2 OMNotebook

* Q: OMNotebook hangs, what to do?

* A: It is probably waiting for the omc.exe (compiler) process. (Under windows): Kill the processes
omc.exe, g++.exe (C-compiler), as.exe (assembler), if present. If OMNotebook then asks whether
to restart OMC, answer yes. If not, kill the process OMNotebook.exe and restart manually.

* Q: After a previous session, when starting OMNotebook again, I get a strange message.

* A: You probably quit the previous OpenModelica session in the wrong way, which left the process
omc.exe running. Kill that process, and try starting OMNotebook again.

¢ Q: I copy and paste a graphic figure from Word or some other application into OMNotebook, but the
graphic does not appear. What is wrong?

* A: OMNotebook supports the graphic picture formats supported by Qt 4, including the .png, .bmp
(bitmap) formats, but not for example the gif format. Try to convert your picture into one of the
supported formats, (e.g. in Word, first do paste as bitmap format), and then copy the converted version
into a text cell in OMNotebook.

* Q:Iselect a cell, copy it (e.g. Ctrl-C), and try to paste it at another place in the notebook. However,
this does not work. Instead some other text that I earlier put on the clipboard is pasted into the nearest
text cell.
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e A: The problem is wrong choice of cursor mode, which can be text insertion or cell insertion. If you
click inside a cell, the cursor become vertical, and OMNotebook expects you to paste text inside
the cell. To paste a cell, you must be in cell insertion mode, i.e., click between two cells (or after a
cell), you will get a vertical line. Place the cursor carefully on that vertical line until you see a small
horizontal cursor. Then you should past the cell.

* Q: Iam trying to click in cells to place the vertical character cursor, but it does not seem to react.

¢ A: This seems to be a Qt feature. You have probably made a selection (e.g. for copying) in the output
section of an evaluation cell. This seems to block cursor position. Click again in the output section to
disable the selection. After that it will work normally.

* Q:Ihave copied a text cell and start writing at the beginning of the cell. Strangely enough, the font be-
comes much smaller than it should be.

* A: This seems to be a Qt feature. Keep some of the old text and start writing the new stuff inside the
text, i.e., at least one character position to the right. Afterwards, delete the old text at the beginning of
the cell.

26.3 OMDev - OpenModelica Development Environment

¢ Q: I get problems compiling and linking some files when using OMDev with the MINGW (Gnu) C
compiler under Windows.

* A: You probably have some Logitech software installed. There is a known bug/incompatibility in Log-
itech products. For example, if lvprcsrv.exe is running, kill it and/or prevent it to start again at reboot;
it does not do anything really useful, not needed for operation of web cameras or mice.
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CHAPTER
TWENTYSEVEN

MAJOR OPENMODELICA RELEASES

This Appendix lists the most important OpenModelica releases and a brief description of their contents. Right
now versions from 1.3.1 to 1.14.0 are described.

27.1 Release Notes for OpenModelica 1.14.0

27.1.1 OpenModelica Compiler (OMC)
27.1.2 Graphic Editor OMEdit
27.1.3 FMI Support

27.1.4 Other things

-,col=changelog,group=component,format=table)

27.2 Release Notes for OpenModelica 1.13.0

27.2.1 OpenModelica Compiler (OMC)

¢ Removed the Java interface from the installer. It is now available as

a stand-alone package (like OMPython).

27.2.2 Graphic Editor OMEdit
27.2.3 FMI Support

27.2.4 Other things

-,col=changelog,group=component,format=table)

27.3 Release Notes for OpenModelica 1.12.0

* A new (stand-alone) FMI- and TLM-based simulation tool OMSimulator, first version for connected FMUs,
TLM objects, Simulink models (via wrappers), Adams models (via wrappers), BEAST models (via wrap-
pers), Modelica models

* Graphic configuration editing of composite models consisting of FMUs
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* Basic graphical editing support for state machines and transitions

* Faster lookup processing, making some libraries faster to browse and compile

* Additional advanced visualization features for multibody animation

* Increased library coverage including significantly increased verification coverage

* Increased tool interoperability by addition of the ZeroMQ communications protocol

* Further enhanced OMPython including linearization, now also working with Python 3

* Support for RedHat/Fedora binary builds of OpenModelica

27.3.1 OpenModelica Compiler (OMC)

* Faster lookup processing

» Initializing external objects together with parameters

* Handle exceptions in numeric solvers

* Support for higher-index discrete clock partitions

* Improved unit checking

* Improved initialization of start values

* Decreased compilation time of models with large size arrays

* New approach for homotopy-based initialization (still experimental)
* A bunch of fixes: Bugs, regressions, performance issues

* Improved Dynamic Tearing by adding constraints for the casual set
* Improved module wrapFunctionCalls with one-time evaluation of Constant CSE-variables
¢ Added initOptModule for inlineHomotopy

* Added configuration flag tearingStrictness to influence solvability

¢ New methods for inline integration for continuous equations in clocked partitions, now covering: Explici-
tEuler, ImplicitEuler, SemilmplicitEuler and ImplicitTrapezoid

* Complete implementation of synchronous features in C++ runtime

» Refactored linear solver of C++ runtime

* Improved Modelica_synchronous_cpp coverage

* New common linear solver module, optionally sparse, for the C++ runtime

» Coverage of most of the OpenHydraulics library

* Improved coverage of ThermoSysPro, IdealizedContact and Chemical libraries
* Support of time events for cpp-simulation and enabled time events in cpp-FMUs
* Global homotopy method for initialization

e Scripting API to compute accumulated errors (1-norm, 2-norm, max. error) of 2 time series

27.3.2 Graphic Editor OMEdit
» Additional advanced visualization features for multibody animation (transparency, textures, change colours
by dialog)
* An HTML WYSIWYG Editor, e.g. useful for documentation

* Support for choices(checkBox=true) annotation.
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* Support for loadSelector & saveSelector attribute of Dialog annotation.

* Panning of icon/diagram view and plot window.

* AutoComplete feature in text editing for keywords, types, common Modelica constructs
¢ Follow connector transformation from Diagram View to Icon View.

* Further stability improvements

* Improved performance for rendering some icons using the interactive API

* Improved handling of parameters that cannot be evaluated in Icon annotations

* Basic graphic editing support for state machines and transitions (not yet support for showing state internals
on diagram layer)

* Interactive state manipulation for FMU-based animations

27.3.3 FMI Support

¢ A new (stand-alone) FMI- and TLM-based simulation tool OMSimulator, first version (a main deliverable
of the OPENCPS project, significant contributions and code donations from SKF)

* Graphic configuration editing of composite models consisting of FMUs

* Co-simulation/simulation of connected FMUs, TLM objects, Simulink models (via wrappers), Adams mod-
els (via wrappers), BEAST models (via wrappers), Modelica models.

27.3.4 Other things

¢ Increased OpenModelica tool interoperability by adding the ZeroMQ communications protocol in addition
to the previously available Corba. This also enables Python 3 usage in OMPython on all platforms.

 Textual support through the OpenModelica API and graphical support in OMEdit for generation of single
or multiple requirement verification scenarios

* VVDRIib — a small library for connecting requirements and models together, with notions for mediators,
scenarios, design alternatives

* Further enhanced OMPython including linearization, now also working with Python 3.”
¢ Jupyter notebooks also supported with OMPython and Python 3

* New enhanced library testing script (libraries.openmodelica.org/branches).

* Addition of mutable reference data types in MetaModelica

* Support for RedHat/Fedora binary builds of OpenModelica

* Support for exporting the system of equations in GraphML (yEd) format for debugging

-,col=changelog,group=component,format=table)

27.4 Release Notes for OpenModelica 1.11.0

* Dramatically improved compilation speed and performance, in particular for large models.
* 3D animation visualization of regular MSL MultiBody simulations and for real-time FMUs.

* Better support for synchronous and state machine language elements, now supports 90% of the clocked
synchronous library.

» Several OMEdit improvements including folding of large annotations.

64-bit OM on Windows further stabilized
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An updated OMDev (OpenModelica Development Environment), involving msys2. This was needed for
the shift to 64-bit on Windows.

Integration of Sundials/IDA DAE solver with potentially large increase of simulation performance for large
models with sparse structure.

Improved library coverage.

Parameter sensitivity analysis added to OMC.

27.4.1 OpenModelica Compiler (OMC)

Real-time synchronization support by using simFlag -rt=1.0 (or some other time scaling factor).

A prototype implementation of OPC UA using an open source OPC UA implementation. The old OPC
implementation was not maintained and relied on a Windows-only proprietary OPC DA+UA package. (At
the moment, OPC is experimental and lacks documentation; it only handles reading/writing Real/Boolean
input/state variables. It is planned for OMEdit to use OPC UA to re-implement interactive simulations and
plotting.)

Dramatically improved compilation speed and dramatically reduced memory requirements for very large
models. In Nov 2015, the largest power generation and transmission system model that OMC could handle
had 60000 equations and it took 700 seconds to generate the simulation executable code; it now takes only
45 seconds to do so with OMC 1.11.0, which can also handle a model 10 times bigger (600 000 equations) in
less than 15 minutes and with less than 32 GB of RAM. Simulation times are comparable to domain-specific
simulation tools. See for example ScalableTestSuite for some of the improvements.

Improved library coverage

Better support for synchronous and state machine language elements, now simulates 90% of the clocked
synchronous library.

Enhanced Cpp runtime to support the PowerSystems library.
Integration of Sundials/IDA solver as an alternative to DASSL.

A DAEMode solver mode was added, which allows to use the sparse IDA solver to handle the DAEs
directly. This can lead to substantially faster simulation on large systems with sparse structure, compared to
the traditional approach.

The direct sparse solvers KLU and SuperLLU have been added, with benefits for models with large algebraic
loops.

Multi-parameter sensitivity analysis added to OMC.

Progress on more efficient inline function mechanism.

Stabilized 64-bit Windows support.

Performance improvement of parameter evaluation.

Enhanced tearing support, with prefer iteration variables and user-defined tearing.

Support for external object aliases in connectors and equations (a non-standard Modelica extension).
Code generation directly to file (saves maximum memory used). #3356

Code generation in parallel is enabled since #3356 (controlled by omc flag ‘-n*). This improves performance
since generating code directly to file avoid memory allocation.

Allowing mixed dense and sparse linear solvers in the generated simulation (chosen depending on simflags
‘-1s‘ (dense solver), *-Iss* (sparse solver), ‘-IssMaxDensity‘ and ‘-IssMinSize®).
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27.4.2 Graphic Editor OMEdit

Significantly faster browsing of most libraries.

Several GUI improvements including folding of multi-line annotations.
Further improved code formatting preservation during edits.

Support for all simulation logging flags.

Select and export variables after simulation.

Support for Byte Order Mark. Added support enables other tools to correctly read the files written by
OMEdit.

Save files with line endings according to OS (Windows (CRLF), Unix (LF)).

Added OMEdit support for FMU cross compilation. This makes it possible to launch OMEdit on a remote
or virtual Linux machine using a Windows X server and export an FMU with Windows binaries.

Support of DisplayUnit and unit conversion.
Fixed automatic save.

Initial support for DynamicSelect in model diagrams (texts and visible attribute after simulation, no expres-
sions yet).

An HTML documentation editor (not WYSIWYG; that editor will be available in the subsequent release).

Improved logging in OMEdit of structured messages and standard output streams for simulations.

27.4.3 FMI Support

Cross compilation of C++ FMU export. Compared to the C runtime, the C++ cross compilation covers the
whole runtime for model exchange.

Improved Newton solver for C++ FMUs (scaling and step size control).

27.4.4 Other things

3D animation visualization of regular MSL MultiBody simulations and for real-time FMUs.

An updated OMDev (OpenModelica Development Environment), involving msys2. This was needed for
the shift to 64-bit on Windows.

OMWebbook, a web version of OMNotebook online. Also, a script is available to convert an OMNotebook
to an OMWebbook.

A Jupyter notebook Modelica mode, available in OpenModelica.

1.11.0,status=closed,severity !=trivial ,resolution=fixedl-,col=changelog,group=component,format=table)

27.5 Release Notes for OpenModelica 1.10.0

The most important enhancements in the OpenModelica 1.10.0 release:

27.5.1 OpenModelica Compiler (OMC)

New features:

Real-time synchronization support by using simFlag -rt=1.0 (or some

27.5.
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other time scaling factor). - A prototype implementation of OPC UA using an open source OPC UA imple-
mentation. The old OPC implementation was not maintained and relied on a Windows-only proprietary OPC
DA+UA package. (At the moment, OPC is experimental and lacks documentation; it only handles reading/writing
Real/Boolean input/state variables. It is planned for OMEdit to use OPC UA to re-implement interactive simula-
tions and plotting.)

Performance enhancements:
* Code generation directly to file (saves maximum memory used). #3356 -

Code generation in parallel enabled since #3356 allows this without allocating too much memory (controlled
by omc flag ‘-n‘). - Various scalability enhancements, allowing the compiler to handle hundreds of thousands
of equations. See for example ScalableTestSuite for some of the improvements. - Better defaults for handling
tearing (OMC flags ‘—maxSizeLinearTearing* and ‘-maxSizeNonlinearTearing‘). - Allowing mixed dense and
sparse linear solvers in the generated simulation (chosen depending on simflags ‘-1s* (dense solver), ‘-Iss‘ (sparse
solver), ‘-IssMaxDensity‘ and ‘-IssMinSize*).

27.5.2 Graphic Editor OMEdit

27.5.3 OpenModelica Notebook (OMNotebook)
27.5.4 Optimization

27.5.5 FMI Support

27.5.6 OpenModelica Development Environment (OMDev)

27.6 Release Notes for OpenModelica 1.9.4

OpenModelica v1.9.4 was released 2016-03-09. These notes cover the v1.9.4 release and its subsequent bug-fix
releases (now up to 1.9.7).

27.6.1 OpenModelica Compiler (OMC)

* Improved simulation speed for many models. simulation speed went up for 80% of the models. The com-
piler frontend became faster for almost all models, average about 40% faster.

* Initial support for synchronous models with clocked equations as defined in the Modelica 3.3 standard

* Support for homotopy operator

27.6.2 Graphic Editor OMEdit

* Undo/Redo support.

* Preserving text formatting, including indentation and whitespace. This is especially important for diff/merge
with several collaborating developers possibly using several different Modelica tools.

* Better support for inherited classes.

¢ Allow simulating models using visual studio compiler.

* Support for saving Modelica package in a folder structure.
» Allow reordering of classes inside a package.

* Highlight matching parentheses in text view.

* When copying the text retain the text highlighting and formatting.
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* Support for global head definition in the documentation by using ‘°__OpenModelica_infoHeader* annota-
tion.

* Support for expandable connectors.

* Support for uses annotation.

27.6.3 FMI Support

 Full FMI 2.0 co-simulation support now available

» Upgrade Cpp runtime from C++03 to C++11 standard, minimizing external link dependencies. Exported
FMUs don’t depend on additional libraries such as boost anymore

* FMI 2.0 is broken for some models in 1.9.4. Upgrading to 1.9.6 is advised.

27.7 Release Notes for OpenModelica 1.9.3

The most important enhancements in the OpenModelica 1.9.3 release:

* Enhanced collaborative development and testing of OpenModelica by moving to the GIT-hub framework
for versioning and parallel development.

* More accessible and up-to-date automatically generated documentation provided in both html and pdf.
* Further improved simulation speed and coverage of several libraries.
* OMEdit graphic connection editor improvements.

* OMNotebook improvements.

27.7.1 OpenModelica Compiler (OMC)
This release mainly includes improvements of the OpenModelica Compiler (OMC), including, but not restricted
to the following:
* Further improved simulation speed and coverage for several libraries.
* Faster generated code for functions involving arrays, factor 2 speedup for many power generation models.
* Better initialization.
* An implicit inline Euler solver available.
* Code generation to enable vectorization of for-loops.
* Improved non-linear, linear and mixed system solving.
* Cross-compilation for the ARMhf architecture.
* A prototype state machine implementation.
* Improved performance and stability of the C++ runtime option.

* More accessible and up-to-date automatically generated documentation provided in both html and .pdf.

27.7.2 Graphic Editor OMEdit

There are several improvements to the OpenModelica graphic connection editor OMEdit:
* Support for uses annotations.
* Support for declaring components as vectors.

* Faster messages browser with clickable error messages.

27.7. Release Notes for OpenModelica 1.9.3 295


https://www.openmodelica.org/doc/OpenModelicaUsersGuide/latest/
https://openmodelica.org/doc/OpenModelicaUsersGuide/OpenModelicaUsersGuide-latest.pdf

OpenModelica User’s Guide, Release v1.13.0

* Support for managing the stacking order of graphical shapes.

* Several improvements to the plot tool and text editor in OMEdit.

27.7.3 OpenModelica Notebook (OMNotebook)

Several improvements:
* Support for moving cells from one place to another in a notebook.
* A button for evaluation of whole notebooks.

* A new cell type called Latex cells, supporting Latex formatted input that provides mathematical typesetting
of formulae when evaluated.

27.7.4 Optimization

Several improvements of the Dynamic Optimization module with collocation, using Ipopt:
* Better performance due to smart treatment of algebraic loops for optimization.

¢ Improved formulation of optimization problems with an annotation approach which also allows graphical
problem formulation.

* Proper handling of constraints at final time.

27.7.5 FMI Support

Further improved FMI 2.0 co-simulation support.

27.7.6 OpenModelica Development Environment (OMDev)

A big change: version handling and parallel development has been improved by moving from SVN to GIThub.
This makes it easier for each developer to test his/her fixes and enhancements before committing the code. Auto-
matic mirroring of all code is still performed to the OpenModelica SVN site.

27.8 Release Notes for OpenModelica 1.9.2

The OpenModelica 1.9.2 Beta release is available now, January 31, 2015. Please try it and give feedback! The
final release is planned within 1-2 weeks after some more testing. The most important enhancements in the
OpenModelica 1.9.2 release:

* The OpenModelica compiler has moved to a new development and release platform: the bootstrapped Open-
Modelica compiler. This gives advantages in terms of better programmability, maintenance, debugging,
modularity and current/future performance increases.

¢ The OpenModelica graphic connection editor OMEdit has become 3-5 times faster due to faster commu-
nication with the OpenModelica compiler linked as a DLL. This was made possible by moving to the
bootstrapped compiler.

* Further improved simulation coverage for a number of libraries.

* OMEdit graphic connection editor improvements
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27.8.1 OpenModelica Compiler (OMC)

This release mainly includes improvements of the OpenModelica Compiler (OMC), including, but not restricted
to the following:

* The OpenModelica compiler has moved to a new development and release platform: the bootstrapped Open-
Modelica compiler. This gives advantages in terms of better programmability, maintenance, debugging,
modularity and current/future performance increases.

* Further improved simulation coverage for a number of libraries compared to 1.9.1. For example:

MSL 3.2.1 100% compilation, 97% simulation (3% increase)

MSL Trunk 99% compilation (1% increase), 93% simulation (3% increase)

ModelicaTest 3.2.1 99% compilation (2% increase), 95% simulation (6% increase)

ThermoSysPro 100% compilation, 80% simulation (17% increase)

ThermoPower 97% compilation (5% increase), 85% simulation (5% increase)

Buildings 80% compilation (1% increase), 73% simulation (1% increase)

* Further enhanced OMC compiler front-end coverage, scalability, speed and memory.
* Better initialization.

* Improved tearing.

* Improved non-linear, linear and mixed system solving.

¢ Common subexpression elimination support - drastically increases performance of some models.

27.8.2 Graphic Editor OMEdit

* The OpenModelica graphic connection editor OMEdit has become 3-5 times faster due to faster commu-
nication with the OpenModelica compiler linked as a DLL. This was made possible by moving to the
bootstrapped compiler.

* Enhanced simulation setup window in OMEdit, which among other things include better support for inte-
gration methods and dassl options.

* Support for running multiple simultaneous simulation.
* Improved handling of modifiers.

* Re-simulate with changed options, including history support and re-simulating with previous options possi-
bly edited.

* More user friendly user interface by improved connection line drawing, added snap to grid for icons and
conversion of icons from PNG to SVG, and some additional fixes.

27.8.3 Optimization

Some smaller improvements of the Dynamic Optimization module with collocation, using Ipopt.

27.8.4 FMI Support

Further improved for FMI 2.0 model exchange import and export, now compliant according to the FMI compliance
tests. FMI 1.0 support has been further improved.
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27.9 Release Notes for OpenModelica 1.9.1

The most important enhancements in the OpenModelica 1.9.1 release:

Improved library support.

Further enhanced OMC compiler front-end coverage and scalability
Significant improved simulation support for libraries using Fluid and Media.
Dynamic model debugger for equation-based models integrated with OMEdit.

Dynamic algorithm model debugger with OMEdit; including support for MetaModelica when using the
bootstrapped compiler.

New features: Dynamic debugger for equation-based models; Dynamic Optimization with collocation built into
OpenModelica, performance analyzer integrated with the equation model debugger.

27.9.1 OpenModelica Compiler (OMC)

This release mainly includes improvements of the OpenModelica Compiler (OMC), including, but not restricted
to the following:

Further improved OMC model compiler support for a number of libraries including MSL 3.2.1, ModelicaT-
est 3.2.1, PetriNet, Buildings, PowerSystems, OpenHydraulics, ThermoPower, and ThermoSysPro.

Further enhanced OMC compiler front-end coverage, scalability, speed and memory.

Better coverage of Modelica libraries using Fluid and Media.

Automatic differentiation of algorithms and functions.

Improved testing facilities and library coverage reporting.

Improved model compilation speed by compiling model parts in parallel (bootstrapped compiler).
Support for running model simulations in a web browser.

New faster initialization that handles over-determined systems, under-determined systems, or both.
Compiler back-end partly redesigned for improved scalability and better modularity.

Better tearing support.

The first run-time Modelica equation-based model debugger, not available in any other Modelica tool, inte-
grated with OMEdit.

Enhanced performance profiler integrated with the debugger.

Improved parallelization prototype with several parallelization strategies, task merging and duplication,
shorter critical paths, several scheduling strategies.

Some support for general solving of mixed systems of equations.

Better error messages.

Improved bootstrapped OpenModelica compiler.

Better handling of array subscripts and dimensions.

Improved support for reduction functions and operators.

Better support for partial functions.

Better support for function tail recursion, which reduces memory usage.

Partial function evaluation in the back-end to improve solving singular systems.
Better handling of events/zero crossings.

Support for colored Jacobians.
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* New differentiation package that can handle a much larger number of expressions.
* Support for sparse solvers.

* Better handling of asserts.

* Improved array and matrix support.

* Improved overloaded operators support.

* Improved handling of overconstrained connection graphs.

* Better support for the cardinality operator.

* Parallel compilation of generated code for speeding up compilation.

* Split of model files into several for better compilation scalability.

* Default linear tearing.

* Support for impure functions.

* Better compilation flag documentation.

* Better automatic generation of documentation.

* Better support for calling functions via instance.

* New text template based unparsing for DAE, Absyn, SCode, TaskGraphs, etc.
 Better support for external objects (#2724, reject non-constructor functions returning external objects)
* Improved C++ runtime.

* Improved testing facilities.

* New unit checking implementation.

* Support for model rewriting expressions via rewriting rules in an external file.

* Reject more bad code (r19986, consider records with different components type-incompatible)

27.9.2 OpenModelica Connection Editor (OMEdit)

* Convenient editing of model parameter values and re-simulation without recompilation after parameter
changes.

* Improved plotting.
* Better handling of flags/units/resources/crashes.

* Run-time Modelica equation-based model debugger that provides both dynamic run-time debugging and
debugging of symbolic transformations.

* Run-time Modelica algorithmic code debugger; also MetaModelica debugger with the bootstrapped Open-
Modelica compiler.

27.9.3 OMPython

The interface was changed to version 2.0, which uses one object for each OpenModelica instance you want active.
It also features a new and improved parser that returns easier to use datatypes like maps and lists.

27.9.4 Optimization

A builtin integrated Dynamic Optimization module with collocation, using Ipopt, is now available.
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27.9.5 FMI Support

Support for FMI 2.0 model exchange import and export has been added. FMI 1.0 support has been further im-
proved.

27.10 Release Notes for OpenModelica 1.9.0

This is the summary description of changes to OpenModelica from 1.8.1 to 1.9.0, released 2013-10-09. This
release mainly includes improvements of the OpenModelica Compiler (OMC), including, but not restricted to the
following:

27.10.1 OpenModelica Compiler (OMC)

This release mainly includes bug fixes and improvements of the OpenModelica Compiler (OMC), including, but
not restricted to the following:

A more stable and complete OMC model compiler. The 1.9.0 final version simulates many more models
than the previous 1.8.1 version and OpenModelica 1.9.0 beta versions.

Much better simulation support for MSL 3.2.1, now 270 out of 274 example models compile (98%) and 245
(89%) simulate, compared to 30% simulating in the 1.9.0 betal release.

Much better simulation for the ModelicaTest 3.2.1 library, now 401 out of 428 models build (93%) and 364
simulate (85%), compared to 32% in November 2012.

Better simulation support for several other libraries, e.g. more than twenty examples simulate from Ther-
moSysPro, and all but one model from PlanarMechanics simulate.

Improved tearing algorithm for the compiler backend. Tearing is by default used.
Much faster matching and dynamic state selection algorithms for the compiler backend.
New index reduction algorithm implementation.

New default initialization method that symbolically solves the initialization problem much faster and more
accurately. This is the first version that in general initialize hybrid models correctly.

Better class loading from files. The package.order file is now respected and the file structure is more thor-
oughly examined (#1764).

It is now possible to translate the error messages in the omc kernel (#1767).

FMI Support. FMI co-simulation with OpenModelica as master. Improved

FMI Import and export for model exchange. Most of FMI 2.0 is now also supported.

Checking (when possible) that variables have been assigned to before they are used in algorithmic code
(#1776).

Full version of Python scripting.
3D graphics visualization using the Modelica3D library.

The PySimulator package from DLR for additional analysis is integrated with OpenModelica (see Model-
ica2012 paper), and included in the OpenModelica distribution (Windows only).

Prototype support for uncertainty computations, special feature enabled by special flag.

Parallel algorithmic Modelica support (ParModelica) for efficient portable parallel algorithmic program-
ming based on the OpenCL standard, for CPUs and GPUs.

Support for optimization of semiLinear according to MSL 3.3 chapter 3.7.2.5 semiLinear (r12657,r12658).

The compiler is now fully bootstrapped and can compile itself using a modest amount of heap and stack
space (less than the RML-based compiler, which is still the default).
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* Some old debug-flags were removed. Others were renamed. Debug flags can now be enabled by default.
* Removed old unused simulation flags noClean and storeInTemp (r15927).
* Many stack overflow issues were resolved.

¢ Dynamic Optimization with OpenModelica. Dynamic optimization with XML export to the CasADi pack-
age is now integrated with OpenModelica. Moreover, a native integrated Dynamic Optimization prototype
using Ipopt is now in the OpenModelica release, but currently needs a special flag to be turned on since it
needs more testing and refinement before being generally made available.

27.10.2 OpenModelica Notebook (OMNotebook)

¢ A ‘shortOutput® option has been introduced in the simulate command

for less verbose output. The DrModelica interactive document has been updated and the models tested. Almost
all models now simulate with OpenModelica.

27.10.3 OpenModelica Eclipse Plug-in (MDT)

¢ Enhanced debugger for algorithmic Modelica code, supporting both

standard Modelica algorithmic code called from simulation models, and MetaModelica code.

27.10.4 OpenModelica Development Environment (OMDev)

* Migration of version handling and configuration management from

CodeBeamer to Trac.

27.10.5 Graphic Editor OMEdit

* General GUI: backward and forward navigation support in Documentation view, enhanced parameters win-
dow with support for Dialog annotation. Most of the images are converted from raster to vector graphics i.e
PNG to SVG.

 Libraries Browser: better loading of libraries, library tree can now show protected classes, show library
items class names as middle ellipses if the class name text is larger, more options via the right click menu
for quick usage.

* ModelWidget: add the partial class as a replaceable component, look for the default component prefixes
and name when adding the component.

* GraphicsView: coordinate system manipulation for icon and diagram layers. Show red box for models
that do not exist. Show default graphical annotation for the components that doesn’t have any graphical
annotations. Better resizing of the components. Properties dialog for primitive shapes i.e Line, Polygon,
Rectangle, Ellipse, Text and Bitmap.

* File Opening: open one or more Modelica files, allow users to select the encoding while opening the file,
convert files to UTF-8 encoding, allow users to open the OpenModelica result files.

* Variables Browser: find variables in the variables browser, sorting in the variables browser.

* Plot Window: clear all curves of the plot window, preserve the old selected variable and update its value
with the new simulation result.

 Simulation: support for all the simulation flags, read the simulation output as soon as is is obtained, output
window for simulations, options to set matching algorithm and index reduction method for simulation.
Display all the files generated during the simulation is now supported. Options to set OMC command line
flags.
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* Options: options for loading libraries via loadModel and loadFile each time GUI starts, save the last open
file directory location, options for setting line wrap mode and syntax highlighting.

* Modelica Text Editor: preserving user customizations, new search & replace functionality, support for
comment/uncomment.

* Notifications: show custom dialogs to users allowing them to choose whether they want to see this dialog
again or not.

* Model Creation: Better support for creating new classes. Easy creation of extends classes or nested classes.
* Messages Widget: Multi line error messages are now supported.

* Crash Detection: The GUI now automatically detects the crash and writes a stack trace file. The user is
given an option to send a crash report along with the stack trace file and few other useful files via email.

* Autosave: OMEdit saves the currently edited model regularly, in order to avoid losing edits after GUI or
compiler crash. The save interval can be set in the Options menu.

27.10.6 ModelicaML

* Enhanced ModelicaML version with support for value bindings in

requirements-driven modeling available for the latest Eclipse and Papyrus versions. GUI specific adaptations.
Automated model composition workflows (used for model-based design verification against requirements) are
modularized and have improved in terms of performance.

27.11 Release Notes for OpenModelica 1.8.1

The OpenModelica 1.8.1 release has a faster and more stable OMC model compiler. It flattens and simulates
more models than the previous 1.8.0 version. Significant flattening speedup of the compiler has been achieved for
certain large models. It also contains a New ModelicaML version with support for value bindings in requirements-
driven modeling and importing Modelica library models into ModelicaML models. A beta version of the new
OpenModelica Python scripting is also included. The release was made on 2012-04-03 (r11645).

27.11.1 OpenModelica Compiler (OMC)

This release includes bug fixes and improvements of the flattening frontend part of the OpenModelica Compiler
(OMC) and several improvements of the backend, including, but not restricted to:

* A faster and more stable OMC model compiler. The 1.8.1 version flattens and simulates more models than
the previous 1.8.0 version.

* Support for operator overloading (except Complex numbers).

* New ModelicaML version with support for value bindings in requirements-driven modeling and importing
Modelica library models into ModelicaML models.

* Faster plotting in OMNotebook. The feature sendData has been removed from OpenModelica. As a result,
the kernel no longer depends on Qt. The plot3() family of functions have now replaced to plot(), which in
turn have been removed. The non-standard visualize() command has been removed in favour of more recent
alternatives.

 Store OpenModelica documentation as Modelica Documentation annotations.

¢ Re-implementation of the simulation runtime using C instead of C++ (this was needed to export FMI source-
based packages).

e FMI import/export bug fixes.

» Changed the internal representation of various structures to share more memory. This significantly improved
the performance for very large models that use records.
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* Faster model flattening, Improved simulation, some graphical API bug fixes.
* More robust and general initialization, but currently time-consuming.

» New initialization flags to omc and options to simulate(), to control whether fast or robust initialization is
selected, or initialization from an external (.mat) data file.

* New options to API calls list, loadFile, and more.
* Enforce the restriction that input arguments of functions may not be assigned to.

 Improved the scripting environment. cl := $TypeName(Modelica);getClassComment(cl); now works as
expected. As does looping over lists of typenames and using reduction expressions.

* Beta version of Python scripting.
* Various bugfixes.

* NOTE: interactive simulation is not operational in this release. It will be put back again in the near future,
first available as a nightly build. It is also available in the previous 1.8.0 release.

27.11.2 OpenModelica Notebook (OMNotebook)

* Faster and more stable plottning.

27.11.3 OpenModelica Shell (OMShell)

* No changes.

27.11.4 OpenModelica Eclipse Plug-in (MDT)

* Small fixes and improvements.

27.11.5 OpenModelica Development Environment (OMDev)

* No changes.

27.11.6 Graphic Editor OMEdit

* Bug fixes.

27.11.7 OMOptim Optimization Subsystem

* Bug fixes.

27.11.8 FMI Support

* Bug fixes.

27.12 OpenModelica 1.8.0, November 2011

The OpenModelica 1.8.0 release contains OMC flattening improvements for the Media library - it now flattens the
whole library and simulates about 20% of its example models. Moreover, about half of the Fluid library models
also flatten. This release also includes two new tool functionalities - the FMI for model exchange import and
export, and a new efficient Eclipse-based debugger for Modelica/MetaModelica algorithmic code.
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27.12.1 OpenModelica Compiler (OMC)

This release includes bug fixes and improvements of the flattening frontend part of the OpenModelica Compiler
(OMC) and several improvements of the backend, including, but not restricted to: A faster and more stable OMC
model compiler. The 1.8.0 version flattens and simulates more models than the previous 1.7.0 version.

¢ Flattening of the whole Media library, and about half of the Fluid

library. Simulation of approximately 20% of the Media library example models. - Functional Mockup Interface
FMI 1.0 for model exchange, export and import, for the Windows platform. - Bug fixes in the OpenModel-
ica graphical model connection editor OMEdit, supporting easy-to-use graphical drag-and-drop modeling and
MSL 3.1. - Bug fixes in the OMOptim optimization subsystem. - Beta version of compiler support for a new
Eclipse-based very efficient algorithmic code debugger for functions in MetaModelica/Modelica, available in the
development environment when using the bootstrapped OpenModelica compiler. - Improvements in initialization
of simulations. - Improved index reduction with dynamic state selection, which improves simulation. - Better
error messages from several parts of the compiler, including a new API call for giving better error messages. -
Automatic partitioning of equation systems and multi-core parallel simulation of independent parts based on the
shared-memory OpenMP model. This version is a preliminary experimental version without load balancing.

27.12.2 OpenModelica Notebook (OMNotebook)

No changes.

27.12.3 OpenModelica Shell (OMShell)

Small performance improvements.

27.12.4 OpenModelica Eclipse Plug-in (MDT)

Small fixes and improvements. MDT now also includes a beta version of a new Eclipse-based very efficient
algorithmic code debugger for functions in MetaModelica/Modelica.

27.12.5 OpenModelica Development Environment (OMDev)

Third party binaries, including Qt libraries and executable Qt clients, are now part of the OMDev package. Also,
now uses GCC 4.4.0 instead of the earlier GCC 3.4.5.

27.12.6 Graphic Editor OMEdit

Bug fixes. Access to FMI Import/Export through a pull-down menu. Improved configuration of library loading.
A function to go to a specific line number. A button to cancel an on-going simulation. Support for some updated
OMC API calls.

27.12.7 New OMOptim Optimization Subsystem

Bug fixes, especially in the Linux version.

27.12.8 FMI Support

The Functional Mockup Interface FMI 1.0 for model exchange import and export is supported by this release. The
functionality is accessible via API calls as well as via pull-down menu commands in OMEdit.
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27.13 OpenModelica 1.7.0, April 2011

The OpenModelica 1.7.0 release contains OMC flattening improvements for the Media library, better and faster
event handling and simulation, and fast MetaModelica support in the compiler, enabling it to compiler itself. This
release also includes two interesting new tools — the OMOptim optimization subsystem, and a new performance
profiler for equation-based Modelica models.

27.13.1 OpenModelica Compiler (OMC)

This release includes bug fixes and performance improvements of the flattening frontend part of the OpenModelica
Compiler (OMC) and several improvements of the backend, including, but not restricted to:

* Flattening of the whole Modelica Standard Library 3.1 (MSL 3.1),

except Media and Fluid. - Progress in supporting the Media library, some models now flatten. - Much faster
simulation of many models through more efficient handling of alias variables, binary output format, and faster
event handling. - Faster and more stable simulation through new improved event handling, which is now default.
- Simulation result storage in binary .mat files, and plotting from such files. - Support for Unicode characters
in quoted Modelica identifiers, including Japanese and Chinese. - Preliminary MetaModelica 2.0 support. (use
setCommandLineOptions({ "+g=MetaModelica"}) ). Execution is as fast as MetaModelica 1.0, except for garbage
collection. - Preliminary bootstrapped OpenModelica compiler: OMC now compiles itself, and the bootstrapped
compiler passes the test suite. A garbage collector is still missing. - Many bug fixes.

27.13.2 OpenModelica Notebook (OMNotebook)

Improved much faster and more stable 2D plotting through the new OMPlot module. Plotting from binary .mat
files. Better integration between OMEdit and OMNotebook, copy/paste between them.

27.13.3 OpenModelica Shell (OMShell)

Same as previously, except the improved 2D plotting through OMPlot.

27.13.4 Graphic Editor OMEdit
Several enhancements of OMEdit are included in this release. Support for Icon editing is now available. There is
also an improved much faster 2D plotting through the new OMPlot module. Better integration between OMEdit

and OMNotebook, with copy/paste between them. Interactive on-line simulation is available in an easy-to-use
way.

27.13.5 New OMOptim Optimization Subsystem

A new optimization subsystem called OMOptim has been added to OpenModelica. Currently, parameter opti-
mization using genetic algorithms is supported in this version 0.9. Pareto front optimization is also supported.

27.13.6 New Performance Profiler

A new, low overhead, performance profiler for Modelica models has been developed.
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27.14 OpenModelica 1.6.0, November 2010

The OpenModelica 1.6.0 release primarily contains flattening, simulation, and performance improvements regard-
ing Modelica Standard Library 3.1 support, but also has an interesting new tool — the OMEdit graphic connection
editor, and a new educational material called DrControl, and an improved ModelicaML UML/Modelica profile
with better support for modeling and requirement handling.

27.14.1 OpenModelica Compiler (OMC)

This release includes bug fix and performance improvemetns of the flattening frontend part of the OpenModelica
Compiler (OMC) and some improvements of the backend, including, but not restricted to:

* Flattening of the whole Modelica Standard Library 3.1 (MSL 3.1),

except Media and Fluid. - Improved flattening speed of a factor of 5-20 compared to OpenModelica 1.5 for a
number of models, especially in the MultiBody library. - Reduced memory consumption by the OpenModelica
compiler frontend, for certain large models a reduction of a factor 50. - Reorganized, more modular OpenModelica
compiler backend, can now handle approximately 30 000 equations, compared to previously approximately 10 000
equations. - Better error messages from the compiler, especially regarding functions. - Improved simulation
coverage of MSL 3.1. Many models that did not simulate before are now simulating. However, there are still many
models in certain sublibraries that do not simulate. - Progress in supporting the Media library, but simulation is
not yet possible. - Improved support for enumerations, both in the frontend and the backend. - Implementation of
stream connectors. - Support for linearization through symbolic Jacobians. - Many bug fixes.

27.14.2 OpenModelica Notebook (OMNotebook)

A new DrControl electronic notebook for teaching control and modeling with Modelica.

27.14.3 OpenModelica Development Environment (OMDev)

Several enhancements. Support for match-expressions in addition to matchcontinue. Support for real if-then-else.
Support for if-then without else-branches. Modelica Development Tooling 0.7.7 with small improvements such as
more settings, improved error detection in console, etc.

27.14.4 New Graphic Editor OMEdit

A new improved open source graphic model connection editor called OMEdit, supporting 3.1 graphical annota-
tions, which makes it possible to move models back and forth to other tools without problems. The editor has
been implemented by students at Link&ping University and is based on the C++ Qt library.

27.15 OpenModelica 1.5.0, July 2010

This OpenModelica 1.5 release has major improvements in the OpenModelica compiler frontend and some in the
backend. A major improvement of this release is full flattening support for the MultiBody library as well as limited
simulation support for MultiBody. Interesting new facilities are the interactive simulation and the integrated UML-
Modelica modeling with ModelicaML. Approximately 4 person-years of additional effort have been invested in
the compiler compared to the 1.4.5 version, e.g., in order to have a more complete coverage of Modelica 3.0,
mainly focusing on improved flattening in the compiler frontend.

306 Chapter 27. Major OpenModelica Releases



OpenModelica User’s Guide, Release v1.13.0

27.15.1 OpenModelica Compiler (OMC)

This release includes major improvements of the flattening frontend part of the OpenModelica Compiler (OMC)
and some improvements of the backend, including, but not restricted to:

* Improved flattening speed of at least a factor of 10 or more compared

to the 1.4.5 release, primarily for larger models with inner-outer, but also speedup for other models, e.g. the robot
model flattens in approximately 2 seconds. - Flattening of all MultiBody models, including all elementary models,
breaking connection graphs, world object, etc. Moreover, simulation is now possible for at least five MultiBody
models: Pendulum, DoublePendulum, InitSpringConstant, World, PointGravityWithPointMasses. - Progress in
supporting the Media library, but simulation is not yet possible. - Support for enumerations, both in the frontend
and the backend. - Support for expandable connectors. - Support for the inline and late inline annotations in
functions. - Complete support for record constructors, also for records containing other records. - Full support
for iterators, including nested ones. - Support for inferred iterator and for-loop ranges. - Support for the function
derivative annotation. - Prototype of interactive simulation. - Prototype of integrated UML-Modelica modeling
and simulation with ModelicaML. - A new bidirectional external Java interface for calling external Java functions,
or for calling Modelica functions from Java. - Complete implementation of replaceable model extends. - Fixed
problems involving arrays of unknown dimensions. - Limited support for tearing. - Improved error handling at
division by zero. - Support for Modelica 3.1 annotations. - Support for all MetaModelica language constructs
inside OpenModelica. - OpenModelica works also under 64-bit Linux and Mac 64-bit OSX. - Parallel builds and
running test suites in parallel on multi-core platforms. - New OpenModelica text template language for easier
implementation of code generators, XML generators, etc. - New OpenModelica code generators to C and C#
using the text template language. - Faster simulation result data file output optionally as comma-separated values.
- Many bug fixes.

It is now possible to graphically edit models using parts from the Modelica Standard Library 3.1, since the sim-
Forge graphical editor (from Politecnico di Milano) that is used together with OpenModelica has been updated to
version 0.9.0 with a important new functionality, including support for Modelica 3.1 and 3.0 annotations. The 1.6
and 2.2.1 Modelica graphical annotation versions are still supported.

27.15.2 OpenModelica Notebook (OMNotebook)

Improvements in platform availability.
* Support for 64-bit Linux. - Support for Windows 7. - Better support
for MacOS, including 64-bit OSX.

27.16 OpenModelica 1.4.5, January 2009

This release has several improvements, especially platform availability, less compiler memory usage, and support-
ing more aspects of Modelica 3.0.

27.16.1 OpenModelica Compiler (OMC)

This release includes small improvements and some bugfixes of the OpenModelica Compiler (OMC):
* Less memory consumption and better memory management over time. This

also includes a better API supporting automatic memory management when calling C functions from within the
compiler. - Modelica 3.0 parsing support. - Export of DAE to XML and MATLAB. - Support for several platforms
Linux, MacOS, Windows (2000, Xp, Vista). - Support for record and strings as function arguments. - Many bug
fixes. - (Not part of OMC): Additional free graphic editor SimForge can be used with OpenModelica.
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27.16.2 OpenModelica Notebook (OMNotebook)

A number of improvements, primarily in the plotting functionality and platform availability.
¢ A number of improvements in the plotting functionality: scalable

plots, zooming, logarithmic plots, grids, etc. - Programmable plotting accessible through a Modelica API. - Simple
3D visualization. - Support for several platforms Linux, MacOS, Windows (2000, Xp, Vista).

27.17 OpenModelica 1.4.4, Feb 2008

This release is primarily a bug fix release, except for a preliminary version of new plotting functionality available
both from the OMNotebook and separately through a Modelica API. This is also the first release under the open
source license OSMC-PL (Open Source Modelica Consortium Public License), with support from the recently
created Open Source Modelica Consortium. An integrated version handler, bug-, and issue tracker has also been
added.

27.17.1 OpenModelica Compiler (OMC)

This release includes small improvements and some bugfixes of the OpenModelica Compiler (OMC):
* Better support for if-equations, also inside when. - Better support

for calling functions in parameter expressions and interactively through dynamic loading of functions. - Less
memory consumtion during compilation and interactive evaluation. - A number of bug-fixes.

27.17.2 OpenModelica Notebook (OMNotebook)

Test release of improvements, primarily in the plotting functionality and platform availability.
¢ Preliminary version of improvements in the plotting functionality:

scalable plots, zooming, logarithmic plots, grids, etc., currently available in a preliminary version through the
plot2 function. - Programmable plotting accessible through a Modelica API.

27.17.3 OpenModelica Eclipse Plug-in (MDT)

This release includes minor bugfixes of MDT and the associated MetaModelica debugger.

27.17.4 OpenModelica Development Environment (OMDev)

Extended test suite with a better structure. Version handling, bug tracking, issue tracking, etc. now available under
the integrated Codebeamer.

27.18 OpenModelica 1.4.3, June 2007

This release has a number of significant improvements of the OMC compiler, OMNotebook, the MDT plugin and
the OMDev. Increased platform availability now also for Linux and Macintosh, in addition to Windows. OMShell
is the same as previously, but now ported to Linux and Mac.
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27.18.1 OpenModelica Compiler (OMC)

This release includes a number of improvements of the OpenModelica Compiler (OMC):
* Significantly increased compilation speed, especially with large

models and many packages. - Now available also for Linux and Macintosh platforms. - Support for when-
equations in algorithm sections, including elsewhen. - Support for inner/outer prefixes of components (but without
type error checking). - Improved solution of nonlinear systems. - Added ability to compile generated simulation
code using Visual Studio compiler. - Added "smart setting of fixed attribute to false. If initial equations, OMC
instead has fixed=true as default for states due to allowing overdetermined initial equation systems. - Better state
select heuristics. - New function getIncidenceMatrix(ClassName) for dumping the incidence matrix. - Builtin
functions String(), product(), ndims(), implemented. - Support for terminate() and assert() in equations. - In
emitted flat form: protected variables are now prefixed with protected when printing flat class. - Some support
for tables, using omcTableTimelni instead of dymTableTimelni2. - Better support for empty arrays, and support
for matrix operations like a*[1,2;3,4]. - Improved val() function can now evaluate array elements and record
fields, e.g. val(x[n]), val(x.y) . - Support for reinit in algorithm sections. - String support in external functions. -
Double precision floating point precision now also for interpreted expressions - Better simulation error messages.
- Support for der(expressions). - Support for iterator expressions such as {3*i for i in 1..10}. - More test cases in
the test suite. - A number of bug fixes, including sample and event handling bugs.

27.18.2 OpenModelica Notebook (OMNotebook)

A number of improvements, primarily in the platform availability.
* Available on the Linux and Macintosh platforms, in addition to

Windows. - Fixed cell copying bugs, plotting of derivatives now works, etc.

27.18.3 OpenModelica Shell (OMShell)

Now available also on the Macintosh platform.

27.18.4 OpenModelica Eclipse Plug-in (MDT)

This release includes major improvements of MDT and the associated MetaModelica debugger:
 Greatly improved browsing and code completion works both for standard

Modelica and for MetaModelica. - Hovering over identifiers displays type information. - A new and greatly
improved implementation of the debugger for MetaModelica algorithmic code, operational in Eclipse. Greatly
improved performance - only approx 10% speed reduction even for 100 000 line programs. Greatly improved
single stepping, step over, data structure browsing, etc. - Many bug fixes.

27.18.5 OpenModelica Development Environment (OMDev)

Increased compilation speed for MetaModelica. Better if-expression support in MetaModelica.

27.19 OpenModelica 1.4.2, October 2006

This release has improvements and bug fixes of the OMC compiler, OMNotebook, the MDT plugin and the
OMDev. OMShell is the same as previously.
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27.19.1 OpenModelica Compiler (OMC)

This release includes further improvements of the OpenModelica Compiler (OMC):
 Improved initialization and index reduction. - Support for integer

arrays is now largely implemented. - The val(variable,time) scripting function for accessing the value of a sim-
ulation result variable at a certain point in the simulated time. - Interactive evalution of for-loops, while-loops,
if-statements, if-expressions, in the interactive scripting mode. - Improved documentation and examples of calling
the Model Query and Manipulation API. - Many bug fixes.

27.19.2 OpenModelica Notebook (OMNotebook)

Search and replace functions have been added. The DrModelica tutorial (all files) has been updated, obsolete
sections removed, and models which are not supported by the current implementation marked clearly. Automatic
recognition of the .onb suffix (e.g. when double-clicking) in Windows makes it even more convenient to use.

27.19.3 OpenModelica Eclipse Plug-in (MDT)

Two major improvements are added in this release:
* Browsing and code completion works both for standard Modelica and for

MetaModelica. - The debugger for algorithmic code is now available and operational in Eclipse for debugging of
MetaModelica programs.

27.20 OpenModelica 1.4.1, June 2006

This release has only improvements and bug fixes of the OMC compiler, the MDT plugin and the OMDev com-
ponents. The OMShell and OMNotebook are the same.

27.20.1 OpenModelica Compiler (OMC)

This release includes further improvements of the OpenModelica Compiler (OMC):
* Support for external objects. - OMC now reports the version number

(via command line switches or CORBA API getVersion()). - Implemented caching for faster instantiation of large
models. - Many bug fixes.

27.20.2 OpenModelica Eclipse Plug-in (MDT)

Improvements of the error reporting when building the OMC compiler. The errors are now added to the problems
view. The latest MDT release is version 0.6.6 (2006-06-06).

27.20.3 OpenModelica Development Environment (OMDev)

Small fixes in the MetaModelica compiler. MetaModelica Users Guide is now part of the OMDeyv release. The
latest OMDev was release in 2006-06-06.
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27.21 OpenModelica 1.4.0, May 2006

This release has a number of improvements described below. The most significant change is probably that OMC
has now been translated to an extended subset of Modelica (MetaModelica), and that all development of the
compiler is now done in this version..

27.21.1 OpenModelica Compiler (OMC)

This release includes further improvements of the OpenModelica Compiler (OMC):
* Partial support for mixed system of equations. - New initialization

routine, based on optimization (minimizing residuals of initial equations). - Symbolic simplification of builtin
operators for vectors and matrices. - Improved code generation in simulation code to support e.g. Modelica
functions. - Support for classes extending basic types, e.g. connectors (support for MSL 2.2 block connectors). -
Support for parametric plotting via the plotParametric command. - Many bug fixes.

27.21.2 OpenModelica Shell (OMShell)

Essentially the same OMShell as in 1.3.1. One difference is that now all error messages are sent to the command
window instead of to a separate log window.

27.21.3 OpenModelica Notebook (OMNotebook)

Many significant improvements and bug fixes. This version supports graphic plots within the cells in the notebook.
Improved cell handling and Modelica code syntax highlighting. Command completion of the most common OMC
commands is now supported. The notebook has been used in several courses.

27.21.4 OpenModelica Eclipse Plug-in (MDT)

This is the first really useful version of MDT. Full browsing of Modelica code, e.g. the MSL 2.2, is now supported.
(MetaModelica browsing is not yet fully supported). Full support for automatic indentation of Modelica code,
including the MetaModelica extensions. Many bug fixes. The Eclipse plug-in is now in use for OpenModelica
development at PELAB and MathCore Engineering AB since approximately one month.

27.21.5 OpenModelica Development Environment (OMDev)

The following mechanisms have been put in place to support OpenModelica development.
* A separate web page for OMDev (OpenModelica Development Environment).
* A pre-packaged OMDev zip-file with precompiled binaries for

development under Windows using the mingw Gnu compiler from the Eclipse MDT plug-in. (Development is
also possible using Visual Studio). - All source code of the OpenModelica compiler has recently been translated
to an extended subset of Modelica, currently called MetaModelica. The current size of OMC is approximately
100 000 lines All development is now done in this version. - A new tutorial and users guide for development in
MetaModelica. - Successful builds and tests of OMC under Linux and Solaris.

27.22 OpenModelica 1.3.1, November 2005

This release has several important highlights.
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This is also the *first* release for which the New BSD (Berkeley) open-source license applies to the source code,
including the whole compiler and run-time system. This makes is possible to use OpenModelica for both academic
and commercial purposes without restrictions.

27.22.1 OpenModelica Compiler (OMC)

This release includes a significantly improved OpenModelica Compiler (OMC):
* Support for hybrid and discrete-event simulation (if-equations,

if-expressions, when-equations; not yet if-statements and when-statements). - Parsing of full Modelica 2.2 -
Improved support for external functions. - Vectorization of function arguments; each-modifiers, better implemen-
tation of replaceable, better handling of structural parameters, better support for vector and array operations, and
many other improvements. - Flattening of the Modelica Block library version 1.5 (except a few models), and
simulation of most of these. - Automatic index reduction (present also in previous release). - Updated User’s
Guide including examples of hybrid simulation and external functions.

27.22.2 OpenModelica Shell (OMShell)

An improved window-based interactive command shell, now including command completion and better editing
and font size support.

27.22.3 OpenModelica Notebook (OMNotebook)

A free implementation of an OpenModelica notebook (OMNotebook), for electronic books with course material,
including the DrModelica interactive course material. It is possible to simulate and plot from this notebook.

27.22.4 OpenModelica Eclipse Plug-in (MDT)

An early alpha version of the first Eclipse plug-in (called MDT for Modelica Development Tooling) for Mod-
elica Development. This version gives compilation support and partial support for browsing Modelica package
hierarchies and classes.

27.22.5 OpenModelica Development Environment (OMDev)

The following mechanisms have been put in place to support OpenModelica development.
 Bugzilla support for OpenModelica bug tracking, accessible to anybody.
* A system for automatic regression testing of the compiler and

simulator, (+ other system parts) usually run at check in time. - Version handling is done using SVN, which is
better than the previously used CVS system. For example, name change of modules is now possible within the
version handling system.
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CHAPTER
TWENTYEIGHT

CONTRIBUTORS TO OPENMODELICA

This Appendix lists the individuals who have made significant contributions to OpenModelica, in the form of soft-
ware development, design, documentation, project leadership, tutorial material, promotion, etc. The individuals
are listed for each year, from 1998 to the current year: the project leader and main author/editor of this document
followed by main contributors followed by contributors in alphabetical order.
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